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N はじめに

ECU ソフトウェアをリアルタイム環境でテストを行うには、リアルタイム処理を
実行できる実験用ハードウェアシステムが必要です。このハードウェア（ES1000
システム）のプロセッサノードとしての役割を果たすシミュレーションボードは、

「実験ターゲット」または「E-Target」（Experimental Target）と呼ばれ、本製品
ASCET-RP V5.4 （ASCET Rapid Prototyping V5.4）を使用して ASCET の実験環境
に統合します。そしてさらに各種 I/O ボードを統合することにより、強力な開発
システムを構築することができます。

ASCET-RP の製品パッケージには、コンパイラコールやリンカコールの統合機能や
実験ターゲットのための ERCOSEK オペレーティングシステムカーネル、といった
ASCET 開発環境の拡張機能に加え、コンパイラツールセットのライセンスも含ま
れています。

ASCET-RP には、ASCET 基本システムの基本機能も含まれています。モデルの作
成や編集を行うには、別製品「ASCET-MD」が必要です。

1.1 コンポーネント

ASCET-RP V5.4 には、以下の機能を実現するコンポーネントが含まれています。

• ES1130 または ES11351 を実験環境に統合

• I/O ボード、または ETK バイパスや CAN バイパス機能を、実験ターゲット
（ES1130 および ES1135）に統合 （RTIO パッケージ）

• GNU コンパイラ

• 各種ドキュメントとサンプルファイル

1.2 インストール

ASCET 基本システムと ASCET-RP は、同じ CD-ROM に納められています。PC に
ASCET-RP V5.4 をインストールするには、あらかじめ ASCET 基本システムがイン
ストールされている必要があります。

最初に ASCET.exeというインストールプログラムを実行し、続いて
ASCET-RP.exeを実行してください。

ASCET-RP V5.4 のインストールについての詳細は、リリースノートを参照してく
ださい。

1. 本マニュアル内においては、任意のシステムコントローラを表わす場合は「ES113x」
という名称が使用されています。
はじめに 11



12
サンプルファイル

ASCET-RP V5.4 をインストールすると、ASCET からエクスポートされたサンプル
データベース（RTIOTutorial.exp および INTECRIO_Tutorial.exp という
エクスポートファイル）が、ASCET ディレクトリ内の EXPORTディレクトリに格
納されます。

1.3 本書の構成

この『ASCET-RP V5.4 ユーザーズガイド』は、以下の 3 つの内容で構成されてい
ます。

• 概要

• リアルタイム I/O パッケージの詳細（バイパスインターフェースの機能説明
を含む）

• チュートリアル

概要の部分は ASCET-RP V5.4 のすべてのユーザーの方を対象としています。ここ
では ASCET-RP V5.4 の構成とインストール、および一般的な使用方法に関して説
明されています。

次の部分に、ASCET-RP V5.4 に含まれる RTIO（リアルタイム I/O）パッケージの
機能や操作方法についての詳しい情報が記載されています。

チュートリアルには、いくつかのボードの設定方法と INTECRIO での実験方法に
ついて説明されています。

1.4 本書の記述について

1.4.1 記述形式

ユーザーが実行するすべてのアクションは、以下のような“Use-Case”形式で記
述されています。

目標の定義：

• 手順 1

手順 1 についての説明

• 手順 2

• 手順 3

上記のように、操作を行う目標がタイトルとして最初に簡潔に定義され（例：「新
しいコンポーネントを作成する」、「エレメントの名前を変更する」）、その下に、
その目標を実現するために必要な操作手順が列挙され、必要に応じて ASCET の
ウィンドウやダイアログボックスのスクリーンショットが添付されています。
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1.4.2 表記上の規約

本書は以下の規則に従って表記されています。

特に重要な注意事項は、以下のように表記されています。

また PDF 文書において、索引、および他の部分を参照する個所（例：「xxxx を参
照してください」の「xxxx」の部分）については、その参照先へのリンクが設け
られているので、必要な参照個所を素早く見つけることができます。

表記例 説明

File → Exit を選択して、... メニューコマンドは、青の太字で表記
します。

OK をクリックして、... ユーザーインターフェース上のボタン
名は、青の太字で表記します。

<Ctrl> を押して、... キーボードの各キーは、< > で囲んで表
記します。

“Open File”ダイアログボックスが
開きます。

プログラムウィンドウ、ダイアログ
ボックス、入力フィールド等のタイト
ルは、“ ”で囲んで表記します。

setup.exeファイルを選択します。 リストボックス、プログラムコード、
ファイル名、パス名等のテキスト文字
列は、Courierフォントで表記しま
す。

論理型のデータから算術型のデータ
への変換はできません。

注意すべき個所、または新出の用語は
太字、または「 」で囲んで表記されま
す。

OSEK グループ（http://www.osek-
vdx.org/ を参照してください）はさま
ざまな標準規格を策定しています。

インターネットへのリンクは、青い下
線で表記されています。

注記

ユーザー向けの重要な注意事項
はじめに 13
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O 実験ターゲットの設定

ASCET-RP V5.4（ASCET Rapid Prototyping V5.4）には、トランスピュータまたは
PowerPC を搭載した各ターゲット用の実行ファイルを作成するために必要なコン
パイラ／リンカツールと、ハードウェアを統合するための ASCET 開発環境の拡張
機能が含まれています。ASCET のプロジェクトエディタにおいてターゲット

（Target オプション）を選択するだけで、そのターゲット用のすべての機能が
ASCET の環境に統合されます。

コンパイラとリンカのコンフィギュレーション、および実際のターゲットハード
ウェア用インターフェースは、ASCET ソフトウェアから直接定義するのではな
く、ETAS ネットワークマネージャ、または一連の *.iniファイルで定義します。
2.1 項では ASCET-RP ソフトウェア内で行うハードウェアオプション設定について
説明し、2.2 項で ETAS ネットワークマネージャを利用したハードウェア接続の設
定方法について説明します。また 2.4 項では target.iniファイルを変更して
ホストインターフェースの設定を行う方法やイーサネットインターフェースの設
定方法について説明します。

さらに 2.4 項と 2.5 項では、コンパイラの選択と設定について説明します。

2.6 項では、ASCET からは変更することのできない、ascetsd.iniファイルの
いくつかのオプションについて説明します。これらの設定を変更するには、同
ファイルをテキストエディタで編集する必要があります。

mçïÉêJm` を使用した実験ターゲット用ディレクトリの構造

ASCET-RP V5.4 をインストールすると、ASCET ディレクトリの下に 2 つのター
ゲットディレクトリ（PowerPC ベースの各実験ターゲット用のサブディレクト
リ）が作成され、各ターゲットに固有な情報や設定、およびライブラリファイル
が格納されます。

両方のシミュレーションボード（ES1130 および ES1135）で共通に使用される
ファイルは、..¥target¥ES113x ディレクトリに格納されています。

実験ターゲットを変更する際、ASCET の“Options”ダイアログボックスのシス
テムルートパス設定を変更する必要はありません。

ASCET の
サブディレクトリ

実験システム
（VME システム）

実験ターゲット
（シミュレーションボード）

..¥Target¥ES1130 ES1000.2/ES1000.3a ES1130

..¥Target¥ES1135 ES1000.2/ES1000.3 ES1135

a: 本マニュアル内において「実験システム」は、特定の機種に限定した説明部
分を除き、通常は「ES1000」または「ES1000.x」という名称で記載されていま
す。
実験ターゲットの設定 15
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2.1 ハードウェアに関するオプション設定

ASCET-RP をインストールすると、ASCET の“Options”ダイアログボックスに
“Hardware”タブが追加され、ここでハードウェアインターフェースの設定を簡
単に行うことができます。以下にこのタブで設定できるオプションについて説明
します。通常は、最も頻繁に使用するハードウェア構成を設定しておいてくださ
い。

• Use ETAS Network Manager (enables ’Select Hardware’)

ETAS ネットワークマネージャ（第 12 章を参照してください）を使用する
かどうかを指定するためのオプションです。デフォルトではオンになって
います。
このオプションがオンになっていると、Select Hardware ボタン、および
メニューコマンド Extras → Select Hardware が使用可能となります。

• Skip HW selection if exactly one matching target instance found

このオプションがオン（デフォルト）になっていると、実験開始時のハー
ドウェア検索によって、プロジェクトで定義されたものと一致するハード
ウェアが 1 台のみ検知された場合、“Experimental Target Hardware 
Selection”ダイアログボックスが開きません。
このオプションがオフになっていると、次のオプション（Skip HW 
selection if last used target instance found）の設定によって、実験開
始時に“Experimental Target Hardware Selection”ダイアログボックスが

注記

以下の 2 つのオプションは、ETAS ネットワークマネージャの使用が有効に
なっている場合にのみ意味を持ちます。
実験ターゲットの設定



開くかどうかが決まります。このダイアログボックスには、PC に接続さ
れているすべての実験ハードウェアが表示され、使用するものを選択する
ことができます。

• Skip HW selection if last used target instance found

このオプションがオン（デフォルト）になっていると、実験開始時のハー
ドウェア検索によって、前回プロジェクトで使用されたハードウェアのみ
が検知された場合、“Experimental Target Hardware Selection”ダイアログ
ボックスが開きません。
このオプションがオフになっていると、前のオプション（Skip HW 
selection if exactly one matching target instance found）の設定に
よって、実験開始時に“Experimental Target Hardware Selection”ダイア
ログボックスが開くかどうかが決まります。

• HW connection

このコンボボックスで、ES1000 システム内の ES1120 コントローラボー
ドと PC を接続するか（indirect (ES1120)、デフォルト）。それとも
ES113ｘ シミュレーションボードと PC を接続するか（direct 
(ES113x)）を選択します。

• Try alternative HW connection

ハードウェア検査時、このオプションがオン（デフォルト）になっている
と、“HW connection”コンボボックスで選択されたもの以外のデバイス
も検索され、オプションがオフになっていると、選択されたデバイスのみ
が検索されます。

• Check HW connection before Build

実験開始時（Open Experiment）、このオプションがオン（デフォルト）
になっていると、ビルド処理の前後にハードウェア検索が行われ、オフに
なっているとビルド処理の前にのみ行われます。検索によって適切なハー
ドウェアが検知されなかった場合、エラーメッセージが出力されます。

このオプションがオンになっていれば、未接続のハードウェアをビルド処
理実行中に接続できるので、時間の無駄がなくなります。

オプションがオフになっていると、未接続のハードウェアがあっても、ビ
ルド処理時にエラーメッセージが出力されません。

注記

以下の 2 つのオプションは、ETAS ネットワークマネージャの使用が無効に
なっている場合にのみ意味を持ちます。

注記

以下のオプションは、他のオプション設定に関わらず常に意味を持ちます。
実験ターゲットの設定 17
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2.2 ETAS ネットワークマネージャを用いたハードウェア接続設定

ETAS ネットワークマネージャ（ETAS Network Manager）を使用すると、さまざ
まなハードウェア接続環境を詳細に設定できます。

• 1 つのネットワークアダプタを、ETAS ハードウェアと社内ネットワークの
両方で共有できます。

• 個々のネットワークアドレスを指定できます。

• ETAS ハードウェアネットワーク内から、使用するシミュレーションボード
（ES113x）を選択できます。

ETAS ネットワークマネージャを使用してハードウェア接続を設定する方法は、本
書の第 12 章で説明されています。

ETAS ネットワークマネージャの使用を有効にする：

• ASCET コンポーネントマネージャから、Tools → 
Options を選択します。

“Options” ダイアログボックスが開きます。

• “Hardware”タブを開きます。

• Use ETAS Network Manager (enable ’Select 
Hardware’) オプションをオンにします。

このオプションのみがオンになっていると、実験
を開始するたびに“Experimental Target Hardware 
Selection”ダイアログボックスが開きます。

• Skip HW selection if ... オプションをオンにする
と、所定の条件に該当するハードウェアのみが接
続されている場合、ハードウェア選択ダイアログ
ボックスが開きません。

• ビルド処理の実行前にもハードウェア検索が行わ
れるようにするには、Check HW connection 
before Build オプションをオンにします。

“Experimental Target Hardware Selection”ダイアログボックスは、マニュアル操
作で任意に開くこともできます。
実験ターゲットの設定



マニュアル操作でハードウェア選択ダイアログボックスを開く：

• Extras → Select Hardware を選択します。

または

• Select Hardware ボタンをクリックします。

ハードウェア選択ダイアログボックスが開きま
す。

2.2.1 ハードウェア選択ダイアログボックス

このダイアログボックス（“Experimental Target Hardware Selection”ダイアログ
ボックス）には以下のエレメントが含まれています。

• “Select simuation board of type YíóéÉ[”1 フィールド

このフィールドには、メインアイテム HWC（シンボル ）の下に、PC に
接続されているすべてのシミュレーションコントローラ（ES113x、シンボ
ル ）が一覧表示されます。シミュレーションコントローラのラベルに

注記

この操作で使用する Select Hardware ボタン、および Extras → Select 
Hardware メニューコマンドは、Use ETAS Network Manager (enable 
’Select Hardware’) オプションがオンに設定されている場合のみ、使用可能で
す。

1. YíóéÉ[ の内容は、プロジェクトで選択されているターゲットです。
実験ターゲットの設定 19



20
は、ES113ｘ の接続方法（direct または indirect）などの情報が含
まれます（20 ページ参照）。接続されている各種ボード（シンボル ）
は、シミュレーションボードの下に表示されます。

ここで、プロジェクトのコード生成オプションで選択されているシミュ
レーションボードを選択してください。

• Skip HW selection if exactly one matching target instance found オプ
ション、および Skip HW selection if last used target instance found
オプション

これらのオプションは、ASCET オプションダイアログボックスの
“Hardware”タブのオプションと同じです。ここで設定された内容は、
“Hardware" タブに反映されます。

• Set Alias Name ボタン

このボタンで、ES113x または ES1120 に任意の名前を割り当てることが
できます。

• Refresh ボタン

このボタンをクリックすると、“Select simulation board of type YíóéÉ[”
フィールドの内容が更新されます。新たに接続したり電源をオンにした
ハードウェアが表示され、切り離したり電源をオフにしたハードウェアは
表示されなくなります。

• OK ボタンと Cancel ボタン

選択を確定するに OK ボタンをクリックし、設定内容をキャンセルしてダ
イアログボックスを閉じるには Cancel ボタンをクリックします。

直接 PC に接続されているシミュレーションボードについては、“Selection 
simulation board of type YíóéÉ[”ダイアログボックス内のラベルは以下のように
なります。

ES113x - Name:<alias> - SN:<serial number> - 
IP:<IP address> - <direct> - ES1120 present 
[<SW>, <syslib version>, <boot mode>, 
ProgID=<ID>]

• ES113xはシミュレーションボードのラベルです。

• Name:<alias> は、シミュレーションボードに任意に割り当てられた名
前です。
名前が割り当てられていない場合、この部分は表示されません。

• SN:<serial number> は ES113ｘ のシリアル番号です。

• IP:<IP address> は ES113x の IP アドレスです。

• <direct> は、ES113x が直接 PC に接続されていることを示します。

• ES1120 present は、ES1000 システム内に、未接続の ES1120 が組み込
まれていることを示します。
ES1000 に ES1120 が 1 枚も組み込まれていない場合、この部分は表示さ
れません。
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• <SW> は、プログラムを ES1000 にロードする際に使用したソフトウェア
（ASCET、INTECRIO など）です。

• <syslib version> は、使用されているハードウェアシステムライブ
ラリのバージョンです。

• <bood mode> は、プロジェクトが ES1000 の電源投入時に FLASH メモリ
から起動されたか（ROM）、またはパワーオン後にダウンロードされたも
のであるか（RAM）を示します。

• ProgID=<ID> は、ソフトウェア <SW> によってプロジェクトに割り当
てられた識別子（<ID>）を示します。

ES1120 などを経由して間接的に PC に接続されているシミュレーションボードに
ついては、ラベルは以下のように表示されます。

ES113x - <indirect via ES1120 - Name:<alias> - 
SN:<serial number> - IP:<IP address>> 
[<SW>, <syslib version>, <boot mode>, ProgID=<ID>]

• ES113ñ はシミュレーションボードのラベルです。

• <indirect via ES1120 ...> はES113xが間接的にPCに接続されてい
ることを示します。

• Name:<alias> は、ES1120 に任意に割り当てられた名前です。

• SN:<serial number> は ES1120 のシリアル番号です。

• IP:<IP address> は ES1120 の IP アドレスです。

• <SW>、<syslib version>、<bood mode> 、ProgID=<ID> は、直
接接続の場合と同じです。

2.3 ETAS ネットワークマネージャを用いないインターフェース設定

旧バージョンとの互換性のため、ETAS ネットワークマネージャを使用せず、代わ
りに各ターゲット用の target.iniファイルで ASCET 用のイーサネットイン
ターフェースを設定することもできます。このファイルは、..¥target¥ES1130
または ..¥target¥ES1135 というディレクトリに格納されています。

ES1000 の接続インターフェースを指定する：

• ASCET コンポーネントマネージャから、Tools → 
Options を選択します。

“Options” ダイアログボックスが開きます。

• “Hardware”タブを開きます。

• Use ETAS Network Manager (enable ’Select 
Hardware’) オプションをオフにします。

• “HW connection”コンボボックスで、使用する
ES1000 の接続タイプを選択します。
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22
• “HW connection”コンボボックスで選択された
デバイス以外のデバイスも検索されるようにする
には、Try alternative HW connectionse ETAS 
Network オプションをオンにします。

このオプションがオフになっていると、選択され
ているデバイス以外は検索されません。

• ビルド処理の前後にハードウェア検索が行われる
ようにするには、Check HW connection before 
Build オプションをオンにします。

このオプションがオフになっていると、ハード
ウェア検索はビルド処理の後にしか実行されませ
ん。

• OK をクリックして設定を確定します。

選択内容に応じて、各ターゲット用サブディレクトリ内の target.iniファイ
ルから適切な IP アドレス変数が読み込まれ、ASCET の実験環境においてそのアド
レスが使用されます。

• コントローラボード ES1120 と ASCET のホスト PC 間の通信には、以下の変
数が使用されます。

－ ES1130 

IndirectIpAddress=192.168.40.10
;Default IP-Address for ES1120.x

－ ES1135 

IndirectIpAddress=192.168.40.10
;Default IP-Address for ES1120.x

• シミュレーションボード ES113x と ASCET のホスト PC 間の通信には、以下
の変数が使用されます。

－ ES1130 

DirectIpAddress=192.168.40.11
;Default IP-Address for ES1130.x

－ ES1135 

DirectIpAddress=192.168.40.15
;Default IP-Address for ES1135.1

ES1000.xシステムの接続に使用されるネットワークインターフェースを PCに
インストールして設定するための情報は、以下のドキュメントに記載されていま
す。

• ES1000 Ethernet InstallationGuide.pdf

このドキュメントは、ASCET のインストール時に
..¥ETAS¥ETASManuals¥ASCET V5.1¥E1000というディレクトリに保存さ
れます。
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2.4 コンパイラの選択

ASCET-RP には、ES1130 および ES1135 ターゲット用の GNU クロスコンパイラ
が含まれています。また、ES1130 には Diab Data コンパイラ（ASCET-RP には含
まれていません）も使用できます。

表 2-1 各ターゲット用に使用できるコンパイラ

2.4.1 任意のコンパイラを使用する

ASCET-RP V5.4 の製品 パッケージには、標準ツールとして MS-DOS 版の GNU ク
ロスコンパイラ（ASCET のユーザーインターフェースでは “GNU-C 
(PowerPC)” と記述されています）が含まれています。その他のコンパイラを使
用する場合は、以下の点に注意してください。

1. ASCET の“Options”ダイアログボックスで、GNU-C (PowerPC)のコー
ド生成パスを、使用するコンパイラのパスに合わせて変更してください。

ターゲット 使用できるコンパイラ

ES1130 GNU Cross Compiler、Diab Data V4.1a

ES1135 GNU Cross Compiler
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2. 使用するターゲット（ES1130 または ES1135）の comptool.iniファイ
ル内の RelativeToolPath変数（コンパイラのパスを示す変数）の値
を、RelativeToolPath=¥powerpc-eabi¥binから、たとえば
RelativeToolPath=¥win32¥binに変更します。

2.4.2 GNU クロスコンパイラへの変更

ASCET の“Options”ダイアログボックスの“Code Generation”タブには、Diab 
Data コンパイラのデフォルトパスが設定されていますが、これは、実際にコンパ
イラインストールされていない場合でも、デフォルト値として設定されます。こ
れと同様に、コンパイラがインストールされていなくても、各プロジェクトの
コード生成オプション内で Diab Data コンパイラを選択することが可能です。

Diab Data コンパイラを使用して作成された ES1130 ターゲット用の旧バージョン
のプロジェクトを ASCET-RP V5.4 で操作する場合、プロジェクトを開く時にはエ
ラーメッセージは出力されませんが、コード生成時には、ASCET モニタウィンド
ウにエラーメッセージが出力されます。

また、ES1112 をターゲットとした旧バージョンのプロジェクトの場合は、プロ
ジェクトを開く際に以下のようなエラーメッセージが表示され、ターゲットは PC
に置き換えられます。

いずれの場合も、プロジェクトを開いた後に、ターゲットとコンパイラの適切な
組合せを設定する必要があります。以下のように行ってください。

注記

パスとシステム変数は、必ず ASCET で使用するコンパイラバージョンのものを
設定してください。
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GNU コンパイラに変更する：

• プロジェクトエディタの Specify Code 
Generation Options ボタンをクリックします。

“Setting for:” ダイアログボックスが開きます。

• “Build”タブで、ターゲットを ES1130または
ES1135、コンパイラを GNU-C (PowerPC) に
設定します。

• OK をクリックします。

次に、プロジェクトで使用するターゲット用に C
コードをコピーします。この手順は、25 ページ
の「オペレーティングシステムの設定と C コード
をコピーする：」 を参照してください。

• Component → Touch → Recursive を選択して、
次回のコンパイル時にプロジェクトの全コンポー
ネントがコンパイルされるようにします。

オペレーティングシステムの設定と C コードをコピーする：

• プロジェクトエディタの“OS”タブを選択しま
す。

• プロジェクトエディタで、Operating System → 
Copy From Target を選択します。

“Selection Required”ダイアログボックスが開き
ます。

• “Selection Required”ダイアログボックスで PPC
ターゲットを選択します。

• OK をクリックします。

オペレーティングシステムのコードが、元のター
ゲットから ES1130または ES1135用にコピー
されて変換されます。
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• プロジェクトエディタで、Extras → Copy C-
Code From を選択します。

“Selection Required”ダイアログボックスが開き
ます。

• “Selection Required”ダイアログボックスで、元
のターゲットと実験を選択します。

• OK をクリックします。

元の C コードが、新しいターゲットと実験の組合
せ用にコピーされ、変換されます。
実験ターゲットの設定



2.4.3 Diab Data コンパイラへの変更

TIP Exp V4.2 までは、MS-DOS 版の Diab Data 4.1a コンパイラが 製品パッケージ
に含まれていました。このコンパイラは、ASCET-RP V5.4 においても ES1130
ターゲット用に使用することができますが、ASCET-RP の製品パッケージには含ま
れていないため、別個に購入してインストールする必要があります。

2.5 コンパイラの設定

ASCET にターゲット（PC ターゲットも含む）をインストールすると、各ター
ゲット用のディレクトリが作成されます。このターゲットディレクトリにター
ゲット固有のファイルがすべて格納され、その 1 つにコンパイラ設定ファイル
comptool.iniも含まれます。このファイルはコンパイラとリンカ実行時の動
作全般に影響するので、変更する際には注意が必要です。以下に示すように行っ
てください。

2.5.1 一般的な引数

コンパイラは、以下のような引数を使用します。

• %bp% はコンパイラのベースパスです。
例：c:¥ETAS¥ASCET5.1¥bc

注記

ES1135 ターゲットには Diab Data コンパイラは使用できません。
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• %lp%はコンパイラのライブラリパスです。
例：c:¥ETAS¥ASCET5.1¥bc¥libs

• %ip%はコンパイラのインクルードパスです。
例：c:¥ETAS¥ASCET5.1¥bc¥include

• %tp%はコンパイラのツールパスです。
例：c:¥ETAS¥ASCET5.1¥bc¥bin

• %tarbp%は全ターゲットのベースパスです。
例：c:¥ETAS¥ASCET5.1¥target

• %tarsp%は各ターゲットのパスです。
例：c:¥ETAS¥ASCET5.1¥target¥pc

• %fn%は処理対象ファイル名です。

• %LD%は行区切り文字（1 文字または複数文字）です。

• %SP%はスペース文字です。

1 つのコンパイラコマンドに複数の引数を指定する場合は、引数間をカンマで区
切ります。冒頭と末尾のスペースは無視されます（コンパイラにスペース文字を
渡したい場合には %SP%を挿入してください）。

2.5.2 初期化に関する項目

• DOSVariableSettings： コンパイラ／リンカツールに DOS 変数が必要
な場合にはここに定義します。たとえば、INMOS ツールセットを使用す
る場合には、DOSVariableSettings=%lp%¥というように設定します。

• FilesInWorkingDirectory： コンパイラによっては、ワーキング
ディレクトリに特定のファイルが保存されていなければならない場合があ
りますが、このワーキングディレクトリ（通常は cgenディレクトリ）の
内容は、オプション設定（『ASCET ユーザーガイド』の 2.2.1 章を参照し
てください）に応じて、ASCET セッションが終了するたびに削除されてし
まいます。そこで、たとえば FilesInWorkingDirectory = 
%tarbp%¥dos4gw.exeというように指定しておけば、必要なファイル
がコンパイルの前に必ずこのディレクトリに自動的にコピーされます。

2.5.3 コンパイラに関する項目

• CompilerCall1： コンパイル実行時に実行されるコンパイラコールを定
義します。CompilerCall2、CompilerCall3、...をそれぞれ定義
すれば、複数のコンパイラコールを行なうことができます。

• CompilerErrorKeywords： ここに定義された文字列のいずれかがコン
パイラのエラー出力に含まれている場合、その出力内容が ASCET 上に表
示されます。

• GlobalIncludeFiles： コンパイル時に使用されるインクルードファイ
ルを指定します。ヘッダファイルはコンパイルが実行される直前に読み込
まれます。ここにはユーザー独自のヘッダファイルを挿入することができ
ます。
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• CompilerResultExtension： コンパイラによって生成されるファイ
ルの拡張子です。普通は .objです。

2.5.4 リンカに関する項目

• LinkCall1： リンク時に実行されるリンカコールを定義します。
LinkCall2、LinkCall3、...をそれぞれ定義すれば、複数のリンカ
コールを行なうことができます。

• LinkerErrorKeywords： ここに定義された文字列のいずれかがリンカ
のエラー出力に含まれている場合、それらが ASCET 上に表示されます。

• LinkerResultExtension： リンカによって生成されるファイルの拡張
子です。.dllなどを指定します。

• ObjectLibraries： リンカ実行時にリンクされるライブラリです。

• ObjectFiles： リンカ実行時にリンクされるオブジェクトファイルで
す。

2.5.5 ローダに関する項目

現時点では、ローダのための項目はサポートされていません。

2.6 ascetsd.ini ファイルの設定

ascetsd.iniファイルは、ASCET のデータディレクトリ
（ETASData¥Ascet5.1）に格納されています。このファイル内の以下の変数の
設定は、ASCET のユーザーインターフェースからは変更できません。

• Bubbledelaytime： ツール用のヒントが表示されるまでのディレイ時
間をミリ秒単位で指定します。

• MeasureCycleTime： 数値表示や棒グラフ表示用の測定データをホスト
に転送する周期を、ミリ秒単位で指定します。ホストとターゲットの間の
L1 通信に問題が発生する場合は、この数値を大きくしてください。

• ExitWithPrompter： yesを指定すると、ユーザーが実験環境を終了し
ようとするたびに ASCET はその環境を保存するかどうかを尋ねます。no
を指定すると保存は行なわれず、確認メッセージも表示されません。

その他の変数は、内部的なもの（これらは変更できません）、または ASCET に
よって自動的に変更されるものです。一般的に、*.ini ファイルはすべて、ツー
ルの処理内容全体に影響を与える可能性があるため、内容を変更する際には充分
な注意が必要です。
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P ^p`bqJomを使用する際のヒント

3.1 旧バージョンのデータベースの使用

V4.1.1 より前のバージョンの ASCET で作成された ASCET データベースを ASCET 
V5.4 用データベースに変換するには、前もってそのデータベースを ASCET 
V4.1.1 で読み込み、保存しておく必要があります。

3.2 ES1000.1 用プロジェクトから ES1000.2/ES1000.3 用プロジェクトへ

の変換

実験システム ES1000.1 用に作成された ASCET プロジェクトを ES1000.2/
ES1000.3 で使用するには、プロジェクトの変換が必要です。以下の手順で変換を
行ってください。

ES1000.1 用 ASCET プロジェクトを ES1000.2/ES1000.3 用に変換する：

• 変換する ASCET プロジェクトをロードします。

ES1112 ターゲットは使用できない、という内容
のメッセージが表示されます。

• メッセージを確認して、OK をクリックします。

プロジェクトが開きます。使用できないターゲッ
トの変わりに、PC ターゲット（>PC<）が選択さ
れた状態になっています。

注記

非常に古いバージョンの ASCET は、プロジェクト（TIPExp V3.x またはそれ以
前のプロジェクトや、PPC ターゲットのプロジェクトなど）の変換についての
詳しい情報は、『TipExp V4.4 ユーザーガイド』を参照してください。
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• プロジェクトエディタの Specify Code 
Generation Options ボタンをクリックします。

• “Setting for:”ダイアログボックスの
“Build”タブで、以下のように各オプションを設
定します。

Target: >ES1130< または >ES1135<
Compiler: GNU-C (PowerPC)

• OK をクリックして“Setting for:”ダイアログ
ボックスを閉じます。

• プロジェクトエディタの“OS”タブを開きます。

• プロジェクトエディタのメニューからOperating 
System → Copy From Target を選択します。

• “Selection Required”ダイアログボックスで元の
ターゲットを選択し、OK をクリックします。

オペレーティングシステムのコードが、ES113x
ターゲット用にコピーされて変換されます。
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• プロジェクトエディタのメニューから Extras → 
Copy C-Code From を選択します。

• “Selection Required”ダイアログボックスで、元
のターゲットと実験の組合せを選択します。

• OK をクリックします。

元の C コードが、新しいターゲットと実験の組合
せ用にコピーされ、変換されます。

これで、プロジェクトは ES1000.2/ES1000.3 システム用として使用できるように
なりました。

3.3 dT の使用方法

ES113x ターゲットで実行されるプロトタイピングソフトウェアには、ERCOSEK

オペレーティングシステムが統合されます。ERCOSEK の環境下においては、タス
クの前回の実行開始時から今回の実行開始時までに経過した時間を表す「dT」と
いう変数を利用できます。dTはタスクごとに存在し、それを使用するタスク自身
についての値が常に格納されています（図 3-1）。

図 3-1 各タスク用の dT

A

B

dTB1

dTA1 dTA2

優先度

時間

Task B

Task A

Background

dTA3
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ERCOSEK において、dTは uint32型のグローバル変数です。ERCOSEK のヘッダ
ファイルのうちのひとつで宣言され、現在実行中のタスクについての値をシステ
ムクロックの単位で格納します。

dTを利用するには、ASCET のエディタ上の dT ボタンを使用して、秒単位の時間
が格納される ASCET エレメント（real64）を作成します。

この dTは、ユーザーによって C コードエディタ上で宣言されていない状態で使
用された場合でも、ERCOSEK ファイル内で dT が宣言されているため、エラー
メッセージは出力されません。しかし ERCOSEK 内の dTと ASCET 内の dTでは単
位が異なるため（ERCOSEK ではシステムクロック、ASCET では秒）、正しい値は
得られません。必ず dT ボタンでエレメントを作成してから使用するようにして
ください。
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Q ラピッドプロトタイピング実験

この章では、ラピッドプロトタイピングの実験を行うためのいくつかの方法を紹
介します。

4.1 ASCET を使用した実験

ASCET でラピッドプロトタイピングの実験を行う際は、プロジェクトエディタで
オンライン実験とオフライン実験のいずれかを選択します。詳しい操作方法は、

『ASCET ユーザーズガイド』の「プロジェクトの実験」の項を参照してください。
また ASCET の実験環境については『ASCET ユーザーズガイド』の「実験環境」
の項を参照してください。

ここではオンライン実験に固有な機能についてのみ説明されています。

4.1.1 ユーザーインターフェース

オンライン実験のユーザーインターフェースは、オフライン実験の場合とほとん
ど同じです。異なるのは以下の点のみです。

• プログラムの実行を制御するボタン

• NVRAM コックピット（ES1135 を使用する場合のみ）

• “Task”コンボボックス

• Experiment メニュー

実行制御ボタン（実験、NVRAM コックピット）“Task”コンボボックス
ラピッドプロトタイピング実験 35
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ツールバーのボタン

1. Exit to Component - 実験を終了してプロジェクトエディタに戻る

2. Load Environment - 実験環境（測定／適合ウィンドウの設定と、各ウィン
ドウに割り当てられた変数）のロード

3. Save Environment - 現在の実験環境の保存

4. Save Environment As - 現在の実験環境を任意の名前で

5. Stop ERCOS - オペレーティングシステムの実行終了（= 実験の終了）

6. Start ERCOS - オペレーティングシステムの実行開始（= 実験の開始）

7. Stop Measurement - 測定の終了（= データ表示の終了）

8. Start Measurement - 測定の開始（= データ表示の開始）

9. Open Data Logger - データロガーを開く

10. Open NVRAM Cockpit - NVRAM コックピットを開く（75 ページ参照）

このボタンは ES1135 がターゲットとして選択されている場合のみ表示さ
れます。

11. Open CT Solver - 積分メソッドの設定ダイアログボックスを開く

このボタンは CT ブロックプロジェクトまたはハイブリッドプロジェクト
を実行する際にのみ表示されます。

12. Update Dependent Parameters - 依存パラメータの値の更新

13. Expand / Collapse Window - コンポーネントの表示／非表示切り替え

14. Always on top - 実験ウィンドウを常に最前面に表示

15. Navigate down to child component - 選択された、内包されるコンポーネ
ントの内容を表示

16. Navigate up to parent component - 上位のコンポーネントを表示

bñéÉêáãÉåíメニュー

以下のメニューコマンドが含まれます。

－ Data Logger
データロガーを開きます。

－ NVRAM Cockpit
（ES1135 がターゲットとして選択されている場合のみ使用できます）

NVRAM コックピットを開きます。

－ Stop ERCOS

オペレーティングシステムの実行を終了します。

－ Start ERCOS

オペレーティングシステムの実行を開始します。

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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－ Stop Measurement

測定を終了します。

－ Start Measurement

測定を開始します。

－ Open Target Debugger

C コードコンポーネント用のデバッガウィンドウを開きます。

－ Update Calibration Windows

適合ウィンドウの内容を更新します。

－ Close Calibraion Windows

すべての適合ウィンドウを閉じます。

－ Close Measure Windows

すべての測定ウィンドウを閉じます。

ユーザーインターフェースの他のエレメントは、オフライン実験の場合と同じで
す。これらは『ASCET ユーザーズガイド』の「実験環境」の項に説明されていま
す。

4.1.2 オンライン実験の実行

プロジェクトのオンライン実験は、プロジェクトエディタから起動します。

オンライン実験を開始する：

• コンポーネントまたはプロジェクトを開きます。

• コンポーネントの実験を行う場合は、デフォルト
プロジェクトを開きます。

• プロジェクトまたはデフォルトプロジェクトの
コード生成オプションに、ES1130 または 
ES1135をターゲットとして選択します。

“Experiment Target”コンボボックスで、
Offline (RP) または Online (RP)を選択でき
るようになります。

また、Open Experiment for selected 
Experiment target ボタンと Reconnect to 
Experiment of selected Experiment target ボ
タンが有効になります。

• “Experiment Target”コンボボックスから 
Online (RP)を選択します。

Offline (RP) は、ターゲット上でオフライン
実験を行う際に選択します。
ラピッドプロトタイピング実験 37



38
• Component → Open Experiment を選択しま
す。

または

• Open Experiment for selected Experiment 
target ボタンをクリックします。

ハードウェアオプション（2.1 項参照）の Use ETAS Network Manager 
(enables ’Select Hardware’) オプションをオンに設定しておくと、状況に応じて
ハードウェア選択ダイアログボックス（2.2.1 項参照）が自動的に開きます。

ハードウェアを選択する（ETAS ネットワークマネージャを使用）：

• “Select simulation board of type YíóéÉ[”フィー
ルドで、使用したいハードウェアを選択します。

OK ボタンが使用可能になります。

• 必要に応じて他の設定を行います。

• OK をクリックしてダイアログボックスを閉じま
す。

システムは、選択されたハードウェアが使用可能
であるか、またそのハードウェアが、プロジェク
トのコード生成オプションで選択されているター
ゲットと一致するかをチェックします。

エラーが発生した場合：

選択されたハードウェアが実際に存在しない場合、以下のエラーメッセージが表
示されます。

• Yes をクリックして、ハードウェア検索を再実行
します。

または

注記

ETAS ネットワークマネージャを使用しない場合、この操作は不要です。
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• No をクリックして、ハードウェアが未接続のま
まビルド処理を実行します。

ETAS ネットワークマネージャを使用している場
合、ビルド処理の終了後に、再度ハードウェア選
択ダイアログボックスが開きます。

ETAS ネットワークマネージャを使用していない
場合は、ビルド処理の終了後、再度ハードウェア
検索を行うかどうかが尋ねられます。

または

• Cancel をクリックして、実験開始を中止します。

ETAS ネットワークマネージャを使用していない場合、またはハードウェアの選択
（38 ページ参照）が正常に行われた場合、実験が開始されると（37 ページ参照）、
すぐにコンポーネントのデフォルトの実験環境が開きます。

オンライン実験用に実験環境を開く：

• 複数の環境がすでに保存されている場合は、どれ
を開くかを選択します。詳細は、『ASCET ユー
ザーズガイド』の「環境設定のロードと保存」と
いう項を参照してください。

プロジェクト内に複数のタスクが含まれている場
合、各測定変数について、その値を取得するため
のタスクを選択する必要があります。

• “Selection Required”ダイアログボックスでタス
クを選択し、OK をクリックします。

測定タスクは、後から“Task”コンボボックスで
選択することができます。

オンライン実験に必要な準備は、測定ウィンドウと適合ウィンドウの用意だけで
す。これらのウィンドウの使用方法は、オフライン実験の場合と同じです。

『ASCET ユーザーズガイド』の「実験環境」の項を参照してください。

これらの準備ができたら、実験を開始します。オンライン実験の実行中には、測
定／適合ウィンドウの表示オプションの変更や、これらのウィンドウの追加や削
除を行え、また適合システムを利用してパラメータ（適合変数）の値を変更する
ことができます。
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オンライン実験と測定を開始する：

• 実験を行うプロジェクトの実験環境を開きます。

• Experment → Start ERCOS を選択します。

または

• Start ERCOS ボタンをクリックします。

オペレーティングシステムと実験が起動されま
す。ここでは、まだ測定データは表示されませ
ん。

• Experment → Start Measuremet を選択します。

または
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• Start Measurement ボタンをクリックします。

測定が開始され、測定システムで設定されたすべ
ての変数の値が所定のウィンドウに表示されま
す。

測定を終了する：

• Experment → Stop Measurement を選択しま
す。

または

注記

測定を実行すると、モデルのリアルタイム挙動が
影響を受ける可能性があります。
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• Stop Measurement ボタンをクリックします。

測定が終了しますが、実験はそのまま続行されま
す。測定が再開されると、時間軸は現在の値に更
新されます。

すべての設定は保持されます。測定データはオシ
ロスコープウィンドウにそのまま表示されている
ので、そのデータを分析することができます。

実験を終了する：

• Experment → Stop ERCOS を選択します。

または

• Stop ERCOS ボタンをクリックします。

測定が行われていた場合は、測定も終了します。
オペレーティングシステムの実行が終了するた
め、実験も終了します。この状態、つまり「起動
していない状態」のオペレーティングシステムに
は、Init タスクを 1つ割り当てることができます。
このタスクはオペレーティングシステムが停止し
ている間に実行されます。このタスクを利用し
て、外部ハードウェアのリセットなどを行うこと
が可能です。オペレーティングシステムが再起動
すると、開始モードが実行され、その Initタス
クが再度実行されます。オペレーティングシステ
ムをポーズする機能はありません。

• Exit to Component ボタンをクリックして実験
環境を閉じ、プロジェクトエディタに戻ります。

または

• File → Exit を選択して実験環境を閉じ、プロジェ
クトを閉じます。

オフライン実験の場合と同様に、実験が実行されているがどうかに関わらず、プ
ロジェクトのインプリメンテーションを実験環境からることができます。

またオフライン実験と同様、C コードで記述されたコンポーネントについては、
実験中にデバッグ情報やエラーメッセージを表示することができます。これらの
メッセージは C コード内に任意に埋め込むことができます。デバッグ情報は、実
験中に開くことのできる「ターゲットデバッグビューア」に表示され、エラー
メッセージは ASCET モニタウィンドウに出力されます。詳しくは、『ASCET ユー
ザーズガイド』の「実験の実行」の項を参照してください。

4.1.3 スタンドアロンモード

実験ターゲットがあれば、実験環境を使用せずにスタンドアロンモードでコード
を実行することができます。ただしその場合、実験ターゲットにフラッシュメモ
リが搭載されていて、そこから実験ターゲットを起動できる、という条件が満た
されている必要があります。
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実験を FLASH メモリにロードする：

• “Experiment Target”コンボボックスからOnline 
(RP)を選択します。

• Component → Flash Target を選択します。

ハードウェアオプションの Use ETAS Network 
Manager (enables ’Select Hardware’) オプショ
ン（2.1 項を参照）がオンになっていると、状況
に応じてハードウェア選択ダイアログボックス

（2.2.1 項を参照）が開きます。
このダイアログボックスの使用方法は、38 ペー
ジ「ハードウェアを選択する（ETAS ネットワー
クマネージャを使用）：」 に説明されています。

ASCET で生成されたコードが実験ターゲットの
FLASH メモリに書き込まれます。このコードに
は、FRASH メモリから起動するためのスタート
アップルーチンが組み込まれます。これ以降、
ターゲットハードウェアは、リセットが行われる
たびに ASCET モデルを実行します。

スタンドアロンモードで実験を行う：

• Component → Reconnect To Experiment を選
択します。

または

• Reconnect to Experiment of selected 
Experiment Target ボタンをクリックします。

ハードウェアオプションの Use ETAS Network 
Manager (enables ’Select Hardware’) オプショ
ン（2.1 項を参照）がオンになっていると、状況
に応じてハードウェア選択ダイアログボックス

（2.2.1 項を参照）が開きます。
このダイアログボックスの使用方法は、38 ペー
ジ「ハードウェアを選択する（ETAS ネットワー
クマネージャを使用）：」 に説明されています。

オンライン実験環境が起動し、実験が初期状態か
ら開始されます。

実験ターゲット上で通常のモード（非スタンドアロンモード）で実行されている
実験プログラムへの接続を断って、その後、その実験に再接続することもできま
す。実行中の実験プログラムとの接続を断つには実験環境を終了するだけでよく、
実験ターゲット上のプログラムを終了する必要はありません。
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4.2 INCA を使用した実験

プロジェクトの実験は、INCA（バージョン 4.0.4 以降、およびそのバージョンに
対応するアドオン製品 INCA-EIP が必要）を使用して行うことができます。このた
めには、プロジェクトエディタのメニューコマンドを利用して、プロジェクトを
INCA に転送します。

プロジェクトの転送を開始する：

• 実験を行うプロジェクトを開きます。

• プロジェクトエディタでコード生成オプションを
設定します。ES1130 または ES1135をター
ゲットとして選択し、コンパイラは GNU-C 
(PowerPC)を選択します。

• “Experiment Target”コンボボックスから INCA を
選択します。

Transfer Project to selected Experiment Target 
および Reconnect to Experiment of selected 
Experiment Target ボタンが有効になります。

• Transfer Project to selected Experiment Target 
ボタンをクリックします。

または

• Component → Transfer Project を選択します。

“INCA Project Transfer”ダイアログボックスが開
きます。

このダイアログボックスで、INCA データベースと、その中に含まれるワークス
ペースとプロジェクトを指定します。
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この時点で INCA が起動していない場合、いずれかの Browse... ボタンまたは OK 
ボタンをクリックすると INCA が起動します。もしも複数のバージョンの INCA が
同じ PC にインストールされている場合は、最後にインストールされたバージョ
ン（最新のバージョンとは限りません）が起動します。

INCA データベースのパスを指定する：

• “INCA Project Transfer”ダイアログボックスの
“INCA Database”フィールドに既存のデータベー
スパスを入力します。

または

• Browse ボタンをクリックしてデータベースパス
を検索します。

“Select INCA database path”ダイアログボックス
が開きます。データベースは赤いフォルダシンボ
ルで示されます。

注記

ここで、V3.x またはそれ以前のバージョンがインストールされていたり、また
は INCA がまったくインストールされていない場合、エラーメッセージが表示
されてデータ転送は中止されます。
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• INCAデータベースを選択してOK をクリックしま
す。

または

• New ボタンをクリックして、プロジェクトの転
送先となる新しい INCA データベースを作成する
ための空のディレクトリを作成します。作成され
たディレクトリは黄色のフォルダとして表示され
ます。

INCA ワークスペースを選択する：

• “INCA Project Transfer”ダイアログボックスの
“INCA Workspace”フィールドに、既存のワーク
スペースのパスと名前を入力します。

または

• Browse ボタンをクリックしてワークスペースを
検索します。

“INCA Workspace Selection Dialog”ダイアログ
ボックスが開き、選択されている INCA データ
ベースに含まれるワークスペースの一覧が表示さ
れます。

• 既存のワークスペースを選択します。

または

• 既存のフォルダまたは新しいフォルダ内に、新し
いワークスペースを作成します。手順は次に示さ
れています。

注記

このダイアログボックスでは、ASCET データベースと INCA データベースが
まったく同様に表示されますが、ここでは必ず INCA データベースを選択して
ください。
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• ワークスペースを指定したら、OK をクリックし
ます。

“Workspace Selection Dialog”ダイアログボックスで新しいフォルダ／ワーク
スペースを作成する：

1. フォルダを作成する

• “INCA Workspace Selection Dialog”ダイアログ
ボックスでデータベースまたはフォルダを選択し
ます。

New Folder ボタンが有効になります。

• New Folder ボタンをクリックします。

• “Create New INCA Folder”ダイアログボックスに
フォルダ名を入力して OK ボタンをクリックしま
す。

新しいフォルダが作成されます。

2. ワークスペースを作成する

• フォルダを選択します。

New Workspace ボタンが有効になります。

• New Workspace ボタンをクリックします。

“INCA Workspace Template Selection Dialog”ダ
イアログボックスが開きます。
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• ワークスペースのテンプレートを選択して OK を
クリックします。

“Create New INCA Workspace”ダイアログボッ
クスが開きます。

[ASCET-WS] <ascet project name> とい
うデフォルト名が割り当てられます。

• ワークスペースの名前を編集して、OK をクリッ
クします。

選択されたフォルダに新しいワークスペースが作
成され、そのワークスペースが選択された状態と
なります。

INCA デバイスを選択する：

• “INCA Project Transfer”ダイアログボックスの
“INCA Device”フィールドにデバイスを入力しま
す。

または

• Browse ボタンをクリックしてデバイスを検索し
ます。

“INCA Device Selection Dialog”ダイアログボック
スが開き、選択可能なデバイスの一覧が表示され
ます。

• デバイスを選択して OK をクリックします。
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INCA プロジェクトを選択する：

• “INCA Project Transfer”ダイアログボックスの
“INCA Project”フィールドに既存の INCA プロ
ジェクトのパスを名前を入力します。

または

• Browse ボタンをクリックしてプロジェクトを検
索します。

“INCA Project Selection Dialog”ダイアログボッ
クスが開き、選択されているデータベース内のプ
ロジェクトが一覧表示されます。

• 既存のプロジェクトを選択します。

または

• 既存のフォルダまたは新しいフォルダ内に、新し
いプロジェクトを作成します。手順は次に示され
ています。

• プロジェクトを指定したら、OK をクリックしま
す。

“INCA Project Selection Dialog”ダイアログボックスで新しいフォルダ／プロ
ジェクトを作成する：

1. フォルダを作成する

• 47 ページの「フォルダを作成する」の方法で、新
しいフォルダを作成します。

2. プロジェクトを作成する

注記

選択されたプロジェクトは、この転送処理によっ
て作成されたプロジェクトに強制的に置き換わり
ますが、その際、警告メッセージは出力されませ
ん。
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• フォルダを選択します。

New INCA Project ボタンが有効になります。

• New INCA Project ボタンをクリックします。

“Create New Workspace”ダイアログボックスが
開き、[ASCET-Prj] <ascet project 
name>というデフォルト名が表示されます。

• プロジェクト名を入力して OK をクリックしま
す。

選択されたフォルダに新しいプロジェクトが作成
され、そのプロジェクトが選択された状態となり
ます。

データを転送する：

• “INCA Project Transfer”ダイアログボックスの項
目を設定したら、 Continue ボタンをクリックし
ます。

ASCET プロジェクトから INCA プロジェクトへの
転送が実行されます。この際、最初に ASAM-
MCD-2MC コードが生成され、必要に応じてプロ
ジェクトの内容の更新（コード生成、コンパイ
ル、リンク）が行われます。

“INCA Project”フィールドに既存の INCA プロ
ジェクトが指定されていた場合、そのプロジェク
トは上書きされます。

転送が終了すると、INCA での実験を開始することができます。INCA での実験に
ついての詳しい情報は、『INCA ユーザーズガイド』および『INCA-EIP ユーザーズ
ガイド』を参照してください。

ASCET でバックアニメーションを行う際は、特殊な実験環境を使用します。そこ
では通常の方法でパラメータの適合を行うことができます。測定システムも通常
どおりに動作しますが、ASCET のオフライン／オンライン実験とは異なり、オシ
ロスコープ、レコーダ、およびデータロガーの機能は使用できません。INCA での
バックアニメーションでは、これらの機能に必要な同期測定が行えないためです。
その他の測定ツールを使用して測定作業を行ってください。
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バックアニメーションを行う：

• INCA で、プロジェクトの実験を開始します。

• ASCET プロジェクトエディタで、“Experiment 
Target”に INCAが選択されていることを確認し
てください。

• Reconnect to Experiment of Selected 
Experiment Target ボタンをクリックします。

または

• Component → Reconnect to Experiment を選
択します。

ハードウェアオプションの Use ETAS Network 
Manager (enables ’Select Hardware’) オプショ
ン（2.1 項を参照）がオンになっていると、状況
に応じてハードウェア選択ダイアログボックス

（2.2.1 項を参照）が開きます。
このダイアログボックスの使用方法は、38 ペー
ジ「ハードウェアを選択する（ETAS ネットワー
クマネージャを使用）：」 に説明されています。

INCA で実験を実行するための接続が確立され、
“Physical Experiment...”ウィンドウが開きます。
タイトルバーに“INCA Backanimation”と表示さ
れ、バックアニメーション専用の実験環境である
ことがわかります。

通常のオフライン／オンライン実験とは異なり、
このウィンドウには“Graphics”タブのみが表示
されます。

• 必要な測定ウィンドウを作成して設定します
（『ASCET ユーザーズガイド』の「測定システム」
の項を参照してください）。
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• 必要な適合ウィンドウを作成して設定します
（『ASCET ユーザーズガイド』の「適合システム」
の項を参照してください）。

• Experiment → Start Measuremet を選択しま
す。

または

• Start Measurement ボタンをクリックして測定
を開始します。

測定／適合ウィンドウの表示内容が周期的に更新
されます。

実験のロード、保存、エクスポートの方法は、『ASCET ユーザーズガイド』の
「環境設定のロードと保存」の項に説明されています。ロードされた環境内に、
バックアニメーションで使用できないエレメント（オシロスコープなど）が含ま
れていると、それらのエレメントは無視されます。

ここでは、モニタ機能（『ASCET ユーザーズガイド』の「モニタ機能」の項を参
照してください）を使用して、数値変数と論理変数をモニタすることもできます。
モニタ機能の設定は、環境内に保存されます。

また、プロジェクト内のコンポーネント間をナビゲートすることができます
（『ASCET ユーザーズガイド』の「ブロックダイアグラム間のナビゲート」の項を
参照してください）。

プロジェクトにステートマシンが含まれている場合、ステートマシンのアニメー
ション機能（『ASCET ユーザーズガイド』の「ステートマシンの検証」の項を参
照してください）を利用できます。

実験で得られたデータは、ASCET モデルやハードディスクに書き込むことができ
ます。またデータをハードディスクから読み込むことも可能です。詳しくは

『ASCET ユーザーズガイド』の「データの扱い」の項を参照してください。

バックアニメーションを終了する：

• File → Exit を選択します。

または

• Exit to Component ボタンをクリックします。

バックアニメーションが終了し、実験環境が閉じ
ます。INCA の実験はそのまま続行されます。

4.3 INTECRIO を使用した実験

ASCET-RP と INTECRIO がインストールされていると、ラピッドプロトタイプ実験
を INTECRIO を使用して行うことができます。このためには、プロジェクトエ
ディタのメニューコマンドを利用して、プロジェクトを INTECRIO に転送します。
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この項には、INTECRIO を使用して実験を行う際の一般的な方法がまとめられてい
ます。具体的な操作例は、11.1「チュートリアル - INTECRIO を使用した実験」の
項に紹介されています。

INTECRIO で実験を行うには、まず始めに ASCET プロジェクトを作成します。こ
の際、以下の点に注意が必要です。

• デフォルト状態において、ASCET 内で受信のみが行われるメッセージ、つ
まり対応する送信メッセージが存在しない受信メッセージは、INTECRIO
内で「シグナルシンク」となります。またその逆に ASCET 内で送信のみ
が行われるメッセージ、つまり対応する受信メッセージが存在しない送信
メッセージは、INTECRIO 内で「シグナルソース」となります。ASCET 内
で送受信の両方が行われるメッセージについては、INTECRIO への統合時
には省略されます。

• プロジェクトに未解決のメッセージ（対応するエクスポートメッセージが
ないインポートメッセージなど）がある場合、INTECRIO 用のコード生成
時にエラーメッセージが出力されます。

この場合、自動的にメッセージを解決するか、またはコード生成をキャン
セルして手動操作でメッセージを解決します。

• グローバル変数とパラメータを使用することはできますが、これらの使用
は極力避けるようにしてください。

• プロジェクトのコード生成オプションで、ES1130 または ES1135 をター
ゲットとして選択する必要があります。これらのターゲットが選択されて
いる場合に限り、“Experiment Target”コンボボックスに INTECRIOが表
示されます。

プロジェクトが完成したら、コード生成を行うために、まずそのプロジェクトを
INTECRIO に転送します。

転送の設定を開始する：

• 実験を行うプロジェクトを開きます。

• プロジェクトエディタでコード生成オプションを
設定します。ES1130 または ES1135をター
ゲットとして選択し、コンパイラは GNU-C 
(PowerPC)を選択します。

• “Experiment Target”コンボボックスから
INTECRIOを選択します。

Transfer Project to selected Experiment Target 
および Recconect to Experiment of selected 
Experiment Target ボタンが有効になります。

• Transfer Project to selected Experiment Target 
ボタンをクリックします。

または
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• Component → Transfer Project を選択します。

“INTECRIO Project Transfer”ダイアログボックス
が開きます。“Path”フィールドには、ASCET オ
プションダイアログボックスボックスの“Code 
Generation”タブで設定されたコード生成パスが
表示されます。

この“INTECRIO Project Transfer”ダイアログボックスボックスで、生成された
ファイルを格納するパスを指定します。それには以下の 4 通りの方法があります。

• INTECRIO に必要なコード生成のみを行うには、その他のフィールドは空の
ままにしておきます。

すでに生成されたコードを INTCRIO に転送する場合は、この方法で行いま
す。

• コード生成を行い、それを INTECRIO にインポートするには、さらに
INTECRIO のバージョンと INTECRIO のワークスペースを選択する必要があ
ります。“Systems”フィールドは空のままにします。

デフォルトでは、“Version”フィールドには最後にインストールされた
INTECRIO のバージョンが表示されます。1 つのバージョンしかインストー
ルされていない場合はそのバージョンが表示され、Change ボタンは無効
になります。

指定したワークスペースが存在しない場合は、自動的に作成されます。

注記

INTECRIO が PC にインストールされていなくても、INTECRIO 用のコー
ド生成を行うことは可能です。
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• コード生成を行って INTECRIO にインポートし、それを INTECRIO に統合す
る（つまり INTECRIO のシステムプロジェクトに追加する）には、
INTECRIO システムプロジェクトを指定します。

この場合、指定したワークスペースとシステムプロジェクトはすでに存在
していなければなりません。

• コード生成を行って INTECRIO にインポートし、それを INTECRIO に統合し
て、さらに INTECRIO でビルド処理を開始するには、すべてのフィールド
を設定して Trigger INTECRIO Build をオンにします。

ビルド処理が正常に実行され、有効なプロトタイプが生成されるようにす
るには、INTECRIO においてハードウェアシステムとオペレーティングシ
ステムコンフィギュレーションが完全に設定されている必要があります。

ASCET モデル内で送受信されるメッセージを INTECRIO のシグナルソースとして
利用できるように変換する必要がある場合は、Ignore internally connected 
messages オプションをオフにしてください。このオプション設定は、上記の 4
通りの転送方法のすべてにおいて適用されます。表 4-1 は、各タイプのメッセー
ジについて、オプションをオン／オフに設定した場合にどのような INTECRIO イ
ンターフェースに変換されるかを示したものです。

表 4-1 メッセージ変換規則（S はコンポーネントによって送信されるメッセー
ジ、R はコンポーネントによって受信されるメッセージを表す）

メッセージアクセスをアクセスする
ASCET コンポーネント

INTECRIO インターフェース

プロジェクト モジュール
A

モジュール
B

オプション
= オン

オプション
= オフ

S/R — —

S/R S シグナルソース シグナルソース

S/R R シグナルシンク シグナルシンク

S/R S/R シグナルソース シグナルソース

S シグナルソース シグナルソース

S S シグナルソース シグナルソース

S R — シグナルソース

S S/R — シグナルソース

R シグナルシンク シグナルシンク

R R シグナルシンク シグナルシンク

R S/R — シグナルソース
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生成されたファイルを格納するパスを指定する：

• “Path”フィールドの隣の Browse ボタンをク
リックします。

“Path Selection”ダイアログボックスが開きます。

• 必要に応じて“Volume”コンボボックスでボ
リュームを選択します。

• “Directories”リストから既存のディレクトリを選
択します。

または

• New ボタンをクリックして新しいディレクトリ
を作成します。

• OK をクリックします。

“Path”フィールドにパスが表示されます。この
設定は、プロジェクト内に保存され、次回の転送
時には同じ設定がプリセットされます。

INTECRIO のバージョンを選択する：

PC 上に INTECRIO の 1 つのバージョンしかインストールされていない場合は、そ
のバージョンが自動的に選択されるので、この操作を行う必要はありません。

• “Version”フィールドの隣の Change ボタンをク
リックします。

選択ダイアログボックスが開き、PC 上にインス
トールされているすべての INTECRIO のバージョ
ンが表示されます。

• バージョンを選択します。

• OK をクリックします。

“Version”フィールドにバージョンが表示されま
す。この設定は、プロジェクト内に保存されま
す。
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INTECRIO ワークスペースを選択する：

• “Workspace”フィールドに、使用する INTECRIO
ワークスペースのパスと名前を入力します。

または

• “Workspace”フィールドの隣の Browse ボタン
をクリックします。

Windows のファイル選択ダイアログボックスが
開きます。

• 使用するワークスペースを含むディレクトリを選
択します。

• ワークスペース（*.iow）を選択します。

• Open をクリックします。

“Workspace”フィールドにワークスペース名が
表示されます。

ASCET プロジェクトを INTECRIO システムプロジェクトに正しく統合するには、
ワークスペースが選択されていて、かつ INTECRIO が起動している必要がありま
す。

INTECRIO システムプロジェクトを選択する：

• “System”フィールドに使用する INTECRIO システ
ムプロジェクトの名前を入力します。

または

• “System”フィールドの隣の Browse ボタンをク
リックします。

INTECRIO が起動していない場合は、ここで起動
されます。

“INTECRIO systems”ダイアログボックスが開き
ます。ワークスペースに含まれるすべてのシステ
ムプロジェクトが表示されます。
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• ASCET プロジェクトを追加したシステムプロジェ
クトを選択します。

• OK をクリックします。

“System”フィールドにシステムプロジェクト名
が表示されます。

INTECRIO システムに 1 つの ASCET プロジェクトのみが含まれ、かつハードウェ
アシステムと OS コンフィギュレーションが INTECRIO 内で設定されている場合、
プロジェクトの転送後、INTECRIO 内でビルド処理が自動的に開始されます。

INTECRIO のビルド処理を選択する：

• Trigger INTECRIO Build オプションをオンにしま
す。

この操作は、INTECRIO ワークスペースとシステ
ムプロジェクトが選択されている場合にのみ可能
です。

最後に、INTECRIO への転送を実行します。

転送を実行する：

• “INTECRIO Project Transfer”ダイアログボックス
で必要な項目をすべて設定したら、OK をクリッ
クします。

ASCET プロジェクトの INTECRIO への転送が開始
されます。

転送時の状況に応じて、以下のようなワーニング
メッセージが表示される場合があります。

1. 未解決のメッセージが存在する場合：

プロジェクトに未解決のメッセージが含まれてい
ると、以下のダイアログボックスが開きます。

• OK をクリックすると、メッセージは自動的に解
決されます。

自動処理が完了すると、INTECRIO への転送が続
行されます。

または
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• コード生成を中断してマニュアル操作でメッセー
ジの解決を行うには、Cancel をクリックします。

この場合、転送を再度実行する必要があります。

2. 別の INTECRIO ワークスペースが開いている場合：

INTECRIO が起動していて、指定されたものとは
異なるワークスペースが開いていた場合、転送開
始時に以下のダイアログボックスが開きます。

• OK をクリックすると、開いているワークスペー
スが閉じて、転送処理が実行されます。

自動処理が完了すると、INTECRIO への転送が続
行されます。

または

• 転送を中止するには Cancel をクリックします。

プロジェクトの転送中には、INTECRIO での作業に必要なすべてのファイルが生成
され、指定されたディレクトリに保存されます。すべてのオプションが設定され
ていれば、INTECRIO が起動し、プロジェクトが INTECRIO にインポートされてシ
ステムプロジェクトに統合され、INTECRIO のビルド処理が開始されます。

INTECRIO 用に作成されるファイルには、以下のようなものがあります。

• <project name>.six

このファイルには、XML ベースの SCOOP-IX という言語で、プロジェクト
インターフェースのディスクリプションが記述されています。
なおハードウェアコンフィギュレーションの設定は INTECRIO 内で行われ
るため、HWC モジュールのインターフェースは SCOOP-IX ファイルには
含まれません。

SCOOP-IX のインターフェースディスクリプションには、以下のような情
報が含まれます。

－ C 変数の名前、型、サイズ

－ C 関数の名前、戻り値、引数

－ 各 C エレメントが含まれるファイル

詳しくは、『INTECRIO ユーザーズガイド』の「SCOOP と SCOOP-IX」の章
を参照してください。

• <project name>.a2l

INTECRIO 用に作成された ASAM-MCD-2MC ファイルです。
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• <project name>.oil

INTECRIO で使用されるオペレーティングシステムのディスクリプション
が格納されたファイルです。
なおハードウェアと OS のコンフィギュレーション設定は INTECRIO 内で
行われるため、HWC モジュールはこのファイルには含まれません。

• *.c および *.h

プロジェクトとそのコンポーネントの C コードファイルおよびヘッダファ
イルです。 *.six ファイルの以下のブロック内に、INTECRIO が使用する
*.c ファイルと *.hファイルが記述されます。

<fileContainer complete="false">

<pathBase path="{{codeDir}}" />

<!-- model specific C files -->

... *.c- and *.h files ...

</fileContainer>

上記のファイル以外にもいくつかのファイルが生成され、
ETAS¥ASCET5.1¥CGenに保存されますが、これらのファイルは INTECRIO での
作業には関係ありません。

転送が完了すると、INTECRIO でプロジェクトの実験を行うことができますが、転
送時の設定内容に応じて、実験を開始する際の操作が異なります。

実験を開始する：

以下の手順の個々のステップの具体的な操作方法は、INTECRIO のマニュアルに説
明されています。

• マニュアル操作でINTECRIOにコードをインポート
します。

このステップは、コードが自動的にインポートさ
れた場合は不要です。

• モデルをINTECRIOシステムプロジェクトに追加し
ます。

このステップは、コードが自動的に統合された場
合は不要です。

注記

このファイルは、自動的には INTECRIO にインポートされません。
INTECRIO でマニュアル操作を行ってオペレーティングシステムを設定
するか、または *.oilファイルをマニュアル操作でインポートしてく
ださい。
この *.oilファイルのフォーマットは、OSEK 規格には準拠していま
せん。このファイルはオペレーティングシステムのコンフィギュレー
ションを XML 形式で記述したものです。
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• システムプロジェクトを完成させます。

このステップには、ハードウェアシステムの作
成、オペレーティングシステムの設定、および
ハードウェアとソフトウェアの接続が含まれま
す。

• オペレーティングシステムの設定を、マニュアル
操作、または *.oilファイルを読み込むことに
よって行います。

• 実行ファイルを生成します。

• 実験を開始します。

INTECRIO の実験環境の使用方法は、『INTECRIO ユーザーズガイド』に説明されて
います。

ASCET で INTECRIO のバックアニメーションを行う際は、特殊な実験環境を使用
します。そこでは通常の方法でパラメータの適合を行うことができます。測定シ
ステムも通常どおりに動作しますが、ASCET のオフライン／オンライン実験とは
異なり、オシロスコープ、レコーダ、およびデータロガーの機能は使用できませ
ん。INTECRIO でのバックアニメーションでは、これらの機能に必要な同期測定が
行えないためです。その代わり、INTECRIO 上で別の測定ツールを使用できます。

バックアニメーションを行う：

• INTECRIO で、プロジェクトの実験を開始します。

• ASCET プロジェクトエディタで、“Experiment 
Target”に INTECRIOが選択されていることを確
認してください。

• Reconnect to Experiment of Selected 
Experiment Target ボタンをクリックします。

または

• Component → Reconnect to Experiment を選
択します。

ハードウェアオプションの Use ETAS Network 
Manager (enables ’Select Hardware’) オプショ
ン（2.1 項を参照）がオンになっていると、状況
に応じてハードウェア選択ダイアログボックス

（2.2.1 項を参照）が開きます。
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このダイアログボックスの使用方法は、38 ペー
ジ「ハードウェアを選択する（ETAS ネットワー
クマネージャを使用）：」 に説明されています。

INTECRIO で実験を実行するための接続が確立さ
れ、“Physical Experiment...”ウィンドウが開きま
す。タイトルバーに“INTECRIO Backanimation”
と表示され、バックアニメーション専用の実験環
境であることがわかります。

通常のオフライン／オンライン実験とは異なり、
ウィンドウには“Graphics”タブのみが表示され
ます。

• 必要な測定ウィンドウを作成して設定します
（『ASCET ユーザーズガイド』の「測定システム」
の項を参照してください）。

• 必要な適合ウィンドウを作成して設定します
（『ASCET ユーザーズガイド』の「適合システム」
の項を参照してください）。

• Experiment → Start Measuremet を選択しま
す。

または

• Start Measurement ボタンをクリックして測定
を開始します。

測定／適合ウィンドウの表示内容が周期的に更新
されます。

実験のロード、保存、エクスポートの方法は、『ASCET ユーザーズガイド』の
「環境設定のロードと保存」の項に説明されています。ロードされた環境内に、
バックアニメーションで使用できないエレメント（オシロスコープなど）が含ま
れていると、それらのエレメントは無視されます。
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ここでは、モニタ機能（『ASCET ユーザーズガイド』の「モニタ機能」の項を参
照してください）を使用して、数値変数と論理変数をモニタすることもできます。
モニタ機能の設定は、環境内に保存されます。

また、プロジェクト内のコンポーネント間をナビゲートすることができます
（『ASCET ユーザーズガイド』の「ブロックダイアグラム間のナビゲート」の項を
参照してください）。

プロジェクトにステートマシンが含まれている場合、ステートマシンのアニメー
ション機能（『ASCET ユーザーズガイド』の「ステートマシンの検証」の項を参
照してください）を利用できます。

実験で得られたデータを ASCET モデルやハードディスクに書き込むことができま
す。またハードディスクからデータを読み込むことも可能です。詳しくは

『ASCET ユーザーズガイド』の「データの扱い」の項を参照してください。

バックアニメーションを終了する：

• File → Exit を選択します。

または

• Exit to Component ボタンをクリックします。

バックアニメーションが終了し、実験環境が閉じ
ます。INTECRIO の実験はそのまま続行されます。
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R oqflパッケージ

5.1 概要

RealTime Input/Output Package（RTIO パッケージ）は、ASCET と ETAS 実験ハー
ドウェアシステム間の接続を容易に実現するためのものです。VME バスベースの
ETAS 実験システムハードウェアは、さまざまな目的に使用できる開発／実験用プ
ラットフォームです。アナログ信号やデジタル信号の入出力には、ES シリーズの
VME バスインターフェースボードを使用します。

この RTIO パッケージのユーザーインターフェースを利用して、複数のハードウェ
アコンポーネント（割り込みにより制御されるものも含みます）の ASCET プロ
ジェクトへの組み込みとコンフィギュレーション設定を容易に行うことができま
す。

組み込まれたハードウェアについては、ターゲットシステム専用の C コードが自
動生成されます。

5.2 RTIO パッケージのアーキテクチャ

ASCET-RP を使用すれば、ASCET モデルから、ES1000 システムにおいてリアルタ
イム環境で動作するプロトタイプソフトウェアを容易に生成することができます。

このためには、シミュレーションボードとその他何枚かの I/O ボードで構成され
た ES1000 システムのハードウェア環境に、ASCET モデルを組み込む必要があり
ます。この際、ASCET モデルは論理レベルで I/O チャンネルに接続されます。

この接続を行う作業は、2 つのステップで行います。HWC エディタ（第 7 章を参
照してください）を使用して、まず I/O ボードのコンフィギュレーション、つま
り物理的な入出力チャンネルの設定を行い、次にそれらのチャンネルを ASCET モ
デルの入出力である ASCET メッセージに割り当てます。

入力チャンネルの
コンフィギュレーション

ASCETモデル
出力チャンネルの

コンフィギュレーション

デバイスドライバ

物理的な
出力

チャンネル

物理的な
入力

チャンネル
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物理チャンネルの設定（ハードウェアコンフィギュレーション）は、XML ディス
クリプションファイル（*.hwx）に書き込まれ、同時に ASCET プロジェクト内に
も保存されます。

プロトタイプソフトウェアを生成するため、HWC エディタには、選択された実験
のタイプ（物理実験、量子化実験、実装実験）に応じたターゲット用の C コード

（第 8 章を参照してください）を生成する機能もあります。生成された C コード
は、各プロジェクト用に生成される HWC（5.2.1 項を参照してください）という C
モジュールに保存され、このモジュールは、ASCET データベースに格納されま
す。

ASCET モデル全体のコードが生成されてコンパイルされる際、ハードウェアコン
フィギュレーションの C コードモジュール（「HWC モジュール」）も同時にコン
パイルされて I/O ドライバにリンクされ、実験ターゲット上で実行可能なプロト
タイプが生成されます。

5.2.1 HWC モジュール

RTIO パッケージを使用する ASCET プロジェクトには、上述の「HWC モジュー
ル」が必要です。これは、ハードウェアとの接続に必要な C コードを格納するた
めのコンテナとして使用される C コードモジュールです。RTIO フレームワーク
は、この C コードモジュールを“HWC”というインスタンス名により識別します。

HWC モジュールは、メッセージを使用してモデル内の他の部分と通信します。こ
の方法によって、モデル内のハードウェア制御部分とそれ以外の部分とが明確に
分離されます。

注記

デフォルト状態において、ハードウェアコンフィギュレーションは XML フォー
マット（*.hwx）で保存されます。
必要に応じて既存の *.hwcフォーマットを選択して使用することもできます
が、ASCET-RPの将来のバージョンでは *.hwcフォーマットはサポートされ
なくなるため、できる限り XML フォーマットをお使いいただくことをお勧めし
ます。

HWCエディタ

*.hwx

ディスクリプションファイル

HWC 実験のタイプに応じた
Cモジュール
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下図は、RTIO プロジェクト内のモジュール間の関係を示しています。

HWC モジュール用の C コードは、各システムやボードの専用ドライバルーチンの
API1 インターフェースに合わせて調整されるので、システムは、ドライバルーチ
ンをライブラリとして使用することが可能となります。HWC モジュール内の API
関数呼び出しやドライバ用データは、各ドライバに依存しない標準の記述形式で
定義されています。

このようにして、新しいボードを容易に統合できるモジュラーシステムを構築で
きます。

5.2.2 HWC エディタ

ハードウェアコンフィギュレーションエディタ（HWC エディタ）は、RTIO フ
レームワークの中核となる機能です。

HWC エディタは、プロジェクトから起動され、ここで、使用される実験システム
に対応するハードウェアコンフィギュレーションを設定します。そして、コード
生成時には、ハードウェアコンフィギュレーションに組み込まれたハードウェア
に対して必要なエレメントとその C コードが生成され、ハードウェアにアクセス
するための環境が実装されます。

1. API ＝ Application Programming Interface

Module 1 HWC
Module Module 2

SmesgE

RmesgB

SmesgA

RmesgC

SmesgB

RmesgH

SmesgF

RmesgF

SmesgC

RmesgA

SmesgG

RmesgK

RmesgE

RmesgG

RmesgI

A
P

I

Driver
Routines
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S 準備

本項では、RTIO パッケージをインストールして使用するための一般的な条件と準
備作業ついて説明します。

6.1 ハードウェア - ES1000.x 実験システム

RTIO パッケージを稼働させるためには、いずれかの ETAS 実験ハードウェアシス
テム（VME システム）が必要です。通常は以下のような機種が使用され、これら
を組み合わせて使用することもできます。

• ES1000.2

• ES1000.3

RTIO フレームワークは、ETAS のシステムコントローラボードをすべてサポート
しています。標準構成例を下図に示します。

図 6-1 標準的なシステムコントローラ構成
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コントローラボード bpNNOM とシミュレーションボード bpNNPM=L=bpNNPR

ES1000.x を使用してラピッドプロトタイピングと適合作業を並行して行う場合
は、ホスト PC との通信は、コントローラボード ES1120 を介したイーサネット接
続によって行われます。ASCET で開発されたファンクションを、コントローラ
ボード ES1120 経由で PPC モジュール ES1130 または ES1135 にロードして実行
し、この環境において、プロトタイピング実験とデータ測定／適合を並行して行
うことができます。

q`mLfm プロトコルオプション

社内 LAN 用に別のネットワークカードを使用している場合、IP アドレスの競合を
防ぐため、TCP/IP を以下のように設定する必要があります。

TCP/IP プロトコルオプションを設定する :

• DHCP サービスを無効にします。

• IPアドレスフィールドに 192.168.40.240 と入
力します。

• サブネットマスクフィールドに 
255.255.255.0 と入力します。

• DNS サービスを利用する場合は、社内 LAN のロー
カル設定を使用してください。

• WINS サービスを無効にします。

• IP 転送オプションが無効になっていることを確認
します。

（Windows® 2000 の場合）
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6.2 ES1135 の特殊な機能の紹介

ES1130 の後継機種である ES1135 には、いくつかの機能が追加されています。こ
こではこれらの機能について説明します。

6.2.1 不揮発性 RAM（NVRAM）

基本事項

「不揮発性（NV）変数」つまり NVRAM にマッピングされる適合変数は、ASCET
で記述される他の適合変数と同様に使用できます。この変数に対しては、モデル
からの読み書きのほか、適合ウィンドウでの適合処理や、データ測定やロギング
を行うことができます。NV 変数の特徴は、シミュレーションを中断した場合、そ
の後、同じモデルを用いるシミュレーションを再開するときに、中断時の値をそ
のまま継続して使用できるという点です。これは、ECU コード内の自己学習アル
ゴリズムに使用されるアダプティブ適合変数や、診断結果を保存する変数などに
利用できます。

NV 変数であることを表わす åçåJîçä~íáäÉ（NV）という属性は、ASCET のすべての
基本データタイプ（スカラ、配列、マトリックス、特性カーブ／マップ）の適合
変数に対して任意に割り当てることができます。ただし、NV 変数として使用でき
るのはこれらの ASCET 変数だけで、C コードで記述された変数を NV 変数として
使用することはできません。

NV 変数を定義するには、クラスエディタまたはモジュールエディタにおいて、変
数のエレメントエディタ上の Non-volatile オプションをオンにします。

ハードウェアの特徴

ES1135 のメインプロセッサである IBM750GX のアドレス空間には、64K バイト
の NVRAM（不揮発性 RAM）が含まれています。このメモリ領域に格納された値
は、電源障害の復旧後、または電源を一度切って再投入した後でも、そのまま保
たれています。

NVRAM へのアクセスは、通常の揮発性 RAM に比べてはるかに時間がかかる上、
キャッシングも行えません。そのため、パフォーマンス上の理由から、NV 変数は
NVRAM に直接マッピングされるのではなく、通常の揮発性変数と同様に通常の

注記

NVRAM を使用するプロジェクトには、ユーザー定義の INIT プロセ
スを用意し、すべての NV 変数の値の妥当性を、各変数ごと、およ
び変数間でチェックする必要があります。このチェックが確実に行
われない場合は、すべての NV 変数を所定のデフォルト値（安全な
値）に初期化しなければなりません。
これは、NVRAM 上の不正な値が初期値として使用されたことに
よって人体や機材を傷付ける可能性が生じるような環境（車両やテ
ストベンチなど）においてプロジェクトを稼動させる場合は、絶対
に必要な処置です。
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RAM にマッピングされ、その値が定期的に NVRAM に保存されます（自動更新
モード）。デフォルトの更新周期は 10 秒ですが、以下の API 関数（13.2 項を参照
してくださいを参照してください）で、更新周期を 1 ～ 30 秒の範囲内で任意に
設定することもできます。

uint32 nvramSetUpdateInterval(uint32 interval_sec) 

NVRAM への値の保存はアイドルタスク内で行われるので、モデルのリアルタイ
ム挙動には影響しません。

NVRAM は、データの整合性を保つために交代バッファ方式になっているので、
実際に使用できる容量は、メモリサイズの半分です。また、多少のオーバーヘッ
ドもあるため、最終的に ASCET モデルが使用できる NVRAM 容量は、32K バイト
弱となります。

ES1135 のファームウェアでは、この容量制限が考慮されています。モデル内に定
義された NV 変数の合計サイズが NVRAM の容量を超えていると、実験開始時に

“NVRAM overflow”というエラーメッセージが ASCET モニタウィンドウに表示さ
れます。この場合、NVRAM はまったく使用されません。つまり、値は NVRAM
に保存されません。このような場合は、モデル内の NV 変数の数を減らしたり、
サイズを小さくする必要があります。

NVRAM データにはアドレス情報や変数名は含まれないため、それらのデータは、
前回の更新後にモデル内の NV 変数の構成が変わっていない場合にのみ、モデル
に適用されます。このために、コード生成時に特殊な NV 識別子が作成され、そ
の変更の有無がチェックされます。

NV 識別子は、以下のアクションによって変更されます。

• プロジェクト、モジュール、クラス、サブクラス内のいずれかの NV エレメ
ントのインスタント名の変更

• プロジェクト、モジュール、クラス、サブクラス内のいずれかの NV エレメ
ントのインプリメンテーションの変更

これは、以下の条件を指します。

－ コード生成オプションが Physical Experimentの状態で、実装
データ型を contから sdisc/udiscに変更したとき

－ コード生成オプションが Implementation Experimentの状態で、
実装値のインターバル（範囲）を変更したとき

• いずれかの NV 変数の変換式パラメータの変更

変換式の名前やコメントのみを変更した場合、NV 識別子は変更されませ
ん。

• NV 列挙型データの場合：

－ 列挙子の順番の変更

－ 列挙子の名前（値）の変更

－ 列挙子の削除／追加

－ 異なる列挙型データを選択（含まれる列挙子が同じである場合を含む）
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• 多次元の NV エレメント（配列、マトリックス、特性カーブ／マップ）の最
大サイズの変更

• 実装実験（コード生成オプションが Implementation Experiment）
における、実装値のインターバルの変更

• プロジェクト、モジュール、クラス、サブクラス内での NV エレメントの削
除／追加

• ステートマシン内のステートの追加／削除

NV 識別子は、以下のアクションによっては変更されません。

• プロジェクト名の変更

• プロジェク内のモジュールまたはクラスの名前の変更

• プロジェクト、モジュール、クラス、サブクラス内に含まれるいずれかの
通常の変数（Volatile 変数）のインスタンス名の変更

• いずれかの NV エレメントの変換式の、名前またはコメントの変更

変換式のパラメータが変更されたときは NV 識別子も変わります。

• 列挙型データの名前の変更

• NV エレメントと通常のエレメントの値の変更

• 多次元の NV エレメント（配列、マトリックス、特性カーブ／マップ）の実
効サイズの変更

• NV エレメントおよび通常のエレメントに使用されるメモリ領域の変更

ks 変数の初期化と更新

シミュレーションの開始時 : モデルコードがターゲットにダウンロードされた
時、そのモデルに含まれる NV 変数について、NVRAM 内に対応するデータがない
場合は、その NV 変数にデフォルト値が初期設定されます。「対応するデータがな
い」というのは、NV メモリが空であるか、チェックサムの照合によって不一致が
認められたか、または NV 識別子のチェックにより NV データとダウンロードされ
たモデルとの不整合が認められた、ということです。

一方、対応するデータが NV メモリ内に保存されていた場合には、その値がモデ
ルの初期値として使用され、ERCOSEK を起動して実験を開始できるようになりま
す。

シミュレーションの終了時 : ERCOSEK を停止してシミュレーションを終了する
と、最後に保存された NV 変数の値が NVRAM 内に保存されます。ターゲットの
電源がオフになったり、コードが再度ダウンロードされた場合でも、最後に保存
された NV 変数値を用いてシミュレーションを再開できます。

前述のように、NV 変数の値は自動更新モードでは NVRAM に定期的に保存されま
すが、値を確実に NVRAM に格納するためには、以下の API 関数を、Exit タスク

（アプリケーションモードが inactiveであるタスク）の最後に呼び出してくだ
さい。

void nvramUpdateMemoryExit(void)
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現在使用されているモデル内に NV 変数が 1 つもない場合には、NVRAM の内容
はまったく変更されません。

NV 変数を含むモデルがフラッシュメモリ内に書き込まれている場合 : シミュ
レーションコントローラの FLASH メモリ内に NV 変数を使用するシミュレーショ
ンモデルが書き込まれている場合、このモデルは電源の投入によって通常どおり
ブートされますが、シミュレーションが開始される前に対応する NV データが保
存されているかどうかが調べられ、あればその値が初期値として書込まれます。

モデルがデフォルトの NV 変数値に基づいて実行されているかどうかを調べる :
モデルの初期化時において、ASCET のデータエディタで定義されたデフォルト値
が NV 変数に設定されたのか、あるいは NVRAM に保存されていた値が設定され
たのかは、実験環境の Target Debugger ウィンドウに表示される情報メッセージ
で判断できます。また、モデル内から以下の API 関数を実行しても、このメッ
セージと同じ情報が得られます。

uint8 nvramCheckForInitializedVars(void) 

NVRAM の内容をクリアする : 前記のとおり、プログラム識別子が整合している
場合は NVRAM の値が NV 変数の初期値として使用されますが、必要に応じて
NVRAM の内容を任意にクリアし、NV 変数にモデルのデフォルト値が初期値とし
て設定されるようすることができます。現時点において、この機能は GUI ではサ
ポートされていませんが、以下の API 関数を使って、モデルから NVRAM をクリ
アすることができます（13.2 項 「API 関数（NVRAM）」を参照してください）。

uint32 nvramClear(void)

データの整合性

電源断またはシステムクラッシュによりシミュレーションが中断された場合でも、
NV 変数の値は NVRAM に格納されています。しかしこれらの値が妥当なものであ
るかどうかは、自動更新またはモデル内からの操作によって最後に値が保存され
たときのタイミングによります。

このため、予想外の中断が発生した時の NVRAM の内容の整合性を、以下に示すよ
うなさまざまなレベル、または方法で確保することができます。

以下の API 関数では、3 通りの整合性レベル（なし、低レベル、高レベル）を設
定します。

uint32 nvramSetConsistencyLevel(T_consistencyLevel 
level)

整合性なし : NVRAM の更新は、すべてのタイプの NV 変数の整合性を無視して
行われます。

低レベルの整合性（単一変数の整合性）: このレベルにおいては、スカラ、配
列、およびマトリックスタイプの各 NV 変数単位でのデータ整合性は保証されま
すが、特性カーブ／マップの整合性は保証されません。

このレベルにおいては、特性カーブ／マップのような複合タイプの変数の更新を
アトミックに、つまり中断されることなく行うことはできません。
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高レベルの整合性（複合変数、およびタスク終了後の整合性）: このレベルにお
いては、アイドルタスクにおいてすべての NV 変数の値が中断されることなく
ローカルバッファに保存された場合のみ、NVRAM の更新が行われます。

アプリケーションにおいて、一連の NV 変数の値を変更する処理は、アトミック
に実行されるようにしてください。たとえば、自己学習アルゴリズムは複数の変
数を対象に処理されるので、NVRAM 内の複数の変数の値が、同じ演算サイクル
で得られるようにする必要があります。

モデルにより制御される整合性（複合変数、および複数のタスクサイクル間の整
合性）: 上記の「高レベルの整合性」メカニズムは、NV 変数の操作が 1 つのタ
スクサイクル内で行われる場合に限り整合性を保証します。しかし、NV 変数の操
作は複数のタスクサイクルにわたって行われる場合もあり（たとえば、1 つの適
合変数を複数のタスクで更新する場合など）、そのような場合、ES1135 ファーム
ウェアはそれを認識できないので、モデルの側で NVRAM の更新タイミングを制
御する必要があります。

自動更新をオフにするには、以下の関数を用います。

uint32 nvramDisableAutoUpdate(void)

また、次の関数で、すべての NV 変数の更新をモデルから任意に開始することが
できます。

uint32 nvramManualUpdateBackground(void)

任意更新を行う場合でも、更新処理が完了するまでの間にシステム全体がブロッ
クされたりリアルタイム挙動が変わってしまったりすることがないように、この
関数は、呼び出された後にすぐに呼び出し元に戻り、実際の更新はバックグラウ
ンドで行われます。この際、以下の関数を用いてバックグラウンドでの更新ス
テータスを調べることができます。

uint8 nvramCheckRunningUpdate(void)

この関数は、更新処理が実行中である場合には trueを返します。ユーザー側
（モデル）は、更新中に NV 変数が変更されないようにしなければなりません。

自動更新を再開するには、以下の関数を使用します。

uint32 nvramEnableAutoUpdate(void)

任意更新の際、一部の NV 変数だけを選択して更新することはできません。

現在のモデル内に NV 変数が 1 つも含まれていない場合には、NVRAM の内容は
まったく変更されません。

NVRAM の内容の不整合 : NVRAM の内容に不整合があった場合、たとえば、
チェックサムの照合結果が不良だった場合には、実験環境、または ASCET モニタ
ウィンドウに、警告メッセージが出力されます。

kso^j コックピット

NVRAM 用 API（13.2 項を参照してください）には NVRAM の更新を制御するた
めの機能が含まれています。実験中に、「NVRAM コックピット」という専用ウィ
ンドウを使用してこの機能を利用することができます。このウィンドウには、API
関数を使用して設定された内容も反映されます。
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NVRAM コックピットを使用する：

• 実験ウィンドウから Experiment → NVRAM 
Cockpit を選択します。

または

• Open NVRAM Cockpit ボタンをクリックしま
す。

NVRAM コックピットが開きます。

• 必要に応じて各コントロールエレメントを使用し
ます。

• 操作が終了したら、Close をクリックして
NVRAM コックピットを閉じます。

NVRAM コックピットには、以下のコントロールエレメントが含まれています。

• Update Interval [sec] （更新周期の設定）

このスライダエレメントで、NVRAM の内容の自動更新の周期（秒単位）
を調整します。デフォルトは 10 秒で、30 秒まで設定可能です。

スライダは、自動更新が ON になっている場合のみ使用可能です。
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• Auto Update （自動更新 ON/OFF）

このボタンで、自動更新の ON/OFF を切り替えます。自動更新は、このボ
タンが押された状態（a）になっていると行われ、押されていない状態

（b）においては行われません。.

• Consistency level （整合性レベルの設定）

このコンボボックスで、更新の整合性レベルを選択します。詳しくは 74
ページの「データの整合性」 を参照してください。

• Clear NVRAM （NVRAM の消去）

このボタンで NVRAM の内容を消去できます。

自動更新が有効になっているときに Clear NVRAM をクリックすると、
NVRAM の内容が消去されますが、次回の自動更新のタイミングにおいて
再度書き込みが行われます。

• Update Now（任意更新）

このボタンをクリックすると、NVRAM の内容が更新されます。

このボタンは、自動更新が OFF になっている場合にのみ使用できます。

NVRAM コックピットには、以下の表示エレメントが含まれています。

• Time since last Update [sec]（前回の更新からの経過時間表示）

この棒グラフに、前回更新が行われた時からの経過時間が表示されます。
全体の幅は 30 秒を表します。もしも自動更新が OFF になっていて 30 秒
以上更新が行われないと、秒数を表す数字だけが更新されます。

時間のカウントは、実験終了後も継続されます。実験終了後に任意更新を
行うと、カウンタがリセットされ、新たにカウントが開始されます。

前回の更新から 30 秒が経過するまでは棒グラフは緑で表示され、それ以
上経過すると赤で表示されます。ただし、30 秒経過する前に実験を終了

（Stop ERCOS）した場合は、30 秒経過した時点で黄色表示になります。

注記

NVRAM の内容の自動更新は、実験の実行中にのみ行われます。
Experiment → Stop ERCOS または Stop ERCOS ボタンで実験を終了する
と、NVRAM の内容のは自動更新されなくなります。

注記

NVRAM の内容の任意更新は、Experiment → Stop ERCOS または Stop 
ERCOS ボタンで実験を終了した後も、任意に行えます。

(a) (b)
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• Non Volatile Variables initialized from NVRAM（Non-Volatile 変数が
NVRAM の値で初期化されたかどうかを表示）

NV 変数が NVRAM 上の値で初期化されると、明るい緑の LED（a）が表示
されます。暗い緑（b）の LED は、NV 変数がデフォルト値で初期化され
たことを示します。

• NVRAM Update running（NVRAM の更新状態）

NVRAM の更新処理が実行されている間、明るい緑の LED が表示されま
す。

kso^j 使用上のヒント

以下に、NVRAM を使用する際に役立つヒントを紹介します。

• ステート変数を NVRAM 変数として定義する

NVRAM のサポート機能が強化され、ステートマシンのステート変数 sm
に対して Non-Volatile 属性を割り当てることができるようになりました。
そのためには、ステートマシンエディタの“Elements”リストの sm 変数
を右クリックし、Settings → Non-Volatile を選択します。

(a)

(b)
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• 集合エレメントの実際のサイズの保存

Non-Volatile 性が割り当てられた集合エレメント（配列、マトリックス、
特性カーブ／マップ）の実際のサイズ（“current size”属性）は、NVRAM
に保存されます。

オフライン時にモデル内のこれらの変数のサイズを変更し、プログラムを
ダウンロードした場合、新しいサイズが有効になるのは、NVRAM コック
ピットからの操作などによって NVRAM の内容が消去された後、または
NVRAM の内容とプログラムの内容とが不一致になった後です。

• NVRAMを使用するプロジェクトをES1000のフラッシュメモリ上で実行す
る際の注意点

フラッシュメモリ上に書き込まれたプログラムは、ES1000 の電源をオン
にするたびに起動される、ということを常に念頭に置いておくようにして
ください。このプログラムが NV 変数を使用する場合、その変数は
NVRAM 上に配置されます。その状態で、NV 変数を使用する別のプログ
ラムをフラッシュメモリに上書きすると、NVRAM の内容がリセットされ
てしまう可能性があります。

6.2.2 ウォッチドッグ

ラピッドプロトタイピングシステムの安全性を高めるため、ES1135 にはハード
ウェアウォッチドッグ機能が搭載されています。これは ES1135 のメインプロ
セッサをモニタする、独立した制御ユニットです。あらかじめ定義されている
データシーケンスがメモリセル（「ウォッチドッグサービスレジスタ」）に周期的
に書き込まれ、もしもこの書き込みアクセス（「ウォッチドッグサービス」）が成
功しないまま最大時間（「ウォッチドッグ周期」）が経過すると、プロセッサの例
外処理（「イベント」）がトリガされます。

ES1135 HW ウォッチドッグは、以下の 2 つのモードで使用できます。

1. 安全性を優先するモード（「セーフティモード」）

2. 機能が強化されたフレキシブルモード（「RSEF（Reduced Safety Mode 
Enhanced Function）モード」）

RSEF モードにおいては、実行中のモデルから、ウォッチドッグ機能を以下のよう
に再設定することができます。

• イベント設定

ウォッチドッグタイマ満了時に実行される例外処理を定義します。ウォッ
チドッグがオフになるように設定することも可能です。

• ウォッチドッグ周期 

ウォッチドッグサービス（値の書き込み）の発生の有無を監視するウォッ
チドッグタイマのリミット値を定義します。
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• モード切り替え

ウォッチドッグ周期とイベントが適切に設定されていないと、セーフ
ティーモードに切り替わり、その後は、モードを再設定したり、別のモー
ドに切り替えることはできなくなります。不正なイベントの発生を防ぐた
め、あらかじめ、ウォッチドッグサービスを適切に設定しておいてくださ
い。

電源電圧がオンになると、ウォッチドッグは RSEF モードになり、セーフティー
モードはオフになります。

ウォッチドッグサービス

ウォッチドッグサービス（メモリセルへのデータ書き込み）がウォッチドッグ周
期が満了する前に行われないと、所定のウォッチドッグイベントが発生します。
モデルを設計する際は、必ず、モデルの誤動作を確実に検知できる位置でこの
サービス関数を呼び出すようにしてください。

シミュレーションコントローラのファームウェアには自動ウォッチドッグサービ
スメカニズムが搭載されているので、モデルによって割込みが無効になっていな
ければ、30ms ごとにウォッチドッグサービスが行われます。従って、オペレー
ティングシステムが適切に稼動している限り、ウォッチドッグサービスは定期的
に処理されます（ウォッチドッグ機能が有効になっている場合）。このメカニズム
は、さまざまなケースに利用できます。

割込み制御

モニタやデバッグを行う際、ウォッチドッグタイマ満了時にシミュレーションプ
ロセッサ割込みをトリガするように設定することができます。

割込みは、ポーリングしたり、また内部割込みコントローラに送ることもできま
す。ウォッチドッグ割込みはラッチされるので、明示的に応答

（"acknowledging"）する必要があります。割込みソースのディセーブル／イネー
ブルの切替えは、専用の関数で高速に行うことができます。これらの関数の処理
は、割込みの伝達にのみ影響します。
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ウォッチドッグ割込みは、ASCET 内の HW タスクに割り当てられます。このタス
クには、ASCET の OS エディタで、Interrupt というタスクタイプと Int2とい
う ISR ソースを指定してください。

ウォッチドッグハンドラは、ERCOSEK レベルよりも下、また他の HW 割込み
（VME Bus からの割込みなど）よりも上のレベルで実行されるので、ウォッチドッ
グ割込みは、他の HW 割込みが処理されている途中であっても処理されます。割
込みに対する応答は ES1135 ファームウェア内で行われるので、ハンドラタスク
内では行わないようにしてください。ハンドラタスク内ではすべての ERCOSEK 関
数を使用できます。

ウォッチドッグ割込みが発生すると、ウォッチドッグは、250µs 後にタイムアウ
ト状態から自動的に復元され、設定されている周期で新しい監視サイクルが再開
されます。標準のウォッチドッグサービス wdService()を使用すれば、この復
元処理を短時間で行うことができます。

ウォッチドッグ API については、13.3「API 関数（ウォッチドッグ）」という項で
詳しく説明します。
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6.2.3 LED

ES1135 のフロントパネル上の LED は、「システム LED」（M、I、S、F、A、L、S）
と、自由にプログラミングできる「プログラマブル LED」（1、2、3）とに分かれ
ています。

図 6-2 ES1135 - フロントパネル

システム LED については、ES1135 のハードウェアマニュアルに説明されていま
す。

プログラマブル LED へのアクセスは、RTIO（10.2「ES1135-LED」を参照してく
ださい）、またはプログラムインターフェース（13.4「API 関数（ES1135 LED）」
を参照してください）から行えます。

6.3 システムソフトウェア

本書で説明する RTIO パッケージは、以下のソフトウェア製品の一部です。

• ASCET（V5.1.1 以降）とそのアドオン製品 - ASCET-RP（V5.4.0 以降）
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6.3.1 システムルートパス

ASCET-RP をインストールすると、ASCET ディレクトリの下に
Ascet5.1¥targetという新しいサブディレクトリが作成されるので、このサ
ブディレクトリをシステムルートパスとして設定します。

システムルートパスを指定する :

• システムルートパスは、ASCET の“Station 
Options”ダイアログボックスで設定します。

• ASCET のコンポーネントマネージャから、Tools
→ Options を選択します。
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“Options”ダイアログボックスが開きます。

• “System Root Path”の項目に ¥TARGETというパ
スが指定されている必要があります。

6.3.2 C コードモジュール

RTIO によるハードウェア接続を行なうには、ASCET-SD プロジェクトごとに独立
した C コードモジュールがデータベース内に生成される必要があります。

6.3.3 プロジェクト

RTIO ハードウェアリンクを実行するためには、考慮しなければならない事柄がい
くつかあります。

• RTIO コード生成を行なうプロジェクトには、プロジェクト専用に生成され
た C コードモジュールが追加されます。（前項を参照してください）。この
モジュールには、“HWC”というインスタンス名が含まれていなければな
りません。

• 使用するシステムコントローラのタイプ（ES1130 または ES1135）に応じ
て、ターゲットタイプを選択する必要があります。

注記

従来のバージョンの RTIO には、データベース内のモジュール名についての制約
（“HWC”）がありましたが、現在ではこの制約はなくなり、どのような名前で
も使用できるようになっています。
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• RTIO 接続をできるだけ容易に行うことができるように、プロジェクトエ
ディタの“OS”タブのタスクリストに以下のタスクを定義してください。

ハードウェアコンポーネントによっては、これ以外のタスクも必要です。
これについては、各コンポーネントについての章で詳しく説明します。

• RTIO HWC モジュールがプロジェクト内の他のコンポーネント（他のモジュー
ル、グローバルメッセージ）との通信に使用するすべてのメッセージは、
通信相手側で“Exported”として定義されている必要があります。送信
メッセージや送受信メッセージは、通常そのようなかたちで生成されます
が、受信メッセージについてはそれが明示的に行なわれていることを確認
してください。

従来のバージョンの RTIO とは異なり、階層モジュール内で生成された
メッセージにもアクセスできます。

タスク名 タスクタイプ アプリケーション
モード

機能

Init Init active RTIO フレームワークがハー
ドウェアドライバを初期化し
ます。

Config Software active 一部のハードウェアドライバ
の再設定を行ないます。

Exit Init inactive ドライバリソースを解放しま
す。
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T et`エディタ

HWC エディタは RTIO フレームワークの中核となる部分で、ハードウェアの構成
と設定が定義された「ハードウェアコンフィギュレーション」を編集するための
エディタです。

7.1 HWC エディタを開く

まずプロジェクトエディタで ASCET プロジェクトを開きます。RTIO パッケージ
が正しくインストールされていれば、メインメニューバーに RTIO メニューが表
示されます。このメニューから Open Editor または Open Editor with... コマン
ドを選択すると、HWC エディタが開きます。

ASCET セッションにおいて HWC エディタを初めて開くときには、いくつかのシ
ステムコンポーネントがロードされるため、時間が多少長めにかかります。（シス
テムの起動を高速化してリソースを節約するため、一部の拡張機能は実際に必要
になった時点でロードされます。）

パッケージが正しくインストールされている状態で、メインメニューバーの RTIO
→ Open Editor コマンドで HWC エディタを 開くと、ASCET プロジェクトの

“Files”タブ（ファイルコンテナ）内で、HWC.HWX（または HWC.HWC）という
ファイルが検索されます。

ファイルが見つかると、それが自動的にエディタにロードされます。HWC.HWX
（または HWC.HWC）ファイルの内容は、その HWC モジュールのコード生成が最
後に実行されたときのものです。

Open Editor with... コマンドで HWC エディタを 開く場合は、HWC.HWX（また
は HWC.HWC）以外の任意のハードウェアコンフィギュレーションファイルを選択
してロードすることができます。

ハードウェアコンフィギュレーションファイルのファイルフォーマットの選択
（*.HWXまたは *.HWC）は、“HWC Editor Options”ダイアログボックス（メ
ニューコマンド Extras → Options）の“Files”タブで行えます。
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7.2 エディタの画面構成と操作方法

本項では、HWC エディタウィンドウの構成と一般的な操作方法について説明しま
す。

ユーザーインターフェースは、ツールバー、“Items”リスト、および各オプショ
ン項目の値を入力したり修正するための一連のタブで構成されています。

タブの下のテキストフィールドには、選択された行についての簡単な説明文が表
示されます。Accept ボタンをクリックすると設定の変更内容が有効になり、
Reset ボタンをクリックすると変更内容は破棄されます。

7.2.1 ツールバー

本項では、ツールバーのボタンを使用して実行できる機能について説明します。

新しいハードウェアコンフィギュレーションを作成する：

• 新しいハードウェアコンフィギュレーションを作
成するには、New ボタンをクリックします。

または

• File → New を選択します。

注記

個々の機能についての詳細は、92 ページの「メインメニュー」という項を参照
してください。
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ハードウェアコンフィギュレーションを開く：

• ハードウェアコンフィギュレーションを開くに
は、Open ボタンをクリックします。

または

• File → Open を選択します。

ハードウェアコンフィギュレーションを保存する：

• ハードウェアコンフィギュレーションを保存する
には、Save ボタンをクリックします。

または

• File → Save を選択します。

• ハードウェアコンフィギュレーションを任意の名
前で保存するには、File → Save As を選択しま
す。

すべてのアイテムを展開して表示する：

• “Items”リスト内の枝をすべて展開して表示する
には、Expand all ボタンをクリックします。

または

• View → Expand all を選択します。

すべてのアイテムを省略して表示する：

• “Items”リスト内の枝を可能な限り閉じて表示す
るには、Collapse all ボタンをクリックします。

または

• View → Collapse all を選択します。

新しいアイテムを追加する：

• アイテムのリストに新しいアイテムを追加するに
は、Add  Item ボタンをクリックします。

または

• Edit → Add  Item を選択します。

アイテムを削除する：

• アイテムを削除するには、そのアイテムをリスト
から選択し、Delete Item ボタンをクリックしま
す。

または

• Edit → Delete Item を選択します。
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ハードウェアコンフィギュレーションをチェックする：

• ハードウェアコンフィギュレーションの妥当性を
チェックするには、Check Hardware 
Configuration ボタンをクリックします。

または

• Extra → Check Hardware Configuration を選択
します。

コード生成を開始する：

• コード生成を開始するには、Generate Code For 
Current Experiment ボタンをクリックします。

または

• Extras → Generate Code → For Current 
Experiment を選択します。

ハードウェアコンフィギュレーションをインポートする：

• ハードウェアコンフィギュレーションをインポー
トするには、Import ボタンをクリックします。

または

• Files → Import を選択します。

ハードウェアコンフィギュレーションをエクスポートする：

• ハードウェアコンフィギュレーションをエクス
ポートするには、Export ボタンをクリックしま
す。

または

• Files → Export を選択します。

7.2.2 “Items”リスト

エディタの左側ペーンにツリー構造で表示される“Items”リストは、ハードウェ
アシステムの構成を表すものです。ここにハードウェアを追加することにより、
システム構成を定義します。

ここで、アイテム（"Item”）という語は、ハードウェアシステムを構成する各階
層の 1 つの要素を表します。つまり、ボード単体を示す場合もあり、またある特
定の機能を実現するための１つのユニット全体を表す場合もあります。

“Items”リスト内の各アイテムを選択すると、そのアイテムについての情報や設
定内容が右側の表に表示されます。

注記

ハードウェアの構成は、ハードウェアツリーのすべての末端に“Device”タイ
プのアイテムが定義されていないと、完全に定義されたことにはなりません。
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7.2.3 コンフィギュレーション用タブ

アイテムリストのどのアイテムが選択されているかにより、ウィンドウ右側部分
に表示されるアイテム設定用のタブの種類が異なります。

“Device”タイプのアイテムが選択されている場合は 4 つのタブが表示され、それ
以外の場合は“Globals”というタブだけが表示されます。

各タブの内容は以下のとおりです。

• “Globals”タブ

グローバルオプション、つまりアイテム全体に共通なオプション項目
（例、I/O ボードの VME バスアドレス）が含まれます。

• “Groups”タブ

シグナルグループに関するオプション項目（例、マルチチャンネル A/D コ
ンバータ用のゲインファクタや CAN メッセージの識別子）が含まれます。

• “Signals”タブ

シグナルごとのオプション項目（例、変換式）を設定するために使用され
ます。

• “Mappings”タブ

シグナルと ASCET メッセージの対応関係を定義するために使用されます。
HWC モジュールと他の部分との間の RTIO データフローもここで設定しま
す。

各タブの設定についての詳細は、107 ページの「コンフィギュレーションタブ」
を参照してください。

さらに、各タブには Accept および Reset という 2 つのボタンがあります。これ
らのボタンは以下のように使用します。

Accept ボタン :

タブが初めて開かれたときや再度開かれたときには、各オプション項目に設定さ
れているデータのコピーが作成され、その内容が表示されます。いずれかのセル
を編集すると、そのコピーされたデータが変更されます。

注記

1 つのシグナルグループ内のすべてのシグナルの転送方向（send または
receive）は同じで、同じタイミングで取得されます。
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そのため、編集終了後は、Accept ボタンをクリックして変更後のデータを元の
データに明示的に書き込む必要があります。書き込みを行わずにタブを閉じよう
とすると、システムはデータ書き込みを行うようにユーザーに要求します。

“Items”リスト内の複数のアイテムの依存関係を考慮しなければならない場合が
あるので、上記のメカニズムによって常にデータの整合性を保証することが必要
となります。

Reset ボタン :

このボタンで、前回 Accept をクリックした後に行われたすべての修正内容が取
り消されます。

7.2.4 メインメニュー

本項では、各メニューに含まれるメニューコマンドについて説明します。

“cáäÉ”メニュー

• File → New 

新しいハードウェアコンフィギュレーションを生成します。既存のハード
ウェアコンフィギュレーションを変更した後にその変更内容がまだ保存さ
れていない場合、システムはユーザーに対して以下の質問を行います。

Yes をクリックして確定すると、プロジェクトファイルコンテナ内のコン
フィギュレーションが保存されます。No をクリックすると、たった今作
成されたコンフィギュレーションは削除され、新しいハードウェアコン
フィギュレーションが生成されます。Cancel はハードウェアコンフィ
ギュレーション生成処理を打ち切ります。

• File → Open... 

“Open Hardware Configuration File”ダイアログボックスが開きます。
“File Type”コンボボックスでフォーマット（*.HWXまたは *.HWC）を選
択すると、プロジェクトファイルコンテナに含まれるそのフォーマットの
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ファイルがすべて“Select from Project Files”リストに表示されるので、
ファイルを選択して OK をクリックすると、そのファイルが HWC エディ
タにロードされます。

• File → Save 

ハードウェアコンフィギュレーションを同じ名前で ASCET プロジェクト
のファイルコンテナに保存します。

注記

HWC.HWX（または HWC.HWC）というファイルは特別なファイルです。
このファイルは、HWC エディタでコード生成が開始されると必ず暗黙
的に生成、または上書きされます。
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• File → Save As ... 

ハードウェアコンフィギュレーションを新しい名前で ASCET プロジェク
トのファイルコンテナに保存します。“Save Configuration Files as”ダイア
ログボックスでフォーマット（*.HWXまたは *.HWC）を選択し、

“Filename”フィールドに新しいファイル名を入力します。

“Project Files”リストには、選択されているタイプの既存のファイルがす
べて表示されるので、この中のいずれかのファイルに上書きすることもで
きます。ファイルを選択するとそのファイル名が“Filename”フィールド
に表示され、OK をクリックすると、現在のハードウェアコンフィギュ
レーションがそのファイルに上書きされます。
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• File → Save Item as Template ... 

選択されているアイテムの設定を「アイテムテンプレート」として保存
し、他の同じタイプのアイテムに同じ設定を適用できるようにします

（104 ページの「Extras → Options ...」メニューの Use Item Templates を
参照してください）。

このメニューコマンドを選択すると“Save Item As Template”ダイアログ
ボックスが開くので、“File Type”コンボボックスでフォーマット（*.itx
または *.itp）を選択し、“Filename”フィールドにファイル名を入力し
ます。必要に応じて任意のパスを選択することも可能です。

注記

ASCET-RP V5.2 より、アイテムテンプレートは、デフォルト状態におい
ては XML フォーマット（*.itx）で保存されるようになりました。
必要に応じて既存の *.itp フォーマットを選択して使用することもで
きますが、ASCET-RP の将来のバージョンでは *.itpフォーマットはサ
ポートされなくなるため、できる限り XML フォーマットをお使いいた
だくことをお勧めします。

注記

ダイアログボックスが開いた時には、“Options”の“Template Path”で
設定されたデフォルトバスが表示されますが、このパスは任意に変更で
きます。
ただし、表示されるファイル名は絶対に変更しないでください。
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• File → Import ...  

ハードウェアコンフィギュレーションはファイルから読み込むことが可能
です。このためには、“Import Hardware Configuration”ダイアログボッ
クスでファイルタイプ（*.HWXまたは *.HWC）を選択し、さらにパスを
選択してファイルを指定します。

ただしここで読み込めるハードウェアコンフィギュレーションは、ASCET 
TIP Exp V4.0.0、またはそれ以降のバージョンでエクスポートされたものに
限ります。
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• File → Export ... 

ハードウェアコンフィギュレーションは、フォーマットと名前を指定して
ファイルにエクスポートすることができます。ファイルフォーマットは 3
種類のものから選択できます。

ASCET-RP 環境内でハードウェアコンフィギュレーションの交換を行うに
は、*.HWXまたは *.HWCフォーマットを使用します。もう 1 つの
*.csvフォーマット（値がカンマで区切られたフォーマット）は、ド
キュメント作成やスプレッドシートアプリケーションに利用するためのも
のです。

• File → Exit

HWC エディタを閉じます。修正後のハードウェアコンフィギュレーショ
ンを保存せずにエディタを閉じようとすると、警告メッセージが表示され
ます。

注記

デフォルト状態において、ハードウェアコンフィギュレーションは XML
フォーマット（*.hwx）で保存されます。
必要に応じて既存の *.hwc フォーマットを選択して使用することもで
きますが、ASCET-RP の将来のバージョンでは *.hwcフォーマットはサ
ポートされなくなるため、できる限り XML フォーマットをお使いいた
だくことをお勧めします。
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“bÇáí”メニュー

• Edit → Copy → Item(s) （<Ctrl> + <C>）

選択されたアイテムとそのサブツリー（存在する場合）のコピーを作成
し、HWC エディタの内部バッファに転送します。

このバッファの内容は、HWC エディタが開いている間のみ有効です。

• Edit → Copy → Item(s) For Export 

このメニューコマンドの機能は Copy → Item(s) と同様ですが、コピーさ
れた内容が外部ファイル（*.HSXまたは *.HWS）に書き込まれる点が異
なります。この機能は、コンフィギュレーションの一部を交換するような
場合に便利です。

• Edit → Copy → Item Data 

アイテムのデータを内部バッファにコピーします。サブツリー全体のコ
ピーは行われません。この機能を利用して、2 つのアイテム間で設定内容
を交換することができます。

• Edit → Paste → To Selected Item （<Ctrl> + <V>）

このメニューコマンドは、Copy → Item(s) でコピーされたアイテム（ま
たはサブツリー）を、現在選択されているアイテムの下の階層に貼り付け
ます。この機能を利用するには、以下の条件が満たされている必要があり
ます。

1.コピー元と貼り付け先のアイテムのタイプが互いに一致していなければ
なりません。ただし例外として、システムコントローラアイテム間で
サブツリーを交換することは可能です。

2.貼り付け先のアイテムが、アイテムまたはサブツリーを追加できる状態
でなければなりません（Add Hardware Item と同様の条件が適用さ
れます）。

• Edit → Paste → To Selected Item From Import 

機能は Paste → To Selected Item と同じですが、ファイルから読み込ま
れた内容が貼り付けられます。Edit → Paste → To Selected Item と同じ
制約条件があります。

注記

ASCET-RP V5.2 より、サブツリーは、デフォルト状態においては XML
フォーマット（*.hsx）で保存されるようになりました。
必要に応じて既存の *.hwsフォーマットを選択して使用することもで
きますが、ASCET-RP の将来のバージョンでは *.hwsフォーマットはサ
ポートされなくなるため、できる限り XML フォーマットをお使いいた
だくことをお勧めします。
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• Edit → Paste → Item Data 

現在選択されているアイテムに、Copy → Item Data でバッファに書き込
まれたデータを上書きします。

前の 2 つの Paste メニューコマンドとは異なり、互換性のある異なるタイ
プのアイテム間でデータを交換することもできます（互換性のあるアイテ
ムのリストは後で紹介します）。この機能を実行するには、データのコ
ピー先となるアイテムのタイプが、コピー元のアイテムと同じ、あるいは
互換性のあるものでなければなりません。つまり、両方のアイテムのデー
タ構造が同じで、“Groups”、“Signals”、“Mappings”の各タブに表示され
る設定データの行数が一致している必要があります。

• Edit → Add Item ... （<Ins>）

新しいハードウェアアイテムをハードウェアコンフィギュレーションに追
加します。

選択リストが表示され、現在の階層で選択可能なアイテムがリストアップ
されます。

ここで選択されたアイテムが、ハードウェアコンフィギュレーションに追
加されます。

• Edit → Delete Item （<Del>）

選択されたアイテムをハードウェアコンフィギュレーションから削除しま
す。

階層内の先頭の“Hardware Interface Manager”タイプのアイテムは、削
除することはできません。

注記

コンフィギュレーションによっては、必要なリソース（ポート、ス
ロット）がすでに使用されている場合や特別なシーケンスが必要な
場合など、アイテムを正しく選択しても、それが追加されずにエ
ラーメッセージが発行される場合があります。
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• Edit → Move Item Up （<Ctrl> + <U>）

ハードウェアコンフィギュレーションにおいて、ある階層レベル内のアイ
テムの並びを変更します。選択されたアイテムが 1 つ上に移動します。

• Edit → Move Item Down （<Ctrl> + <D>）

ハードウェアコンフィギュレーションのある階層レベル内のアイテムの並
びを変更します。選択されたアイテムが 1 つ下に移動します。

• Edit → Add Row Before 

このメニューコマンドは、“Device”タイプのアイテムのうち、シグナル
グループ数またはシグナル数を動的に変更できるものについてのみ有効で
す。

このメニューコマンドを使用できる条件は、以下のとおりです。

1.“dynamic”機能を持つ“Device”タイプのアイテム（例、CAN-IO デバ
イス）が選択されていること

2.“Groups”または“Signals”タブが選択されていること

3.“No”列（テーブルの第 1 列）の項目が選択されていること

このメニューコマンドによって、選択されているセルまたは領域の前（=
上）に行が追加されます。

注記

システムによってテーブルのサイズが制限される場合があり、その場
合、このメニューコマンドは無効になり、グレイアウト表示になりま
す。

注記

この機能を実行するとテーブルの構造が変更されてしまうため、bÇáí → 
Add * または bÇáí → Delete Row(s) コマンドで実行された変更内容を
Reset ボタンで取り消すことはできません。
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例：
“Signals”タブの選択されているセル領域（No.3 ～ 4）の前に、1 行追加
します。これによって、第 3 行（“Signal6”シグナル）が新規に作成され
ます。

図 7-1 HWC エディタで行の挿入位置の直後の領域を選択したところ

図 7-2 HWC エディタに新しい行（強調表示されている“Signal6”シグナルの
行）が挿入されたところ
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• Edit → Add Row After

Add Row Before と同様に、選択されたセルまたは領域の後ろに 1 行が追
加されます。

• Edit → Add Multiple Rows Before

Add Row Before と同様の機能ですが、ここでは一度に複数の行を追加す
ることができます。挿入する新しい行の数は、ダイアログボックスで指定
します。

• Edit → Add Multiple Rows After

Add Multiple Rows Before と同様に、選択されたセルまたは領域の後ろ
に複数の行が追加されます。

• Edit → Delete Row(s)

“No”列が強調表示されている行（1 行または複数行 ) を削除します。

“sáÉï”メニュー

• View → Expand All

“Items”リスト内のツリー構造をすべて展開表示します。

• View → Collapse All

“Items”リスト内のツリー構造をすべて省略表示します。

• View → Show All

表示できるすべてのオプション項目と列を表示します。

デフォルト状態においては、テーブル表示を見やすくするため、通常は使
用されない一部の項目または列は、表示されません。

注記

システムの都合上、テーブルにはシグナルグループまたはシグナルが最
低 1 つは残っている必要があるため、最後の行を削除しようとするとエ
ラーメッセージが表示されます。

注記

Accept ボタンでテーブルを確定してハードウェアコンフィギュレー
ションを保存すると、再度ロードされるテーブルは、保存された時と
まったく同じ状態で表示されます。つまり、新しく表示された項目／列
もそのまま表示されます。
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• View → Hide All Hidable

上の Show All とは反対に、非表示にできるすべてのオプション項目／列
を非表示にします。

• View → Hide Selected

現在選択されているオプション項目または列が非表示にできるものであれ
ば、それを非表示にします。

“bñíê~ë”メニュー

• Extra → Check Item 

選択されているアイテムに関するすべての設定内容を明示的にチェック
し、さらに現在の ASCET プロジェクトに対する妥当性もチェックします。
このチェックは、RTIO のコードが生成される前にも暗黙的に行なわれま
す。

このチェックが正常に終了すると、RTIO コード生成が可能となります。
ワーニングは許容されますが、その内容には充分な注意が必要です。

• Extra → Check Hardware Configuration 

ハードウェアコンフィギュレーション内の設定内容の整合性に関して可能
な限りのチェックを明示的に行いながら、現在の ASCET プロジェクトに
照らしたチェックも行います。このチェックは、RTIO コード生成が行わ
れる前にも、必ず暗黙的に行われます。

RTIO コード生成は、このチェックが正常に完了したときに限り可能です。
ワーニングが発行された場合もコードは生成されますが、ワーニングの内
容には充分な注意が必要です。

• Extras → Generate Code → For Current Experiment 

現在 ASCET プロジェクトエディタ上に開いている実験用の RTIO コード生
成を開始します。これは以下の手順で行われます。

1.HWC モジュール全体の内容が削除されます（その HWC モジュールに
より生成されたすべてのプロセスがタスクリストから削除されます）。

2.必要なすべてのエレメント（メッセージ、パラメータ、変数など）が
HWC モジュール内に生成されます。

3.HWC モジュールのヘッダおよびプロセス用の C コードが生成されます。

4.HWC モジュールのすべてのプロセスが、適切なタスクに分割されます。

• Extras → Generate Code → For Phys. and Quant. Experiment 

上の ... Generate Code → For Current Experimen と同じ方法で、物理実
験および量子化実験用のコードが HWC モジュール内に生成されます。

• Extras → Generate Code → For Phys., Quant. and Impl. Experiment 

これも ... Generate Code → For Current Experimen と同じ方法で、物理
実験、量子化実験、および実装実験用のコードが生成されます。
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• Extras → Item Code Generation On/Off

選択されているアイテム以下のすべてのアイテムについて、コード生成を
行なうかどうかを指定します。デフォルト状態においては全アイテムにつ
いてコード生成が行なわれるようになっているため、このメニューコマン
ドを最初に選択した時にはそのアイテムのコード生成は無効になり、アイ
テムツリー上に赤い X 印が付きます。

上のように表示されている状態でコード生成を行なうと、X 印の付いたア
イテムは無視されます。

ここでもう一度このメニューコマンドを選択すると、X 印が消えてコード
生成が有効になります。

• Extras → Clear HWC Module 

HWC モジュールの全内容（エレメントおよびプロセス）を削除します。

• Extras  →  Options ...
HWC エディタの環境設定を変更するためのダイアログボックスを開きま
す。

各タブとその設定項目について、以下に説明します。
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“Check”タブ

^ÑíÉê=?^ÅÅÉéí?：Éå~ÄäÉÇ=L=Çáë~ÄäÉÇ

Accept ボタンがクリックされたときに、設定内容の整合性チェックが自
動的に行なわれるようにするかどうかを指定します。パフォーマンス上の
理由から、チェックは現在選択されているタブ内のデータについてのみ行
われます。

^ÑíÉê=äç~ÇáåÖ：Éå~ÄäÉÇ=L=Çáë~ÄäÉÇ

新しいハードウェアコンフィギュレーションがロードされた時に、自動的
に暗黙的なチェックが行なわれるようにするかどうかを指定します。

_ÉÑçêÉ=ë~îáåÖ：Éå~ÄäÉÇ=L=Çáë~ÄäÉÇ

ハードウェアコンフィギュレーションが保存される前にそのハードウェア
コンフィギュレーションについてのチェックが自動的に行なわれるように
するかどうかを指定します。

“Code Generation”タブ

^ìíçã~íáÅ=êÉé~áêW=åç=L=óÉë

ハードウェアコンフィギュレーション内で見つかったエラーのうちのいく
つかを自動的に修復する機能を有効にするかどうかを指定します。ただし
現時点では、この修復機能が実際に働くケースは、ごくまれです。

içÖ=iÉîÉäW=ëáäÉåí=L=ÄêáÉÑ=L=îÉêÄçÇÉ

HWC コード生成においてログ生成が必要かどうか、また必要な場合はそ
の内容の詳細さを指定します。

“Files”タブ

aÉÑ~ìäí=ëíçê~ÖÉ=Ñçêã~íW=uji=EGKÜïñ=~åÇ=GKáíñF=L=iÉÖ~Åó=EGKÜïÅ=~åÇ=GKáíéF

ハードウェアコンフィギュレーションファイルとアイテムテンプレート
ファイルのデフォルトフォーマットを選択します。

s~äáÇ~íÉ=uji=ÑáäÉëW=óÉë=L=åç

*.hwxまたは *.itxファイルの読み込み時に XML コードの構文を
チェックするかどうかを指定します。このオプションがオン（Yes）に
なっていると、ファイルの読み込み時に構文エラーが見つかった場合、読
み込み処理が中断されます。

sÉêáÑó=uji=`ÜÉÅâëìãW=óÉë=L=åç

*.hwxまたは *.itxファイルの読み込み時にチェックサムの照合を行う
かどうかを指定します。この照合により、読み込まれたファイルが、
ASCET-RP で生成された後に内容が変更されていないかどうかがチェック
されます。このオプションがオン（Yes）になっていると、照合エラー発
生時にはワーニングメッセージが出力されます。
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“Mapping”タブ

jÉëë~ÖÉ=`êÉ~íáçå=q~êÖÉíW=mêçàÉÅí=L=jçÇìäÉ

自動マッピング実行時に生成される ASCET メッセージを、プロジェクト
に生成されるようにするか（Project：デフォルト）、またはインクルー
ドされるモジュール内に生成されるようにするかを指定します。

jçÇìäÉ=fåëí~åÅÉ=k~ãÉ

このオプションは、"Mesage Creation Target”が Module に設定されて
いる場合にのみ有効です。

ここにはメッセージを生成するモジュール名を入力します。指定されたモ
ジュールがプロジェクト内に含まれていない場合、以下のエラーメッセー
ジが出力されます。

Can't add sendReceiveMessage '<msg name>',
because module '<module name>' doesn't exist in
project, see option 'Module Instance Name' in
tab 'Automatic Mapping'!

“Miscellaneous”タブ

a~í~=ÇáÖáíë=~ÑíÉê=ÇÉÅáã~ä=éçáåíW=NKKKS

a~í~=ÇáÖáíë=ÄÉÑçêÉ=ÇÉÅáã~ä=éçáåíW=NKKKV

これら 2 つのオプションは、デバイスの“Mappings”タブの“Data”列
の値を表示する際に使用されるフォーマット（桁数）を定義します。

表記：<Data digits before...>.<Data digits after...>

“Templates”タブ

qÉãéä~íÉ=m~íÜ

アイテムテンプレートを格納するディレクトリを選択します。

rëÉ=fíÉã=qÉãéä~íÉëW=óÉë=L=åç

アイテムテンプレートを使用するかどうかを指定します。

アイテムテンプレートは、システムにより指定されるデフォルト値に個々
の設定を上書きするために使用されます。Template オプションがオンに
なっていると、Edit → Add Item でアイテムを追加するたびに、システム
により指定されたデフォルト値が、Edit → Save Item As Template でテ
ンプレートディレクトリに保存された値によって上書きされます。
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• Extras → Installed Items ...

このメニューコマンドは、その時点でシステムがサポートしているすべて
のアイテムおよびその階層的な従属関係をリストアップします。

7.2.5 ショートカットメニュー（“Items" リスト）

“Items“リスト内では以下のショートカットメニューを使用できます。

このショートカットメニューに含まれるメニューコマンドは、HWC エディタのメ
ニューバーのメインメニューにも含まれています。各コマンドの機能は前述のと
おりです。

7.3 コンフィギュレーションタブ

すべてのアイテムに関するオプション設定は、各コンフィギュレーションタブで
行います。“Globals”というタブはすべてのアイテムタイプについて表示され、

“Groups”、“Signals”、および“Mappings”タブは、“Device”タイプのアイテム
についてのみ表示されます。

注記

“*”の付いているアイテムには、API 関数を使用する下位レベルハード
ウェアドライバへのリンクが含まれています。
HWC エディタ 107



108
7.3.1 全般的な説明

テーブルセルの選択と編集

各タブ上のテーブル内の各セルを選択するには、そのセルをマウスでクリックし
ます。また、矢印キーを使用してテーブル内をナビゲートすることも可能です。

セルが選択された状態でマウスを 1 回クリックするか、または <F2> キーを押す
と、編集モードになります。入力された内容は <Enter> キーで確定され、<Esc>
キーでキャンセルされます。

また、一部の列（“Formula”列など）は、列内の複数のセルを一度に選択して編
集することができます。

連続した複数のセルを一度に編集するには、以下のいずれかの方法で行います。

• 選択範囲の端でマウスの左ボタン押し、そのまま選択範囲の反対側の端ま
でドラッグします。

または

• 選択範囲の端でマウスの左ボタンをクリックし、<Shift> キーを押しなが
ら反対側の端でもう一度マウスの左ボタンをクリックします。

上記のいずれかの操作後、<Shift> キーを押したまま最後に選択したセル
をクリックすると、編集モードになります。

• カーソルキーで選択範囲の端のセルを選択し、<Shift> キーを押したまま
上下の矢印キーで複数のセルを選択します。

<F2> キーを押すと編集モードになります。

連続しない複数のセルを一度に編集するには、以下の方法で行います。

• <Ctrlt>キーを押しながら選択したいセルをそれぞれマウスの左ボタンでク
リックします。

<Ctrlt> キーを押したまま最後のセルをダブルクリックするか、または
<F2> キーを押すと、編集モードになります。

編集を行って <Enter> キーを押すと、その内容は選択されたすべてのセルに代入
されます。<Esc> キーを押すと入力はキャンセルされます

編集

一部のオプション項目は常にロック（グレイアウト表示）されていて編集は行え
ず、ステータス値を表示するためだけに使用されます。それ以外の項目は、選択
されているアイテムやその階層内の他のアイテムのオプション設定に応じて、
ロックされる場合もあれば、入力を受け付ける場合もあります。
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編集後のページ切り替え

HWC エディタはテーブルの値が変更されたかどうかを認識しているため、
Accept ボタンで変更内容を有効にする前に別のアイテムまたはタブを選択しよう
とすると、以下のメッセージが表示されます。

この場合は、OK で変更を保存するか、または Cancel で選択操作を取り消しま
す。

テーブルのスクロール

テーブルが左右に大きすぎてタブ内に表示しきれない場合、以下のようなスク
ロールバーが表示されます。

図 7-3 コンフィギュレーションタブ内のスクロール可能領域
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110
スクロールバーを左右に動かすと、テーブル全体ではなく所定の部分（図 7-3 の
四角で囲んだ部分）だけが動きます。

列幅の変更

列の縁でマウスの左ボタンをクリックして押し下げたままで左右に動かして、列
幅を調整することができます。Accept ボタンで確定すると、新たに指定された列
幅がハードウェアコンフィギュレーションとともに保存されます。

ハードウェアコンフィギュレーションを再びロードすると、保存された時のレイ
アウトで表示されます。

ヘルプテキスト

タブの一番下にあるテキストフィールドに、現在選択されているオプション項目
についてのヘルプテキストが表示されます。

7.3.2 “Globals”タブ内の共通オプション

本項では、“Globals”タブに表示される共通オプションについて説明します。そ
の他の各アイテム固有のオプションについては、第 10 章「HWC アイテム」の各
項で説明します。

k~ãÉ

アイテムの名前を任意に指定することができます。この名前は、ANSI-C 互換の名
前で、ハードウェアツリー内でユニークなものでなければなりません。

このオプションは、すべてのアイテムの“Globals”タブに含まれます。

fåáí=q~ëâ

ハードウェアドライバの初期設定を行うタスクを選択します。通常は Init タスク
を指定します。Software タスクを指定することも可能ですが、これは例外的な
ケースであるため、ワーニングが表示されます（69 ページの「準備」という章を
参照してください）。

注記

テーブルの左側のスクロールされない部分に表示される列が多すぎる場合、右
側のスクロール可能な部分がタブ内に入りきらず、スクロールバーを動かして
も実際には画面がスクロールされない場合があります。この問題を解決するに
は、HWC エディタの表示ウィンドウを広げるか、スクロールされない部分に
必要最小限の列だけを表示するようにしてください。
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このオプションは、アイテムが低水準ドライバにリンクしている場合にのみ表示
されます。

以下のようなタスクシーケンスが守られるようにしてください。

1. Init Task（初期化タスク）

2. Start Task（開始タスク）

3. Stop Task（停止タスク）

4. Exit Task（終了タスク）

pí~êí=q~ëâ

ドライバを起動するための独立したタスクを指定することができますが、その必
要がない場合には、通常は“Init Task”と同じタスクを指定します。

この“Start Task”は、一部のハードウェアドライバでしかサポートされていませ
ん。

píçé=q~ëâ

ドライバを停止するための独立したタスクを指定することができますが、その必
要がない場合には、通常は“Exit Task”と同じタスクを指定します。

この“Stop Task”は、一部のハードウェアドライバでしかサポートされていませ
ん。

注記

各タスク処理が実行される際に、この初期化タスクを実行してからでないと同
じドライバにリンクしている別のタスク（開始タスク、コンフィギュレーショ
ンタスクなど）が実行されないようにする必要があり、また“Init”コールは必
ず“Exit”コールの後で行なわれなければなりません。それらの条件が守られな
いと、実験中にランタイムエラーが発生し、ドライバがロックされてしまいま
す（ドライバロック）。

注記

タスクの順序を必ず守ってください（110 ページの「Init Task」を参照してくだ
さい）。

注記

タスクの順序を必ず守ってください（110 ページの「Init Task」を参照してくだ
さい）。
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bñáí=q~ëâ

ハードウェアドライバの初期設定を解除するタスクを選択します。これは通常は
実際の Exit タスク（非アクティブな Init トリガタスク）を指定します。Software
タスクでもかまいませんが、これは例外的なケースなので、ワーニングが表示さ
れます（69 ページの「準備」という章を参照してください）。

この“Exit Task”は、アイテムが低水準ドライバにリンクしている場合にのみ表示
されます。

`çåÑáÖ=q~ëâ

実行時に設定値の変更を行う“Config Task”の選択は、他の ETAS 製品（LabCar）
で RTIO を使用する際にのみ行います。ASCET-RP として使用する際は意味を持ち
ません。

fon=e~åÇäÉê=q~ëâ

ここでは必ず Software タスクを選択してください。このタスクは、ASCET プロ
ジェクトエディタ上のタスクリスト内に“Software”タスクとして定義し、

“Max. number of Activations”フィールドの値は 2 以上（最大は 50）に設定して
ください。

割り込みモードで稼働するドライバの場合、この“IRQ Handler Task”が必要で
す。

aÉîáÅÉ=j~å~ÖÉê=q~ëâ

このタスクは、実際に交換されるデータの内容（例、エラー処理、バスモニタリ
ング）とは無関係に、確実にデータをドライバに送るためのもので、一部のドラ
イバにのみ必要です。

通常は、ここには Alram タスクを指定します。サイクルタイムとして設定できる
値の範囲はデバイスによって異なるため、詳細な情報は、タブ上に表示されるヘ
ルプテキストや本書内の各ハードウェアアイテムについての記述事項を参照して
ください。

注記

タスクの順序を必ず守ってください（110 ページの「Init Task」を参照してくだ
さい）。

注記

このタスクは、アイテムとそれに対応するハードウェアドライバごとに個別の
ものを指定する必要があり、ここで指定されたタスクを他のアイテムやユー
ザープロセスで共有することはできません。また同じタイプのアイテム（たと
えば 2 枚の ES1222）であっても、同じタスクを共有することはできません。
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sÉêëáçå

デバイスのバージョンをチェックして低水準ハードウェアドライバと比較を行う
ためのオプションです。

“Version”はデフォルトでは非表示になっています。

cçêã~í

アイテムのフォーマットを表示し、低水準ハードウェアドライバとの互換性
チェックを行うためのオプションです。

“Format”はデフォルトでは非表示になっています。

7.3.3 “Groups”タブ内の共通オプション

本項では、“Groups”タブに表示される共通オプションについて説明します。各
アイテム固有のオプションについては、第 10 章「HWC アイテム」の各項で説明
します。

kç

エラーメッセージなどの行番号として使用されます。

aÉîáÅÉ

アイテム名が表示されます。

“Device”はデフォルトでは非表示になっています。

dêçìé

シグナルグループの名前が表示されます。通常この名前は編集可能ですが、必ず
ANSI-C に準拠した名前を使用してください。

aáêÉÅíáçå

シグナルグループの転送方向が表示されます。この設定がロックされている場合、
つまり表示されたデータがグレイアウトされていて編集できない場合は、転送方
向はハードウェアにより規定されるため、ユーザーが変更することはできません

（例、A/D ボードは常に“receive”で、D/A ボードは常に“send”になります）。
一部のデバイス（例、CAN-IO）についてのみ、ユーザーが転送方向を選択するこ
とができます。

注記

1 つのデバイス内の各シグナルグループは、それぞれユニークな名前でなけれ
ばなりません。
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q~ëâ

データ転送を行うタスクを指定します。また、複数のタスクを指定して、データ
転送をその各タスクで行うようにすることもできます。一般的には Alarm タスク
または Software タスクが使用可能です。一部のデバイスはここでタスクを指定す
ることはできず、データ転送は割り込み制御などの別の方法で行われます。

7.3.4 “Signals”タブ内の共通オプション

本項では、“Signals”タブに表示される共通オプションについて説明します。各ア
イテム固有のオプションについては、第 10 章「HWC アイテム」の各項で説明し
ます。

kç

エラーメッセージなどの行番号として使用されます。

aÉîáÅÉ

アイテム名が表示されます。

“Device”はデフォルトでは非表示になっています。

dêçìé

シグナルグループの名前が表示されます。“CAN-IO”など一部のデバイスについ
ては、シグナルグループへのシグナルの割り当てを自由に定義することができま
す。

“Group”はデフォルトでは非表示になっています。

aáêÉÅíáçå

シグナルグループの各シグナルの転送方向が表示されます。

“Direction”はデフォルトでは非表示になっています。

注記

同じシグナルグループに 2 つ以上のタスクが割り当てられると、付随する RTIO
プロセスが複数のタスクに割り当てられることになり、実行時にエラーが発生
します。
HWC エディタによって定義される RTIO プロセスはリエントラントな構造に
なっていないため、複数の RTIO プロセスが同時に実行されることのないように
OS コンフィギュレーションを設定する必要があります。
1 つのシグナルグループに複数のタスクを割り当てる場合、この条件を実現す
る最も簡単な方法は、それらのタスクをすべて協調タスクにする、という方法
です。ただしどうしてもプリエンプティブタスクが必要な場合は、ユーザーの
責任において適切な OS コンフィギュレーションを設定してエラーを回避して
ください。
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q~ëâ

シグナルグループの転送を行うタスクが表示されます。

“Task”はデフォルトでは非表示になっています。

páÖå~ä

シグナル名を指定できます。一部のデバイスについては、シグナルの仕様が固定
されているため、ユーザーがこれを変更することはできません。シグナル名を入
力する場合は、ANSI-C に準拠した名前を使用してください。

cçêãìä~

必要に応じてシグナル値に線形変換を割り当てることができます。デフォルトで
は 1：1 変換（f(phys) := phys という変換式）が選択されています。一部の
デバイスについては、式が固定されているため、この列の入力はロックされてい
ます。たとえば、ETK-BYPASS デバイスなどがその例で、シグナルは ASAM-
MCD-2MC ディスクリプションから生成され、変換式も決められたものが使用さ
れます。

変換式は、シグナル調整処理において使用されます。この処理には、変換、量子
化、およびマッピングの 3 つのレイヤが含まれ、RTIO ドライバから受け取ったシ
グナルグループが、このシグナル調整処理に直接送られます。

変換レイヤでは、シグナルグループが個々の I/O シグナルに分割され、各シグナ
ルは、“Signals" タブのこのオプションで設定された変換式により、ASCET メッ
セージに対応する物理値に変換されます。

量子化実験または実装実験においては、量子化レイヤによって、これらの物理シ
グナルが ASCET メッセージに対応して量子化されます。

そして最後のマッピングレイヤで、量子化されたシグナルが ASCET メッセージに
コピーされます。

7.3.5 “Mappings”タブ内の共通オプション

本項では、“Mappings”タブに表示される共通オプションについて説明します。
各アイテム固有のオプションについては、第 10 章「HWC アイテム」の各項で説
明します。

kç

エラーメッセージなどの行番号として使用されます。

aÉîáÅÉ

アイテム名が表示されます。

注記

1 つのシグナルグループに割り当てられるシグナルの名前は互いにユニークで
なければなリません。
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“Device”はデフォルトでは非表示になっています。

dêçìé

シグナルグループの名前が表示されます。

“Group”はデフォルトでは非表示になっています。

aáêÉÅíáçå

シグナルグループの各シグナルの転送方向が表示されます。

“Direction”はデフォルトでは非表示になっています。

q~ëâ

シグナルグループの転送を行うタスクが表示されます。

“Task”はデフォルトでは非表示になっています。

páÖå~ä

シグナル名が表示されます。

^p`bq=jÉëë~ÖÉ

必要に応じて、ここでシグナルと ASCET メッセージの割り当て（マッピング）を
行います。ダイアログボックスから、現在のシグナルに割り当てることのできる
プロジェクト内のすべての“Exported”メッセージを選択することができます。
ただし受信シグナルの場合はエクスポートされる受信メッセージのみが選択でき、
また送信シグナルの場合はエクスポートされる送信メッセージのみが選択できま
す。
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“Message selection”ダイアログボックスでは、文字列をキー入力して、目的の
メッセージを素早く探すことができます。入力した検索文字列は、ダイアログ
ボックスの一番下に表示されます。

図 7-4 “Message selection”ダイアログボックス

選択ウィンドウを開くと、以下の処理が行われます（図 7-4 を参照してくださ
い）。

• “ASCET Message”列にメッセージがある場合には、そのメッセージが検
索キーとして使用されます。

• “ASCET Message”列にメッセージがない場合には、シグナル名が検索
キーとして使用されます。

“Message selection”ダイアログボックスで <clear message>を選択すると、
“ASCET Message”列に入力されているメッセージを削除することができます。

新しいメッセージを生成するには、<new message>を選択します。すると以下
のダイアログボックスが開きます。
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このダイアログボックスに新しいメッセージ名を入力すると、その名前のメッ
セージがグローバルな送受信メッセージとしてプロジェクトに登録されます。

a~í~

送信メッセージのデフォルト値を入力します。RTIO コードジェネレータは、
ASCET パラメータにこの値を書き込みます。

bñéä~å~íáçå

シグナルについての情報が表示されます。このカラムは一部のアイテムでのみ表
示ます。
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U コード生成

RTIO のコード生成は、まず始めにハードウェアコンフィギュレーションの暗黙的
なチェックが行われ、それがエラーなしで完了した場合にのみ実行されます

（ワーニングのみが発生した場合もコード生成は行われますが、ワーニングの内容
に充分注意してください）。

コード生成の処理手順としては、最初に HWC モジュールの全内容（エレメント、
コード、およびプロセス）が削除され、その後、新たなコードが生成されます。

8.1 HWC モジュール

本項では、生成されるコードについての概要を簡単に紹介します。ハードウェア
やリアルタイム動作についての知識のある方であれば、RTIO リンクの動作原理に
ついて要点を押さえることができ、エラーを見つけ出す際にも役立ちます。

8.1.1 エレメント

下図は、プロジェクトと HWC モジュールの間のデータフローをおおまかに示し
たものです。

注記

生成されたコードをマニュアル操作で修正しないでください。マニュアル操作
で修正してしまうと正しい動作が保証されなくなります。最悪の場合、ハード
ウェアが損傷してしまう可能性もあります。

マッピングされた
入力信号

ASCETモデル HWCモジュール

HW
ドライバ用
I/Oバッファ

メッセージ 変数 変換式

変数

変数 変換式

パラメータ 変換式

マッピングされていない
入力信号

x_c0, x_c1x_outyy

x = <アイテム名>,[<グループ名>],[<信号名>]
y = 通常のASCETメッセージ名

(exported)

(exported) (imported)

マッピングされた
出力信号

マッピングされていない
出力信号

メッセージ メッセージ

(imported)

変換式

メッセージ
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メッセージ

HWC エディタの“ASCET Message”列（“Mappings”タブ内）の各項目につい
て、同じ名前のメッセージエレメントが“インポートメッセージ”（前図には“y”
と示されています）として作成されます。

fLl インターフェース

ハードウェアドライバと通信を行うすべてのシグナル（x_outと表示されます）
は、HWC モジュール内で I/O インターフェースを通じてルーティングされます。
そのシグナルが送信シグナルと受信シグナルのどちらなのか、あるいはそのシグ
ナルがメッセージにマッピングされているかどうかに応じて、x_outという名前
の変数またはパラメータが生成されます。

式

シグナルについて線形変換式が指定されている場合には、係数 c0および c1用の
パラメータが生成されます。

コンフィギュレーションパラメータ

コンフィギュレーション用の値については、それぞれ適合パラメータが生成され
ます。パラメータの名前は“Item”（および“Group”）プレフィックスとパラ
メータ識別子で構成されます。パラメータ識別子は各アイテムごとに固有です。

外部コード

割り込みベクタテーブル用のコードおよび割り込みベクタ用のコードは、HWC モ
ジュールの外部コードとして生成されます。

ヘッダコード

低水準ドライバとデータ交換を行うためのデータバッファおよびドライバを初期
化するためのデータ構造体は、ヘッダコード内に定義されます。

プロセス

RTIO フレームワークにより生成されるプロセスは、ドライバ制御プロセスとデー
タ交換プロセスに分類されます。

ドライバ制御用には、以下のプロセスがあります。

• <item_name>_InitCode_<task_name>_HWCF

• <item_name>_StartCode_<task_name>_HWCF

• <item_name>_ConfigCode_<task_name>_HWCF

• <item_name>_DeviceManagerCode_<task_name>_HWCF

• <item_name>_AcknowledgeCode_<task_name>_HWCF

• <item_name>_AnalyzeCode_<task_name>_HWCF

• <item_name>_StopCode_<task_name>_HWCL
コード生成



• <item_name>_ExitCode_<task_name>_HWCL

ハードウェアドライバとのデータ交換用には、各シグナルグループごとに以下の
ようなプロセスが生成されます。

• <item_name>,<signal_group_name>_<task_name>_HWCF
（受信プロセス）

• <item_name>,<signal_group_name>_<task_name>_HWCL
（送信プロセス）

HWCFは、<task_name> で指定されるタスク内の既存プロセスの前にプロセスが
挿入されることを意味します。HWCLは、既存プロセスの後にプロセスが挿入さ
れることを意味します。

8.2 プロセスの実行順序

RTIO フレームワークでは、ハードウェア通信の一貫性を保証するため、プロセス
は自動的に適切な順でタスクリストに割り当てられます。

RTIO フレームワークにより生成されるすべてのプロセスが 1 つのタスクに割り当
てられた場合、プロセスシーケンスは以下のようになります。

• Init

• Analyze

• Acknowledge

• DeviceManager

• Start

• Config

• 最初の受信シグナルグループ

• ...

• 最後の受信シグナルグループ

• ユーザープロセス

• 最初の送信シグナルグループ

• ...

• 最後の送信シグナルグループ

• *Stop

• *Exit

注記

この割り当ては、定義されたスキームに従って RTIO コードが生成されるたび
に実行されます。この“HWC”プロセスの割り当ては絶対に変更しないでくだ
さい。変更すると予期しない結果になり、ハードウェアが損傷する可能性もあ
ります。
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これらのプロセスが、各ハードウェアアイテムについて、階層構造の定義に従っ
て上から順に実行されます。つまり、システムコントローラである ES113x が最
初に初期化されてから、下位のハードウェアドライバの初期化が行われます。

ただし上記の“*”が付いているプロセス（“Stop”および“Exit”）は、上記の逆
の順序で実行されます。つまり、まず下位のハードウェアドライバの終了処理が
行われてから、最後にシステムコントローラの終了処理が行われます。
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V bqhバイパス（bpNOMMLbpNOMNLbpNOPNLbpNOPO）

本章では、ETK バイパスの機能とそれに関連した RTIO パッケージの使用方法につ
いて説明します。ここでの記述は ASCET に関する基本的な知識のあるユーザーを
対象としているため、ASCET の詳しい使用方法などについては触れられていませ
ん。

9.1 ETK バイパスとは？

ETK バイパスとは、ECU の全ファンクションのうちの一部のみをシミュレーショ
ンボード、つまり ETAS の実験ハードウェアシステム内に組み込まれた PowerPC
シミュレーションプロセッサによって実行させることです。ECU のデータが実験
システムに転送され、このデータを使用して、実験ターゲット上にバイパスされ
たファンクションが実行されます。この部分のデータは容易に変更したり検証し
たりすることができます。そしてその処理の結果として出力されたデータが ECU
に戻され、その後の処理が ECU によって続行されます。

ECU ソフトウェア内でバイパスされる部分に「バイパスフック」と呼ばれるソフ
トウェアが挿入され、その部分が実験ターゲットにより実行されます。

ETK バイパスは、この ECU と実験ターゲットとの接続に ETK（エミュレータテス
トプローブ）を使用するもので、ECU と ETK 間はデュアルポート RAM 経由で
データ交換が行なわれます。
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9.2 ETK バイパスのハードウェア構成

ES1000.2 システムを使用して ETK バイパス環境を構築するたのハードウェア構
成例を下図に示します。

ETK バイパス実験においてバイパス実行されるファンクションは、ASCET で記述
します。それを元に、実験システム（ES1000）内の PPC モジュール（PowerPC
シミュレーションプロセッサを搭載したシミュレーションボード）上で実行可能
なコードが生成され、このコードがホスト PC から実験システムにダウンロード
されます。実験システムは、ETK インターフェースボード（ES1200、ES1201、
または ES1231）経由で、ECU に取り付けられた ETK に接続します。

必要に応じて、シミュレーションプロセッサと ECU との間のソフトウェアイン
ターフェースの設定に必要なインターフェースパラメータを、ECU プログラム内
に定義することができます。また、新しいソフトウェアバージョンを ECU にダウ
ンロードしたり、バイパスを稼働させながら ECU に関する測定・適合作業を実行
することも可能です。

ETK

エンジン

コントローラボード

ES1120
ETKインターフェース

ES1231

ASCET
INCA

ES1000.2

6...34V

ON

AUTO

UA Temp

ES1120

PC

ES1130

PC

ES1231.1
A

A

ETKを装備した 
ECU

イーサネット

シミュレーションボード

ES1130
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9.3 ETK バイパス用 ASCET プロジェクト

ETK バイバスを使用する ASCET RTIO プロジェクト（つまり RTIO が組み込まれた
ASCET プロジェクト）には、以下の点についての注意が必要です。

• ASCET RTIO プロジェクトに、必ず HWCという名前の HWC モジュール
（5.2.1 項を参照してください）が含まれていること。

• OS エディタのタスクリストに、必ず Init（タイプ： Init、アプリケーショ
ンモード： active）および Exit（タイプ： Init、アプリケーションモード： 
inactive）というタスクが含まれていること。RTIO パッケージが使用する
これらのタスクの標準的な名前は“Init”および“Exit”です。他のタスク
名を使用する場合は、HWC エディタで各コンポーネントを定義する際に
タスクをマニュアル操作で割り当てる必要があります。

• OS エディタのタスクリストに、2 つの特殊なタスク（送信タスクおよび受
信タスク）が定義されていること。これらのタスクは、シグナルグループ
に割り当てられたバイパスデータをドライバへ送信、またはドライバから
受信します。いずれのタスクも、タスクのタイプは Software です。この
タスクの割り当ては、HWC エディタ上でマニュアル操作によって行いま
す。

• RTIO 通信で使用されるすべてのメッセージ（受信メッセージを含みます）
が、“Exported”として宣言されている必要があります。

• RTIO 通信用のグローバルメッセージが定義されていること。

これらの条件がすべて設定されると、“OS”タブは以下のようになります。
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タスク設定の詳細は、以下のとおりです。

各属性についての詳細は、『ASCET ユーザーズガイド』を参照してください。

9.4 ETK バイパスのしくみ

バイパスプロジェクトを構築するためには、ECU 側に「バイパスフック」（バイパ
スファンクションを実行するために修正されたソフトウェア）が組み込まれてい
る必要がありです。このバイパスフックによって、ECU 上で実行されるファンク
ションとシミュレーションボード上で実行されるファンクションの切り替えが行
われます。バイパスフック内には、バイパス入力データをシミュレーションボー
ドに転送し、その出力結果を ECU に戻すために必要な情報が含まれています。

通常、バイパスがイネーブルになっている間、ECU 内のバイパスファンクション
も実行されますが、この処理結果は実際には使用されず、シミュレーションボー
ドにおける処理結果、つまり「バイパス出力データ」が有効となります。

「バイパス入力データ」とは ES1000 が ECU から読みとるデータのことで、この
データがバイパスされたファンクションによって処理されます。そしてその処理
結果が、バイパス出力データとして ECU プログラムにフィードバックされます。

ETK のメモリは、エミュレーションメモリ領域と出力領域とに分かれています。
ECU プログラムはエミュレーション領域にアロケートされ、この領域が ECU の
ROM 領域に対応します。ECU は出力領域の内容を直接読みとることができない
ので、バイパス出力データはエミュレーション領域に格納されます。

出力領域は、バイパス入力データを ECU からシミュレーションボードに転送する
ためにのみ使用されます。この領域には、ECU の外部 RAM の内容がコピーされ、
ETK や ECU の種類によっては、ECU の内部 RAM の内容もコピーされる場合があ
ります。

タスク名 アプリケーション
モード

トリガ
モード

優先
度

グループ Max. No. 
of Act.

周期

Init active Init - - - -

Exit inactive Init - - - -

t_sync active Software 16 preemptive 1 -

n_sync active Software 17 preemptive 1 -
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次の図は、ETK バイパスシステムのデータフローを示したものです。

データはバイパスプロジェクト内をサイクリックに流れます。つまり、ECU から
のバイパス入力データが ES1000 システム内で処理され、処理結果であるバイパ
ス出力データが ECU に書き戻されて、それ以降の処理が行われます。バイパス入
力データの読み取りは ECU の同期グリッド（時間同期またはは角度同期）によっ
て行われますが、ECU へのデータの書き戻しは非同期に行われます。

9.5 ECU と実験システム間のデータ交換

ETAS 実験システムと ECU の間のデータ転送には、DISTAB データ交換メソッドが
使用されます。

ここ数年は、ECU と ETK とのデータ交換には主に DISTAB 12 メソッドが使用され
てきました。DISTAB 12 は最大 2 バイト長の測定データをサポートします。

しかし、4 バイト整数や、4 または 8 バイトの実数、または浮動小数点の変数が
使用されている場合は、DISTAB 13 を使用する必要があります。DISTAB 13 では、
ECU からの 1、2、4、8 バイト長の測定データの取り込みを、フォーマット（符
号あり／符号なし、整数／浮動小数点）を問わず行うことができます。
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ETK バイパスプロジェクトで DISTAB を扱うためには、さまざまなパラメータを、
ECU の現在のソフトウェアバージョンに対応した ASAM-MCD-2MC ディスクリ
プションファイルに格納して ASCET に渡す必要があります。DISTAB は、ASAM-
MCD-2MC ファイル内の TP_BLOB の DISTAB_CFGセクションに、以下のよう
に定義します。

/begin DISTAB_CFG

0xC  /* type of display table:  */
 /* 0xC =DISTAB12, 0xD =DISTAB13  */

0x1  /* Data type of display table:  */
 /* 1=byte 2=word (ECU Data Mode)  */
 /* additional code table for  */
 /* distab13 depending on bus  */
 /* width/bus access (see distab13  */
 /* spec. for more information)  */

MSB_LAST  /* Byte Order: MSB_FIRST/MSB_LAST  */

0x383000  /* Trigger Segment Address  */

0x0  /* Trigger Configuration  */

TRG_MOD 0xB7  /* Dyn. length for TRG_MOD  */
 /* (special code)  */

/end DISTAB_CFG 

ASAM-MCD-2MC は、ECU プロジェクト（適合パラメータ、測定変数、変換メ
ソッド、アドレスなど）を記述するための自動車業界標準の規格です。ASAM-
MCD-2MC ファイルは、ソフトウェア開発プロセスの出力として、個々のプログ
ラムバージョンごとに作成されます。必要な設定はすべてカットオフの中に含ま
れるので、ETK プロセスを行うにあたって DISTAB メソッドについての詳しい知識
は必要はありませんが、ETK メモリを診断する際に役立つように、DISTAB メソッ
ドの動作原理をここで簡単にご紹介します。

ECU とシミュレーションボードの間のデータ転送のための通信メカニズムは「バ
イパスチャンネル」と呼ばれます。

ES1201 または ES1231 を使用する場合、ECU 上には 2 つのバイパスチャンネル
が設けられ、そのうちの 1 つ（チャンネル A、高優先度）は ECU の角度同期グ
リッドで実行され、もう 1 つ（チャンネル B、低優先度）は時間同期グリッドで
実行されます。各バイパスチャンネルごとに、複数のデータバッファのアドレス
情報とサイズによって定義されています。ES1232 の場合は、32 のチャンネル

（16 のバイパスチャンネルと 16 の測定チャンネル）があり、各チャンネルの名前
と優先度は自動的に決められます（201 ページの 10.8.7 項を参照してください）

注記

通常、ASAM-MCD-2MC ファイルにはコメントは含まれません。上記のリスト
は、注釈のためにコメントを付加したものです。
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バイパス通信（^ji=sNKN）

ここでは、ES1231 のバイパスチャンネル A を例に、バイパス通信の内容を詳し
く説明します。処理内容はどのチャンネルも同じです。下の表は、ASAM-MCD-
2MC ファイル（*.a2l、AMLV1.1）で使用される ETK バイパス用パラメータの
一覧です。

表 9-1 バイパス通信用パラメータ（AML V1.1）

チャンネル A 用のパラメータは、ASAM-MCD-2MC ファイルの IF_DATA ETK セ
クション内の QP_BLOBで定義されます。

/begin IF_DATA ETK 

/begin SOURCE  "BYPASS A" 

 0 

 0 

 /begin

 QP_BLOB

注記

以下のパラメータ名は、ASAM-MCD-2MC 規格で定義されたものではなく、本
項のサンプルリストに補助的なコメントとして付け加えられているものです。

パラメータ 説明

BYPASS_S バイパス入力データのポインタリストの先頭アドレス（バイパス ch A）

BYPASS_X バイパス入力データのポインタリストの先頭アドレス（バイパス ch B）

CHNL_S バイパス入力データのデータバッファの先頭アドレス（バイパス ch A）

CHNL_X バイパス入力データのデータバッファの先頭アドレス（バイパス ch B）

CHNL_T バイパス出力データのデータバッファの先頭アドレス（バイパス ch A）

CHNL_Y バイパス出力データのデータバッファの先頭アドレス（バイパス ch B）

TRGID_S バイパス入力データのトリガ ID アドレス （バイパス ch A）

TRGID_X バイパス入力データのトリガ ID アドレス （バイパス ch B）

BPMAX_S バイパス入力データのデータバッファサイズ （バイパス ch A）

BPMAX_X バイパス入力データのデータバッファサイズ （バイパス ch B）

BPMAX_T バイパス出力データのデータバッファサイズ（バイパス ch A）

BPMAX_Y バイパス出力データのデータバッファサイズ （バイパス ch B）

TRGSEG_A バイパス ch A のトリガアドレス

TRGSEG_B バイパス ch B のトリガアドレス
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4 /* Acquisition raster; */
/* 1=A (typ. angle synchronous) */
/* 2=B (typ. time synch. 10ms) */
/* 3=C (typ. time synch. 100ms) */
/* 4=S/T angle synch. (bypass only) */
/* 5=X/Y time synch. (bypass only) */

 100 /* BPMAX_S */

 0x81025E /* BYPASS_S */

 0x3801E0 /* CHNL_S */

 0x38302E /* TRGID_S */

 2 /* trigger repetition rate */
/*(worst case) */

 100 /* BPMAX_T */

 0x8103F2 /* CHNL_T */

 /end QP_BLOB

/end SOURCE 

...

/end IF_DATA 
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次の図は、DISTAB データ交換メソッドによるバイパスサイクルのプロセスを、バ
イパスチャンネル A を例にして図示したものです。図中の番号はバイパスサイク
ルの各ステップを表します。

図 9-1 バイパスサイクルの処理の流れ（DISTAB メソッド）
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1. シミュレーションボード上でバイパス実験が開始されると、バイパス入力
データ用のポインタリストにポインタが書き込まれます。

このステップにおいて、バイパス出力データ用のバイパスオフセット
（133 ページのステップ 11. を参照してください）も転送されます。

2. ポインタリストのデータがすべて設定されると、アクティブフラグが 1 に
セットされ、これによって ECU とシミュレーションボードとの通信が開
始されます。ここまでの処理（ステップ 1 および 2）は、バイパス実験開
始時に一度だけ実行されます。

3. ECU は、常にポインタリストのアクティブフラグバイトを調べます。そし
てフラグが 1 にセットされると、バイパスがアクティブになり、データ転
送が開始されます。

4. ECU が、バイパス入力データを適切なデータバッファ（CHNL_Sで示され

ます）に書き込みます。

DISTAB12 DISTAB13

シミュレーションボードに送信され
る各バイトごとに、対応する ECU
メモリのバイトアドレスを指し示す
ポインタが使用されます。DISTAB 
12 メソッドではデータは常にバイ
ト単位で転送されるので、1 ワード
を送信するためにはポインタが 2 つ
必要です。ポインタリストがすべて
設定されると、ポインタリストの長
さがリストの先頭バイトに書き込ま
れます。

ポインタリストの 4 ～ 7 番目のバイ
トには、8 バイト、4 バイト、2 バ
イト、および 1 バイトシグナルの数
が順に格納され、それ以降のバイト
に、8 バイトシグナルから 1 バイト
シグナルの順でシグナルアドレスが
格納されます。各アドレスは 4 バイ
トで構成され、アドレスのバイト
オーダーは Byte Orderというパ
ラメータで決定されます（128 ペー
ジのリストを参照してください） 。

DISTAB12 DISTAB13

アクティブフラグ： ポインタリスト
の 2 番目のバイトの最後のビット

アクティブフラグ： ポインタリスト
の先頭バイト（バイト 0）の先頭
ビット（ビット 0）

DISTAB12 DISTAB13

データは、ポインタリスト中の各ポ
インタが指し示すデータバッファ
に、1 バイトずつ書き込まれます。
リストの先頭バイトで示されるバイ
ト数の送信が終わると、転送が終了
します。

データは、シグナル単位で、ポイン
タリストに示される順、つまり 8 バ
イトシグナルの 1 番目のシグナルか
ら順に書き込まれます。Byte 
Orderというパラメータによって、
どのバイトから書き込まれるかが決
まります。
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5. ECU は現在のバイパスチャンネルの ID を TRGID_Sで示されるアドレスに
書き込みます。全部で 5 つあるチャンネルのうちチャンネル ID として使
用できるアドレスは 2 つだけで、残りの 3 つのチャンネルは適合に使用さ
れます。

6. ECU により、TRGSEG_A で示されるトリガアドレスにランダムな値がロー
ドされます。

7. このトリガアドレスへの書き込みによって、シミュレーションプロセッサ
への割り込みが発生します。

8. シミュレーションプロセッサはチャンネル ID を TRGID_Sで示されるアド
レスから読みとって、どのチャンネルが初期化されたかを判断し、対応す
るデータバッファの内容を読み取ります。そして ASAM-MCD-2MC ファ
イル内の変換式などの情報をもとに、ECU から得られたデータを物理モデ
ル用の物理値に変換し、ASCET モデルで処理できるようにします。

9. シミュレーションプロセッサは、バイパスされたファンクションをバイパ
ス入力データに基づいて実行します。実行結果はバイパス出力データとし
て、適切なデータバッファに書き戻されます。データバッファは各バイパ
スチャンネル用に 2 つあり、それらが交互に使用されます。まず、シミュ
レーションプロセッサが内部的にカウンタをインクリメントし、それが後
に CHNL_Tで示されるアドレスに書き込まれます。そしてこのカウンタは
上記 7 の割り込みが発生するとインクリメントされ、カウンタの値に応じ
て、2 つのデータバッファのどちらが書き込み対象になるかが決まります。
つまり、カウンタの値が奇数なら 1 番目のデータバッファが使われ、偶数
なら 2 番目のデータバッファが使われます。

10. データバッファへの書き込みが終わると、内部カウンタが CHNL_Tで示さ
れるアドレスに書き込まれます。

11. ECU がカウンタ値を読み取り、その値によってどちらのデータバッファを
読み取るかが決まります。値が奇数なら 1 番目のデータバッファが、また
偶数なら 2 番目のデータバッファが読み取り対象になります。これによっ
てバイパス出力データの整合性が保証されます。

これら 2 つのバッファのレイアウトは、バイパス出力シグナルの数や内容
によって変わります。このため、ECU は、各シグナル値がバッファ内のど
こに格納されているかを把握するために、バッファの先頭アドレスからの
相対位置を示す「バイパスオフセット」を使用します。安全のため、バイ
パス出力シグナル用のポインタリスト、というものは存在せず、代わり
に、ECU ソフトウェア内に定義された、各シグナルのバイパスオフセット
用の特殊なパラメータが使用されます。この「バイパスオフセットパラ
メータ」には、ステップ 1（132 ページ）においてバイパスオフセットが
セットされます。これらのパラメータは、ETK の RAM 上の ECU 適合デー
タ内に配置されるため、直接アクセスが可能です。

12. ECU がバイパス出力データを読み取ります。一般に、ECU には安全機構が
組み込まれていて、バイパス通信で障害が発生した場合に重大なトラブル
が起こらないような対策が施されています。詳細は、ECU のプログラムの
内容をご確認ください。
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2 つのデータバッファが必要なのは、バイパス出力データを書き戻す処理が同期
していないためです。シミュレーションプロセッサの処理結果は、処理が終わっ
た後に直ちに書き戻されますが、データがまだ書き戻されていない時、または
データが書き戻されている途中に ECU が結果を要求する可能性があります。そこ
で、バイパス出力データの整合性を保証するために、新しいデータが完全に書き
戻されるまで、そのデータのコピーが必ずデータバッファに保持されています。

^ji=sNKN 以外のバージョン

AML V1.1.1 の QP_BLOBの内容は、AML V1.1 の例と同じです（129 ページを参
照してください）。

ただし AML V1.2 には若干の変更点があります。いくつかのパラメータが削除さ
れて新しいパラメータが追加され、そのためパラメータ名（オプション）も変更
されています。AML V1.2 の QP_BLOBの内容は以下のようになります。

/begin IF_DATA ETK 

/begin SOURCE  "BYPASS A4" 

 0 

 0 

 /begin 

QP_BLOB 

 0x0100 /* version 1.0 */

 15 /* hardware trigger */

 INDIRECT /* indirect/direct triggering */

 5 /* raster number/priority */ 
/* (32..1) */

 BYPASS /* raster type */
/*(BYPASS/MEASUREMENT) */

 0x38302E /* trigger id/flag address for */
/* indirect triggering */

 100 /* Max. length of display table */
/* in bytes */

 0x81025E /* address of the display table */
/* in the memory */

 0x3801E0 /* address, where the ECU */
/* writes the display values */

 100 /* Max. size of bypass receive */
/* table */

 0x0 /* StartAddress of the Adress */
/* table for bypass output */
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 0x8103F2 /* Output address of the */
/* bypass table */

 2 /* worst case raster timing */

/end QP_BLOB

/end SOURCE 

...

/end IF_DATA 

AML V1.3、AML V1.4、AML V1.6 も使用できます。これらのバージョンと AML 
V1.2 との相違点は、ASCET-RP で作業する際には何も影響はありません。

9.6 ETK バイパスプロジェクトに必要な情報とデータ

ETK バイパスプロジェクトの作成を始めるには、ECU についての情報やデータが
必要です。これらは、一般的に、バイパスフックを実装した ECU プログラマから
入手できます。本項に示す項目は、情報を確実かつ円滑に得るためのチェックリ
ストとしてお役立てください。

b`r プログラム

バイパス処理部分にバイパスフックプログラムがロードされている必要がありま
す。

^p^jJj`aJOj` ファイル

ASAM-MCD-2MC ファイルは、ECU のデータ配置の記述などの目的で使用されま
す。ETK バイパスパッケージは、ASAM-MCD-2MC ファイルを使用して入力／出
力変数にアクセスするため、ECU の現在のソフトウェアバージョンに対応する
ASAM-MCD-2MC ファイルが必要です。使用できる AML のバージョンは、ハー
ドウェアによって異なります。詳しくは、各ボードのドキュメントを参照してく
ださい。

b`r プロセッサのデータフォーマット

プロセッサファミリが異なれば、ワードデータの格納フォーマット（_áÖ=båÇá~å=L=
iáííäÉ=båÇá~å）も異なります。ETK バイパスをセットアップする際には、ECU のプ
ロセッサが iáííäÉ=båÇá~å と _áÖ=båÇá~å のどちらのフォーマットあるか、また、そ
のワードデータ格納フォーマットが ASAM-MCD-2MC ファイルに記述されていて
HWC エディタで読み取ることができるかどうかを確認しておく必要があります。

注記

AML V1.1.x では、ETK データは 3+2 測定ラスタ用に記述され、これは
ES1232[ETK-CTRL-BAS]、ES1231、ES1200/1 に対して有効です。また AML 
V1.2 以降のバージョンでは ETK データはマルチラスタ用に記述され、これは
ES1232[ETK-CTRL-ADV] に対してのみ有効です。
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Motorola 社のプロセッサなどで使用されている _áÖ=båÇá~å フォーマットの場合は
1 番目のバイトが最上位バイト=で、Intel 社のプロセッサなどで使用されている
iáííäÉ=båÇá~å フォーマットでは、1 番目のバイトが最下位バイトになります。

ベースアドレス

転送チャンネルの先頭アドレスとトリガアドレスが ETK バイパスパッケージで定
義されているか、あるいは先頭アドレスが ASAM-MCD-2MC ファイルに定義され
ていてそれを HWC エディタで読むことができなければなりません。各ベースア
ドレス（先頭アドレス）については、127 ページの「ECU と実験システム間の
データ交換」 を参照してください。

バイパスを起動するためのパラメータ

バイパスを起動するには、ECU プログラム内でバイパスをイネーブルにする必要
があります。バイパスがイネーブルのときは、ECU プログラムの処理結果の代わ
りに、シミュレーションボードでの処理結果が使用されます。個々のバイパス
ファンクションは、INCA でのパラメータ設定により有効になります。

バイパス出力変数

ETK バイパスプロジェクトでは ECU 内の一部の変数しか変更できません。これら
の変数、いわゆるバイパス出力変数は、ECU ソフトウェアのプログラマがバイパ
スフック内に定義します。バイパスプロジェクトを作成する際は、バイパス出力
変数がわかっているか、あるいはそれらの変数に関する情報が ASAM-MCD-2MC
ファイルに格納されていて、それを HWC エディタで読みとることができなけれ
ばなりません。

åÉ~ê 領域での変換に用いるビットマスク

DISTAB12 メソッドでは、ECU とシミュレーションボードの間のデータ転送にお
いて、16 ビットメモリアドレスしか扱われません。ECU のメモリアドレスが 16
ビットアドレスより大きい場合には、データページポインタを使用してアドレス
を 16 ビットアドレスに変換する必要があります。これには longAdrANDMask
および
longAdrORMaskというビットマスクを使用し、これらのビットマスクは HWC
エディタで指定します。

エラー時の対処／安全機構

ECU には通常、バイパス通信で障害が発生した場合の ECU の動作を定義した、安
全機構が組み込まれています。これによって、バイパスファンクションの代わり
に ECU ファンクションの結果が使用されたり、あるいは ECU を oÉëÉí または
bãÉêÖÉåÅó モードに切り替える、などの処理が行われます。特に実車でのバイパ
ス実験の場合には、障害発生時の ECU の動作を知っておくことが重要です。
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NM et`アイテム

本章では、ASCET で使用できるすべての HWC アイテムについて説明します。

10.1 実装されているアイテム

HWCエディタでOptions→Show Installed Itemsを選択すると、RTIOパッケージ
に実装されているアイテムが表示されます。

図 10-1 “Item Information”ダイアログボックス（* ＝ HW ドライバ）

以降の項では、各アイテムごとに表示される HWC エディタタブを紹介します。
ここではアイテム固有のオプションについてのみ説明されているので、すべての
アイテムで共通に使用できるオプションについては、107 ページ「コンフィギュ
レーションタブ」 の項を参照してください。特に“Mappings”タブについては、
アイテム固有のオプションがないため、「コンフィギュレーションタブ」の項での
み説明されています。
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10.2 ES1135-LED

この項では、シミュレーションボード ES1135 のフロントパネル上に設置された
LED についての設定を説明します。

10.2.1 Globals（ES1135-LED デバイス）

“Globals”タブで、LED デバイスの一般的なオプション設定を行います。

図 10-2 ES1135-LED デバイスの“Globals”タブ

^ìíçã~íáÅ=j~ééáåÖ

このオプションで、シグナルと ASCET メッセージの間の自動割り当てを行いま
す。詳しい情報は、163 ページの「Automatic Mapping」の項を参照してくださ
い。
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10.2.2 Groups（ES1135-LED デバイス）

“Groups”タブでは、ES1135-LED デバイスの各シグナルグループのオプション設
定を行います。

図 10-3 ES1135-LED デバイスの“Groups”タブ

ES1135-LED デバイスの“Globals”タブには、このデバイス固有の項目はありま
せん。一般的な設定内容は、113 ページの 7.3.3 項に説明されています。

10.2.3 Signals（ES1135-LED デバイス）

“Signals”タブでは、ES1135-LED デバイスの各シグナルのオプション設定を行い
ます。

図 10-4 ES1135-LED デバイスの“Signals”タブ

ES1135-LED デバイスの“Signals”タブには、このデバイス固有の項目はありま
せん。一般的な設定内容は、114 ページの 7.3.4 項に説明されています。
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10.2.4 Mappings（ES1135-LED デバイス）

このタブ上の設定は、すべてのデバイスについて共通です。115 ページの 7.3.5
項を参照してください。

10.3 ES1201-ETK

ETK インターフェースボード ES1200 または ES1201 を使えば、ETK を搭載した
ECU に実験システムを接続することができます。外部からの干渉に強いシリアル
インターフェース（8MBit/s）で、ECU メモリの内容を ETAS 実験システムに転送
したり修正したりすることができます。

ES1200 は 1 基、ES1201 は 2 基の ETK インターフェースを搭載しています。それ
以外の点では、これらのボードの機能はまったく同じです。

10.3.1 Globals（ES1201-ETK サブシステム）

図 10-5 ES1201-ETK サブシステムの“Globals”タブ

fa=L=sjb=Ä~ëÉ=~ÇÇêÉëë

この行では、VME ベースアドレスの設定を行います。この設定は ES1201 ボード
上のスイッチ設定と一致している必要があります。ES1201 の場合、2 種類の異な
る VME ベースアドレスから選択することができ、1 つの ETAS 実験システムで最
大 2 枚の ES1201 を使用することができます。

注記

ES1201 ボードを使用して ETK と通信できるようにするためには、特別なシス
テムサービスが必要です。これらのサービスは、ES1111（VCU）および
ES1120（VCU2）システムコントローラボードにしか搭載されていません（詳
細は、69 ページの「ハードウェア - ES1000.x 実験システム」という項を参照
してください）。
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ES1201-ETK サブシステムには最大 2 つの ETK-CTRL サブシステムを割り当てるこ
とができます。これらの ETK-CTRL サブシステムは、ボード上の 2 基の ETK イン
ターフェースコントローラに相当します。

ES1201-ETK サブシステムは、ES1200 を組み込むためにも使用できます。この
ボードには ETK インターフェースが 1 基しかないので、ETK-CTRL サブシステム
を 1 つしか割り当てることができません（ETK ポート A）。

10.3.2 Globals（ETK-CTRL サブシステム）

ETK-CTRL サブシステムの“Globals”タブで、実際の ETK コントローラまたは
ETK ポートを ETK-CTRL サブシステムに割り当てます。

図 10-6 ETK-CTRL サブシステムの“Globals”タブ

bqh=mçêí

独立した 2 つの ETK チャンネル（ポート A、ポート B）のうちの 1 つ、つまり
ES1201 の 2 基の ETK コントローラのうちの 1 つを、ETK インターフェースとし
て割り当てます。ES1200 の場合には、ポート A だけを選択できます。

qêáÖÖÉê=pÉÖãÉåí=^ÇÇêÉëë=EÜÉñF

DISTAB 処理のトリガセグメントアドレスを指定します。

ETK バイパスアイテムとそれに関連する ASAM-MCD-2MC プロジェクトが ETK-
CTRL サブシステムに割り当てられている場合には、この設定を編集することはで
きません。関連する変数がその ASAM-MCD-2MC プロジェクト内に正しく定義さ
れている場合には、この設定は自動的に設定されます。

トリガセグメントアドレスは、バイパスチャンネル経由のデータ転送を制御する
ために使用されるハードウェアトリガアドレスの位置を規定します。トリガセグ
メントアドレスに対するハードウェアトリガアドレスの相対位置は、DISTAB デー
タ交換プロセス内で固定されています。
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64 バイトのトリガセグメントの先頭アドレス（8 ビット幅または 16 ビット幅の
バスアクセスの場合）は、64 で割り切れる偶数のアドレスでなければなりませ
ん。また、128 バイトのトリガセグメントの先頭アドレス（32 ビット幅のバスア
クセスの場合）は、128 で割り切れるアドレスでなければなりません。

トリガセグメントのフォーマットは、DISTAB 12 および DISTAB 13 インター
フェースに定義されています。

qêáÖÖÉê=pÉÖãÉåí

トリガセグメントのサイズを定義します。

ETK バイパスアイテムとそれに対応する ASAM-MCD-2MC プロジェクトが ETK-
CTRL サブシステムに割り当てられている場合には、この設定を任意に編集するこ
とはできません。対応する変数がその ASAM-MCD-2MC プロジェクト内に正しく
定義されていると、この値は自動的に設定されます。

トリガセグメントのアドレススペースを ECU で使用することはできません。16
ビット幅のトリガアドレスの場合にはトリガセグメントの大きさは 64 バイトで、
32 ビット幅のトリガアドレスの場合にはトリガセグメントの大きさは 128 バイト
です。

qêáÖÖÉê

ここには、バイパスに使用されるハードウェアトリガアドレスの数（2 または
16）を設定します。

1 つの ETK バイパスアイテムとそれに対応する ASAM-MCD-2MC プロジェクトが
ETK-CTRL サブシステムに割り当てられている場合には、この設定を任意に編集す
ることはできません。対応する変数がその ASAM-MCD-2MC プロジェクト内に正
しく定義されていると、この値は自動的に設定されます。
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10.3.3 Globals（ETK-BYPASS デバイス）

ETK-BYPASS というアイテムの“Globals”タブで、パイパス処理に必要なすべて
のパラメータを定義します。バイパス処理を行うには、バイパス機能を持ち ETK
が装着されている ECU と、バイパス用のソフトウェアが必要です。

図 10-7 ETK-BYPASS デバイスの“Globals”タブ
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^p^jJOj`=mêçàÉÅí

ETK バイパスには ASAM-MCD-2MC プロジェクト（AML V1.1）が必要です。プ
ロジェクトは、データベース内に ASAM-MCD-2MC ディスクリプションファイル
を読み込んで作成します。

ASAM-MCD-2MC ファイルには、IF_DATA ETKというラベル（古いバージョン
では IF_DATA ASAP1B_ETK）でバイパスについての設定が定義され、その中に、
各バイパスチャンネルの設定を定義する QP_BLOBが含まれます。この例は、129
ページの「バイパス通信（AML V1.1）」に記載されています。また TB_BLOBに
は、以下のような一般的な情報が含まれています。

/begin TP_BLOB 

0x1000100 /* TP_BLOB version */

2 /* Project Base Address */

0x0 /* RESET_CFG (only PPC family CPU)*/

/begin DISTAB_CFG 0xC 0x1 MSB_LAST 0x383000 0x0

 TRG_MOD 0xB7

/end DISTAB_CFG 

CODE_CHK /* check whether program and data  */
/* are matching  */

0x0 /* program ID address in data range  */
0x0 /* program ID length in data range  */
0x0 /* program ID address in external RAM */
0x0 /* program ID length in external RAM  */

ETK_CFG 0xF 0xF0 0xFF 0x3 0xFD 0xEE 0xFF 0x1
 /* ETK configuration  */

RESERVED 0x810000 /* start address  */
 0x8103F9 /* length  */
 EXTERN /* memory attribute  */
 0x-1 0x-1 0x-1 0x-1 0x-1 

/* mirror offsets 1 - 5  */

/end TP_BLOB 

注記

AML V1.2 以降のバージョンを使用した ASAM-MCD-2MC プロジェクトは読み
込めません。そのようなプロジェクトをデバイスに割り当てようとすると、次
のようなエラーメッセージが出力されます。
Error: Incompatible version 0x<version> of QP_BLOB found 
in SOURCE ’<sName>’. Expected version = 0x1. Selected 
ASAM-2MC Project is not suitable for the basic ETK-
Controller (ES1232/ETK-CTRL-BAS, ES1231/ETK-CTRL, ES1201/
ETK-CTRL) ! Please use an advanced ETK-Controller (ES1232/
ETK-CTRL-ADV)!
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ASAM-MCD-2MC ファイルに定義されていない情報は、HWC エディタで設定し
ます。

“ASAM-2MC Project”の右側のセルをクリックすると、ASAM-MCD-2MC プロ
ジェクトを選択するためのダイアログボックスが開きます。

図 10-8 ”Select ASAM-2MC Project”ダイアログボックス

_ia ソース

このオプションは、バイパス出力データとして使用される ASAM-MCD-2MC 変数
間の依存関係がどこで定義されるかを決めるものです（BLD = Bypass Label 
Dependencies）。

以下のいずれかを選択します。

içÅ~ä=_ia=aÉÑáåáíáçåë

ASCET から ECU へのバイパス出力データの転送は、各ラスタ（角度同期／時間同
期）ごとに個別のデータバッファを使用して行われます。

一部の ECU プログラムは、バイパス変数をフレキシブルにこのデータバッファへ
割り当てる機能を持っていますが、この機能は、データバッファで転送されるよ
りも多くのバイパス変数が ECU ソフトウェアによって使用される場合に必要で
す。

ASAM-2MC File ASAM-MCD-2MC ファイル内で定義されます。

Local ETK-BYPASS デバイスに設定されたローカル定義が使用
されます（次の「Local BLD Definitions」の項を参照し
てください）。
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バイパス変数を定義するためには、ECU プログラムに応じて、１つのバイパス出
力変数（Measurement - 測定変数 - として定義されます）ごとに、最大 3 つの
Characteristic - 適合変数 - が必要となります。

以下に例を示します。

上の例で、ビット変数 Variable6 は、バイパス出力変数用データバッファのバ
イト 6 のビット 0 に格納されているので、オフセット値は「バイトオフセット：
6 ／ビットオフセット：0」です。

もう 1 つのビット変数である Variable7はバイト 6 のビット 1 に格納されてい
るので、オフセット値は「バイトオフセット：6 ／ビットオフセット：1」です。

Variable3は 1 バイトで、バッファ内のバイト 4 に格納されているため、その
バイトオフセットは 4 で、また Variable4のバイトオフセットは 5 です。

Variable1はデータバッファの先頭にあるので、そのバイトオフセットは 0 で
す。この Variable1 は 2 バイトを占めるワードデータなので、Variable2の
バイトオフセットは 2 になります。

“Value”列の [Edit] という項目をクリックしてテキストエディタを開き、バ
イパスラベル間の依存関係のローカル定義を設定します（BLD Bypass Label 
Dependencies）。

Byte offset
or vector
parameter:

バイパス出力変数の位置をデータバッファの先頭からのオフセッ
ト（バイト数）で指定します。

Bit offset: ビット変数にのみ有効で、バイト内のビット位置で指定します。

Source: 一部の ECU は、バイパス変数をバイパスラスタ（角度同期／時
間同期）に自由に割り当てる機能を持っています。このパラメー
タに、割り当て先を指定する値が格納されます（0 = 角度同期、 1 
= 時間同期）。

Basisadresse
Byte 0

Byte 1
Byte 2

Byte 3

Byte 4

Variable6 (6) (0)

Variable7 (6) (1)

Variable3 (4)

Variable4 (5)

Variable1 (0)

Byte 5

Byte 6

Variable2 (2)

Variable6(6)(0)

Variable7(6)(1)

Variable4(5)

Variable3(4)

Variable2(2)

Variable1(0)

バイト 6

バイト 5

バイト 4

バイト 3

バイト 2

バイト 1

バイト 0
ベースアドレス
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テキストは複数の行で構成され、各行に１つのバイパス出力シグナルを記述しま
す。バイパス出力シグナルのラベルの依存関係は、以下のような構文で定義しま
す。

<Grid>, <Signal>, [<Byte Offset>], [<Bit Offset>], [<Source>]

ここで定義されるパラメータのオフセットは、ASCET によって自動的に設定され
ます。

ローカル BLD 定義の例：

1 // current version of the BLD

sgetas2 // (optional) name of the dependent
// ASAP2 file
// (is ignored by BLD reader)

A, t1b_8, EBOTT1_8 // definition of a bypass signal
// available for angle sync sample 
// grid

B, B_t1b, EBOTBT1, BOBBT1
// definition of a bypass bit 
// signal available for time
// sync grid

AB, B_Test, B_Test_Vector,, B_Test_Channel 

// definition of a bypass signal
// available for both sample grids 
// with definition for the actual
// sample grid (source) parameter

Grid: “A”（角度同期）、“B”（時間同期）、“AB”（角度および時間同
期）

Signal: バイパス出力変数に割り当てられる ASAM-MCD-2MC の
Measurement の名前

Byte Offset: バイトオフセットを指定する ASAM-MCD-2MC の
Characteristic の名前

Bit Offset: ビット変数のビット位置を指定する ASAM-MCD-2MC の
Characteristic の名前

Source: 2 つ以上のラスタ（AB）がある場合、現在選択されているラ
スタを指定するための ASAM-MCD-2MD の Characteristic の
名前

// コメント行であることを示します。
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A, log_uint8_0_A, log_uint8_0_offset_A.Model_Byp_A, 
log_uint8_0_bitOffset_A.Model_Byp_A

// definition of a bypass signal
// available for angle sync sample 
// grid

この例は、ASAM-MCD-2MC ファイル（AML V1.1）内に定義された以下のよう
な Measurementセクションに対応するものです。

/begin MEASUREMENT log_uint8_0_A 

"" 

UBYTE 

ident 

1 

100

0.0 

1.0 

READ_ONLY 

BIT_MASK 0x8 

ECU_ADDRESS 0xFD00 

/end MEASUREMENT

^ìíçã~íáÅ=j~ééáåÖ

詳しい情報は、163 ページの「Automatic Mapping」の項を参照してください。

_óíÉ=lêÇÉê=

ECU のプロセッサのワードデータ格納フォーマット（MSB first / MSB last）を表し
ます。この設定は、ASAM-MCD-2MC プロジェクト（128 ページ参照）から読み
込まれます。

一般的なバイトオーダーは以下のとおりです。

aáëí~Ä=qóéÉ=

ECU とのデータ交換に使用される DISTAB バージョンを表示します。この設定は、
ASAM-MCD-2MC プロジェクト（128 ページ参照）から読み込まれます。

DISTAB 12 は、最大 2 バイトのシグナルをサポートします。

DISTAB 13 は 1、2、4、8 バイトのシグナルをサポートします。

MSB first big endian モトローラ

MSB last little endian インテル
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dêáÇ=^=L=_

ASAM-MCD-2MC プロジェクトに定義されている 2 つのラスタ、A および B（角
度同期と時間同期）を表示します。

_óé~ëë=s~êá~ÄäÉ=pÉäÉÅíáçå=jçÇÉ

バイパス出力変数（“Gourp”タブの“send”シグナルグループ）の選択リスト
に、ASAM-MCD-2MD デスクリプションに“Measurement”として定義されてい
るすべての ECU 変数を表示する（“all”）か、それともバイパス出力変数だけを表
示する（“bypass”）かを選択します。

この設定が影響しないバイパス入力変数（“Gourp”タブの“receive”シグナルグ
ループ）については、常に ASAM-MCD-2MD デスクリプションに定義されている
すべての測定変数が表示されます。

réÇ~íÉ=çå

バイパス通信において、シミュレーションボードと ECU 間のデータ転送を、ETK
のどのページ（Working Page、Reference Page、Working & 
Reference Page）で行うかを選択します。

b`r=a~í~=jçÇÉ=

ECU プロセッサがデータメモリにアクセスする際に使用するアクセスモード
（byteアクセス／ wordアクセス）を指定します。この設定は、ASAM-MCD-2MC
プロジェクト（128 ページ参照）から読み込まれます。

_~ëÉ=lÑÑëÉí=s~äìÉ

各バイパス出力変数のバイトオフセット (0、2、または 8 バイト ) を指定します。

バイトオフセットのデフォルト値は DISTAB 12 では 0、DISTAB 13 では 8 です。
それ以外の設定を使用するのは特殊な場合に限られますので、ECU プログラマと
の調整作業が必要になります。

_ÉÖáå=c~ê=^ÇÇêÉëë=o~åÖÉ=EÜÉñF

FAR アドレス領域の先頭アドレスを指定します。通常、この設定は DISTAB12 を
使用する場合にのみ必要です。

DISTAB 12 を使用する C16x マイクロコントローラ搭載の ECU では、ECU の FAR
アドレス域の変数を読み書きすることはできません。FAR アドレス域の値はすべ
て個別に ETK アクセスで読み取られるため、データ転送の速度が低下します。

iÉåÖíÜ=c~ê=^ÇÇêÉëë=o~åÖÉ=EÜÉñF

FAR アドレス域のサイズを指定します。通常、この設定は DISTAB12 を使用する
場合にのみ必要です。
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j~ñ=c~ê=páÖå~äë=

FAR アドレス域から読みとることのできる変数の最大数を指定します。通常、こ
の設定は DISTAB12 を使用する場合にのみ必要です。

FAR 領域から多くの変数を読みとることは、ETK バイパスのパフォーマンスに悪
影響を与えます。そのため、この範囲から読みとる変数の数は最小限に抑えるよ
うにしてください。

içåÖ=^ÇÇêÉëë=^ka=L=lo=j~ëâ=EÜÉñF

この 2 行に、次の“Adress Mapping”オプションで選択されたマスクが表示され
ます。

^ÇÇêÉëë=j~ééáåÖ

この行は、DISTAB12 が使用されている場合にのみ変更できます。

ここでは、アドレス変換を行う際のビットマスクを選択します。16 ビットよりも
長いメモリアドレスを使用する C16x マイクロコントローラ搭載の ECU の場合、
このビットマスクを使用して、DISTAB 12 が使用可能な 16 ビットアドレスに変換
することができます。

式：

<ECU_address> := 

<Memory_address> & <AND Mask> | <OR Mask>

ここで選択されたマスクの値は、“Long Address AND / OR Mask (hex)”の行に表
示されます。以下に、“Address Mapping”の設定に応じたマスクの値を示しま
す。

10.3.4 Groups（ETK-BYPASS デバイス）

ETK-BYPASS デバイスのシグナルグループの数は、4 に固定されています。最初の
2 つのグループが 1 番目のバイパスラスタ（通常は角度同期）に割り当てられ、
残りの 2 つのグループが 2 番目のバイパスラスタ（通常は時間同期）に割り当て
られます。

各ラスタは 2 つのシグナルグループの送受信を行います。

Address Mapping Long Address

AND Mask (hex) OR Mask (hex)

Mask 16 Bit 0xFFFF 0x0000

C167x DPP0 0x3FFF 0x0000

C167x DPP1 0x3FFF 0x4000

C167x DPP2 0x3FFF 0x8000

C167x DPP3 0x3FFF 0xC000
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受信シグナルグループのデータは標準的な DISTAB メソッドで転送され、送信シ
グナルグループのデータは ECU と RTIO の間でバイパステーブルメソッドによっ
て交換されます。」

図 10-9 ETK-BYPASS デバイスの“Groups”タブ

q~ëâ

バイパスファンクションが正しく実行されるためには、以下のようにタスクが割
り当てられている必要があります。

図 10-10 ETK バイパスを行なう際の標準的なタスク割り当て

注記

グループ名、シグナル名、シグナル方向を変更した際、それ以前にマッピング
されていた ASCET メッセージは自動的に再割り当てされないため、マニュアル
操作で再度マッピングを行う必要があります。
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^Åíáî~íÉÇq~ëâ

このフィールドに software タスクが指定されていると、データ送受信時に、明示
的な“activate Task”コールによってそれらが起動されます。

_óé~ëë=s~êá~ÄäÉë

10.5.4 項の「Bypass Variables」（177 ページ）を参照してください。

aá~ÖåçëíáÅ=s~êá~ÄäÉ

10.5.4 項の「Diagnostic Variable」（178 ページ）を参照してください。

pí~êí=_ìÑÑÉê=EÜÉñF

バイパス入力データとバイパス出力データのデータバッファの先頭アドレスを指
定します。

バイパス処理に対応した ASAM-MCD-2MC プロジェクトには、通常、これらのア
ドレスが含まれています。その場合、このフィールドには ASAM-MCD-2MC プロ
ジェクトに定義された値が表示され、編集はできません。

この項目に関連して、以下の値が ASAM-MCD-2MC プロジェクトに定義されてい
ます（表 9-1 の“Parameter”カラムを参照してください）。

CHNL_S、CHNL_X、CHNL_T、CHNL_Y

_ìÑÑÉê=ëáòÉ=EÜÉñF

バイパス入力データとバイパス出力データのデータバッファのサイズを、バイト
単位で指定します。

バイパス処理に対応した ASAM-MCD-2MC プロジェクトには、通常これらの設定
が含まれています。その場合、このフィールドには ASAM-MCD-2MC プロジェク
トに定義された値が表示され、編集はできません。

この項目に関連して、以下の値が ASAM-MCD-2MC プロジェクトに定義されてい
ます（表 9-1 の“Parameter”カラムを参照してください）。

BPMAX_S、BPMAX_X、BPMAX_T、BPMAX_Y

qêáÖÖÉê=fÇ=EÜÉñF

“receive”シグナルグループについて、DISTAB 用のトリガ識別子のアドレスを指
定します。

バイパス処理に対応した ASAM-MCD-2MC プロジェクトには、通常これらの設定
が含まれています。その場合、このフィールドには ASAM-MCD-2MC プロジェク
トに定義された値が表示され、編集はできません。

この項目に関連して、以下の値が ASAM-MCD-2MC プロジェクトに定義されてい
ます（表 9-1 の“Parameter”カラムを参照してください）。

TRGID_S、---、TRGID_X、---
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pí~êí=mçáåíÉê=EÜÉñF

“receive”シグナルグループについて、DISTAB 用のポインタリストのアドレスを
指定します。

バイパス処理に対応した ASAM-MCD-2MC プロジェクトには、通常これらの設定
が含まれています。その場合、このフィールドには ASAM-MCD-2MC プロジェク
トに定義された値が表示され、編集はできません。

この項目に関連して、以下の値が ASAM-MCD-2MC プロジェクトに定義されてい
ます（表 9-1 の“Parameter”カラムを参照してください）。

BYPASS_S、---、BYPASS_X、---

10.3.5 Signals（ETK-BYPASS デバイス）

図 10-11 ETK-BYPASS デバイスの“Signals”タブ

バイパス変数は、シグナルグループごとにバイトサイズ順にソートされます。
“send”シグナルの場合は、8-4-2-1 バイトとなります。

“receive”シグナルの場合、そのシグナルが ECU コントローラの内部変数であれ
ば、DISTAB によって間接的に読み込むことしかできず、また ECU コントローラ
の外部メモリに格納される変数であれば、ETK で直接読み込むこともできます。
これを区別するために、各シグナルは、8-4-2-1（直接）と 8-4-2-1（間接）とに
分けて表示されます。

páÖå~ä=^ÇÇêÉëë=EÜÉñF

バイパス変数に割り当てられた ASAM-MCD-2MC の Measurement のメモリアド
レスメモリアドレスを表示します。

注記

“Signals”タブにはバイパス変数のステータス値が表示されます。ユーザーが
編集できる項目はありません。
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pÖå~ä=a~í~=qóéÉ

バイパス変数の型を表示します。

páÖå~ä=páòÉ

バイパス変数のデータサイズをバイト数で表示します。

páÖå~ä=içÅ~íáçå

この項目は“receive”シグナルに関してのみ有効で、バイパス変数のメモリロ
ケーション（Internal ／ External）を示します。

• Internal

このバイパス変数が ECU コントローラの内部 RAM に配置されることを示
します。この場合、DISTAB によってのみ読み込み可能です。

• External

このバイパス変数が ECU コントローラの外部 RAM に配置され、ETK で直
接読み込むことも可能であることを示します。

páÖå~ä=lÑÑëÉí=EÜÉñF

バイパス変数の、データバッファ内のインデックス（0 ～）を示します。

^ÅÅÉëë

この項目は“receive”シグナルに関してのみ有効で、測定変数にアクセスするた
めに使用されるメソッドを表示します。

^ÅÅÉëë=^ÇÇêÉëë=EÜÉñF

変換されたバイパス変数のターゲットアドレスが表示されます。

ASAM-MCD-2MC プロジェクトには、ETK アクセスに使用される“memory 
segment”というエレメントが含まれていて、ここにターゲットアドレスを算出
するための変換方法が格納されています。

DISTAB12 を使用する場合は、さらに“Globals”タブのアドレスマスク、“AND 
Mask”および“OR Mask”が使用されます。

変換式：

<target_address> := 
(<signal_address> & <AND Mask> | <OR Mask>)

（“memory segment”変換による）

“Distab” DISTAB 経由

“Direct” ETK によるダイレクトアクセス
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lÑÑëÉí=i~ÄÉä

この項目は“send”シグナルに関してのみ有効で、バイパス変数について BLD 参
照が定義されている場合に使用されるベクタパラメータの名前を表示します（詳
しい情報は、145 ページの「Local BLD Definitions」 を参照してください）。

lÑÑëÉí=^ÇÇêÉëë=EÜÉñF

この項目は“send”シグナルに関してのみ有効で、バイパス変数について BLD 参
照が定義されている場合に使用されるベクタパラメータのアドレスを表示します

（詳しい情報は、145 ページの「Local BLD Definitions」 を参照してください）。

lÑÑëÉí=s~äìÉ=EÜÉñF

この項目は“send”シグナルに関してのみ有効で、バイパス開始時に、必要なバ
イパス変数を有効にするために必要なパラメータを調整する値を表示します。こ
の値はバイパス変数について BLD 参照が定義されている場合にのみ有功です（詳
しい情報は、145 ページの「Local BLD Definitions」 を参照してください）。

変換式：

Offset Value = 
Signal Offset + Base Offset Value

（Base Offset Valueは“Globals”タブで設定されます。）

_áí=i~ÄÉä

この項目は“send”シグナルに関してのみ有効で、ビットデータであるバイパス
変数について BLD 参照が定義されている場合に使用される、ビットオフセットパ
ラメータの名前を表示します（詳しい情報は、145 ページの「Local BLD 
Definitions」 を参照してください）。

_áí=^ÇÇêÉëë=EÜÉñF

この項目は“send”シグナルに関してのみ有効で、ビットデータであるバイパス
変数について BLD 参照が定義されている場合に使用される、ビットオフセットパ
ラメータのアドレスを表示します（詳しい情報は、145 ページの「Local BLD 
Definitions」 を参照してください）。

_áí=s~äìÉ

この項目は“send”シグナルに関してのみ有効で、バイパス開始時に、データバ
イト内のビットポジション（0 ～）を指定するために必要なビットオフセットパ
ラメータを調整する値を表示します。この値はビットデータであるバイパス変数
について BLD 参照が定義されている場合にのみ有功です（詳しい情報は、145
ページの「Local BLD Definitions」 を参照してください）。
HWC アイテム 155



156
pêÅ=i~ÄÉä

この項目は“send”シグナルに関してのみ有効で、“Source”パラメータの名前を
表示します。この値はバイパス変数について BLD 参照が定義されている場合にの
み有功です（詳しい情報は、145 ページの「Local BLD Definitions」 を参照してく
ださい）。

pêÅ=^ÇÇêÉëë=EÜÉñF

この項目は“send”シグナルに関してのみ有効で、“Source”パラメータのアドレ
スを表示します。この値はバイパス変数について BLD 参照が定義されている場合
にのみ有功です（詳しい情報は、145 ページの「Local BLD Definitions」 を参照し
てください）。

pêÅ=s~äìÉ

この項目は“send”シグナルに関してのみ有効で、バイパス開始時に、ECU にど
ちらのラスタで各バイパス変数を更新するかを通知するために必要なパラメータ

（Src Label）を調整する値を表示します。角度同期ラスタ (A) の場合はこの値は 0
で、時間同期ラスタ（B）の場合は 1 となります。

この値は、バイパス変数について BLD 参照が定義されている場合にのみ有功です
（詳しい情報は、145 ページの「Local BLD Definitions」 を参照してください）。

10.3.6 Mappings（ETK-BYPASS デバイス）

このタブ上の設定は、すべてのデバイスについて共通です。115 ページの 7.3.5
項を参照してください。

10.4 ES1222-CAN

ES1222 ボードは、VME バスシステムの CAN インターフェースとして使用されま
す。このボードには 4 つの CAN チャンネルが搭載されていて、各チャンネルごと
に Intel 82527 タイプの CAN コントローラが装備されています。

また、このボードでは、受信したメッセージで VME バス割り込みをトリガして、
メッセージのポーリングを繰り返し行わないですむようにもできます。各 CAN コ
ントローラは、それぞれ最大 255 の送信メッセージと最大 255 の受信メッセージ
を処理できます。専用のプロセッサが使用されるので、システムコントローラの
負荷は大幅に軽減されます。

注記

FIFO メモリにはチャンネルあたり 82 のメッセージしか格納できないため、同
時に 255 のメッセージを送信することはできません。FIFO メモリのオーバーブ
ローを避けるため、メッセージをいくつかのタスクから何回かに分けて FIFO メ
モリに送り出す必要があります。
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本項では、ES1222 ボード（以前は VSIC ボードと呼ばれていました）を RTIO に
組み込む方法について説明します。HWC エディタに ES1222 ボードを組み込むに
は、“ES1222-CAN”というアイテムを選択します。

基本的は、このボードを使用して、定義済みメッセージによる CAN 通信を行うす
べてのリモートターミナルを接続することができます。

10.4.1 Globals（ES1222-CAN サブシステム）

図 10-12 ES1222-CAN サブシステムの“Globals”タブ

ES1222-CAN サブシステムには、最大 4 つの CAN-CTRL サブシステムを割り当て
ることができます。1 つの“CAN-CTRL”アイテムは、ボード上の 4 基の Intel 
82527 CAN コントローラのうちの 1 つに対応します。

fon=e~åÇäÉê=q~ëâ

“IRQ Handler Task”は、ES1222 ボードの割り込みを使用する場合に必要です。こ
のタスクは、ASCET プロジェクトエディタのタスクリスト内に、“Software”タ
スクとして定義されている必要があります。“Max. No. of Activations”フィール
ドには 2 以上の数（最大 50）を入力してください。

fa

アドレシングするボードのボード番号を入力します。

注記

ES1222 は、システムがオンになったときにハードウェアマネージャにより ID
番号およびフリーアドレス領域が自動的に割り当てられる、“Auto-ID”ボード
と呼ばれるタイプのボードです。同じタイプのボードが複数存在する場合には、
左から右の順に番号が付けられます。つまり、一番左のボードの番号が 1 にな
り、その次の番号は 2 になります。1 つの実験システムでは最大 4 枚のボード
を使用することができ、4 種類の ID を指定できます。
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10.4.2 Globals（CAN-CTRL サブシステム）

CAN-CTRL サブシステムの“Globals”タブでは、実際の 1 つの CAN コントロー
ラまたは CAN コネクタを CAN-CTRL サブシステムに割り当てます。

図 10-13 CAN-CTRL サブシステムの“Globals”タブ

`^k=`çååÉÅíçê

CAN コントローラまたは CAN コネクタ（ポート A、ポート B、ポート C、ポート
D）を選択します。

_~ìÇ=o~íÉ=xâ_~ìÇz

転送レートを指定します。標準的な 8 種類のボーレート（1000、500、250、
125、100、50、20、10 kBaud）から選択できます。また、<Special 
Timing>設定を選択し、CAN コントローラのビットタイミングおよび転送レー
トに関して低水準の制御をアクティブにすることもできます。“Special Timing”
設定を指定するためには、以下の 5 つのオプションが必要です。

fÇÉåíáÑáÉê

CAN メッセージについて、11 ビット識別子を持つ「標準フレーム」と 29 ビット
識別子を持つ「拡張フレーム」のどちらを使用するかを選択することができます。
ëí~åÇ~êÇ= または ÉñíÉåÇÉÇ を選択します。

注記

CAN-CTRL デバイス内で標準フレームと拡張フレームを混在して使用すること
はできません。
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ëí~åÇ~êÇ==識別子が選択されていると、CAN-IO デバイスの“Group”タブの
“identifer dec/hex”フィールド（166 ページを参照してください）には 11 ビット
の値しか入力できません。それより大きな値を入力すると、上位のビットが自動
的に削除され、このときワーニングメッセージは表示されません。

ÉñíÉåÇÉÇ=識別子が選択されていると、同フィールドに 29 ビットの値を入力でき
ます。それより大きな値を入力すると、上位のビットが自動的に削除され、この
ときもやはりワーニングメッセージは表示されません。

péÉÅá~ä=qáãáåÖW=_om=EÇÉÅF

このオプションはデフォルトでは非表示になっています。“Baud Rate”オプショ
ンの値が <Special Timing>になっている場合に限り、編集可能です。

このパラメータは、CAN コントローラの入力クロックの転送レートを決定する
“Baud Rate Prescaler”を設定するためのものです。この設定値の範囲は、0 ～ 63
です。

この設定についての詳細は、Intel 82527 CAN コントローラのデータシートを参照
してください。

péÉÅá~ä=qáãáåÖW=pgt=EÇÉÅF

このオプションはデフォルトでは非表示になっています。“Baud Rate”オプショ
ンの値が <Special Timing>になっている場合に限り、編集可能です。

このパラメータは“Synchronization Jump Width”を設定するためのものです。
この設定値の範囲は、0 ～ 3 です。

この設定についての詳細は、Intel 82527 CAN コントローラのデータシートを参照
してください。

péÉÅá~ä=qáãáåÖW=qpbdN=EÇÉÅF

このオプションはデフォルトでは非表示になっています。“Baud Rate”オプショ
ンの値が <Special Timing>になっている場合に限り、編集可能です。

このパラメータは“Time Segment 1”を設定するためのもので、サンプリングの
間隔を決定するためのタイムセグメントを指定します。この設定値の範囲は、2
～ 15 です。

この設定についての詳細は、Intel 82527 CAN コントローラのデータシートを参照
してください。

péÉÅá~ä=qáãáåÖW=qpbdO=EÇÉÅF

このオプションはデフォルトでは非表示になっています。“Baud Rate”オプショ
ンの値が <Special Timing>になっている場合に限り、編集可能です。

このパラメータは“Time Segment 2”を設定するためのもので、サンプリングの
間隔を決定するためのタイムセグメントを指定します。この設定値の範囲は、1
～ 7 です。
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この設定についての詳細は、Intel 82527 CAN コントローラのデータシートを参照
してください。

péÉÅá~ä=qáãáåÖW=pmi=EÇÉÅF

このオプションはデフォルトでは非表示になっています。“Baud Rate”オプショ
ンの値が <Special Timing> になっている場合に限り、編集可能です。

このパラメータは“Sampling Mode”を設定するためのもので、論理ステートを
決定するためにシグナルを何回サンプリングするかを決定します。

この設定についての詳細は、Intel 82527 CAN コントローラのデータシートを参照
してください。

CAN バス周波数を計算する式は以下のとおりです（Intel 82527 CAN コントロー
ラのデータシートより引用）。

CAN bus frequency = 

10 MHz / [(BRP + 1) x (3 + TSEG1 + TSEG2)]

10.4.3 Globals（CAN-IO デバイス）

CAN-IO デバイスを使用して、CAN バス上で CAN メッセージの送受信を行うデバ
イスを簡単にシミュレートすることができます。

図 10-14 CAN-IO デバイスの“Globals”タブ

fãéçêí=`^k=a_=cáäÉ

このオプションは、Vector Informatik 社製の CANdb データ管理プログラムで作
成された CAN データベースファイルを読み込む際に使用します。このファイルを
使用して CAN メッセージおよびシグナルを自動的に生成することができます。
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[Do it...]をクリックするとダイアログボックスが開きます。

このダイアログボックスで、インポートする CAN-DB ファイルを選択します。

Open ボタンをクリックすると、以下のダイアログボックスが開き、実行する処
理を指定することができます。

図 10-15 CAN DB Import ダイアログボックス

通常、CAN DB ファイルには、CAN ネットワーク内の複数のノードについての情
報が記述されており、“Select Desired Network Node”リストにこれらのノードが
すべて表示されます。その右側の 2 つのリスト（“Send Messages”と“Receive 
Messages”）には、現在選択されているノード用に定義されているすべての CAN
メッセージが表示され、ここで選択されたメッセージがインポートされます。ま
た“Import Use Case”の項目で、“Replace Nodes”オプションをオンにすると、
CAN-IO デバイスがネットワークノードの役割を負うことになり、たとえばノー
ドの送信メッセージが CAN-IO デバイスの送信メッセージとしても使用されます。
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もう 1 つの“Counterpart to Nodes”オプションをオンにすると、CAN-IO デバイ
スがネットワークノードの相手方になり、たとえば、そのノードの送信メッセー
ジが受信メッセージになります。

OK ボタンで設定内容を確定すると、インポートするデータ（CAN メッセージお
よびシグナル）とシグナルグループおよびシグナルがチェックされ、その結果が
以下のダイアログボックスに表示されます。

図 10-16“CAN DB Check”ダイアログボックス

この段階では、既存の CAN-IO デバイスはまだ変更されていません。実際のイン
ポート処理はここで“OK”ボタンがクリックされるまでは開始されません。

インポート処理では、インポートされたメッセージがシグナルグループに挿入さ
れ、適切なシグナルが確実に定義されるための処理が行われます。

インポートが完了すると、インポート処理の詳細な履歴が、“Monitor”ダイアロ
グボックスに表示されます。

図 10-17“Monitor”ウィンドウに表示されるインポート処理の履歴

インポート時の注意点 :
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CAN DB ファイルをインポートする際、識別子フィールドには、29 ビット（拡張
識別子の場合）または 11 ビット（標準識別子の場合）の識別子が自動的に挿入さ
れます。 識別子については 158 ページの「Identifier」を参照してください。 

CAN-CTRL アイテムで標準識別子が選択されている場合に、CAN DB ファイルに
29 ビット識別子（ID > 231）が含まれていると、以下のような処理が行なわれま
す。

• 11 ビット（ビット [28...18]）のみが識別子フィールドに挿入されます。
MSB のビットは無視されます。

• モニタウィンドウにワーニングメッセージが表示されます。

標準または拡張のいずれか一方の識別子しか使用できないため、両方のタイプの
識別子が含まれている CAN DB ファイルをインポートすると、何らかの不具合の
原因となる場合があります。

^ìíçã~íáÅ=j~ééáåÖ

このオプションで、シグナルと ASCET メッセージの間の自動割り当てを行いま
す。

[Do it...]を選択してクリックするとダイアログボックスが開きます。そこに
は、現在のマッピング状態が表示されます。

図 10-18“Automatic Mapping”ダイアログボックスに表示されるマッピングス
テータス

ウィンドウ下部の各ボタンを押すと、以下のようなコマンドが実行されます。
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• All：
現在のマッピングが完全に書き換えられます。各シグナルについて、同じ
名前の同方向の ASCET メッセージがあればそれが割り当てられ、なけれ
ばそのシグナルのマッピングは行われません。

• X-All：
“All”と同様に機能しますが、この拡張機能では、同じ名前の ASCET メッ
セージが見つからない場合には、グローバルな送受信メッセージが生成さ
れて割り当てられます。つまり、これを選択するとすべてのシグナルが
マッピングされます。

• Mapped：
すでにマッピングされていたシグナルだけについてマッピングが行われま
す。つまり、すでにマッピングされていた各シグナルについて、同じ名前
の ASCET メッセージが検索され、対応するメッセージが見つからないシ
グナルは、マッピングされず、ASCET メッセージの欄は空になります。

• X-Mapped：
“Mapped”と同様に機能しますが、この拡張機能では、同じ名前の
ASCET メッセージが見つからない場合には、グローバルな送受信メッセー
ジが生成されて割り当てられます。

• Unmapped：
ASCET メッセージにマッピングされていないシグナルについてマッピング
が行われますが、同じ名前の ASCET メッセージが見つからないシグナル
はマッピングされません。

• X Unmapped：
“Unmapped”と同様に機能しますが、この拡張機能では、同じ名前の
ASCET メッセージが見つからない場合には、グローバルな送受信メッセー
ジが生成されて割り当てられます。

• Cancel
自動マッピングを中止します。

X-* コマンドの実行時にメッセージが生成される場合、そのメッセージがプロジェ
クト内に生成されるようにするか、またはプロジェクトに含まれるモジュール内
に生成されるようにするかを、HWC オプションウィンドウの "Mpping”タブ

（106 ページ参照）で指定することができます。

dÉåÉê~íÉ=oÉÅÉáîÉ=aÉÄìÖ=páÖå~äë

このオプションを選択すると（＝ yes）、各“receive”シグナルグループごとに 2
つのシグナルがさらに生成されます。

• <GroupName>_Diag_dT

• <GroupName>_Diag_Rec
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KKKÇq シグナルは、前回のメッセージ受信からの経過時間（秒）を示します。

これに対し、メッセージが割り込みにより受信される場合（IRQ＝ yes）には、
値の計算は割り込みタスクが実行されるまでは行われないので、実際の受信モニ
タリングを行うことはできません。メッセージが受信されない場合には計算が行
われないので、古い値がそのまま保持されます。つまり、割り込みが発生した時
に、メッセージの受信が通常のタスク周期で行われたのか割り込みにより行われ
たのかを判断することはできません。

KKKoÉÅ シグナルは、メッセージが受信されるたびに trueになります。このシグ
ナルを送受信メッセージにマッピングして、アプリケーションがこのシグナルが
読みとるたびにそれを falseにリセットするようにすれば、メッセージが各周期
の間で受信されたものかどうかをアプリケーションが容易に判断できます。

10.4.4 Groups（CAN-IO デバイス）

このタブ上で、CAN メッセージをシグナルグループとして定義します。

注記

このシグナルを通常のメッセージレシートとして使用（IRQ ＝ no）して、受信
状態をモニタすることができます。たとえば、CAN バスに割り込みがかかった
場合、そのシグナルの値は受信タスクの各周期において増加します。パフォー
マンス上の理由から、この値のオーバーフロー（約 300 秒で発生します）につ
いての対策は行われません。

注記

このタブのショートカットメニューを使用して、新しいシグナルグループまた
は CAN メッセージを生成することができます（詳細は、102 ページの

「“View”メニュー」の項を参照してください）。
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aáêÉÅíáçå

CAN メッセージの方向を指定します（“send”＝送信メッセージ、“receive”＝受
信メッセージ）。

q~ëâ

メッセージの送信または受信を行うタスクを指定します。受信メッセージが割り
込みモードで受信される場合には、この設定はリセットされてロックされ、変更
できなくなります。

fon

受信メッセージを割り込みモードで受信するかどうかを指定します。通常の受信
の場合、相手方が送信できる範囲でできるだけ多い回数で、タスク内で CAN メッ
セージをポーリングする必要があります。この動作モードでは、固定周期で送信
されない CAN メッセージや散発的にしか発生しない CAN メッセージについては
問題が発生する可能性があるため、そのような状況では、メッセージが受信され
るとメッセージの処理がトリガされる、割り込み受信を行うのが理想的です。

fÇÉåíáÑáÉê=ÇÉÅLÜÉñ

メッセージ識別子を入力します。入力できる値の大きさは、上位のアイテムであ
る CAN コントローラ（CAN-CTRL）の識別子タイプとして選択された設定

（standard または extended）により異なります。

各シグナルグループまたは CAN メッセージの識別子はユニークでなければなりま
せん。

iÉåÖíÜ=x_óíÉz

転送されるメッセージの有効データバイト数（1 ～ 8）を指定します。

注記

グループ名、シグナル名、またはシグナルの方向を変更すると、すでにマッピ
ングされている ASCET メッセージが自動的にはマッピングされなくなる可能性
があり、この場合、マニュアル操作でマッピングし直す必要があります。

標準識別子： 11 ビット 2 047 dec 7 FF hex

拡張識別子： 29 ビット 536 870 911 dec F FF FF FF hex
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^Åíáî~íÉÇ=q~ëâ

ここに“receive”CAN メッセージ1（シグナルグループ）用の software タスクを
指定して、該当するシグナルグループが受信されるたびにそれが起動されるよう
にすることができます。ここで指定されたタスクは、クリーンアップなどのポス
トプロセッシングを行います。

この項目は、デフォルト状態では非表示になっています。

mêÉëÅ~äÉê

割り込みモードで受信されるメッセージによるデータ転送を行うための VME バス
割り込みをいつトリガするかを設定します。デフォルト設定の“1”の場合、メッ
セージが受信されるたびにデータ転送も行われます。この値をたとえば“2”にす
ると、2 回に 1 回のメッセージ受信でしか VME バス割り込みがトリガされなくな
り、最後に受信されたメッセージのデータだけが転送されます。

この項目は、デフォルト状態では非表示になっています。

1. “send" グループ用にもこのようなタスクを指定することは可能ですが、そのような

使用法はお勧めできません。（送信プロセスは非同期で行われるため、タスクが起動

された時に CAN メッセージの送信が完了しているかどうかが一定でないため。）

注記

メッセージ受信の頻度が高すぎて VME バス割り込みによる負荷が大きくなり
すぎてしまう場合は、この値を大きくしてください。
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10.4.5 Signals（CAN-IO デバイス）

このタブでは、CAN I/O シグナルを定義します。

dêçìé

シグナルを任意のシグナルグループに割り当てます。

páÖå~ä=qóéÉ

シグナルが CAN バスで転送される際のシグナルタイプを指定します。

以下の設定が可能です。

注記

新しいシグナルは、このタブ用のメニューで生成することができます（詳細は、
102 ページの「“View”メニュー」の項を参照してください）。

シグナルタイプ データ型

int 符号付きのシグナルをデフォルトの 2 の補数（最大 32 ビッ
ト）で表します。

(s)int 符号付きシグナルの符号が最上位ビットとして転送されてか
ら、シグナルの絶対値が転送されます。符号ビットが 1 のと
きには、その数値は負です（最大 32 ビット）。
HWC アイテム



IEEE 浮動小数点フォーマットの概要を下の表に示します。

TSRQPONKK=E_áí=ã~íêáñF

1 つの CAN メッセージで、最大 8 データバイトを転送できます。ビットマトリッ
クスで、各シグナルがどのビットを使用するかを指定します（1 シグナル＝ 1
行）。

列は以下のような構成になります。

ビットフィールドの意味 :

ビットフィールドの操作 :

キーボードの矢印キーを使用して、操作するビットセルを選択します。

数字キーで割り当てる値を入力します。この値は、以降に説明されている「ブ
ロック指定」の際に重要となります。

マウス操作の場合、マウスをクリックするとセルの“empty”と“1”が切り替わ
り、<Shift> キーを押しながらマウスをクリックすると値が“1”から“9”まで
1 ずつ順に増加します。

uint 符号なしシグナルを表します（最大 32 ビット）。

bool ブールシグナルを表します。ビットマトリックス内の 1 ビッ
トだけを 1 にセットできます。

real 「標準 IEEE 浮動小数点（4 バイト）」フォーマットの浮動小数
点数値を表します。したがって、ビットマトリックス内の最
大 32 ビットまでを 1 にセットできます。

フォーマット 符号 指数部 小数部

Float 1 ビット 8 ビット 24 ビット

Double
（サポートされていません）

1 ビット 11 ビット 52 ビット

7 7 ... 0 0 バイト番号

7 6 ... 1 0 ビット番号

空のフィールド シグナルはそのビットを使用しません。

使用されている
フィールド

シグナルはこの位置のビットを使用します。

“X”フィールド シグナルの有効データバイト数が少ないため、このフィール
ドに対応するビットはデータ転送には使用できません

（“Groups”タブの“Length”を参照してください）。

シグナルタイプ データ型
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一度に複数のビットを選択するには、次の図のように行います。

セルに異なる値（“1111　2222...”）を入力することによってデータブロックを作
成することができ、これにより、事実上あらゆるフォーマットの転送シグナルを
指定できます。データブロックを構成するために使用される数値には意味があり、
転送時には、最大値（“2222”）を持つブロックには上位ビットが含まれ、最小値

（“1111”）を持つブロックには下位ビットが含まれます。1 ～ 9 の範囲の数字を
使用して、最大 9 個のビットブロックで 1 つのシグナルを作成することができま
す。ビット配置は Intel のシグナル転送形式と同じなので、Motorola フォーマッ
トで 8 ビットより長いシグナルを表現するためには、必ずブロック指定を行う必
要があります。

さまざまなシグナル定義の例：

10.4.6 Mappings（CAN-IO デバイス）

このタブ上の設定は、すべてのデバイスについて共通です。115 ページの 7.3.5
を参照してください。
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<Shift> Taste drücken und nochmals
klicken um zweites Bit auszuwählen

1 1 1 1 111 1
Der Block wurde gefüllt

クリックして選択範囲の端のビットをセットします。

クリックして反対側の端のビットをセットします。

<Shift> を押しながらもう一度クリックします。
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16 Bit Signal im Intel Format

2 2 2 2 222 2 1 1 1 1 111 1

2 2 2 2 1 1 1 1 111 1
12 Bit Signal (Intel Format) mit Lücke

Andere Beschreibung des selben Signals

1 1 1 1 111 1 2 2 2 2 222 2
16 Bit Signal im Motorola Format

Intel フォーマットの 16 ビットシグナル

同じシグナルを定義するもう 1 つの方法

ギャップのある 12 ビットシグナル（Intel フォーマット）

Motorola フォーマットの 16 ビットシグナル
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10.5 ES1222-CAN Bypass（CAN バイパスプロトコル - CBP）

CAN バイパスアプリケーションは、ETK バイパスアプリケーションほど効率的で
はありませんが、その反面、ECU ソフトウェアを CAN バイパスに対応させるだ
けで実現でき、特殊なハードウェアを必要としません。

ただし、ECU に CAN インターフェースが装備されていることが条件となります。
CAN バイパスを行うためには以下の 2 つの方法があります。

• ECU ソフトウェアで固定的に定義されたメッセージ、および割り当てられ
たシグナルによる方法。これは CAN バイパスデバイスではなく CAN-IO
デバイスを使用します（156 ページの 10.4 項を参照してください）。

• 可変なメッセージサイズを転送できるプロトコルによる方法。この場合、
次の項のライセンス合意条件に留意してください。

10.5.1 CAN バイパスプロトコル（CBP）のライセンスに関する法的な注意事項

CAN バイパスプロトコル（CBP）は、Robert Bosch GmbH Stuttgart によって開発
され、Robert Bosch GmbH および ETAS GmbH の両者によって応用されています。
すべての権利は Robert Bosch GmbH に留保されています。

CAN バイパスは、このプロトコルが組み込まれた ASCET-RP および Robert Bosch 
GmbH 製 ECU と共に使用する場合に限り、更なるライセンス合意なしに使用する
ことができます。

CBP をサポートする ECU についての情報は、ECU メーカーから入手できます。

ASCET-RP と共に使用する CBP のインターフェースディスクリプションについて
は、ご要望に応じて ETAS GmbH からお渡しできます。

注記

インターフェースディスクリプションの譲渡は、定められた譲渡合意のもとに
行われます。ASCET-RP のライセンス合意からこの譲渡合意への権利授与はあ
りません。
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10.5.2 CAN バイパスのハードウェア構成

下図に、ES1000.2 ／ ES1000.3 を用いた CAN バイパスアプリケーションの構成
例を示します。

ETK による高速プロトタイピングアプリケーションの場合と同様に、ホスト PC は
ホストリンクインターフェース経由で ETAS 実験システムに接続されます。ASCET
で開発されたバイパスファンクションは PPC モジュール（ES113x）上で実行さ
れ、ECU は、ES1222 CAN インターフェースボード経由で ETAS 実験システム

（ES1000.x）に接続されます。

ECU との通信は、CAN バイパスプロトコル（CBP）を使用して行われます（CBP
の著作権は Robert Bosch GmbH に留保されています）。

CANインターフェースボード

ES1222 A

ES1000.2

6...34V

ON

AUTO

UA Temp

ES1130

PC

ES1222.1
A

C
A

N
 1

C
A

N
 2

C
A

N
 3

C
A

N
 4

K-Line

CAN

ES1120

PC

ASCET
INCA

コントローラボード

ES1120

シミュレーションボード

ES1130

イーサネット

エンジンECUエンジン
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10.5.3 Globals（CAN-Bypass デバイス）

図 10-19 CAN Bypass デバイスの“Globals”タブ

aÉîáÅÉ=j~å~ÖÉê=q~ëâ

バイパスシステムで排他的に使用される Alarm タスクを指定します。この Alarm
タスクの時間周期は、0.05 ～ 0.8 秒にしてください。

^p^jJOj`=mêçàÉÅí

すでにデータベースに読み込まれている、ECU に適した ASAM-MCD-2MC プロ
ジェクトを選択します。

`^k=fÇÉåíáÑáÉê=EÇÉÅF

CAN メッセージコマンドの CAN 識別子を 10 進表記で指定します。CAN メッ
セージコマンドは、CAN メッセージブロックの最大値の識別子を持つメッセージ
です（CBP のデフォルト値は 263 です）。識別子の長さ（11 ビット／ 29 ビット）
は、CAN-CTRL サブシステムの“Globals”タブ上の“Identifier”の設定により決
まります。

CAN メッセージブロックのフォーマットとコマンドメッセージは、CBP インター
フェースディスクリプションに定義されています。
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`^k=fÇÉåíáÑáÉê=EÜÉñF

CAN メッセージコマンドの CAN 識別子を 16 進数で指定します（CBP のデフォル
ト値は 107H です）。

@=`^k=jÉëë~ÖÉë

CAN メッセージブロックに含める CAN メッセージの数（4 ～ 16）を指定しま
す。CAN バイパスプロトコルでは、通常、CAN メッセージブロックには 8 つの
CAN メッセージが含まれます。

_óíÉ=lêÇÉê

ECU プロセッサのワードデータのストレージフォーマット（MSB first/MSB last）
が表示されます。この情報は、割り当てられている ASAM-MCD-2MC プロジェク
トから読みとられたものです。

“Byte Order”の一般的な設定：

^ìíçã~íáÅ=j~ééáåÖ

163 ページの「Automatic Mapping」を参照してください。

mêÉÑáñ=L=mçëíÑáñ=íç=i~ÄÉä

バイパスパラメータをバイパス出力値（ASAM-MCD-2MC の Measurement）と
区別できるようにするための、名前の拡張子を指定します。この名前の形式に
よってバイパス出力値（ECU への“send”シグナル）であることが認識され、バ
イパスシグナル用に必要なすべての情報が決定されます。

注記

CAN メッセージの数が多ければ多いほど、たくさんのバイパス変数を転送でき
ます。ただし、ECU ソフトウェア側でもより多くのリソースが必要となるた
め、この項目を設定する際は、ECU ソフトウェアの調整が必要です。

MSB first big endian モトローラ

MSB last little endian インテル
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この関係を下図に示します。

図 10-20 バイパスラベル間の関係

バイパスラベルの役割 :

sÉÅíçê=_~ëÉ=^ÇÇêÉëë=EÜÉñF

ECU のバイパス出力値（ECU の“send”シグナル）のターゲットアドレスの計算
に使用されるベースアドレスを指定します。これは、ターゲットアドレスが CAN
バイパスプロトコルで使用可能な 16 ビットでアドレシングできる領域の外にある
場合に必要です。

ターゲットアドレスは、以下のようにして計算されます。

<bypass address> := 

<vector address> + <ecu calibration offset> - 

<base address>

<ecu calibration offset> は、ASAM-MCD-2MC プロジェクトにより決め
られます。

Bypass Vector Label バイパス変数のベクタアドレスを指定します。0 の場合、
値は転送されません。

Bypass Raster Label バイパス変数を角度同期ラスタで転送する（値＝ 0）か、
時間同期ラスタで転送する（値＝ 1）かを指定します。

Bypass Signal
(Measurement)

"TestSignal"

"PreTestSignalPost"

"???"

Bypass Vector Label
(Characteristic)

Bypass Raster Label
(Characteristic)

Prefix to Label Postfix to Label

次のアドレス
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10.5.4 Groups（CAN-Bypass デバイス）

図 10-21 CAN-Bypass デバイスの“Groups”タブ

dêçìé

CAN-Bypass デバイスは、send 方向と receive 方向の最大 2 つのラスタをサポート
します。シグナルグループには以下の意味があります。

注記

グループ名、シグナル名、またはシグナルの方向を変更すると、すでにマッピ
ングされている ASCET メッセージが自動的にはマッピングされなくなる可能性
があり、この場合は、マニュアル操作でマッピングし直す必要があります。

Nrx ECU から CAN-Bypass デバイスへの速度同期データ

Ntx CAN-Bypass デバイスから ECU への速度同期データ

Trx ECU から CAN-Bypass デバイスへの時間同期データ

Ttx CAN-Bypass デバイスから ECU への時間同期データ
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^Åíáî~íÉÇ=q~ëâ

速度同期または時間同期のデータが受信されたときに起動されるソフトウェアタ
スクを指定します。バイパスファンクションの演算および ECU への結果の返送
も、これらのタスクで行われます（“Task”列の対応する項目を参照してくださ
い）。

_óé~ëë=s~êá~ÄäÉë

この項目のセルを選択すると、Select Variables ダイアログボックスが開き、シグ
ナルグループに割り当てるバイパス変数（Measurement）を選択することができ
ます。

図 10-22“Select Variables”ダイアログボックス

基本的に、ASAM-MCD-2MC プロジェクトで定義されている Measurement（測
定変数）はすべて“receive”シグナルグループに割り当てることができます。ま
た、ECU ソフトウェアによりバイパス変数としてサポートされていて、その名前

注記

ノンリニアな変換式はサポートされていません。そのような変換式が選択され
ると、以下のようなワーニングメッセージが表示されます。

<RTIO Toolbox WARNING >
Error on processing signal ’<signal_name>’ formula: Can’t handle
 ’<formula_name>’ for bypass; formula is converted to ’FormulaId’!
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の形式（“Globals”タブの“Prefix/Postfix to Label”を参照してください）から明
らかにバイパス変数であることがわかる測定値に限り、“send”シグナルグループ
に使用できます。

aá~ÖåçëíáÅ=s~êá~ÄäÉ

必要に応じて、各“receive”シグナルグループに ECU 内のその他の値を割り当
て、診断用（例、バイパス動作をモニタする）に利用することができます。

“Bypass Variables”の項と同じ方法で選択します。

10.5.5 Signals（CAN-Bypass デバイス）

図 10-23 CAN-Bypass デバイスの“Signals”タブ

バイパス変数は、シグナルグループ内でバイトサイズに応じてソートされます
（8-4-2-1 バイト）。

@=_óíÉë

バイパス変数 1 つ当たりのバイト数が表示されます。

注記

使用できる測定値の数は限られていて、測定値のデータ型（byte、word...）や
使用できるバイパス CAN メッセージの数（“Globals”タブの“# Bypass 
Messages”という項目）により異なります。

注記

“Signals”タブの項目にはバイパス変数のステータス値が表示され、編集はで
きません。
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^ÇÇêÉëë=EÜÉñF

バイパス変数のアドレスが表示されます。

receive 値のアドレススペースは 32 ビットで、send 値のアドレススペースは 16
ビットです。

_áí=mçë

現在のところ、標準の ECU ソフトウェアはビット値のバイパスをサポートしてい
ないので、この項目は未使用です。

a~í~=qóéÉ

バイパス変数のデータ型が表示されます。

_óíÉ=lÑÑëÉí

バイパス変数のシグナルグループ内のオフセットが表示されます。

10.5.6 Mappings（CAN-Bypass デバイス）

このタブ上の設定は、すべてのデバイスについて共通です。115 ページの 7.3.5
項を参照してください。

10.6 ES1223-LIN

ES1223 ボードは、VME バスシステムの LIN インターフェースとして使用されま
す。このボードは 4 つの LIN チャンネルを搭載しています。受信したメッセージ
で VME バス割り込みをトリガすることが可能なので、メッセージのポーリングを
行なわないようにすることができます。各 LIN コントローラは、それぞれ最大 64
のメッセージを処理できます。専用のプロセッサが使用されるので、システムコ
ントローラの負荷は大幅に軽減されます。

本項では、ES1223 ボードの RTIO への組み込みについて説明します。HWC エ
ディタに ES1223 ボードを組み込むには、“ES1223-LIN”というアイテムを選択し
ます。
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10.6.1 Globals（ES1223-LIN サブシステム）

図 10-24 ES1223-LIN サブシステムの“Globals”タブ

fa

使用するボートのボート番号を入力します。

10.6.2 Globals（LIN-CTRL サブシステム）

LIN-CTRL サブシステムの“Globals”タブに、”Init Task”、“Exit Task”、“IRQ 
Handler Task”を割り当てます。

注記

ES1223 は、システムがオンになったときにハードウェアマネージャにより ID
番号およびフリーアドレス領域が自動的に割り当てられる、“Auto-ID”ボード
と呼ばれるタイプのボードです。同じタイプのボードが複数存在する場合には、
左から右の順に番号が付けられます。つまり、一番左のボードの番号が 1 にな
り、その次の番号は 2 になります。1 つの実験システムには最大 2 枚のボード
を使用することができ、2 種類の ID を指定できます。
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ボード上の 4 チャンネルの LIN インターフェースを利用し、1 つの LIN-CTRL サブ
システムに最大で 4 つの LIN-IO デバイスを割り当てることができます。

図 10-25 LIN-CTRL サブシステムの“Globals”タブ

fon=e~åÇäÉê=q~ëâ

“IRQ Handler Task”は、ES1223 ボードの割り込みを使用する場合に必要です。こ
のタスクは、ASCET プロジェクトエディタのタスクリスト内に、“Software”タ
スクとして定義されている必要があります。“Max. No. of Activations”フィール
ドには 2 以上の数（最大 50）を入力してください。
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10.6.3 Globals（LIN-IO デバイス）

図 10-26 LIN-CTRL サブシステムの“Globals”タブ

ifk=`çååÉÅíçê

使用する LIN コネクタ（LIN1 ～ LIN4）を選択します。各 LIN-IO デバイスをそれぞ
れのコネクタに接続してください。

_~ìÇ=o~íÉ=xÄáíLëz

転送レートを指定します。標準的なボーレート（19200、9600、2400 bit/s）から
選択できます。また、<Special Timing>設定を選択し、LIN コントローラの
ビットタイミングおよび転送レートに関する低水準の制御をアクティブにするこ
ともできます。

“Special Timing”設定を指定するためには、183 ページの「Special Timing」につ
いての記述を参照してください。

ifk=kÉíïçêâ=kçÇÉ

選択された LIN-IO デバイスをマスタユニットまたはスレーブユニットのどちらで
稼動させるかを指定します。1 つの LIN ネットワーク内に必ず 1 つのマスタユ
ニットが必要です。
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pÅÜÉÇìäÉ=q~ëâ

この設定は、“LIN Network Node”が Masterに設定されている LIN-IO デバイス
にのみ意味を持ちます。送信キューが空である時に常に実行されるマスタコント
ロールユニット用タスクを定義するもので、メッセージの連続送信を行う場合に
有効です。

péÉÅá~ä=qáãáåÖW=_~ìÇo~íÉ=xÄáíLëz

このオプションはデフォルトでは非表示になっています。“Baud Rate”オプショ
ンの値が <Special Timing>になっている場合に限り、編集できます。

標準の転送レート（182 ページの「Baud Rate [bit/s]」を参照してください）とは
異なり、10 ～ 20,000 bit/s の値を任意に設定できます。

péÉÅá~ä=qáãáåÖW=póåÅÜ_êÉ~â=xÄáíz

このオプションはデフォルトでは非表示になっています。“Baud Rate”オプショ
ンの値が <Special Timing>になっている場合に限り、編集できます。

ここで設定される SyncBreak 長には、実際の SyncBreak（Low フェーズ）と同期
デリミタ（1 ビット）が含まれます。標準の設定（最低 14 ビット）以外に、8 ～
15 ビット（低速）の間で任意に同期長を設定できます。

fãéçêí=`^k=a_=cáäÉ

CANdb データ管理プログラムを使用して作成された CAN/LIN データベースファ
イルをインポートします。このファイルを使用して、LIN メッセージやシグナルを
自動生成することができます。

インポートの詳しい方法については、160 ページの「Import CAN DB File」を参照
してください。

^ìíçã~íáÅ=j~ééáåÖ

シグナルと ASCET メッセージのマッピングを自動的に行います。

詳しい情報は、163 ページの「Automatic Mapping」を参照してください。

dÉåÉê~íÉ=oÉÅÉáîÉ=aÉÄìÖ=páÖå~äë

このオプションがアクティブ（= yes）になっていると、各“receive”シグナル
グループに対して以下の 2 つの補助シグナルが生成されます。

• <GroupName>_Diag_dT

• <GroupName>_Diag_Rec

詳しい情報は、164 ページの「Generate Receive Debug Signals」を参照してくだ
さい。
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10.6.4 Groups（LIN-IO デバイス）

シグナルグループごとに LIN メッセージを定義します。

図 10-27 LIN-IO デバイスの“Groups”タブ

“Groups”タブ内のショートカットメニューを使用して、新しいシグナルグルー
プ、または LIN メッセージを作成できます（102 ページの「“View”メニュー」の
項を参照してください）。

各オプションの詳しい内容については、10.4.4「Groups（CAN-IO デバイス）」を
参照してください。LIN-IO デバイスには以下のような特徴があります。

• LIN-IO デバイスの場合、LIN メッセージ長は識別子の中にコード化されて含
まれているため、“Length [Byte]”オプションはデフォルト状態ではマスク
されていて、書き込み不可能です。

• “Prescaler”オプションは使用できません。

• “Send No Data”オプションは LIN 固有のものなので、以下に説明します。

pÉåÇ=kç=a~í~

このオプションは、“Globals”タブの“LIN Network Node”オプションが
Masterに設定されていて、かつ“Groups”タブの“Direction”の項目で send
が選択されている場合のみ使用されます。

注記

グループ名、シグナル名、またはシグナルの方向を変更すると、すでにマッピ
ングされている ASCET メッセージが自動的にはマッピングされなくなる可能性
があり、この場合、マニュアル操作でマッピングし直す必要があります。
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“Send No Data”オプションを Yes に設定すると、メッセージヘッダのみが転送
され、データは転送されません。この場合、メッセージ長は、Length [Byte] = 0
となります。

10.6.5 Signals（LIN-IO デバイス）

このタブで、LIN シグナルを定義します。

図 10-28 LIN-IO デバイスの“Signals”タブ

“Signal”タブ上のショートカットメニューで、新しいシグナルを作成できます
（102 ページの「“View”メニュー」を参照してください）。

テーブルの各項目の内容については、168 ページの 10.4.5「Signals（CAN-IO デ
バイス）」を参照してください。

注記

マスタノードでスレーブノードからのデータを受信するには、同じ識別子を持
つ 2 つのシグナルグループを作成する必要があります。

- 方向が“send”で“Send No Data”が設定されたグループ
- 方向が“receive”であるグループ

マスタノードは最初のシグナルグループでメッセージヘッダを送信し、次にス
レーブノードからのデータを受信します。

注記

メッセージ長は、“Group”タブで設定する識別子によって自動的に決まりま
す。識別子の上位 3 ビットによりメッセージ長（2、4、8 バイト）が決まるの
で、ビットフィールドにおいてこれらの上位ビットは無効です。
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10.6.6 Mappings（LIN-IO デバイス）

このタブ上の設定は、すべてのデバイスについて共通です。115 ページの 7.3.5
を参照してください。

10.6.7 ランタイムのオプション

LIN バスは ES1223 プロセッサによって割り込みモードで使用されます。この割り
込み管理のため、送受信コマンドに 250 µs までのディレイを持たせることができ
ます。

10.7 ES1231-ETK

ETK インターフェースボードの ES1231 は ES1200 ボードの後継モデルで、
ES1200 と同様、ETK 搭載の ECU を実験システムにリンクさせるために使用され
ます。

このボードでは、ブロック転送モードの導入や転送レートの向上など、先代モデ
ルに比べて機能が強化されていて、はるかに高速なデータ転送を行なうことがで
きます。このボードは、メモリを節約できる“Auto-ID”技術も装備しています。

10.7.1 Globals（ES1231-ETK サブシステム）

図 10-29 ES1231-ETK アイテムの“Globals”タブ

注記

ES1231 ボードには、ETK と通信するための特別なシステムサービスが必要で
す。このサービスは ES1120（VCU2）システムコントローラボードによっての
み提供されます（69 ページの「ハードウェア - ES1000.x 実験システム」とい
う項を参照してください）。
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ボード番号を入力します。

ES1231 には ETK コントローラが 1 基しかないので、“ETK-CTRL”アイテムは 1
つしか挿入できません。使用できるポートはポート A のみです。

10.7.2 Globals（ETK-CTRL サブシステム）

141 ページの「Globals（ETK-CTRL サブシステム）」という項を参照してくださ
い。

10.7.3 Globals（ETK-BYPASS デバイス）

143 ページの「Globals（ETK-BYPASS デバイス）」という項を参照してください。

10.7.4 Groups（ETK-BYPASS デバイス）

150 ページの「Groups（ETK-BYPASS デバイス）」という項を参照してください。

注記

ES1231 ボードは、システムがオンになったときにハードウェアマネージャに
より ID 番号およびフリーアドレススペースが自動的に割り当てられる“Auto-
ID”ボードと呼ばれるタイプのボートです。同じタイプのボードが複数（例、
ES1231 が 2 枚）ある場合には、左から右の順に番号が付けられます。つまり、
一番左のボードの番号が 1 になり、次の番号が 2 になります。1 つの実験シス
テムでは最大 4 枚のボードを稼働させることができるため、4 種類の ID を指定
できます。
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10.7.5 Signals（ETK-BYPASS デバイス）

図 10-30 ETK-BYPASS デバイスの“Signals”タブ

この“Signals”タブには、10.3.5「Signals（ETK-BYPASS デバイス）」の項で説明
されている ETK バイパスの“Signals”タブの内容に加え、さらに以下の 2 つのカ
ラムが含まれています。
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ES1231 は、ETK コントローラから 1 バイト（8 ビット）または 1 ワード（16
ビット）ずづデータを読み込みますが、ASAM-MCD-2MC および HWC エディタ
では、それ以外にビットシグナル（1 ビット）を使用することができます。この

“Bit Mask (hex)”フィールドに入力されたビットマスクと ECU から読み込んだ値
が AND 演算されてビットシグナルとなります。

1 バイトの値からは、8 種類のマスク（0x1、0x2、0x4、0x8、0x10、0x20、
0x40、x80）によって 8 個のビットシグナルが作成されます。また FAR アドレス
の場合、マスク（0x00FFまたは 0xFF00）によって、1 つのワード値から 2 つ
のバイト値が作成されます。

このカラムはデフォルトでは非表示になっています。

注記

“Signals”タブにはバイパス変数用ステータス値が表示されます。このタブに
はユーザーが編集できる項目はありません。
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1 つのバイト値から複数のシグナルが生成される際、システムはその値がすでに
読み込まれている値であることを認識すると、転送時間を節約するため、その値
のローカルコピーを使用します。この機能を使用するには、1 つのアドレス内の
先頭のシグナルのみ“Transfer”カラムを Yesにし、他のシグナルは Noにしま
す。

10.7.6 Mappings（ETK-BYPASS デバイス）

このタブ上の設定は、すべてのデバイスについて共通です。115 ページの 7.3.5
項を参照してください。

10.8 ES1232-ETK

ETK インターフェースボードの ES1232 は ES1231 の後継モデルで、実験システ
ムに 1 台の ECU と ETK をリンクするために使用されます。

このボードは、ES1231 の機能がさらに拡張されていて、間接アドレッシングの機
能を持ち、転送レートは 8Mbit または 100Mbit を使用できます。また最大 32 の
測定ラスタに対応し、新しいバージョンの ASAM-MCD-2MC ファイル（AML 
V1.2.0 ）にも対応しています（10.8.5「Globals（ETK-CTRL-ADV サブシステム）」
の項を参照してください）。また、シリアル ETK も使用できます。

10.8.1 Globals（ES1232-ETK サブシステム）

図 10-31 ES1232-ETK アイテムの“Globals”タブ
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ボード番号を入力します。この番号は VME システム内のボードの並び順を表わし
ます。たとえば 1 番左側に挿入された ES1232 には ID1を選択し、2 番目の
ES1232 には ID2を選択してください。

ES1232 には ETK コントローラが 1 基しかないので、この下のレベルには“ETK-
CTRL”アイテムを 1 つしか挿入できません。使用できるポートはポート A のみで
す。

10.8.2 ETK-CTRL-BAS サブシステム

図 10-32 ETK-CTRL-BAS サブシステムの“Globals”タブ

ETK-CTRL-BAS の設定方法は、ES1201 ETK デバイスの ETK-CTRL アイテム（186
ページ、10.7「ES1231-ETK」の項を参照してください）の場合と同じですが、さ
らに以下の“ETK Connection”オプションが含まれます。

注記

ES1232 ボードは、システムがオンになったときにハードウェアマネージャに
より ID 番号およびフリーアドレススペースが自動的に割り当てられる“Auto-
ID”ボードと呼ばれるタイプのボートです。同じタイプのボードが複数（例、
ES1232 が 2 枚）ある場合には、左から右の順に番号が付けられます。つまり、
一番左のボードの番号が 1 になり、次の番号が 2 になります。1 つの実験シス
テムでは最大 4 枚のボードを稼働させることができるため、4 種類の ID を指定
できます。
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ボードの転送レート（8 Mbit/s または 100 Mbit/s）が表示されます。この値は
ASAM-MCD-2MC ファイルから読み込まれたもので、ここで変更することはでき
ません。

10.8.3 ETK-BYPASS デバイス

ETK-CTRL-BAS サブシステムの ETK-BYPASS デバイスの設定方法は、ES1231 ETK
ボードの ETK-BYPASS アイテムと同じです。10.7「ES1231-ETK」の項を参照して
ください。

10.8.4 旧バージョンのプロジェクトを 100 Mbit/s で使用する（ETK-CTRL-BAS サブ

システム）

ES1231 で使用していた旧バージョン（AML V1.1.0）のプロジェクトを、ES1232
および ETK-CTRL-BAS サブシステム環境で使用することができます。

転送レートは ASAM-MCD-2MC ファイル（*.a2l）の TP_BLOBで定義され、
AML V1.1.1 以降のバージョンでは、INTERFACE_SPEEDパラメータが使用され
ます。

旧バージョンのプロジェクトを使用する場合、高速レート（100 Mbit/s）を使用
しなければ、ASAM-MCD-2MC ファイルを変更する必要はありません。以下のよ
うに設定してください。

旧バージョンのプロジェクトを 8 Mbit/s で使用する：

• HWC エディタで、以下のようなアイテムツリー
を作成します（7.2 項と 11.2.3 項を参照してくだ
さい）。

• Edit → Copy → Item(s) および  Hardware →
Paste → to selected Item を使用して、今まで使
用していた ES1231 の ETK-BYPASS デバイスを、
そのまま ES1232 にコピーします。
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• Edit → Copy → Item Data およびEdit→Paste → 
Data to selected Item を使用して、ES1231 の
ETK-BYPASS のデータを ES1232 にコピーします。

• ETK-BYPASS デバイス（ES1232/ETK-CTRL-BAS）
の“Globals”タブの“ASAM-2MC Project”
フィールドをクリックして、ASAM-MCD-2MC
ファイルを選択します（144 ページの「ASAM-
2MC Project」を参照してください）

ASCET モニタウィンドウに、以下のようなワーニ
ングメッセージが表示されます。

Parameter 'Interface Speed' is 
missing in A2L/TP_BLOB: old TP_BLOB 
version 0x1000001. Using default: 8 
MBit

ETK-CTRL-BAS アイテムの“Globals" タブ上の
“ETK Connection”の行には、転送レート 8 Mbit/
s が表示されます。

注記

ES1231 と ETK-CTRL-BAS サブシステムを組み込んだ ES1232 の間でのみ、
ETK-BYPASS デバイスまたはそのデータのみをコピーすることができます。
他のアイテムやデータをコピーしようとすると、エラーメッセージが表示され
てコピーは行なわれません（次の図を参照してください）。
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ES1231 を使用していた旧バージョンのプロジェクトに高速レート（100 Mbit/s）
を適用するには、ASAM-MCD-2MC ファイルの内容を変更し、HWC エディタで
も設定を変更する必要があります。

旧バージョンのプロジェクトを 100 Mbit/s で使用する：

• HWC エディタで、必要なアイテムツリーを作成
します（191 ページを参照してください）。

• テキストエディタでASAM-MCD-2MCファイルを
開きます。

AML V1.1.0 では、TP_BLOBは以下のように定義
されています。

/begin TP_BLOB 0x1000001 0x0 0x0

/begin DISTAB_CFG  0xC 0x1 MSB_LAST 0x383000 0x0

TRG_MOD 0xB7 

/end DISTAB_CFG 

CODE_CHK 

0x0

0x0

0x0

0x0

ETK_CFG 0xF 0xF0 0xFF 0x3 0xFD 0xEE 0xFF 0x1 

RESERVED 0x810000 0x8103F9 EXTERN 0x-1 0x-1 0x-1
 0x-1 0x-1

/end TP_BLOB 

この TP_BLOBの第 1 行目は、わかりやすいよう
にコメントを加えると、以下のようになります。

/begin TP_BLOB 
0x1000001 /* TP_BLOP version */
0x0 /* Project Base Address */
0x0 /* RstCfg parameter (MPC) */
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• 100 Mbit/s で転送を行なうには、TP_BLOBのバー
ジョンを新しくする必要があります。そのために
は、Project base Addressパラメータを
INTERFACE_SPEEDパラメータに置き換えます。

AML V1.1.1/V1.2 では、この行を以下のように変
更してください。

/begin TP_BLOB 
0x1000100 /* TP_BLOP version */
2 /* InterfaceSpeed 1=8MBit, 2=100MBit */
0x0 /* RstCfg parameter (MPC) */

• ファイルを保存します。

• コンポーネントマネージャのメニューで Project 
→  Read ASAM-2MC を選択して、今変更した
ファイルをデータベースに読み込みます。

• HWC エディタで、ETK-BYPASS デバイス
（ES1232/ETK-CTRL-BAS）の“Globals”タブを開
きます。

• “ASAM-2MC Project”のフィールドをクリックし
て、今インポートした ASAM-MCD-2MC プロ
ジェクトを選択します（144 ページの「ASAM-
2MC Project」を参照してください）。

ETK-CTRL-BAS アイテムの“Globals" タブ上の
“ETK Connection”の行には、転送レート 100 
Mbit/s が表示されます。

注記

100 MBit/s を使用するための上記の変更は、必ず
IF_DATA ETKセクションの TP_BLOBについて行
なってください。
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10.8.5 Globals（ETK-CTRL-ADV サブシステム）

ETK-CTRL-ADV サブシステムの“Globals”タブで、物理的な ETK コントローラ
（ETK ポート）を ETK-CTRL サブシステムに割り当てます。

図 10-33 ETK-CTRL-ADV サブシステムの“Globals”タブ
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ES1201（10.3.2 項を参照してください）の場合はこの行で ETK チャンネル（Port 
A、Port B）を選択しますが、ES1232 の場合は Port A しか使用できません。
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ETK バイパスを行なうには、ASAM-MCD-2MC ディスクリプションファイルを
データベースに読み込んで作成される ASAM-MCD-2MC プロジェクト（AML 
V1.2）が必要です。145 ページの図 10-8 に、使用するプロジェクトを選択する
ためのダイアログボックスが示されています。

バイパスについての記述は、ASAM-MCD-2MC ファイルの IF_DATA ETK セク
ションに含まれます。旧バージョンでは IF_DATA ASAP1B_ETK というセクショ
ン名が使用される場合がありましたが、これは ES1232 の ETK-CTRL-ADV サブシ
ステムではサポートされていません。

各バイパスチャンネルごとに、チャンネル設定を定義する QP_BLOBがあり、そ
の例は 134 ページの「AML V1.1 以外のバージョン」の項に示されています。
TP_BLOBには、以下のような一般的な設定が含まれます。

/begin TP_BLOB 

0x1000100 /* TP_BLOP version */

2 /* InterfaceSpeed 1=8MBit, */
/* 2=100MBit */

0x0 /* RstCfg parameter (MPC) */

/begin DISTAB_CFG  0xC 0x1 MSB_LAST 0x383000 0x0

 TRG_MOD 0xB7 

/end DISTAB_CFG 

CODE_CHK 0x0 0x0 0x0 0x0

ETK_CFG 0xF 0xF0 0xFF 0x3 0xFD 0xEE 0xFF 0x1 

RESERVED 0x810000 0x8103F9 EXTERN 0x-1 0x-1 0x-1
0x-1 0x-1

/end TP_BLOB 

注記

AML V1.1 を使用した ASAM-MCD-2MC プロジェクトは読み込めません。その
ようなプロジェクトをデバイスに割り当てようとすると、次のようなエラー
メッセージが出力されます。
Error: Incompatible version 0x<version> of QP_BLOB found 
in SOURCE ’<sName>’. Expected version = 0x1. Selected 
ASAM-2MC Project is not suitable for the advanced ETK 
Controller ETK-CTRL-ADV ! Please select another one!

注記

DISTAB_CFGセクション内のパラメータは 128 ページの例を参照してくださ
い。また CODE_CHKおよび RESERVED セクションについては 144 ページを参
照してください。
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ES1232/ETK-CTRL-ADV の場合、ES1201、ES1231、および ES1232/ETK-CTRL-
BAS とは異なり、すべての設定を ASAM-MCD-2MC ファイルから読み込む必要が
あり、HWC エディタからのマニュアル設定は行なえません。

ローカル BLD 定義についても同様で、HWC エディタでのマニュアル設定は行な
えず、ASAM-MCD-2MC ファイルの MEASUREMENTセクション内において、必要
な情報が KP_BLOBを使用して定義されている必要があります。

/begin MEASUREMENT log_uint8_0_A 

"" 

UBYTE 

ident 

1 

100

0.0 

1.0 

READ_ONLY 

BIT_MASK 0x8 

ECU_ADDRESS 0xFD00

/begin IF_DATA ASAP1B_Bypass 

 /begin KP_BLOB 

BUFFER_OFFSET
"log_uint8_0_offset_A.Model_Byp_A"

/* no SOURCE_ID */

BIT_OFFSET
"log_uint8_0_bitOffset_A.Model_Byp_A"

POSSIBLE_SOURCES 5 

 /end KP_BLOB 

/end IF_DATA 

/end MEASUREMENT

上の MEASUREMENTセクションには、148 ページの例と同じ内容が定義されてい
ます。
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ECU とデータ交換に使用される DISTAB バージョンが表示されます。この情報は、
ASAM-MCD-2MC プロジェクトから取得されます（128 ページを参照してくださ
い）。

• DISTAB12 では、2 バイトまでのデータを扱えます。

• DISTAB13 では、1、2、4、8 バイトのデータを扱えます。
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ECU プロセッサがデータメモリをアクセスする際のアクセスモード（Byte ／
Word）が表示されます。この項目は、DISTAB12 が使用される場合にのみ有効で
す。

この情報は ASAM-MCD-2MC プロジェクトから取得されます（128 ページを参照
してください）。
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ワードデータの格納フォーマット（MSB first ／ MSB last）が表示されます。この
情報は ASAM-MCD-2MC プロジェクトから取得されます（128 ページを参照して
ください）。
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DISTAB プロセスのトリガセグメントアドレスが表示され、編集は行なえません。
この情報は ASAM-MCD-2MC プロジェクトから取得されるので（128 ページを参
照してください）、あらかじめ適切なパラメータが定義されている必要がありま
す。

トリガセグメントアドレスによって、バイパスチャンネル経由で行なわれるデー
タ転送に使用されるハードウェアトリガアドレスの位置が決まります。この位置
は、DISTAB データ交換メソッド内で固定されています。

64 バイトのトリガセグメントの先頭アドレス（8 ビット幅または 16 ビット幅の
バスアクセスの場合）は、64 で割り切れる偶数のアドレスでなければなりませ
ん。また、128 バイトのトリガセグメントの先頭アドレス（32 ビット幅のバスア
クセスの場合）は、128 で割り切れるアドレスでなければなりません。

トリガセグメントのフォーマットは、DISTAB 12 および DISTAB 13 インター
フェースに定義されています。

réÇ~íÉ=lå

パラレル ETK を使用するバイパス通信において、シミュレーションボードと ECU
間のディスプレイテーブルの転送（129 ページの「バイパス通信（AML V1.1）」
を参照してください）を、ETK のどのページ（Working Page、Reference 
Page、Working & Reference Page）で行うかを選択します。

シリアル ETK の場合は、すべてのディスプレイテーブルが RAM 領域内に位置す
るため、自動的に RAM ページが選択されます。この設定は変更できません。

bqh=`çååÉÅíáçå

ボードの転送レート（8 Mbit/s または 100 Mbit/s）が表示されます。この値は
ASAM-MCD-2MC ファイルから読み込まれたもので、ここで変更することはでき
ません。
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réÇ~íÉ=lÑÑëÉíë=lå

パラレルまたはシリアル ETK を使用するバイパス通信において、シミュレーショ
ンボードと ECU 間のバイパスオフセットの転送（129 ページの「バイパス通信

（AML V1.1）」を参照してください）を、ETK のどのページ（Working Page、
Reference Page、Working & Reference Page、RAM）で行うかを選択し
ます。RAMはシリアル ETK の場合のみ選択できます。

シリアル ETK の場合はデフォルトで RAMページが選択されます。

10.8.6 Globals（ETK-BYPASS-ADV デバイス）

ETK-BYPASS デバイスでは、ES1232/ETK-CTRL-ADV でバイパスを実行するために
必要なすべての設定を行います。

図 10-34 ETK-BYPASS デバイスの“Globals”タブ

^ìíçã~íáÅ=j~ééáåÖ

この項目については、163 ページの「Automatic Mapping」を参照してください。

_óé~ëë=o~ëíÉê=pÉäÉÅíáçå=jçÇÉ

“Groups”タブに、バイパスラスタおよび測定ラスタの両方を表示するか
（Bypass & Measuremnt）、またはバイパスラスタのみを表示するか
（Bypass： デフォルト）を指定します。
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Bypass & Measuremntを選択しておくと、INCA 用フックしか定義されていな
い場合でも、ASCET の実験環境において測定ラスタから取得されたシグナルを測
定することができます。

この設定を変更した際、バイパスラスタ用に選択されているシグナルはすべてそ
のまま保持されますが、測定ラスタ用に選択されているシグナルは、Bypass & 
Measuremntから Bypassに設定を変更すると、すべて選択が解除されます。

バイパスラスタと測定ラスタは同じように扱われますが、異なる点は、バイパス
ラスタが RTIO ドライバによってマスタアクセス用として初期化されるのに対し、
測定ラスタはスレーブアクセス用として初期化される必要がある点です。しかし
INCA は測定ラスタを常にマスタアクセスで使用するため、以下のような場合にエ
ラーが発生する可能性があります。

1. すでに INCA による測定が行なわれている状態で ASCET バイパスを開始す
ると、RTIO ドライバは測定ラスタへのアクセス権が得られず、初期化を
行なえません。

2. ASCET バイパス実験が行なわれている状態で INCA による測定が開始され
ると、INCA の方がより高いアクセス権を持つことになるため、ASCET か
ら測定ラスタを奪い取ってしまうことになります。

どちらの場合も、エラーメッセージが表示されます。

_óé~ëë=s~êá~ÄäÉ=pÉäÉÅíáçå=jçÇÉ

10.3.3 項の「Bypass Variable Selection Mode」（149 ページ）を参照してくださ
い。

_~ëÉ=lÑÑëÉí=s~äìÉ

各バイパス出力データのバイトオフセット（0、2、4、または 8）を選択します。

バイトオフセットのデフォルト値は、DISTAB12 の場合は 0、DISTAB13 の場合は
8 です。

_ÉÖáå=c~ê=^ÇÇêÉëë=o~åÖÉ=EÜÉñF

10.3.3 項の「Begin Far Address Range (hex)」（149 ページ）を参照してください。

iÉåÖíÜ=c~ê=^ÇÇêÉëë=o~åÖÉ=EÜÉñF

FAR アドレス領域のサイズを指定します。一般に、この設定は DISTAB 12 でのみ
使用されます。

j~ñ=c~ê=páÖå~äë=

10.3.3 項の「Max Far Signals」（150 ページ）を参照してください。

içåÖ=^ÇÇêÉëë=^ka=L=lo=j~ëâ=EÜÉñF

10.3.3 項の「Long Address AND / OR Mask (hex)」（150 ページ）を参照してくだ
さい。
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^ÇÇêÉëë=j~ééáåÖ

10.3.3 項の「Address Mapping」（150 ページ）を参照してください。

10.8.7 Groups（ETK-BYPASS-ADV デバイス）

ETK-BYPASS-ADV デバイスのシグナルグループの数は、ASAM-MCD-2MC ファイ
ルに定義されています。バイパスラスタと測定ラスタ用のシグナルグループは、
10.8.6 項の“Globals”タブの「Bypass Raster Selection Mode」に設定された内容
に応じて、自動的に生成または消去されます。

1 つのバイパスラスタには 2 つのシグナルグループ（send-group と receive-
group）が含まれ、測定ラスタには 1 つの receive-group のみが含まれます。

ECU と RTIO 間のデータ交換は、recieve シグナルグループの場合は標準の DISTAB
メソッド、send シグナルグループの場合はバイパステーブルメソッドが使用され
ます。

図 10-35 ETK-BYPASS-ADV デバイスの“Groups”タブ

o~ëíÉê=pÜçêí=k~ãÉ

ラスタのタイプ（MT： 測定ラスタ、BT： バイパスラスタ）と番号（優先度）が
表示されます（例： MT_12 、 BT_31など）。各シグナルグループは、デフォル
トでは、優先度に従って降順にソートされて表示されます。

注記

“Bypass Raster Selection Mode”の設定が Bypass & Measuremntから
Bypassに変更されると、バイパスラスタ用に選択されているシグナルはその
まま残りますが、測定ラスタ用に選択されているシグナルはすべて消去されて
いしまいます。
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この値は ASAM-MCD-2MC プロジェクトから読み込まれるので、編集はできませ
ん。

q~ëâ

10.3.4 項の「Task」（151 ページ）を参照してください。

^Åíáî~íÉÇ=q~ëâ

10.3.4 項の「ActivatedTask」（152 ページ）を参照してください。

_óé~ëë=s~êá~ÄäÉë

10.5.4 項の「Bypass Variables」（177 ページ）を参照してください。

aá~ÖåçëíáÅ=s~êá~ÄäÉ

10.5.4 項の「Diagnostic Variable」（178 ページ）を参照してください。

kçK=páÖå~äë

各シグナルグループ用に選択されているシグナルの数が表示されます。この値は、
シグナル選択を変更するたびに自動的に更新されます。

kçK=_óíÉë

各シグナルグループ用に選択されているシグナルの合計バイト数が表示されます。
この値は、シグナル選択を変更するたびに自動的に更新されます。

pí~êí=_ìÑÑÉê=EÜÉñF

バイパス入力データおよび出力データ用に使用されるデータバッファのベースア
ドレスが表示されます。

この値は ASAM-MCD-2MC プロジェクトから読み込まれるので、編集はできませ
ん。

_ìÑÑÉê=páòÉ=EÜÉñF

バイパス入力データおよび出力データ用に使用されるデータバッファのサイズが
表示されます。

この値は ASAM-MCD-2MC プロジェクトから読み込まれるので、編集はできませ
ん。

e~êÇï~êÉ=qêáÖÖÉê

receive シグナルグループに割り当てられたハードウェアトリガの数が表示されま
す。

この値は ASAM-MCD-2MC プロジェクトから読み込まれるので、編集はできませ
ん。
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qêáÖÖÉê=m~íÜ

receive シグナルグループ用のトリガが発生した時に行なわれるシグナル転送の方
法が表示されます。

• direct - 1 つのラスタが直接ハードウェアトリガに割り当てられます。
ECU がトリガアドレスへの書き込みを行なうと、直ちにデータの取得が行
われます。トリガフラグの読み取りは行なわれません。

• indirect - 複数のラスタが 1 つのハードウェアトリガに割り当てられま
す。トリガを発生させたラスタを判定するために、各ラスタの“Trigger 
Flag Address”を読み取る必要があります。

充分な数のハードウェアトリガが使用可能であれば、直接転送が可能です。シリ
アル ETK の場合は、通常、間接転送しか行なえません。

send シグナルグループの場合、このカラムは使用されないため、“---”と表示
されます。

qêáÖÖÉê=cä~Ö=^ÇÇêÉëë

このカラムは、“Trigger Path”で indirect が選択されているときにのみ使用さ
れ、正しいデータ取得を行なうために各ラスタごとに設定されたトリガフラグの
アドレスが表示されます。この値は、ASAM-MCD-2MC プロジェクトから読み込
まれ、ここで編集することはできません。

他の ETK バイパスデバイスで 8 Mbit/s 転送を行なう場合は、トリガ識別子（152
ページの「Trigger Id (hex)」）がこのトリガフラグに対応します。

“Trigger Path”が directに設定されていると、ここには“---”と表示されま
す。

pí~êí=mçáåíÉê=EÜÉñF

receive シグナルグループについて、DISTAB メソッド用のポインタリストの先頭
アドレスが表示されます。

この値は、ASAM-MCD-2MC プロジェクトから読み込まれ、ここで編集すること
はできません。
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10.8.8 Signals（ETK-BYPASS-ADV デバイス）

図 10-36 ETK-BYPASS デバイスの“Signals”タブ

このタブの内容は、10.3.5 項（153 ページ）および 10.7.5 項（188 ページ）を参
照してください。

10.8.9 Mappings（ETK-BYPASS-ADV デバイス）

このタブ上の設定については、115 ページの 7.3.5 項を参照してください。
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10.9 ES1300-AD

アナログ入力ボード ES1300 は、差動入力（最大 8 チャンネル）またはシングル
エンド（最大 16 チャンネル）のアナログ信号を収集することができます。

10.9.1 Globals（ES1300-AD デバイス）

本項では、ES1300-AD デバイスのグローバルオプションについて説明します。

図 10-37 ES1300-AD デバイスの“Globals”タブ

fåáí=q~ëâ

ES1300 を初期化するためのタスクを指定します（タイプ：Init、アプリケーショ
ンモード：active）。

bñáí=q~ëâ

実験を終了するときに ES1300 の終了処理を行なうタスクを指定します（タイプ：
Init、アプリケーションモード：inactive）。

fa=L=sjb=Ä~ëÉ=~ÇÇêÉëë

VME ベースアドレスの設定を行います。この設定はボード上のジャンパ設定と一
致している必要があります。ES1300 の場合、4 種類の異なる VME ベースアドレ
ス（ID1/E00000h、ID2/E00100h、ID3/E00200h、ID4/E00300h）から選
択することができます。つまり、1 つの ES1000 システムで最大 4 枚の ES1300 を
使用することができ、1 枚の ES1300 はベースアドレスから始まる 256 ワードの
アドレススペースを占有します。
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sçäí~ÖÉ=o~åÖÉ=xsz

ES1300 の各チャンネルの入力電圧範囲を指定します。この設定は、ボード上の
ジャンパ設定と一致している必要があります。-25 ～ 25V、-50 ～ 50V、0 ～ 50V
のいずれかを選択できます。

jÉ~ëìêÉ=qóéÉ

測定タイプとして、差動入力（最大 8 チャンネル）またはシングルエンド（最大
16 チャンネル）を選択します。この設定は、ボード上のジャンパ設定と一致して
いる必要があります。

oÉ~Ç=jçÇÉ

読み取りモードを指定します。ハードウェアドライバによる ASCET への A/D 測定
値の転送を、A/D サンプリングの前と後のどちらに行うかを選択します。以下の
設定が可能です。

• auto： 
ドライバは、前回のラスタの値を転送するか現在のラスタの値を転送する
かを、ASCET がアクセスを 2 回行う間に経過した時間に基づいて決定しま
す。

• wait for new values： 
ドライバは、現在のラスタからサンプル値が送られてきた後に転送を行い
ます。

• get old values： 
ドライバは、サンプリングを行う前に前回のラスタの値を転送します。



10.9.2 Groups（ES1300-AD デバイス）

本項では、ES1300-AD デバイスのシグナルグループごとのオプションについて説
明します。

図 10-38 ES1300-AD デバイスの“Groups”タブ

d~áå=Ñ~Åíçê=J[=xsz

この項目で、アナログ入力信号用のプログラマブルゲインファクタ（1、5、10、
50、100、500）を選択します。ゲインファクタにより、入力電圧の全域の中の限
定された範囲を、より高い分解能で測定することが可能となります。

このカラムには、設定されたゲインファクタによって測定される電圧範囲も表示
されます。この電圧範囲は、入力電圧範囲（205 ページの“Global”タブを参照
してください）とゲインファクタから求められます。
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10.9.3 Signals（ES1300-AD デバイス）

本項では、ES1300-AD デバイスの各シグナルごとのオプションについて説明しま
す。

図 10-39 ES1300-AD デバイスの“Signals”タブ

kçK

ES1300 で使用できるアナログ入力信号の最大数（8/16）は、“Globals”タブの
Measure Type設定（differential/single-ended）によって決まりま
す。

10.9.4 Mappings（ES1300-AD デバイス）

このタブ上の設定は、すべてのデバイスについて共通です。115 ページの 7.3.5
を参照してください。

10.10 ES1301-AD

アナログ入力ボードの ES1301 を使えば、最大 7 点のアナログ信号を取り込むこ
とができます。



10.10.1 Globals（ES1301-AD デバイス）

本項では、ES1301-AD デバイスのグローバルオプションについて説明します。

図 10-40 ES1301-AD デバイスの“Globals”タブ

fåáí=q~ëâ

ES1301 を初期化するためのタスクを指定します（タイプ：Init、アプリケーショ
ンモード：active）。

bñáí=q~ëâ

実験を終了するときに ES1301 の終了処理を行なうタスクを指定します（タイプ：
Init、アプリケーションモード：inactive）。

fa=L=sjb=Ä~ëÉ=~ÇÇêÉëë

VME ベースアドレスの設定を行います。この設定は ES1301 にはんだストラップ
でセットされている設定と一致している必要があります。ES1301 の場合、5 種類
の異なる VME ベースアドレス（ID16/F800h、ID15/F000h、ID14/E800h、
ID12/D800h、ID8/B800h）から選択することができます。つまり、1 つの
ES1000 システムで最大 5 枚の ES1301 を使用することができ、1 枚の ES1301 は
ベースアドレスから始まる 2048 ワードのアドレススペースを占有します。
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10.10.2 Groups（ES1301-AD デバイス）

本項では、ES1301 デバイスのシグナルグループごとのオプションについて説明し
ます。

図 10-41 ES1301-AD デバイスの“Groups”タブ

o~åÖÉ

ES1301 の各チャンネルの入力電圧範囲を指定します。-10 ～ 10V、-5 ～ 5V、0
～ 10V、および 0 ～ 5V の入力電圧範囲から選択することができます。入力電圧
範囲を選択するための設定はソフトウェアにより行われるので、ジャンパ設定は
不要です。

cáäíÉê

各チャンネルについて 2 次のローパスフィルタを設定することができます。フィ
ルタを使用する場合、100Hz、200Hz、500Hz、1KHz、2KHz、5KHz、および
10KHz のいずれかの周波数を選択できます。



10.10.3 Signals（ES1301-AD デバイス）

本項では、ES1301-AD デバイスの各シグナルごとのオプションについて説明しま
す。

図 10-42 ES1301-AD デバイスの“Signals”タブ

ES1301-AD デバイスの“Signals”タブには、このデバイス固有の項目はありませ
ん。

10.10.4 Mappings（ES1301-AD デバイス）

このタブ上の設定は、すべてのデバイスについて共通です。115 ページの 7.3.5
を参照してください。

10.11 ES1303-AD

ES1303 A/D ボードは、最大 16 チャンネルのアナログ信号を、高速サンプリング
レート（最大 100 kHz、信号が複数の場合は 50 ｋHz まで可能）において高分解
能の読み取りを行うことができます。ES1303 は、1 システム内で同時に 4 枚まで
使用できます。

信号の取り込みの開始と終了を 2 つのトリガ入力で制御でき、その際、連続測定
またはシングルショット測定（指定した 1 つの値を測定）を行なえます。詳しく
は、ES1303 のユーザーズガイドを参照してください。

16 の測定チャンネルは、個々に ASCET-RP または INCA で使用できます。つまり、
両方のアプリケーションで 1 枚のボートを共有することができます。ただし、
ES1303 のコンフィギュレーションがすでに INCA から設定されていた場合、
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ASCET-RP でその設定を上書きすることはできず、設定を行おうとするとエラー
メッセージが表示されます。また 2 つのデジタルチャンネルは、いずれか一方の
アプリケーションからしか使用できません。

10.11.1 Globals（ES1303-AD デバイス）

本項では、ES1303-AD デバイスのグローバルオプションについて説明します。

図 10-43 ES1303-AD デバイスの“Globals”タブ

fåáí=q~ëâ

ES1303 を初期化するためのタスクを指定します（タイプ：Init、アプリケーショ
ンモード：active）。

bñáí=q~ëâ

実験を終了するときに ES1303 の終了処理を行なうタスクを指定します（タイプ：
Init、アプリケーションモード：inactive）。

fon=e~åÇäÉê=q~ëâ

シグナルチャンネルを割り込みモードで測定する場合、ここに IRQ ハンドラタス
ク（タイプ：Software、アプリケーションモード：active）を指定します。



このタスクは、ASCET プロジェクトエディタ上のタスクリスト内に“Software”
タスクとして定義し、“Max. number of Activations”フィールドの値は 2 以上

（最大は 50）に設定してください。

この項目は、ハードウェアトリガモード（「HW Trigger Mode」を参照してくださ
い）が off に設定されている場合、無効となります。

fa

ボード番号を入力します。

^åíáJ^äá~ëáåÖ=cáäíÉê

アンチエイリアシングフィルタをオン（On）またはオフ（Off）にします。この
フィルタによって入力信号の周波数域が限定され、サンプリングの一般原則（「サ
ンプリングレートは入力信号の周波数の 2 倍以上でなければならない」という条
件）が守られます。

HWC エディタからのフィルタの ON/OFF は全チャンネル同時に行われますが、
ハードウェア自体には、それぞれ 4 つのチャンネルを含む 4 つのチャンネルグ
ループ（ch1 ～ 4、ch 5 ～ 8、ch9 ～ 12、ch13 ～ 16）ごとに切り替えを行なう
機能があります。そのため、ASCET と INCA で同じグループ内のチャンネルを異
なるフィルタ設定でアクセスを行なうと、問題が生じます。たとえば、ASCET が
チャンネル 1 と 2 をフィルタなしでアクセスし、INCA がチャンネル 3 と 4 を
フィルタを使用してアクセスした場合、同じグループに属するそれらのチャンネ
ルは同じ設定である必要があるため、矛盾が発生してしまいます。このような場
合は、エラーメッセージが表示されるので、たとえば INCA でチャンネル 3 と 4
の代わりに 5 と 6 を使用するように変更してください。

アンチエイリアシングフィルタは、100 kHz のサンプリングレート用に最適化さ
れています。このフィルタが使用されない場合は、代わりにローパスフィルタ

（カットオフ周波数 255 kHz）が使用されます。

注記

このタスクは、デバイスとそれに対応するハードウェアドライバ専用のもので
ある必要があり、他のデバイスやユーザープロセスと共有することはできませ
ん。同じタイプのデバイス（たとえば 2 枚の ES1303）であっても、同じタス
クの共有はできません。

注記

ES1303 は、システムがオンになったときにハードウェアマネージャにより ID
番号およびフリーアドレス領域が自動的に割り当てられる、“Auto-ID”ボード
と呼ばれるタイプのボードです。同じタイプのボードが複数存在する場合には、
左から右の順に番号が付けられます。つまり、一番左のボードの番号が 1 にな
り、その次の番号は 2 になります。1 つの実験システムでは最大 4 枚のボード
を使用することができ、4 種類の ID を指定できます。
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et=qêáÖÖÉê=jçÇÉ

トリガ測定を開始する際のトリガモードを指定します。以下のモードから選択で
きます。

• Off： トリガ信号を使用しません。

• Rising Edge： トリガ信号の最初の立ち上がりエッジで測定を開始しま
す。『ES1303 ユーザーズガイド』のモード 3 についての説明を参照してく
ださい。

• Falling Edge： トリガ信号の最初の立ち下がりエッジで測定を開始し
ます。『ES1303 ユーザーズガイド』のモード 4 についての説明を参照して
ください。

“Groups”タブで“IRQ”のカラムが No に設定されているシグナルグループ
（215 ページの「IRQ」を参照してください）については、トリガモード設定は無
効です。

et=qêáÖÖÉê=d~íÉ

トリガの生成のために第 2 のトリガ信号を使用する（ON）かしない（OFF）かを
指定します。

トリガゲートが ON に設定されていると、トリガモードに基づいて 1 番目のトリ
ガ信号の最初のエッジが検出された時、2 番目のトリガ信号が High になっている
場合にのみ測定が開始されます。トリガモードが OFF になっていれば、1 番目の
トリガ信号によってのみ測定が開始されます。以下の表は、測定が開始される条
件をまとめたものです。

“Groups”タブで“IRQ”のカラムが No に設定されているシグナルグループ
（215 ページの「IRQ」を参照してください）については、トリガゲート設定は無
効です。

HW Trigger Mode
（トリガモード）

HW Trigger Gate
（トリガゲート）

トリガ信号 1 トリガ信号 2

Rising Edge On 立ち上がりエッジ High

Rising Edge Off 立ち上がりエッジ 不使用

Falling Edge On 立ち下がりエッジ High

Falling Edge Off 立ち下がりエッジ 不使用



10.11.2 Groups（ES1303-AD デバイス）

本項では、ES1303-AD デバイスのシグナルグループごとのオプションについて説
明します。

図 10-44 ES1303-AD デバイスの“Groups”タブ

16 個のシグナルグループが定義されていて、各シグナルグループごとに 1 つのシ
グナルが割り当てられています。

q~ëâ

シグナルの受信タスクを指定します。複数のラスタから受信を行なう場合は複数
のタスクを指定します。

受信が割り込みモードで行なわれる場合は、このカラムの内容はリセットされ、
入力もできません。

fon

シグナルの受信を割り込みモード（Yes）で行なうかどうかを指定します。この
項目は、ハードウェアトリガモード（「HW Trigger Mode」を参照してください）
が off に設定されている場合、無効となります。

注記

ES1303 は、将来的には 8 チャンネルのみをサポートするようになります。
HWC エディタ上で 8 チャンネル以上のチャンネルが定義されていて、実際の
ボードには 8 チャンネルしか搭載されていない場合、モデルの実行開始時にエ
ラーメッセージが表示されます。その場合、ES1303 は無視されます。
215



216
通常の受信処理（No）の場合は、シャノンの定理に従い、受信タスクのサンプリ
ング周波数を、測定する入力信号の 2 倍以上にする必要があります（『ES1303
ユーザーズガイド』の 3.1.2 項を参照してください）。固定ラスタで測定されない
信号や散発的にしか発生しない信号は、割り込みモードを使用し、発生した信号
が確実に処理されるようにしてください。

各シグナルグループは個々に異なる設定を行なえます。“Trigger Mode”と
“Trigger Gate”は、割り込みモードで受信されるすべてのシグナルグループに適
用されます。

空のシグナルグループ、つまり IRQ もタスクも指定されていないグループについ
ては、プロセスが生成されません。ASCET モニタウィンドウにワーニンメッセー
ジが表示されます。

sçäí~ÖÉ=o~åÖÉ=xsz

測定チャンネルの入力電圧範囲（-10 ～ 10V または -60 ～ 60V）を選択します。

10.11.3 Signals（ES1303-AD デバイス）

本項では、ES1303-AD デバイスの各シグナルごとのオプションについて説明しま
す。

図 10-45 ES1303-AD デバイスの“Signals”タブ

ES1300（10.9.3 項）の場合とは異なり、この“Signals”タブでは変換式しか編集
できません。その他のカラムについては、7.3.4 項に説明されています。

10.11.4 Mappings（ES1303-AD デバイス）

このタブ上の設定は、すべてのデバイスについて共通です。115 ページの 7.3.5
を参照してください。



10.12 ES1310-DA

アナログ出力ボードの ES1310 を使えば、8 点のアナログ信号を出力することが
できます。

10.12.1 Globals（ES1310-DA デバイス）

本項では、ES1310-DA デバイスのグローバルオプションについて説明します。

図 10-46 ES1310-DA デバイスの“Globals”タブ

fåáí=q~ëâ

ES1310 を初期化するためのタスクを指定します（タイプ：Init、アプリケーショ
ンモード：active）。

bñáí=q~ëâ

実験を終了するときに ES1310 の終了処理を行なうタスクを指定します（タイプ：
Init、アプリケーションモード：inactive）。

fa=L=sjb=Ä~ëÉ=~ÇÇêÉëë

この行では、VME ベースアドレスの設定を行います。この設定はボード上のジャ
ンパ設定と一致している必要があります。ES1310 の場合、2 種類の異なる VME
ベースアドレス（ID1/E10000h、ID2/E20000h）から選択することができま
す。つまり、1 枚の ES1000 システムで最大 2 枚の ES1310 を稼働させることがで
き、１枚の ES1310 はベースアドレスから始まる 1024 ワードのアドレススペー
スを占有します。
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10.12.2 Groups（ES1310-DA デバイス）

図 10-47 ES1310-DA デバイスの“Groups”タブ

ES1310-DA デバイスの“Groups”タブには、このデバイス固有の項目はありませ
ん。

10.12.3 Signals（ES1310-DA デバイス）

図 10-48 ES1310-DA デバイスの“Signals”タブ

ES1310-DA デバイスの“Signals”タブには、このデバイス固有の項目はありませ
ん。



10.12.4 Mappings（ES1310-DA デバイス）

このタブ上の設定は、すべてのデバイスについて共通です。115 ページの 7.3.5
を参照してください。

10.13 ES1320-CB（DIO）

デジタル入出力ボードの ES1320（DIO）を使えば、20 点のデジタル信号の測定
や出力を行なうことができます。ES1320 は 2 つの DIO ピギーバックボードを搭
載したキャリアボード（CB）です。

HWC エディタのアイテムリストに組み込む際は、キャリアボードはサブシステム
として追加し、DIO ピギーバックボードはデバイスとして追加します。

10.13.1 Globals（ES1320-CB サブシステム）

本項では、ES1320-CB サブシステムのグローバルオプションについて説明しま
す。

図 10-49 ES1320-CB サブシステムの“Globals”タブ

fa=L=sjb=Ä~ëÉ=~ÇÇêÉëë

この行では、VME ベースアドレスの設定を行います。この設定はボード上のジャ
ンパ設定と一致してしている必要があります。ES1320 の場合、8 種類の異なる
VME ベースアドレス（ID1/FE0400h、ID2/FE0C00h、ID3/FE1400h、ID4/
FE1C00h、ID5/FE2400h、ID6/FE2C00h、ID7/FE3400h、ID8/FE3C00h、
ID9/FE4400h、ID10/FE4C00h、ID11/FE5400h、ID12/FE5C00h、
ID13/FE6400h、ID14/FE6C00h、ID15/FE7400h、ID16/FE7C00h）から
219



220
選択することができます。つまり、1 つの ES1000 システムで最大 8 枚の ES1320
を稼働させることができ、１枚の ES1320 はベースアドレスから始まる 256 ワー
ドのアドレススペースを占有します。

10.13.2 Globals（DIO デバイス）

本項では、DIO デバイスのグローバルオプションについて説明します。

図 10-50 DIO デバイスの“Globals”タブ

fåáí=q~ëâ

ES1320 を初期化するためのタスクを指定します（タイプ：Init、アプリケーショ
ンモード：active）。

bñáí=q~ëâ

実験を終了するときに ES1320 の終了処理を行なうタスクを指定します（タイプ：
Init、アプリケーションモード：inactive）。

máÖÖóÄ~Åâ=mçëáíáçå

デジタルインターフェースとして使用する DIO ピギーバックボード（Upper(A)
または Lower(B)）を選択します。



10.13.3 Groups（DIO デバイス）

図 10-51 DIO デバイスの“Groups”タブ

DIO デバイスの“Groups”タブには、このデバイス固有の項目はありません。
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10.13.4 Signals（DIO デバイス）

本項では、DIO デバイスの各シグナルごとのオプションについて説明します。

図 10-52 DIO デバイスの“Signals”タブ

^ÅíáîÉ=pí~íÉ

信号が反転信号（Active Low）かそうでない（Active High）かを指定しま
す。

10.13.5 Mappings（DIO デバイス）

このタブ上の設定は、すべてのデバイスについて共通です。115 ページの 7.3.5
を参照してください。

10.14 ES1325-DIO

デジタル入／出力ボード ES1325（DIO）は、デジタル信号の取り込みと出力を、
それぞれ 16 点のチャンネルで行うことができます。また 2 つのトリガ入力によ
り、信号の取り込みと出力を制御することも可能です。1 枚の ES1130 または
ES1135 について、最大 4 枚の ES1325 ボードを使用できます。RTIO においては、
1 枚の ES1325 ボードについて、Input デバイス、Output デバイス、LED デバイ
スを、それぞれ最大 1 つずつまで組み込むことができます。



10.14.1 Globals（ES1325-DIO サブシステム）

本項では、ES1325-DIO サブシステムの一般的なオプションについて説明します。

図 10-53 ES1325-DIO サブシステムの“Globals”タブ

fa

ここでは、ボード番号を示す ID をボードに割り当てます。

et=qêáÖÖÉê=jçÇÉ

トリガ測定を開始する際のトリガモードを指定します。以下のモードから選択で
きます。このオプションは、“HW Trigger Gate”が On に設定されている場合にの
み有効です（225 ページの「HW Trigger Gate」を参照してください）。

以下のトリガモードを選択できます。

注記

ES1325 ボードは、システムがオンになったときにハードウェアマネージャによ
り ID 番号およびフリーアドレス領域が自動的に割り当てられる、“Auto-ID”
ボードと呼ばれるタイプのボードです。同じタイプのボードが複数（たとえば
ES!325 ボードが 2 枚）存在する場合には、左から右の順に番号が付けられま
す。つまり、一番左のボードの番号が 1 になり、その次の番号は 2 になります。
1 つの実験システムでは最大 4 枚のボードを使用することができ、4 種類の ID
を指定できます。
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• Off 

トリガ入力信号を使用しません。

• Rising edge

トリガ入力 1 の信号の立ち上がりエッジにおいて、デジタル入力チャンネ
ルからの信号の取り込みや、デジタル出力チャンネルへの信号出力（信号
生成）が行われます。以下の図は、“HW Trigger Gate”がオンになってい
る場合のトリガ信号の生成パターンを示しています。

• Signal state 

トリガ入力 1 の信号の立ち上がりエッジによってデジタル入出力信号の取
り込みや出力が開始し、立ち下がりエッジで終了します。つまり、トリガ
入力 1 がアクティブレベルである間、信号入出力が行われます。

以下の図は、“HW Trigger Gate”がオンになっている場合のトリガ信号の
生成パターンを示しています。

“Signal state”トリガモードでは、オプション設定により、信号入出力処
理のリクエストのタイミングを遅延させることができます（233 ページの

「Signals」を参照してください）。ただしこの遅延時間はトリガ信号のホー
ルド時間よりも短くする必要があります。ホールド時間以上に設定する
と、入出力処理が開始されなくなってしまいます。

• Angle based 

トリガ入力 1 とトリガ入力 2 によって、クランクシャフトの回転角を算出
します。

各トリガ入力には、以下のクランクシャフト信号を接続します。

エッジトリガ

生成されたトリガ信号

トリガユニット

トリガチャンネル 1

トリガチャンネル 2

&

ステートトリガ

生成されたトリガ信号

トリガユニット

トリガチャンネル 1

トリガチャンネル 2



－ トリガ入力 1： ゼロトランジション（角度リセット信号）

－ トリガ入力 2： 歯幅

トリガ入力 2 においては、1 つの PWM 周期が 1 つの角度セグメントに相
当します。2 つのトリガ入力を組み合わせて PWM 周期をカウントするこ
とにより、角度位置、つまり現在の回転角が算出されます。

このトリガモードにおいては、トリガユニット上で、2 つのトリガ入力に
よって角度カウンタがカウントされます。

トリガ入力 1 の立ち上がりエッジでカウンタがゼロにリセットされ、トリ
ガチャンネル 2 の立ち下がりエッジでカウンタ値が 1 だけ大きくなりま
す。これにより、一定の角度セグメント（例えば、歯幅 6°）ごとにトリガ
入力 2 の立ち下がりエッジが検出され、さらにクランクシャフトが 1 回転
するたびに（つまり 0º へのトランジションの時に）トリガ入力 1 の立ち上
がりエッジが検出されるようにすれば、現在のクランク角が取得できま
す。

正しい動作を保証するためには、トリガ入力 2 の信号は、連続する等間隔
の角度セグメントを示す必要があり、トリガ入力 1 の信号の立ち上がり
エッジによって、ゼロトランジションのタイミングが示される必要があり
ます。また、トリガ 1 の立ち下がりエッジは、トリガ入力 2（角度セグメ
ント信号）の立ち下がりエッジ後、所定のホールド時間の後に発生する必
要があります。

上記の図に示されているように、トリガモード Rising edge および Signal 
state の場合、トリガチャンネル 2 をトリガゲートとして定義することもでき
ます（225 ページの「HW Trigger Gate」を参照してください）。

et=qêáÖÖÉê=d~íÉ

トリガ入力のエッジ検出を行うモードを設定します。このパラメータがオンに
なっていると、トリガ入力 2 がゲート信号として使用されます。つまり、トリガ
入力 2 がイネーブル状態（=TTL High）である時にのみトリガ入力 1 の信号が有効
になります。

以下のモードを使用できます。

• Off 

トリガ入力 1 において、“HW Trigger Mode”で指定されたエッジが検出
されるたびに、デジタル入出力処理が行われます。

角度ベース

生成されたトリガ信号

トリガユニット

トリガチャンネル 1

トリガチャンネル 2
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• On 

トリガ入力 2 が HIGH レベルになっている間のみ、トリガ入力 1 の所定の
エッジによってデジタル入出力処理が行われます。

トリガモードとして Angle based が選択されている場合（223 ページの「HW 
Trigger Mode」を参照してください）、“HW Trigger Gate”パラメータは自動的に

“On”になっています。また、トリガモードが Off になっている場合は、“HW 
Trigger Gate”パラメータを編集することはできません。

wÉêç=qê~åëáíáçå=xGz

トリガ入力 1 のゼロトランジション信号について定義します。

このオプションはトリガモードが Angle based である場合にのみ使用でき
（223 ページの「HW Trigger Mode」を参照してください）、上記の値の範囲内で
編集できます。

qççíÜ=táÇíÜ=xGz

トリガ入力 2 について、1 つの PWM 周期分に相当する歯幅を定義します。

このオプションはトリガモードが Angle based である場合にのみ使用でき
（223 ページの「HW Trigger Mode」を参照してください）、上記の値の範囲内で
編集できます。

分解能 歯幅

値の範囲 最小 2 ×歯幅

最大 32767 ×歯幅

クランク信号としての典型的な値 360° または 720°

分解能 0.5°

値の範囲 最小 0.5°

最大 720°

クランク信号としての典型的な値 6°



10.14.2 Globals（ES1325-Input デバイス）

本項では、Input デバイスの一般的なオプションについて説明します。

図 10-54 ES1325-DIO Input デバイスの“Globals”タブ

fon=e~åÇäÉê=q~ëâ

各シグナルチャンネルを割り込みモードで評価する場合は、この“IRQ Handler 
Task”（タイプ：Software、アプリケーションモード：active）が必要です。

このタスクは、ASCET プロジェクトエディタ上のタスクリスト内に“Software”
タスクとして定義し、“Max. number of Activations”フィールドの値は 2 以上

（最大は 50）に設定してください。

このオプションは、トリガモードが Offになっている場合は、使用されません
（223 ページの「HW Trigger Mode」を参照してください）。

注記

このタスクは、アイテムとそれに対応するハードウェアドライバごとに個別の
ものを指定する必要があり、ここで指定されたタスクを他のアイテムやユー
ザープロセスで共有することはできません。また同じタイプのアイテム（たと
えば 2 枚の ES1325）であっても、同じタスクを共有することはできません。
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fon=pé~ÅáåÖ=xãëz

ES1325 により生成される割込み要求の最小間隔を定義します。

このオプションは、トリガモードが Off以外のモードになっている場合（223
ページの「HW Trigger Mode」を参照してください）に、上記の値の範囲内で編
集できます。

^ìíçã~íáÅ=j~ééáåÖ

このオプションで、シグナルと ASCET メッセージの間の自動割り当てを行いま
す。

[Do it...]を選択してクリックするとダイアログボックスが開き、現在のマッ
ピング状態が表示されます。

図 10-55“Automatic Mapping”ダイアログボックスに表示されるマッピングス
テータス

ウィンドウ下部の各ボタンを押すと、以下のようなコマンドが実行されます。

• All：
現在のマッピングが完全に書き換えられます。各シグナルについて、同じ
名前の同方向の ASCET メッセージがあればそれが割り当てられ、なけれ
ばそのシグナルのマッピングは行われません。

• X-All：
“All”と同様に機能しますが、この拡張機能では、同じ名前の ASCET メッ
セージが見つからない場合には、グローバルな送受信メッセージが生成さ
れて割り当てられます。つまり、これを選択するとすべてのシグナルが
マッピングされます。

分解能 0.1 ms

値の範囲 最小 0 ms

最大 25.5 ms



• Mapped：
すでにマッピングされていたシグナルだけについてマッピングが行われま
す。つまり、すでにマッピングされていた各シグナルについて、同じ名前
の ASCET メッセージが検索され、対応するメッセージが見つからないシ
グナルは、マッピングされず、ASCET メッセージの欄は空になります。

• X-Mapped：
“Mapped”と同様に機能しますが、この拡張機能では、同じ名前の
ASCET メッセージが見つからない場合には、グローバルな送受信メッセー
ジが生成されて割り当てられます。

• Unmapped：
ASCET メッセージにマッピングされていないシグナルについてマッピング
が行われますが、同じ名前の ASCET メッセージが見つからないシグナル
はマッピングされません。

• X Unmapped：
“Unmapped”と同様に機能しますが、この拡張機能では、同じ名前の
ASCET メッセージが見つからない場合には、グローバルな送受信メッセー
ジが生成されて割り当てられます。

• Cancel
自動マッピングを中止します。

X-* コマンドの実行時にメッセージが生成される場合、そのメッセージがプロジェ
クト内に生成されるようにするか、またはプロジェクトに含まれるモジュール内
に生成されるようにするかを、HWC オプションウィンドウの "Mpping”タブ

（106 ページ参照）で指定することができます。

^ÇàìëíãÉåí=jçÇÉ

「調整モード」を有効にすることにより、オンライン時、つまり ASCET モデル実
行時に、信号収集に影響を与えることができます。

以下のモードから選択できます。

• Off

調整モードは無効になります。各入力チャンネル（“ChXX”）ごとに 1 つ
の "ChXXMsr”測定グループが表示されます。

• On

調整モードが有効になります。各“ChXX”入力チャンネルごとに、
“ChXXMsr”測定グループ以外に、“ChXXAdj”という「オンライン調整グ
ループ」も表示されます。この“ChXXAdj”グループには、オンライン時
に“Groups”タブの“Signals”列で調整できるコンフィギュレーションパ
ラメータも含まれています。

Adjustment Mode は、HW Trigger Mode が On になっている場合にのみ選択でき
ます（223 ページの「HW Trigger Mode」を参照してください）。
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10.14.3 Groups（ES1325-Input デバイス）

本項では、Input デバイスの各シグナルグループ用オプションについて説明しま
す。

図 10-56 ES1325-DIO Input デバイスの“Groups”タブ

póåÅ=dêçìé

同じタスク（またはタスクグループ）によって同調して転送されるシグナルグ
ループは、1 つのプロセスに割り当てられます。このプロセスには、この列に表
示されているグループ名と同じ名前が付きます。

シグナルグループに複数のタスクが選択されている場合、“Task”フィールドの値
が同じシグナルグループのプロセスのみ、1 つの共通プロセスに割り当てること
ができます。

このプロセスに割り当てられたシグナルグループは、同調して転送されます。

e~êÇï~êÉ=`Ü~ååÉä

ES1325 の入力チャンネル（Ch01 ～ Ch16）

`Ü~ååÉä=jçÇÉ

ES1325 の各入力チャンネルについて、デジタル入力信号をどのように評価するか
を指定します。



• Off

デジタル入力信号を評価しません。

• Digital Input

リクエストされた時点のデジタル入力信号のステートを評価します。

• PWM Input

リクエストされるまでの時点において、最後に取り込まれた 1 周期分の完
全な PWM 信号についての情報を評価します。

• Additive Time

リクエストされたインターバル内で、信号のアクティブフェーズの時間を
合計します。

• Event Counter

リクエストされたインターバル内で、指定の信号エッジの数を合計しま
す。

評価するエッジのタイプ（立ち上がり、立ち下がり、あるいはその両方）は、
“Significant Edge”パラメータで指定します。

チャンネルにおけるデータ転送が有効になるのは、タスクが選択されている場合、
または“IRQ”パラメータ（231 ページの「IRQ」を参照してください）が Yes に
設定され、さらにその IRQ が実際に使用可能な場合だけです。

rëÉ=et=qêáÖÖÉê

デジタル入力信号の取り込みを外部トリガ信号と同調して行うかどうかを指定し
ます。以下のモードを使用できます。

• Yes

入力信号の取り込みは、外部トリガと同調して行われます。

• No

入力信号の取り込みはポーリングモードで行われ、外部トリガ信号とは同
調しません。

“Trigger Mode”パラメータは、ES1325-DIO サブシステムの“Globals”タブで、
すべてのハードウェアチャンネルに共通な値として指定されます。

fon

入力信号の取り込み後に割込みが生成されるようにするかどうかを指定します。

• Yes 

IRQ ハンドラタスク（227 ページの「IRQ Handler Task」を参照してくださ
い）がアクティブ化され、データ取り込み後、データを ASCET モデルに
転送するための割込み要求が生成されます。
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• No

取り込まれた信号はバッファメモリに格納され、処理待ち状態となりま
す。データ転送は、“Task”で指定された ASCET モデルのタスクにより、
ポーリングモードで行われます。

“IRQ”オプションは、“Use HW Trigger”パラメータが Yes になっている場合に
限り有効です（231 ページの「Use HW Trigger」を参照してください）。

^Åíáî~íÉÇ=q~ëâ

“Activated Task”フィールドをクリックすると、“Task Selection”というダイアロ
グボックスが開きます。シグナルグループ受信時にアクティブ化されるタスクを
選択します。

このオプションは、“IRQ”パラメータが Yes に設定されている場合のみ利用可能
です（231 ページの「IRQ」を参照してください）。



páÖå~äë

有効なシグナルグループについては、このフィールドに [Select] と表示されるの
で、そこをクリックすると“Signal Selection”ダイアログボックスが開きます。

各シグナルごとにシグナルコンポーネントが割り当てられます。

“ChXXMsr”測定グループに使用できるシグナルは、以下のとおりです。

• State

• Active Time [µs]

• Inactive Time [µs]

• Period Duration [µs]

• Frequency [Hz]

• Duty Cycle [%]

• Ratio Active Time/Inactive Time [%]

• Ratio Inactive Time/Active Time [%]

• Additive Active Time

• Counter Value

オンラインの“ChXXAdj”調整グループ（192 ページの「“Globels”タブ」の
「Adjustment Mode」を参照してください）については、使用のシグナルを以下で
きます。

• Time Delay [µs]

• Angle Delay [µs]

• Angle Interval [µs]
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“Channel Mode”、“Use HW Trigger”、“HW Trigger Mode”パラメータの設定内
容によっては、一部のシグナルをシグナルグループに必ず使用しなければならな
い場合や、デフォルト値が使用される場合があります。

^ÅíáîÉ=pí~íÉ

入力信号のどちらのレベル（High または Low）をアクティブステートとするかを
指定します。

• High

入力信号の HIGH レベルが「アクティブ」ステートとして扱われます。

• Low

入力信号の LOW レベルが「アクティブ」ステートとして扱われます。

páÖåáÑáÅ~åí=bÇÖÉ

イベント（チャンネルモードが Event Counter の場合）または PWM 周期の開
始（チャンネルモードが PWM Input の場合）を表わすエッジのタイプを選択し
ます。

• Inactive-Active

入力信号が非アクティブからアクティブに遷移する（234 ページの
「Active State」を参照してください）と、イベントがトリガされます。

• Active-Inactive

入力信号がアクティブから非アクティブに遷移する（234 ページの
「Active State」を参照してください）と、イベントがトリガされます。

• Both

入力信号が非アクティブからアクティブに遷移したときと、アクティブか
ら非アクティブに遷移したとき（234 ページの「Active State」を参照して
ください）に、イベントがトリガされます。

この設定はチャンネルモードが Digital Input や Additive Time の場合に
は使用できません（230 ページの「Channel Mode」を参照してください）。

eóëíÉêÉëáë

入力チャンネルごとに、ヒステリシスのタイプを選択する必要があります。選択
可能なオプションは以下のとおりです。

• TTL

• User defined 

TTL User defined 

下側のしきい値 1.728V ユーザー定義

上側のしきい値 2.304V ユーザー定義



User defined オプションを選択した場合には、ヒステリシスの下上のしきい値
を定義する必要があります（235 ページの「Low Thresh. [V]」と 235 ページの

「High Thresh. [V]」を参照してください）。

içï=qÜêÉëÜK=xsz

各入力チャンネルに、入力信号の下側のしきい値を割り当てます。ここには、上
側のしきい値より 1 ステップ以上小さい値を定義してください。

このオプションは、ヒステリシスモードとして TTL が選択されている場合は無効
です（234 ページの「Hysteresis」を参照してください）。

eáÖÜ=qÜêÉëÜK=xsz

各入力チャンネルに、入力信号の上側のしきい値を割り当てます。ここには、下
側のしきい値より 1 ステップ以上大きい値を定義してください。

このオプションは、ヒステリシスモードとして TTL が選択されている場合は無効
です（234 ページの「Hysteresis」を参照してください）。

qáãÉçìí=xãëz

入力信号のステートが 1 回以上変化しなければならない時間を定義します。ここ
で定義された時間内に入力信号のステートが変化しなかった場合、所定のエラー
ステートが生成されます。

分解能 0.144V

値の範囲 最小 0V

最大 上側のしきい値 － 0.144V

分解能 0.144 V

値の範囲 最小 下側のしきい値 ＋ 0.144V

最大 36V

分解能 2.5ms

値の範囲 最小 0ms（この場合、タイムアウトは
発生されません）

最大 163837.5ms
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10.14.4 Signals（ES1325-Input デバイス）

本項では、Input デバイスの各シグナル用オプションについて説明します。

図 10-57 ES1325-DIO Input デバイスの“Signals”タブ

et=`Ü~ååÉä

ES1325 の入力チャンネル（Ch01 ～ Ch16）が表示されます。

páÖå~ä=qóéÉ

シグナルに割り当てられているシグナルタイプが表示されます。この割り当ては、
“Groups”タブの“Signals”パラメータで変更できます。

10.14.5 Mappings（ES1325-Input デバイス）

このタブ上の設定は、すべてのデバイスについて共通です。115 ページの 7.3.5
項を参照してください。



10.14.6 Globals（ES1325-Output デバイス）

本項では、Output デバイスのグローバルオプションについて説明します。

図 10-58 ES1325-DIO Output デバイスの“Globals”タブ

^ìíçã~íáÅ=j~ééáåÖ

Input デバイスの場合と同じ方法で、シグナルに ASCET メッセージを自動的に割
り当てることができます（228 ページの「Automatic Mapping」を参照してくだ
さい）。
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10.14.7 Groups（ES1325-Output デバイス）

本項では、Output デバイスの各シグナルグループ用オプションについて説明しま
す。

図 10-59 ES1325-DIO Output デバイスの“Groups“タブ

póåÅ=dêçìé

同じタスク（またはタスクグループ）によって同調して転送されるシグナルグ
ループは、1 つのプロセスに割り当てられます。このプロセスには、この列に表
示されているグループ名と同じ名前が付きます。

シグナルグループに複数のタスクが選択されている場合、“Task”フィールドの値
が同じシグナルグループのプロセスのみ、1 つの共通プロセスに割り当てること
ができます。

このプロセスに割り当てられたシグナルグループは、同調して転送されます。

e~êÇï~êÉ=`Ü~ååÉä

ES1325 の出力チャンネル（Ch01 ～ Ch16）

`Ü~ååÉä=jçÇÉ

ES1325 の各出力チャンネルについて、どのようなタイプの信号を出力するかを制
定します。



• Off

デジタル信号を出力しません。

• Digital Output

要求に応じて、出力チャンネルのステートをアクティブまたは非アクティ
ブに設定できます。この要求は、ミュレーションプロセッサからトリガで
きます。

• PWM Periodic Output

出力時間の制限なしに PWM 信号が生成されます。

生成される PWM 信号を定義するために、2 つのシグナルコンポーネント
が必要です（241 ページの「Signals（ES1325-Output デバイス）」を参照
してください）。

• PWM Interval Output

PWM 機能により、単一パルスの生成や、所定インターバル分の PWM 信
号の生成が行われます。最初の要求が処理されている間に受信された要求
は、拒否されます。

チャンネルにおけるデータ転送が有効になるのは、タスクが選択されている場合、
または“IRQ”パラメータ（231 ページの「IRQ」を参照してください）が Yes に
設定され、さらにその IRQ が実際に使用可能な場合だけです。

rëÉ=et=qêáÖÖÉê

デジタル出力信号の出力を外部トリガ信号と同調して行うかどうかを指定します。
以下のモードを使用できます。

• Yes

信号出力は、外部トリガと同調して行われます。

• No

信号出力はポーリングモードで行われ、外部トリガ信号と同調しません。

“Trigger Mode”パラメータは、ES1325-DIO サブシステムの“Globals”タブで、
すべてのハードウェアチャンネルに共通な値として指定されます。
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páÖå~äë

有効なシグナルグループについては、このフィールドに [Select] と表示されるの
で、そこをクリックすると“Signal Selection”ダイアログボックスが開きます。
ここで、生成されるシグナルを選択します。

各シグナルごとにシグナルコンポーネントが割り当てられます。

• State

• Active Time [µs]

• Inactive Time [µs]

• Frequency [Hz]

• Duty Cycle [%]

• Time Delay [”s]

• No. of Periods

• Angle Delay [º]

“Channel Mode”、“Use HW Trigger”、“HW Trigger Mode”パラメータの設定内
容によっては、一部のシグナルをシグナルグループに必ず使用しなければならな
い場合や、デフォルト値が使用される場合があります。

^ÅíáîÉ=pí~íÉ

出力信号のどちらのレベル（High または Low）をアクティブステートとするかを
指定します。

• High

出力信号の HIGH レベルが「アクティブ」ステートとして扱われます。



• Low

出力信号の LOW レベルが「アクティブ」ステートとして扱われます。

10.14.8 Signals（ES1325-Output デバイス）

本項では、Output デバイスの各シグナル用オプションについて説明します。

図 10-60 ES1325-DIO Output デバイスの“Signals”タブ

et=`Ü~ååÉä

ES1325 の出力チャンネル（Ch01 ～ Ch16）

páÖå~ä=qóéÉ

シグナルに割り当てられているシグナルタイプが表示されます。この割り当ては、
“Groups”タブの“Signals”パラメータで変更できます。

10.14.9 Mappings（ES1325-Output デバイス）

このタブ上の設定は、すべてのデバイスについて共通です。115 ページの 7.3.5
項を参照してください。
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10.14.10 Globals（ES1325-LED デバイス）

本項では、LED デバイスのグローバルオプションについて説明します。

図 10-61 ES1325-DIO LED デバイスの“Globals”タブ

^ìíçã~íáÅ=j~ééáåÖ

このオプションにより、Input デバイスの場合と同じ方法で、シグナルに ASCET
メッセージを自動的に割り当てることができます（228 ページの「Automatic 
Mapping」を参照してください）。



10.14.11 Groups（ES1325-LED デバイス）

本項では、LED デバイスの各シグナルグループ用オプションについて説明します。

図 10-62 ES1325-DIO LED デバイスの“Groups”タブ

ES1325-LED デバイスの“Groups”タブには、このデバイスに固有なオプション
はありません。一般的なオプションの設定については 113 ページの 7.3.3 項に説
明されています。

q~ëâ

デバイスを使用するタスクをこのフィールドで選択します。
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10.14.12 Signals（ES1325-LED デバイス）

本項では、LED デバイスの各シグナル用オプションについて説明します。

図 10-63 ES1325-DIO LED デバイスの“Signals”タブ

ES1325-LED デバイスの“Signals”タブには、アイテム固有の列は定義されてい
ません。このアイテムに可能な設定については 114 ページの 7.3.4 項に説明され
ています。

10.14.13 Mappings（ES1325-LED デバイス）

このタブ上の設定は、すべてのデバイスについて共通です。115 ページの 7.3.5
項を参照してください。

10.15 ES1330-PWM

ES1330 は、PWM 信号の取り込みと出力を行うためのカウンタボードです。この
ボードには 6 個のカウンタコンポーネント（Am9513A）が搭載されていて、各
カウンタコンポーネントにはカウント周波数が 4MHz の 5 つの 16 ビット幅カウ
ンタがあります。30 点のカウンタ入力と 16 点のカウンタ出力が ES1330 の 6 点
の内部ポート（ポート 1 ～ポート 6）に分けられ、各カウンタコンポーネントが
これらのポートを 1 つずつ占有します。ポートへのアクセスは、ES1330 の D-



SUB コネクタを通じて行われます。HWC エディタのアイテムリストでは、
ES1330 カウンタボードをサブシステムとして追加し、各カウンタコンポーネント
をデバイスとして追加します。

10.15.1 Globals（ES1330-PWM サブシステム）

本項では、ES1330-PWM サブシステムのグローバルオプションについて説明しま
す。

図 10-64 ES1330-PWM サブシステムの“Globals”タブ

fa=L=sjb=Ä~ëÉ=~ÇÇêÉëë

この行では、VME ベースアドレスの設定を行います。この設定はボード上のジャ
ンパ設定と一致している必要があります。ES1330 の場合、4 種類の異なる VME
ベースアドレス（ID1/C00000h、ID2/C00100h、ID3/C00200h、ID4/
C00300h）から選択することができます。つまり、1 つの ES1000 システムで最
大 4 枚の ES1330 を稼働させることができ、１枚の ES1330 はベースアドレスか
ら始まる 256 ワードのアドレススペースを占有します。

注記

ES1330 ボードのユーザーズガイド（EtasManuals¥ASCET5.1¥ES1000
ディレクトリに格納されています）の「Connector X1: Diginal Inputs and 
Outputs」の項に、使用できるカウンタ入出力ポートの一覧が記載されていま
す。
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10.15.2 Globals（PWM-COUNTER デバイス）

本項では、PWM-COUNTER デバイスのグローバルオプションについて説明しま
す。

図 10-65 PWM-COUNTER デバイスの“Globals”タブ

fåáí=q~ëâ

ES1330 を初期化するためのタスクを指定します（タイプ：Init、アプリケーショ
ンモード：active）。

bñáí=q~ëâ

実験を終了するときに ES1330 の終了処理を行なうタスクを指定します（タイプ：
Init、アプリケーションモード：inactive）。

whO=mçêí

ポート、つまりカウンタコンポーネントを指定します。各カウンタコンポーネン
トごとに専用のポートが使用されます。

`çìåíÉê=N=jçÇÉ=～=`çìåíÉê=R=jçÇÉ

ここでは、カウンタコンポーネントの 5 個のカウンタのそれぞれについて、カウ
ンタモードを選択します。選択できるカウンタモードは以下のとおりです。

• inactive

カウンタは使用しません。



• PWM-Generator (PWM_Gen)

カウンタを使用して PWM 信号を生成します。

• Period-Measurement (P_Meas)

カウンタを使用して PWM 信号の周期を測定します。

• High Time Measurement

カウンタを使用して、PWM 信号（アクティブ High）のアクティブパルス
幅を測定します。

• Low Time Measurement

カウンタを使用して、PWM 信号（アクティブ Low）のアクティブパルス
幅を測定します。

• Additive High Time Measurement

シミュレーションプロセッサは、通常、ES1330 から一定の周期で測定値
を取り込みますが、この「High タイムの合計」モードにおいては、2 回の
連続するリードアクセス間に PWM 信号（アクティブ High）がアクティブ
であった時間をすべて合計します。

• Additive Low Time Measurement

シミュレーションプロセッサは、通常、ES1330 から一定の周期で測定値
を取り込みますが、この「Low タイムの合計」モードにおいては、2 回の
連続するリードアクセス間に PWM 信号（アクティブ Low）がアクティブ
であった時間をすべて合計します。

入力信号

時間

ES1330への

リードアクセス

入力信号

時間

Σ Σ

ES1330への

リードアクセス

ES1330への

リードアクセス
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`çìåíÉê=N=mêÉëÅ~äÉê=～=`çìåíÉê=R=mêÉëÅ~äÉê

これらのパラメータは、4MHz の入力周波数用のプリスケーラを指定するための
ものです。スケーリング後の入力周波数は、最初の 4 つのカウンタ用のクロック
信号として使用されます。

プリスケーラを使えば、周期の長い PWM 信号を生成したり評価することができ
ますが、PWM 信号の分解能は低下します。プリスケーラは、1、10、100、1000
および 10000 から選択できます。

10.15.3 Groups（PWM-COUNTER デバイス）

図 10-66 PWM-COUNTER デバイスの“Groups”タブ

ES1330-PWM サブシステムの“Groups”タブには、このサブシステム固有の項目
はありません。



10.15.4 Signals（PWM-COUNTER デバイス）

本項では、PWM-COUNTER デバイスの各シグナルごとのオプションについて説明
します。

図 10-67 PWM-COUNTER デバイスの“Signals”タブ

kçK

シグナルの番号と意味は、“Globals”タブの“ZK2 Port”および“Counter X 
Mode”設定により決まります。

páÖå~ä

シグナルの名前（ANSI-C）を具体的に定義します。以下の命名規則が適用されま
す（x＝カウンタの番号）。

• Genx_Frequency

PWM 出力チャンネルの周波数（Hz）

• Genx_DutyCycle

PWM 出力チャンネルのデューティサイクル（%）

• Measx_Period

PWM 評価チャンネルの周期（秒）

• Measx_DutyCycle

PWM 信号のパルス幅測定（単一パルス幅、またはアクティブタイムの合
計）の結果

10.15.5 Mappings（PWM-COUNTER デバイス）

このタブ上の設定は、すべてのデバイスについて共通です。115 ページの 7.3.5
を参照してください。
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NN チュートリアル

この章では、サンプルプロジェクトを使用して、INTECRIO で実験を行う方法
（11.1 項）や、各種ボードの設定方法（ES1222 - 11.2 項、ES1303 - 11.3 項、
ES1325 -11.4 項と 11.5 項 ）について学習します。

ASCET-RP V5.4 には 2 つのサンプルファイル（INTECRIO_Tutorial.expおよ
び RRIOTutorial.exp）が含まれていて、製品をインストールすると、ASCET
のインストールディレクトリのサブディレクトリ（Ascet5.1¥export）に、こ
のファイルが格納されます。

サンプルファイルは、新しいデータベース、または既存のデータベースにイン
ポートして使用します。

新しいデータベースを作成する：

• ASCET のコンポーネントマネージャで、File → 
New Database メニューコマンドを選択します。

“New Database”ダイアログボックスが開きま
す。

• 新しいデータベースの名前を入力します。

• OK をクリックします。

新しく作成されたデータベースが開きます。

サンプルファイルをインポートする：

• コンポーネントマネージャで File → Import を選
択します。

• ファイル選択ダイアログボックスが開くので、
ASCET のプログラムディレクトリのサブディレク
トリ、Ascet5.1¥exportを選択します。

• RTIOTutorial.expというファイルをクリック
します。

注記

このチュートリアルは、ETAS ネットワークマネージャを使用しないことを前提
にした操作内容となっています。そのため、ETAS ネットワークマネージャを使
用してチュートリアルを実行すると、システムの挙動が若干異なります。詳し
くは、2.2 項と第 4 章を参照してください。
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• 開く をクリックします。

“Specify options for import”ダイアログボックス
が開きます。

• デフォルト設定を変更せずに、OK をクリックし
ます。

• “Import”ダイアログボックスが開くので、ファ
イルに含まれるすべてのアイテムが選択されてい
ることを確認してください。
チュートリアル



• OK をクリックします。

ファイルがデータベースにインポートされます。
インポートされたデータベースアイテムが

“Imported Items”ダイアログボックスに表示され
ます。

• “Imported Items”ダイアログボックス を閉じま
す。

• 同じ方法で INTECRIO_Tutorial.expという
ファイルをインポートします。

インポートの際は、すべてのコンポーネントが選
択されていることを確認してください。

TCP/IP プロトコルオプションを設定する：

ASCET 用 PC に、社内 LAN 用のネットワークカードが別にインストールされてい
る場合、2 枚のカードの IP アドレスの衝突を防ぐため、以下のようなネットワー
ク設定を行う必要があります。

• DHCP サービスを無効にします。

• IP アドレスフィールドに 192.168.40.240 と
入力します。
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• サブネットマスクフィールドに 
255.255.255.0 と入力します。

• DNS サービスを利用する場合は、社内 LAN のロー
カル設定を使用してください。

• WINS サービスを無効にします。

• IP 転送オプションが無効になっていることを確認
します。

11.1 チュートリアル - INTECRIO を使用した実験

この項では、ASCET のサンプルプロジェクトを INTECRIO に転送して INTECRIO
で実験を行い、さらに ASCET 上で INTECRIO のバックアニメーション機能（61
ページ参照）を利用します。ここでは ASCET のプロジェクトや INTECRIO のワー
クスペースを作成する作業は行いません。必要なファイルはすべて用意されてい
ます。

• エクスポートファイル INTECRIO_Tutorial.expには、ASCET プロジェ
クトとその他必要なコンポーネントがすべて含まれています。

ASCET プロジェクト P01_Projectには、ステートマシン
（SM01_DataGenerator）で記述されたデータジェネレータ
（M01_DataGenerator）が含まれています。PModeというパラメータ
を変更し、データジェネレータがのこぎり歯を生成するようにするか

（PMode=1）、または三角波を生成するようにするか（PMode=2）を指定
します。生成されたデータは、同じプロジェクトに含まれるローパスフィ
ルタ（M01_LowPassモジュール）の入力シグナルとなります。

（Windows® 2000 の場合）
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• WS_ES1130というフォルダには、シミュレーションボード ES1130を使
用して実験を行うための INTECRIOワークスペースが含まれています。

• WS_ES1135というフォルダには、シミュレーションボード ES1135を使
用して実験を行うための INTECRIOワークスペースが含まれています。

11.1.1 準備

まず始めに、実験の準備を行います。

INTECRIO のワークスペースをコピーする：

ASCET のインストール用 CD の ETAS¥ASCET5.1¥exportというフォルダに、
INTECRIO のワークスペースが格納されています。

• ES1130 を使用する場合は、CD の
INTECRIO_Tutorial_WorkspaceES1130と
いうディレクトリを PCのハードディスク（以下
のようなパス）にコピーします。

ETASData¥INTECRIO1.0¥INTECRIO_Tutor
ial_WorkspaceES1130

• ES1135 を使用する場合は、CD の
INTECRIO_Tutorial_WorkspaceES1135と
いうディレクトリを PCのハードディスク（以下
のようなパス）にコピーします。

ETASData¥INTECRIO1.0¥INTECRIO_Tutor
ial_WorkspaceES1135

プロジェクト P01_Projectは、ES1130用にセットアップされています。実際
に ES1130を使用する場合は、これで準備作業は終わりですが、ES1135を使用
する場合はターゲットの設定を行う必要があります。

ターゲットを選択する：

• プロジェクト P01_Projectをプロジェクトエ
ディタで開きます。

• コード生成オプションを設定します。ES1135 を
ターゲットとして選択し、コンパイラは GNU-C 
(PowerPC)を選択します。

選択されたターゲット用のオペレーティングシス
テム設定がロードされます。

11.1.2 プロジェクトの転送

次にプロジェクトを INTECRIO に転送します。

プロジェクトを INTECRIO に転送する：

• プロジェクト P01_Projectを開きます。
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• “Experiment Target”コンボボックスから
INTECRIOを選択します。

Transfer Project to selected Experiment Target 
ボタンと Recconect to Experiment of selected 
Experiment Target ボタンが有効になります。

• Transfer Project to selected Experiment Target 
ボタンをクリックします。

“INTECRIO Project Transfer”ダイアログボックス
が開きます。

• “Path”フィールドに、生成されたファイルを格
納するパスを入力します。

• “Workspace”フィールドの隣の Browse ボタン
をクリックして、使用するワークスペースを指定
します。

• “System”フィールドの隣の Browse ボタンをク
リックして、ワークスペース内のプロジェクト
SystemProjectを指定します。

INTECRIO が起動していない場合は、ここで起動
されます。

• OK をクリックします。

INTECRIO での作業に必要なすべてのファイルが
生成され、指定されたディレクトリに保存されま
す。そして ASCET プロジェクトが INTECRIO にイ
ンポートされて P01_Projectという名前のモ
ジュールとして保存され、自動的にプロジェクト
SystemProjectに追加されます。
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11.1.3 INTECRIO での実験

次に INTECRIO でオペレーティングシステムを設定し、ビルド処理を開始して、
INTECRIO での実験を行います。

INTECRIO のオペレーティングシステムを設定する：

• INTECRIO ウィンドウに切り替えます。

• System → OS Configuration を選択します。

OSC オペレーティングシステムエディタが開きま
す。サンプルプロジェクトの構成は非常に単純な
ので、自動設定を行えます。

• Edit → OS Auto mapping を選択します。

UserAppModeというアプリケーションモードの
auto_10msTaskというタスクが生成されます。
ASCET プロジェクトの 2つのプロセスがこのタ
スクに割り当てられます。

これ以外の設定を行う必要はありません。

INTECRIO のビルド処理を開始する：

• INTECRIOウィンドウから Integration → Build を
選択します。

または

• 2 回目以降のビルド処理を行う場合は、
Integration → Rebuild を選択します。

ビルド処理が開始されます。INTECRIO ウィンド
ウの最下部の“Log Window”というボックスに、
実行状況が表示されます。

ビルド処理が正常に終了すると、最終行に以下の
メッセージが表示されます。

Action succeeded

The active system project has been 
set into the „Build" mode

INTECRIO の実験を開始する：

1. 実験環境を開く

• INTECRIO ウィンドウで、 Experiment → Open 
Experiment を選択します。

INTECRIO の実験環境が個別のウィンドウとして
開き、実験がロードされます。

2. 実験を開始する
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• INTECRIO の実験環境で、 Experiment → Open 
Experiment を選択します。

実効形式のファイル（プロトタイプ）が ES1000
にロードされます。

• Experiment → Start Experiment を選択します。

シミュレーションが開始されます。

バックアニメーション機能を使用すれば、INTECRIO の実験環境で測定ウィンドウ
や適合ウィンドウを開く必要はありません。しかし ASCET でのバックアニメー
ションにおいてはオシロスコープが使用できないため、INTECRIO のワークスペー
スにはオシロスコープ（Oscilloscope1.osc）があらかじめ定義されていま
す。また、このワークスペースには、2 つの適合ツールを含むアクティブ GUI
ウィンドウ

（ActiveGUI1.gui）も含まれています。これら 2 つのファイルは、INTECRIO
ワークスペースのサブディレクトリ EE_Dummy¥System¥GUIに格納されていま
す。

測定／適合ツールをロードする：

• INTECRIO の実験環境で、File → Open を選択しま
す。

ファイル選択ダイアログボックスが開きます。

• すべてのファイルを表示します。

• INTECRIO ワークスペースのサブディレクトリ
EE_Dummy¥System¥GUIを選択します。

• 2つのファイル、Oscilloscope.oscと
ActiveGUI1.guiを続けてロードします。
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• Edit → Run を選択して、アクティブ GUI ウィンド
ウを実行モードにします。

シミュレーションはすでに実行されているので、
すぐに値の表示が開始されます。値は、INTECRIO
の実験環境に、以下のように表示されます。

11.1.4 バックアニメーションの使用

ASCET からバックアニメーションを開始します。この際、INTECRIO で実験が実
行されている必要があります。

バックアニメーションを行う：

• ASCET プロジェクトエディタで Reconnect to 
Experiment of Selected Experiment Target ボ
タンをクリックします。

INTECRIO の実験への接続が確立され、“Physical 
Experiment...”ウィンドウが開きます。
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• “Environment Browser”ウィンドウで、INTECRIO
を実験環境として選択します。
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• Start Measurement ボタンをクリックします。

ASCET 環境内の測定が開始され、測定ウィンドウ
に測定値が表示されます。

適合作業は、ASCET と INTECRIO のいずれの実験環境でも行えます。変更された
値は INTECRIO に転送され、そこに表示されます。

値の適合を行う：

• ASCET で“Numeric Editor; 3”ウィンドウ
内の変数 LP_IVの値を変更します。

INTECRIO で、“ActiveGUI1.gui”ウィンドウ
内の左側の適合ツール内の値が更新されます。

• INTECRIO で“ActiveGUI1.gui”ウィンドウ内
の LP_IVの値を変更します。

ASCET で、“Numeric Editor; 3”ウィンドウ
内の値が更新されます。
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• ASCET で“Logical Editor; 2”ウィンドウ
内のパラメータ venableの値を変更します。

シグナルジェネレータの値がその時点の値のまま
固定され、ローパスフィルタは初期値 LP_IVに
設定されます。

• パラメータの値をtrueに戻し、PModeを2に設定
して別のシグナルジェネレータを選択します。

INTECRIO のオシロスコープの表示は以下のよう
に変わります。
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ASCET コンポーネントを表示する：

• ASCET の“Physical Experiment ...”ウィンドウの
“Graphics”タブ上のコンポーネントをダブルク
リックして、内容を表示します。

“Physical Experiment ...”ウィンドウにそのコン
ポーネントの内容が表示されます。

このようにしてモデルの全階層をナビゲートする
ことができます。1 つ上の階層に移動するには、
Navigate up to parent component ボタンをク
リックするか、または空白部分をダブルクリック
します。

• View → Monitor All を選択します。

各エレメントの上部に、その現在値が表示されま
す。

• モデル内をナビゲートし、ステートマシン
SM01_DataGeneratorまで移動します。
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• いずれかのステートを右クリックしてショート
カットメニューを開き、Animate States を選
択します。

ステートダイアグラム内で、現在のステートがカ
ラー表示されます。

11.2 チュートリアル - ES1222（CAN-IO）

インポートされた ES1222 用モデルには、CAN チャンネル 1 から送信されて CAN
チャンネル 2 で受信される 3 つの変数が含まれています。288 ページの図 11-3
のように両チャンネルをターミネータ付きケーブルで接続すると、オンライン実
験においてこれらの変数の送受信が行われ、その状況を実験環境ウィンドウでモ
ニタすることができます。

モデルの内容はすべて完成していて、ES1222 を RTIO に統合するための条件（タ
スク、メッセージ、HWC モジュール）が揃っています。あとは、HWC エディタ
でハードウェアコンフィギュレーションを設定し、コード生成を行なうだけです。
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図 11-1 ES1222 モデルの ES1222_InOutモジュール

図 11-2 ES1222 モデルの OS エディタ設定
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11.2.1 ES1222 ボード

以下の図は、ES1222CAN ボードのフロントパネルの概観です。

4 つのインターフェースポート（CAN1 ～ CAN4）はそれぞれ独立していて、電
気的に絶縁されています。また K ワイヤポートは、外部デバイスを VME バスシ
ステムに接続するためのシリアル K ／ L ラインインターフェース用のものです。

ES1113ES1222.3
A

C
A

N
 1

C
A

N
 2

C
A

N
 3

C
A

N
 4

K-Line
チュートリアル



bpNOOO のジャンパ設定

実験を行うためには、ボード上の各ジャンパスイッチを以下の表のように正しく
設定してください。

複数の bpNOOO ボードの使用

1 台の ES1000 システム内で、最大 4 枚の ES1222 ボードを使用できます。

ジャンパスイッチ ピンの設定 意味

JP1 オープン CAN1 と CAN2 をループバック接続
します。

JP2 オープン

JP3 オープン

JP1000 1-2 をクローズ

JP200 (ES1222.3 のみ ) (Don’t Care) K Line はここでは使用しません。

JP1000
1
2
3

2 2 4

3

4

3 31 1 1

4 2

JP1

JP2
JP3

JP200

3
2
1
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11.2.2 サンプルプロジェクト

サンプルプロジェクトを開く：

• コンポーネントマネージャで ASCET_RP/
RTIOTutorial/ES1222 というフォルダを選
択します。

• ES1222_projectというプロジェクトを選択し
ます。

• プロジェクトを開きます。
チュートリアル



• Spedify Code Generation Options ボタンをク
リックします。

“Settings for: ES1222_project”というタイトルの
ダイアログボックスが開きます。

• “Build”タブで以下のオプションを設定します。

Target: >ES1130< または >ES1135<

Compiler: GNU-C (PowerPC)

注記

RTIO との通信に使用できるメッセージは、“Exported”として宣言されたメッ
セージのみです。
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11.2.3 ハードウェアコンフィギュレーションの作成

HWC エディタを開く：

• プロジェクトエディタで RTIO → Open Editor を
選択します。

HWC エディタが開きます。

ハードウェアコンフィギュレーション（HWC）を作成する：

各ハードウェアは、アイテムリスト内にツリー構造の形で定義します。このツ
リーのルートには、必ず HWCというアイテムが存在します。

• HWC エディタで Edit → Add  Item... を選択しま
す。

または

注記

通常、ハードウェアコンフィギュレーションを作成するには、まず HWC という
C コードモジュールを作成し、それをプロジェクトに組み込んでからその内容
を編集しますが、このチュートリアルでは、すでにこの HWCモジュールがプロ
ジェクトに組み込まれています。
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• Add  Item... ボタンをクリックします。

“Add Item”ダイアログボックスが開きます。

現在選択されているアイテムの次の階層レベルに
追加できるアイテムの一覧が表示されます。

• ES113x を選択します。

このアイテムは、ES1000.x システムで使用され
る PowerPC プロセッサボード ES1130 または
ES1135 に相当します。

• OK をクリックします。

“Items”リストに ES113x が追加されます。

• “Items”リストから ES113x を選択します。

“Globals”タブには、“Init Task” オプションの欄に Initというデフォルトのタス
ク名が表示されます。サンプルプロジェクトの OS エディタで同じ名前の Init タス
クが定義されているので、ここで他のタスクを選択する必要はありません。
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ES1222 の組み込みと設定を行う：

• Edit → Add  Item... を選択して、次の階層レベル
で選択可能なアイテムの一覧を開きます。

• ES1222-CANというアイテムを選択します。

このアイテムは、ES1222 CAN ＋ K-Line インター
フェースに相当します。

• OK をクリックします。

“Items”リストに ES1222-CAN というアイテム
が追加されます。

• “Items”リストから ES1222-CANを選択します。
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“Globals”タブには、“Init Task”および“Exit Task”オプションの欄に Initおよ
び Exitというデフォルトのタスク名が表示されます。サンプルプロジェクトの
OS エディタで同じ名前のタスクが定義されているので、ここで他のタスクを選択
する必要はありません。“IRQ Handler Task”オプションについてはデフォルトタ
スクは定義されていないので、ここで定義を行います。

• “IRQ Handler Task”オプションの右側の空欄をダ
ブルクリックします。

“Task Selection”ダイアログボックスが開きます。

• Analyzeという名前の Software タスクを選択し
て OK をクリックします。

“ID”オプションの番号は、自動的に設定されます。この ES1222-CANアイテム
の他には同じタイプのボードは組み込まれていないため、値は ID1となります。

• Accept ボタンで設定内容を確定します。

CAN チャンネルを組み込む：

• HWC エディタの“Items”リストから ES1222-
CANを選択します。

• Edit → Add  Item... を選択して、次の階層レベル
に組み込むことができるアイテムの一覧を表示し
ます。

• CAN-CTRLというアイテムを選択して OK をク
リックします。

このアイテムは、ボード上の各 CAN コントロー
ラに相当します。
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• “Global”タブで“Baud Rate [kBaud]”オプショ
ンのデフォルト設定値（1000）をクリックしま
す。

設定値のフィールドがコンボボックスに変わり、
選択できるボーレートの一覧が表示されます。

• コンボボックスから 500（kBaud）を選択します。

• Accept ボタンで設定内容を確定します。

• “Items”リストから CAN-CTRLを選択します。

• Edit → Add Item... を選択して、次の階層レベル
で選択可能なアイテムの一覧を開きます。

• CAN-IOというアイテムを選択してOKをクリック
します。

• さらに、CAN コントローラをもう 1 つ追加し、そ
れに CAN チャンネルを追加します。

これで、サンプルシステムのハードウェア構成に対応するアイテムツリーが完成
しました。

11.2.4 ES1222（CAN-IO）の HWC 設定

次に、2 つの CAN チャンネルの設定を行います。1 番目のチャンネル（HWC エ
ディタには CANIO::Canioという名前のアイテムとして組み込まれています）
がシグナルを送信し、2 番目のチャンネル（CANIO::Canio1）がそれを受信す
るように、設定します。

サンプルプロジェクトにおいては、各 CANIOアイテムの“Globals" タブには設
定する必要のあるオプションはありません。
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チャンネル N

“Groups”タブ : CAN メッセージを、シグナルグループとして定義します。

シグナルグループ 1 の設定を行う：

• “Items”リストから CANIO::Canio を選択しま
す。

• “Groups”タブを選択します。

Group1という名前のシグナルグループがすでに
定義されています。

• Group1の行の“Group”カラムをダブルクリッ
クします。

そのフィールドが入力フィールドに変わります。

• MSG_100というグループ名を入力します。

• 同じ行の“Task”カラムをクリックします。

“Task selection”ダイアログボックスが開きます。

• T10msというAlarmタスクを選択してOKをクリッ
クします。

• 同じ行の“Identifier dec”カラムをクリックしま
す。

• 識別子として、100を入力します。

隣の“Identifier hex”カラムに 64という値が
セットされます。

• Accept で設定内容を保存します。
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シグナルグループを追加する：

次に、2 番目のシグナルグループを追加します。これも他のタスクに送信される
ものです。

• 1 番目のシグナルグループの行の“No.”カラムを
クリックします。

Edit メニューの、シグナルグループを追加するた
めのメニューコマンドが有効になります。

• Edit → Add Row After を選択します。

または

• “Groups”タブ上でショートカットメニューを開
き、Add Row After を選択します。

－ 1 番目のグループに対する設定内容がまだ保
存されていない場合は、以下のメッセージが
表示されます。

－ OK でこのメッセージを閉じます。

－ もう一度、Add Row After を選択します。

1 番目のシグナルグループの下に新しい行が追加
されます。

シグナルグループ 2 の設定を行う：

• グループ名を MSG_101にします。

• “Task”カラムに T200ms という Alarm タスクを選
択します。
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• “Identifier dec”カラムに 101という値を入力しま
す。

隣の“Identifier hex”カラムに 65という値が
セットされます。

• Accept で設定内容を保存します。

“Signals”タブ : このタブで各 CAN シグナルを定義します。初期状態において
すでに 1 つのシグナルが存在していますが、サンプルプロジェクトでは 2 つの数
値シグナルと 1 つの論理シグナルが必要なので、まず最初にシグナルを 2 つ追加
します。

シグナルを追加する：

• “Signals”タブを選択します。

• 1 行目のシグナルの“No.”カラムをクリックし
て、選択します。

Edit メニューの、シグナルを追加するためのメ
ニューコマンドが有効になります。

• Edit → Add Multiple Rows After を選択します。

または

• “Groups”タブ上でショートカットメニューを開
き、Add Row After を選択します。

“New Value”ダイアログボックスが開きます。

• 入力フィールドに 2を入力します。

上下の矢印ボタンを使用して入力フィールドの数
字を変更することもできます。

• OK をクリックします。

選択されていた 1 行目のシグナルの下に新しい行
が 2 行追加されます。新しいシグナルには 1 行目
のシグナルと同じグループに割り当てられ、シグ
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ナル名は、Signal<n> というように最後の数字
がカウントアップされた名前が割り当てられま
す。

（上の図は、設定項目全体が見えるように、ビットマトリックス（169 ページの
「7654321.. (Bit matrix)」を参照してください）のうちでこのサンプルプロジェク
トに必要ないカラムが省略されています。）

論理シグナル、および 2 つの数値シグナルのうちの 1 つは 1 番目のシグナルグ
ループで転送し、残りの 1 つの数値シグナルは 2 番目のグループで転送します。

論理シグナルを設定する：

• 1 行目のシグナルの“Signal”カラムをダブルク
リックします。

• シグナル名を vcansend1logに変更します。

• 同じ行の“Signal-Type”カラムをダブルクリック
します。

そのフィールドがコンボボックスに変わり、選択
できるシグナルタイプの一覧が表示されます。

• コンボボックスで boolを選択します。

• 同じ行の“00”カラム（ビットマトリックスの最
後のカラム）をダブルクリックします。

そのフィールドに 1がセットされます。これで、
このシグナルが、1 番目の CAN メッセージのバ
イト 0 のビット 0 を使用して転送されるように設
定されました。

1 番目の数値シグナルを設定する：

• 2 行目のシグナルの名前を vcansend2contに変
更します。

• 同じ行の“Signal-Type”カラムで uint型を選択
します。

• 同じ行の“1 0”カラムをダブルクリックします。

そのフィールドに 1がセットされます。
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• 同じ行の“1 7”カラムをダブルクリックします。

そのフィールドに 1がセットされます。

• <Shift> キーを押しながら、もう一度“1 7”カラ
ムをクリックします。

“1 0”から“1 7”までのすべてのカラムに 1が
セットされます。これで、このシグナルが、1 番
目の CAN メッセージのバイト 1 のビット 0~7 を
使用して転送されるように設定されました。

2 番目の数値シグナルを設定する：

• 3 行目のシグナルの名前を vcansend3IRQに変更
します。

• 同じ行の“Group”カラムで MSG_101グループを
選択します。

• 同じ行の“Signal-Type”カラムで uint型を選択
します。

• 同じ行の“0 0”～“0 7”カラムに 1をセットし
ます。

これで、このシグナルが、2 番目の CAN メッ
セージの バイト 0 のビット 0~7 を使用して転送
されるように設定されました。

• Accept をクリックして設定内容を保存します。

3 つのシグナルをすべて設定すると、“Signals”タブは以下のようになります。

“Mappings”タブ : このタブで、各 CAN シグナルを、プロジェクト内に定義さ
れている ASCET メッセージに割り当てます。各シグナルの“ASCET Message”カ
ラムをクリックするとメッセージを選択するダイアログボックスが開き、このダ
イアログボックスには、bñéçêíÉÇ=属性を持つメッセージのうち、以下のようにシ
グナルグループの転送方向（ëÉåÇ=または êÉÅÉáîÉ）に対応するメッセージのみが表
示されます。

• 転送方向 = receive  → 受信メッセージ

• 転送方向 = send  → 送信メッセージ
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ASCET メッセージをマニュアル操作で割り当てる：

• “Mappings”タブを選択します。

• 3 行目のシグナルの“ASCET Message”カラムを
クリックします。

“Message selection”ダイアログボックスが開き
ます。

ASCET プロジェクトに定義されているすべての送
信メッセージが表示されます。

• vcansend3contメッセージを選択してOKをダブル
クリックします。

• Accept をクリックして設定内容を保存します。

1 行目と 2 行目のシグナルについては、同名の ASCET メッセージがプロジェクト
内に定義されています。上記の方法でそれらを１つずつ割り当てることもできま
すが、以下のように自動的に割り当てることも可能です。

ASCET メッセージを自動的に割り当てる：

• “Globals”タブを選択します。
チュートリアル



• “Automatic Mapping”オプションの“Value“カ
ラムをダブルクリックします。

“Automatic Mapping”ダイアログボックス が開
きます。

自動マッピングを行うための各ボタンについての
簡単な説明と、現在の割り当て状況が表示されま
す。
詳しい説明は、163 ページの「Automatic 
Mapping」を参照してください。

• Unmapped をクリックします。

vcansend1logシグナルと vcansend2cont
シグナルが、それぞれ同名の ASCET メッセージ
に自動的に割り当てられます。
すでにマニュアル操作でメッセージに割り当てら
れている vcansend3IRQシグナルは、影響を受
けません。

“Mappings”タブ上のすべてのシグナルが、以下のように ASCET メッセージに割
り当てられました。

これで、1 番目の CAN チャンネルの設定がすべて終了しました。
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チャンネル O

“Groups”タブ : CAN メッセージを、シグナルグループとして定義します。

シグナルグループ 1 の設定を行う：

• “Items”リストから CANIO::Canio1を選択しま
す。

• “Groups”タブを選択します。

タブ上の各設定オプションには、チャンネル 1 と
同様の初期設定が行われています。

• 1番目のシグナルグループの名前をMSG_100にし
ます。

チャンネル 2 はシグナルの受信を行うので、シグナルグループの転送方向を変更
する必要があります。

• シグナルグループの“Direction”カラムをダブル
クリックします。

そのフィールドがコンボボックスに変わり、選択
できる方向の一覧が表示されます。

• receiveを選択します。

• 同じ行の“Task”カラムで T10msという Alarm タ
スクを選択します（275 ページを参照してくださ
い）。

• 同じ行の“Identifier dec”カラムに 100という値
を入力します。

隣の“Identifier hex”カラムには 64 という値が
セットされます。

• Accept で設定内容を保存します。

次に、276 ページの方法で、割り込みモードで転送される 2 番目のシグナルグ
ループを追加します。

シグナルグループ 2 の設定を行う：

• 2番目のシグナルグループ名をMSG_101にします。

• “Direction”カラムで、転送方向として receive
を選択します。

• 同じ行の“IRQ”カラムをダブルクリックします。

そのフィールドがコンボボックスに変わり、選択
できるオプションの一覧が表示されます。
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• yesを選択します。

自動的に“Task”カラムの内容がリセットされ、
入力がロックされます。“Prescaler”カラムには、
自動的に 1 がセットされます。

• “Identifier dec”カラムに 101という値を入力しま
す。

隣の“Identifier hex”カラムに 65という値が
セットされます。

• Accept で設定内容を保存します。

“Signals”タブ : このタブで各 CAN シグナルを定義します。初期状態において
すでに 1 つのシグナルが存在しているので、277 ページの方法で、2 つのシグナ
ルを追加します。

論理シグナル、および 2 つの数値シグナルのうちの 1 つは 1 番目のシグナルグ
ループで転送し、残りの 1 つの数値シグナルは 2 番目のグループで転送します。

論理シグナルを設定する：

• 1 行目のシグナルの名前を vcanrec1logに変更
します。

• 同じ行の“Signal-Type”カラムで bool型を選択
します。

• 同じ行の“0 0”カラムをクリックして 1 をセット
します（278 ページ参照参照）。

これで、このシグナルが、1 番目の CAN メッ
セージのバイト 0 のビット 0 を使用して転送され
るように設定されました。

1 番目の数値シグナルを設定する：

• 2行目のシグナルの名前をvcanrec2contに変更
します。

• 同じ行の“Signal-Type”カラムで uint型を選択
します。

• 同じ行の“1 0”～“1 7”カラムに 1をセットし
ます（278 ページ参照）。

これで、このシグナルが、1 番目の CAN メッ
セージのバイト 1 のビット 0~7 を使用して転送
されるように設定されました。
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2 番目の数値シグナルを設定する：

• 3行目のシグナルの名前をvcanrec3contに変更
します。

• 同じ行の“Group”カラムで MSG_101グループを
選択します。

• 同じ行の“Signal-Type”カラムで uint型を選択
します。

• 同じ行の“0 0”～“0 7”カラムに 1をセットし
ます。

これで、このシグナルが、2 番目の CAN メッ
セージのバイト 0 のビット 0~7 を使用して転送
されるように設定されました。

• Accept をクリックして設定内容を保存します。

3 つのシグナルをすべて設定すると、“Signals”タブは以下のようになります。

3 つのシグナルと同名のメッセージがプロジェクト内に定義されているため、
メッセージの割り当てはすべて自動的に行えます。

ASCET メッセージを自動的に割り当てる：

• “Globals”タブを選択します。

• “Automatic Mapping”オプションの“Value“カ
ラムをダブルクリックします。

“Automatic Mapping”ダイアログボックス が開
きます。

詳しい説明は、163 ページの「Automatic 
Mapping」を参照してください。

• All をクリックします。

3 つのシグナルが、それぞれ同名の ASCET メッ
セージに自動的に割り当てられます。

また、280 ページのように、“Mappings”タブで個別に割り当てを行うことも可
能です。
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“Mappings”タブ上のすべてのシグナルが、以下のように ASCET メッセージに割
り当てられました。

これで、2 番目の CAN チャンネルの設定がすべて終了しました。

11.2.5 ハードウェアコンフィギュレーションの保存

作成したハードウェアコンフィギュレーションは、プロジェクトのファイルコン
テナ内に保存したり、または DOS ファイル（*.HWC）として保存することがで
きます。

ハードウェアコンフィギュレーションをファイルコンテナに保存する：

• Save ボタンをクリックします。

または

• HWCエディタメニューから File → Saveを選択し
て、ハードウェアコンフィギュレーションを保存
します。

現在のコンフィギュレーションを初めて保存する
際には、“Save Configuration File”が開きます。

• “File Type”コンボボックスから、Hardware 
Configuration (*.hwx)というファイルタイ
プを選択します。
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• ファイル名を入力します。

• OK をクリックします。

ハードウェアコンフィギューションが、ファイル
コンテナに保存されます。この内容は、“Files”
タブに表示されます。

ハードウェアコンフィギュレーションを DOS ファイルに保存する：

• HWC エディタで、File → Export メニューを選択
します。

• “Export Hardware Configuration”ダイアログ
ボックスで、ハードウェアコンフィギュレーショ
ンを保存するファイルタイプ、およびファイルの
パスと名前を指定します。

ハードウェアコンフィギュレーションが、指定さ
れたファイルに保存されます。このファイルは後
に、HWC エディタから File → Import でイン
ポートすることができます。

11.2.6 HWC モジュールのコード生成

次に、HWC モジュールのコード生成処理を行います。

HWC モジュールのコードを生成する：

• HWCエディタのExtras→Generate Code→For 
Current Experiment メニューコマンドを選択し
ます。

または

• Generate Code for Current Experiment ボタン
をクリックします。

• HWC モジュールの上書きを確定します。

注記

サンプルプロジェクトの参考用コンフィギュレー
ションは、ES1222.hwxという名前で保存されて
います。このファイルを上書きしないように注意
してください。
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• プロジェクトのコード生成オプションで選択され
ている実験タイプに合わせて、HWC モジュール
の C コードが生成されます。

また、以下のようにして他のタイプの実験用のコードを生成することもできます。

• HWCエディタでExtras → Generate Code → For 
Phys. And Quant. Experiment を選択して、物
理実験および量子化実験用のコードを生成しま
す。

• HWCエディタでExtras → Generate Code → For 
Phys., Quant. And Impl. Experiment を選択し
て、物理実験、量子化実験、および実装実験用の
コードを生成します。

11.2.7 サンプルプロジェクトの実験

前項までで RTIO に関する設定がすべて完了したので、HWC エディタを閉じ、次
にプロジェクトエディタで実験ターゲット用の標準的なコードを生成します。

実験ターゲット用の実行コードを生成する：

• プロジェクトエディタで Component → Build を
選択して、プロジェクト全体のコード生成を行い
ます。

• Component → View Generated Code を選択し
て生成されたコードを表示し、内容を確認しま
す。

注記

HWC モジュールをプロジェクトエディタのグラフィック表示に含めることはお
勧めできません。HWC モジュールは RTIO のコード生成が行われるたびに変わ
るため、予期しない形で表示されてしまうためです。
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オンライン実験を行う：

• 次の図のように、ES1222 の CAN ポート、CAN1 お
よび CAN2 を、適切なケーブルとターミネータで
接続します。

図 11-3 ES1222 にターミネータ付きケーブルを接続する

• “Experiment Target”コンボボックスから 
Online (RP)を選択します。

Offline (RP) は、ターゲット上でオフライン
実験を行うための設定です。

• Component → Open Experiment を選択しま
す。

または

• Open Experiment for selected Experiment 
target ボタンをクリックします。

“Physical Experiment”ウィンドウに、2 つのオシ
ロスコープを含む実験環境が開きます。

注記

ターミネータを使用しないと、通信は行なわれません。
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• “Physical Experiment”ウィンドウで、
Experiment → Start ERCOS を選択します。

または

• Start ERCOS ボタンをクリックします。

オペレーティングシステムが起動し、モデルが実
行されます。

• “Physical Experiment”ウィンドウで、
Experiment → Start Measurement を選択しま
す。

または

• Start Measurement ボタンをクリックします。

• ASCET メッセージの値が 2 つのオシロスコープ上
に表示されます。
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上側のオシロスコープの“Signals”エリアに、送信メッセージ vcansend2cont
（左側の緑色のライン）と受信メッセージ vcanrec2cont（右側の白いライン）
が表示され、ビット表示部には受信メッセージ vcanrec1log（上側のライン）
と送信メッセージ vcansend1log（下側のライン）が表示されます。

表示される信号の値は、以下のようにして処理されています。

• 送信メッセージ vcansend2contの値は、10ms周期で T10msタスクの

calcCANLoopプロセスにおいてセットされ、同タスクの

CanioMSG100_T10ms_HWCLプロセスによって送信されます。

• 送信された値は、受信メッセージ vcanrec2cont経由で T10msタスクの

CanioMSG100_T10ms_HWCFプロセスによって読み込まれ、ここで 1周期分

の遅延が発生します。

下側のオシロスコープには、送信メッセージ vcansend3cont（細かいステップ
の緑色のライン）と受信メッセージ vcanrec3cont（大きなステップの白いラ
イン）が表示されます。

表示される信号の値は、以下のようにして処理されています。
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• 送信メッセージ vcansend3contの値は、10ms周期で T10msタスクの

calcCANLoopプロセスにおいてセットされるので、上のオシロスコープの

vcansend2contと同様に連続的なラインとなります。この値は、200ms周

期で T2000msタスクの CanioMSG101_T200ms_HWCLプロセスによって送

信されます。

• 送信された値は割り込みモードで受信されます。つまり、Analyze タス
クからトリガが発行された時にメッセージ vcanrec3cont経由で受信さ
れます。そのため、表示されるラインは段階的に変化します。

11.3 チュートリアル - ES1303

この章では、RTIO パッケージを使用して、ES1303 AD ボードを ASCET プロジェ
クトに組み込みます。組み込みを行う前に、6「準備」の章に書かれている準備作
業を行う必要があります。また RTIO チャンネルとモデル間のデータ交換を行うに
は、モデル内において bñéçêíÉÇ=属性で定義されているメッセージが必要です。

ES1303 ボードの場合、メッセージの受信のみを行い、送信は行いません。そのた
めここでは、実際の実験での操作例は示されていません。

11.3.1 ES1303 ハードウェア

以下の図は、ES1303 A/D コンバータボードのフロントパネルの概観です。
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A ～ D の入力ポートにそれぞれ 4 チャンネルのアナログ入力を接続できます。
TRIG 入力はトリガ信号用です。

bpNPMP の入力電圧範囲

ES1303 ボードの入力電圧範囲は、HWC エディタで ±10V または ±60V に設定でき
ます。

複数の bpNPMP ボードの使用

1 台の ES1000 システム内で、最大 4 枚の ES1303 ボードを使用できます。

11.3.2 サンプルプロジェクト

例題を開く：

• コンポーネントマネージャで、ASCET_RP/
RTIOTutorial/ES1303フォルダを選択します。

• ES1303_projectというプロジェクトを開きま
す。
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• Specify Code Generation Options ボタンをク
リックします。

“Setting for: ES1303_project”ダイアログボック
スが開きます。

• “Build”タブで以下のオプションを設定します。

Target: >ES1130< または >ES1135<

Compiler: GNU-C (PowerPC)

サンプルプロジェクトには、ES1303 の RTIO 統合に必要な要素（タスク、メッ
セージ、HWC モジュール）がすでに含まれています。

注記

RTIO との通信に使用できるのは、“Exported”として宣言されたメッセージの
みです。
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11.3.3 ハードウェアコンフィギュレーションの作成

HWC エディタを開く：

• プロジェクトエディタで RTIO → Open Editor を
選択します。

HWC エディタが開きます。

ハードウェアコンフィギュレーション（HWC）を作成する：

各ハードウェアは、アイテムリスト内にツリー構造の形で定義します。このツ
リーのルートには、必ず HWCというアイテムが存在します。

• HWC エディタで、Edit → Add Item... を選択しま
す。

または

注記

通常、ハードウェアコンフィギュレーションを作成するには、まず HWC という
C コードモジュールを作成し、それをプロジェクトに組み込んでからその内容
を編集しますが、このチュートリアルでは、すでにこの HWCモジュールがプロ
ジェクトに組み込まれています。
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• Add Item... ボタンをクリックします。

“Add Item”ダイアログボックスが開きます。

現在選択されているアイテムの次の階層レベルに
追加できるアイテムの一覧が表示されます。

• ES113x を選択します。

このアイテムは、ES1000.x システムに組み込ま
れる PowerPC プロセッサボード ES1130 または
ES1135 に相当します。

• OK をクリックします。

“Items”リストに ES113x が追加されます。

• “Items”リストから ES113x を選択します。
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“Globals”タブには、“Init Task”オプションの欄に Initというデフォルトのタ
スク名が表示されます。サンプルプロジェクトの OS エディタで同じ名前の Init タ
スクが定義されているので、ここで他のタスクを選択する必要はありません。

• 再度 Edit → Add Item... を選択して、次の階層レ
ベルで選択可能なアイテムの一覧を開きます。

• ES1303-ADというアイテムを選択します。

このアイテムは、ES1303 A/D インターフェース
に相当します。

• OK をクリックします。

これで、サンプルシステムのハードウェア構成に対応するアイテムツリーが完成
しました。

11.3.4 ES1303 の HWC 設定

次に、“Globals”タブでタスクの設定を行います。

“Globals”タブの設定を行う：

• アイテムリストから、ES1303-AD というアイテム
を選択します。
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• “Globals”タブを選択します。

“Globals”タブには、“Init Task”および“Exit Task”オプションの欄に Initおよ
び Exitというデフォルトのタスク名が表示されます。サンプルプロジェクトの
OS エディタで同じ名前のタスクが定義されているので、ここで他のタスクを選択
する必要はありません。

“IRQ Handler Task”オプションについてはデフォルトタスクは定義されていませ
ん。ハードウェアトリガを使用する（“HW Trigger Mode”オプション）場合は、
トリガを受け取る割込み処理タスクをここに定義します。

“ID”オプションの番号は、自動的に設定されます。この ES1303-ADアイテムの
他には同じタイプのボードは組み込まれていないため、値は ID1となります。

• 入力シグナルの帯域幅に制限を与えるには、
“Anti-Aliasing Filer”オプションを On に設定しま
す。

• “HW Trigger Mode”オプションで、トリガ信号の
どのエッジで測定を開始するかを指定します。

（例： Falling Edge）

• “HW Trigger Gate”オプションで、第 2 のトリガ
信号を使用するかどうかを指定します。

注記

ポーリングモード（“Groups”タブの“IRQ”オプ
ションが Noの場合）においては、“HW Trigger 
Mode”および“HW Trigger Gate”オプションは無
効です。
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• “IRQ Handler Task”オプションの右側の空欄をク
リックします。

“Task Selection”ダイアログボックスが開きます。

• T_TriggerというSoftwareタスクを選択してOK
をクリックします。

各オプションの設定内容は、以下の例のようにな
ります。

• すべての設定が終了したら、Accept ボタンで設定
内容を保存します。

次の“Groups”タブでは、シグナルグループに関する設定を行います。

ES1303 ボードでは、各チャンネルごとに 1 つのシグナルグループが固定的に使
用されます。ここでは、タスク割り当て、入力電圧範囲、および受信モード（割
込みまたはポーリング）に関する設定を行います。

オプション 値

Name ES1303ad

Init Task Init

Exit Task Exit

IRQ Handler Task T_Trigger

ID ID1

Anti-Aliasing Filter On

Trigger Mode Falling Edge

Trigger Gate On
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“Groups”タブの設定を行う：

• “Groups”タブを選択します。

使用するすべてのシグナルについて、以下の設定を行います。

1. 受信タイプの選択：

• 割り込みモードで読み込みを行うシグナルの
“IRQ”カラムをダブルクリックします。

コンボボックスが開きます。

• コンボボックスから Yes を選択します。

選択された設定が、“IRQ”カラムに表示されま
す。同時に、“Task”カラムがリセットされ、入
力がブロックされます。

• またポーリングモードで受信を行うには、“IRQ”
カラムを No（デフォルト設定）のままにしてお
きます。

2. タスクの割り当て（ポーリングモードのシグナルのみ）：

• タスクを割り当てるシグナルの“Task”カラムを
クリックして、“Task Selection”ダイアログボッ
クスを開きます。
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• タスク選択リストから、T1msというタスクを選
択します。このタスクがデータ転送に使用されま
す。

タスク選択リストから、複数のタスクを選択する
こともできます。ES1303 の場合、通常は Alarm
タスクを選択します。

• OK をクリックします。

• 選択されたタスクが“Task”カラムに表示されま
す。

3. 電圧範囲の選択：

• 入力信号の電圧範囲を選択するシグナルの
“Voltage Range”カラムをクリックします。

コンボボックスが開きます。

• コンボボックスから電圧範囲を選択します。

選択された設定が、“Voltage Range”カラムに表
示されます。

• すべての設定が終了したら、Accept ボタンで設定
内容を保存します。
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“Signals”タブには各シグナルの設定オプションが含まれます。ES1303 ボードの
場合、特殊なオプションはないので、ここで行う設定作業はありません。タブを
開いて、現在の設定内容の確認だけを行ってください。

“Mappings”タブでは、プロジェクト内に定義されている ASCET メッセージに各
シグナルを割り当てます。各シグナルの“ASCET Message”カラムをクリックす
るとメッセージを選択するダイアログボックスが開き、このダイアログボックス
には、bñéçêíÉÇ=属性を持つメッセージのうち、そのシグナルグループの転送方向

（ëÉåÇ=または êÉÅÉáîÉ）に対応するメッセージのみが表示されます。

• 転送方向 = receive  → 受信メッセージ

• 転送方向 = send  → 送信メッセージ（ES1303 では使用されません）
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“Mappings”タブの設定を行う：

• “Mappings”タブを選択します。
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• いずれかの行の“ASCET Message”カラムをダブ
ルクリックして“Message selection”ダイアログ
ボックスを開きます。

このダイアログボックスで、16 個の受信メッ
セージを、対応するシグナルに 1 つずつ割り当て
ます。

• Accept ボタンをクリックして、設定内容を保存し
ます。
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11.3.5 ハードウェアコンフィギュレーションの保存

作成したハードウェアコンフィギュレーションは、プロジェクトのファイルコン
テナ内に保存したり、または DOS ファイル（*.HWX）として保存することができ
ます。285 ページの 11.2.5 項を参照してください。

11.3.6 HWC モジュールのコード生成

続いて、HWC モジュールのコード生成を行います。コード生成の方法は、286
ページの 11.2.6 項を参照してください。

11.3.7 サンプルプロジェクトの実験

前項までで RTIO に関する設定がすべて完了したので、HWC エディタを閉じ、次
にプロジェクトエディタで実験ターゲット用の標準的なコードを生成します。

実験ターゲット用の実行コードを生成する：

• プロジェクトエディタで Component → Build を
選択して、プロジェクト全体のコード生成を行い
ます。

• Component → View Generated Code を選択し
て生成されたコードを表示し、内容を確認しま
す。

オンライン実験を行う：

• プロジェクトエディタの“Experiment Target”コ
ンボボックスから Online (RP)を選択します。

Offline (RP) は、ターゲット上でオフライン
実験を行うための設定です。

• Component → Open Experiment を選択しま
す。

• 実験環境ブラウザで、Tutorial という環境を選
択します。

注記

サンプルプロジェクトの参考用コンフィギュレーションは、ES1303.hwx とい
う名前で保存されています。このファイルを上書きしないように注意してくだ
さい。

注記

HWC モジュールをプロジェクトエディタのグラフィック表示に含めることはお
勧めできません。HWC モジュールは RTIO のコード生成が行われるたびに変わ
るため、予期しない形で表示されてしまうためです。
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• “Physical Experiment”ウィンドウ で、
Experiment → Start ERCOS を選択します。

• “Physical Experiment”ウィンドウで、
Experiment → Start Measurement を選択しま
す。

ES1303 のアナログ測定値が、ASCET のオシロス
コープに表示されます。

11.4 チュートリアル - ES1325（トリガを使用しない）

トリガを使用しない ES1325 サンプルプロジェクトには、ボードの主要な機能が
すべて含まれています。モデルのブロックダイアグラムは、以下のように、各
ファンクションがグラフィック階層で記述されています。

図 11-4 ES1325 － モデル概観

以下に、各ブロックの機能をまとめます。

デジタル I/O: 入力チャンネル 3 からシグナルが読み取られ、出力チャンネル 3
に送られます。このシグナルは、読み取り時に反転され、Low レベルが“active”
ステートとなりますが、送信時には High レベルが“active”ステートになります

（234 ページの「Active State」を参照してください）。

図 11-5 ES1325 － デジタル I ／ O
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PWM: チャンネル 4 は、アクティブ時間と非アクティブ時間が一定である静的
な PWM シグナルを出力し、チャンネル 5 のシグナルは、デューティーサイクル
が鋸歯シグナルにより決まる動的な PWM シグナルを出力します。 

図 11-6 ES1325 － PWM

アクティブタイムの合計 : チャンネル 5 の PWM 出力シグナルは、出力チャンネ
ル 6 からも送信されます。このシグナルを入力チャンネル 6 から読み込み、タス
ク実行時におけるシグナルのアクティブフェーズの合計時間を算出します。

図 11-7 ES1325 － アクティブタイムの合計
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イベントカウンタ : チャンネル 7 は、イベントの立ち上がりエッジをカウント
し、チャンネル 8 はイベントのすべてのエッジをカウントします。どちらのチャ
ンネルも、P_Ch0708DigOutパラメータによりコントロールされます。

図 11-8 ES1325 － イベントカウンタ

LED: ここでは LED1 ～ 3 用の出力シグナルがセットされます。LED1 は logタ
イプ、LED2 は sdiscタイプ、LED3 は contタイプのパラメータによりそれぞ
れコントロールされます。

LED4 は Ch03DigOutメッセージによりコントロールされます。

図 11-9 ES1325 － PWM

注記

contと sdiscの値を使用して LED をコントロールすることは可能ですが、通
常は、お勧めできません。
適切なモデリングやプログラミングのためには、case 文などを用いて論理変数
にマッピングすることをお勧めします。
チュートリアル 307



308
11.4.1 ES1325 ボード

下図は、ES1325 ボードのフロントパネルを示しています。

ポート OUT-A と OUT-B にはそれぞれ 8 個の出力チャンネルがまとめられ、IN-A
と IN-B にはそれぞれ 8 個の入力チャンネルがまとめられています。また、トリガ
入力（2 チャンネル）は、TRG ポートに接続します。LED1 ～ 4 は、モニタ用で
す。
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接続

実験を確実に行えるようにするために、必ず、以下のように正しく配線してくだ
さい。このチュートリアルでは OUT-A と IN-A、さらに 11.5 項では TRG のポート
を使用します。以下の配線で、ES1325 の 2 つのプロジェクト（トリガを使用す
る／しない）を実行できます。

図 11-10 ES1325 の配線

下の表は、どの出力とどの入力を接続するかを示しています。入力 I1 と I2 には何
も接続しません。 

出力 O1 O2 O3 O4 O5 O6 O7 O8

入力 I3 I4 I5 I6 I7 I8

トリガ T1 T2

注記

入力と出力のための接続部品は、ユーザー側で用意してください。
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複数の bpNPOR ボードの使用

1 つの ES1000 システム内で、最大 4 枚の ES1325 ボードを使用できます。

11.4.2 サンプルプロジェクト

サンプルプロジェクトを開く：

• コンポーネントマネージャで ASCET_RP/
RTIOTutorial/ES1325 というフォルダを選択
します。

• ES1325_projectというプロジェクトを開きま
す。
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• Specify Code Generation Options ボタンをク
リックします。

“Settings for: ES1325_project”ダイアログボック
ス が開きます。

• “Build”タブで以下のオプションを設定します。

Target: >ES1130< または >ES1135<
Compiler: GNU-C (PowerPC).

注記

RTIO との通信に使用できるのは、“Exported”として宣言されたメッセージの
みです。
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11.4.3 ハードウェアコンフィギュレーションの作成

HWC エディタを開く：

• プロジェクトエディタで RTIO → Open Editor を
選択します。

HWC エディタが開きます。

ハードウェアコンフィギュレーション（HWC）を作成する：

各ハードウェアは、アイテムリスト内にツリー構造の形で定義します。このツ
リーのルートには、必ず HWCというアイテムが存在します。

• HWC エディタで Edit → Add Item を選択します。

または

注記

通常、ハードウェアコンフィギュレーションを作成するには、まず HWC とい
う C コードモジュールを作成し、それをプロジェクトに組み込んでからその内
容を編集しますが、このチュートリアルでは、すでにこの HWC モジュールが
プロジェクトに組み込まれています。
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• Add Item... ボタンをクリックします。

“Add Item”ダイアログボックス が開きます。

現在選択されているアイテムの次の階層レベルに
追加できるアイテムの一覧が表示されます。

• ES113x を選択します。

このアイテムは、ES1000.x システムで使用され
る PowerPC プロセッサボード ES1130 または
ES1135 に相当します。

• OK をクリックします。

“Items”リストに ES113xというアイテムが追加
されます。

• “Items”リストから ES113x を選択します。
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“Globals”タブには、“Init Task” オプションの欄に Initというデフォルトのタス
ク名が表示されます。サンプルプロジェクトの OS エディタで同じ名前の Init タス
クが定義されているので、ここで他のタスクを選択する必要はありません。

ES1325 の組み込みと設定を行う：

• Edit → Add  Item... を選択して、次の階層レベル
で選択可能なアイテムの一覧を開きます。

• ES1325-DIOを選択します。

このアイテムは、ES1325 インターフェースを定
義するために使用されます。
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• OK をクリックします。

“Items”リストに ES1325-DIOというアイテム
が追加されます。

• “Items”リストから ES1325-DIOを選択します。

“Globals”タブには、“Init Task”および“Exit Task”オプションの欄に Initおよ
び Exitというデフォルトのタスク名が表示されます。サンプルプロジェクトの
OS エディタで同じ名前のタスクが定義されているので、ここで他のタスクを選択
する必要はありません。

“ID”オプションの番号は、自動的に設定されます。この ES1325-DIOアイテム
の他には同じタイプのボードは組み込まれていないため、値は ID1となります。

• Accept ボタンで設定内容を確定します。

デバイスを作成する：

• “Items”リストから ES1325-DIOを選択します。

• Edit → Add  Item... を選択して、次の階層レベル
に組み込むことができるアイテムの一覧を表示し
ます。
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• ES1325-Inputを選択して OK をクリックしま
す。

これは、ES1325 の入力チャンネルを定義するた
めのアイテムです。

• さらに、ES1325-Outputと ES1325-LEDとい
うデバイスも追加します。

ES1325-Outputは ES1325 の出力チャンネルを
定義するためのもので、ES1325-LEDは LED を
定義するためのものです。

このサンプルプロジェクトにおいては、3 つのデ
バイスすべてについて、“Globals”タブではデ
フォルト設定を使用します。

これで、サンプルシステムのハードウェア構成に対応するアイテムツリーが完成
しました。

11.4.4 ES1325 の HWC 設定

次に、各入力と出力チャンネル、および LED について設定します。つまり、出力
チャンネルから供給される信号を入力チャンネルで測定し、また内部の処理状態
を LED でモニタできるように、ハードウェアコンフィギュレーションのパラメー
タ設定を行います。

“Globals”タブ : “Globals”タブについては、ユーザーが設定する必要のあるオ
プションはありません。

出力=－=ES1325-Output デバイス

“Groups”タブ : “Groups”タブではシグナルグループごとの設定を行います。

ES1325-Outputデバイスには、各出力シグナル（Ch<n>Gen、<n>＝ 01～
16）ごとにシグナルグループが割り当てられています。ここでは、使用される各
グループについて、モード、タスク割り当て、生成されるシグナル、トリガタイ
プ（レベルまたはエッジ）を設定します。
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“Groups”タブの設定を行う：

• “Groups”タブを選択します。

シグナルグループ 3 ～ 8 について、以下の設定を行います。

1. チャンネルモードを選択します。

• 各グループについて、“Channel Mode”列で以下
のモードを選択します。

“Active State”列には、設定されたモードに対応
するデフォルト値がセットされます。

“Task”列には、シグナル転送を行うタスクを割
り当てることができます。

Group Channel Mode

Ch03Gen, Ch07Gen, 
Ch08Gen

Digital Output

Ch04Gen, Ch05Gen, 
Ch06Gen

PWM Periodic 
Output
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2. タスクを割り当てます。

• 各行の“Task”列をダブルクリックして“Task 
selection”ダイアログボックスを開きます。

• タスク選択リストから、データ転送用に以下のタ
スクを選択します。

• OK をクリックします。

選択したタスクが“Task”列に表示されます。

Group Task

Ch03Gen, Ch04Gen T_100ms

Ch05Gen, Ch06Gen, 
Ch07Gen, Ch08Gen

T_10ms
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3. シグナルを選択します。

• 各行の“Signals”列をダブルクリックして
“Signal Selection”ダイアログボックス を開きま
す。 

シグナルについての説明は、240 ページの
「Signals」という項を参照してください。

• 以下のシグナルを選択します。

• OK をクリックして選択を確定します。

4. レベルを選択します。

すべてのグループがデフォルト設定の Highを使用するので、“Active 
State”列については何も変更する必要はありません。

• すべての設定が終了したら、Accept ボタンで設定
内容を保存します。

Group Signals

Ch03Gen, 
Ch07Gen, Ch08Gen

デフォルト設定

Ch04Gen Active Time [µs],
Inactive Time [µs]

Ch05Gen, Ch06Gen Frequency [Hz],
Duty Cycle [%]
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シグナルグループの設定が終わると、“Groups”タブの表示は以下のようになり
ます。

“Signals”タブ : ここには“Groups”タブで定義されたシグナルが表示されま
す。

このタブではシグナルの名前と式を編集できますが、サンプルプロジェクトにお
いては、何も変更する必要はありません。
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“Mappings”タブ : ここではプロジェクトのシグナルと ASCET メッセージを互
いに関連付けます。“ASCET Message”列のセルをクリックすると選択ダイアログ
が開きます。そのダイアログには、bñéçêíÉÇ 属性でしかもシグナルグループの転
送方向と一致するメッセージ（ここでは ëÉåÇ メッセージ）だけが表示されます。

シグナルに任意の ASCET メッセージを割り当てる：

• “Mappings”タブを選択します。

• 各行の“ASCET Message”列をダブルクリックし
ます。

“Message selection”ダイアログボックスが開き
ます。

ASCET プロジェクトに含まれるすべての Send
メッセージが表示されます。
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• 各シグナルについて、以下の ASCET メッセージを
選択します。

Ch04GenActiveTimeと
Ch04GenInactiveTimeというシグナルには、
メッセージを割り当てる代わりに固定値を割り当
てます。

• OK をクリックします。

• HWCエディタの Accept ボタンをクリックして設
定内容を保存します。

シグナルに固定値を割り当てる：

ASCET メッセージが割り当てられていないシグナルについて、固定的な値を
“Data”列に入力します。

• 各シグナルの“Data”列をダブルクリックしま
す。

そのフィールドが入力ボックスになります。

• 以下の値を入力します。

Signal ASCET Message

Ch03GenState Ch03DigOut

Ch05GenFrequency, Ch06GenFrequency Ch05PWMfrequencyOut

Ch05GenDutyCycle, Ch06GenDutyCycle Ch05PWMdutycycleOut

Ch07GenState Ch07DigOut

Ch08GenState Ch08DigOut

Signal Data

Ch04GenActiveTime 100.0

Ch04GenInactiveTime 50.0
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すべてのシグナルにメッセージまたは値が割り当てられると、このタブの内容は
以下のようになります。

入力=－=ES1325-Input デバイス

“Groups”タブ : “Groups”タブではシグナルグループごとの設定を行います。

ES1325-Inputデバイスには、各入力シグナル（Ch<n>Msr、<n> ＝ 01 ～ 16）
ごとにシグナルグループが割り当てられています。ここでは、使用される各グ
ループについて、モード、タスク割り当て、生成されるシグナル、トリガタイプ

（レベルまたはエッジ）を設定します。

“Groups”タブの設定を行う：

• “Groups”タブを選択します。

シグナルグループ 3 ～ 8 について、以下の設定を行います。
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1. チャンネルモードを選択します。

• 各行の“Channel Mode”列で以下のモードを選
択します。

“Active State”、“Significant Edge”、“Hysteresis”、
“Low Thresh. [V]”、“High Thresh. [V]”の各列に、
各モードのデフォルト値がセットされます。

“Task”列には、シグナル転送を行うタスクを割
り当てることができます。

2. タスクを割り当てます。 
• 各行の“Task”列をダブルクリックして“Task 

selection”ダイアログボックスを開きます。

• タスク選択リストから、データ転送用に以下のタ
スクを選択します。

• OK をクリックします。

選択したタスクが“Task”列に表示されます。

Group Channel Mode

Ch03Msr Digital Input

Ch04Msr, Ch05Msr PWM Input

Ch06Msr Additive Time

Ch07Msr, Ch08Msr Event Counter

Group Task

Ch03Msr, Ch04Msr T_100ms

Ch05Msr, Ch06Msr, 
Ch07Msr, Ch08Msr

T_10ms
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3. シグナルを選択します。

• 各行の“Signals”列をダブルクリックして
“Signal Selection”ダイアログボックス を開きま
す。 

このダイアログボックス で、当該グループ用に生
成されるシグナルを指定します。シグナルについ
ての説明は、233 ページの「Signals」という項を
参照してください。

• 以下のシグナルを選択します。

• OK をクリックして選択内容を確定します。

4. レベルを選択します。

• 各行の“Active State”列（240 ページを参照して
ください）をダブルクリックします。

ドロップダウンリストが開きます。

Group Signals

Ch04Msr Duty Cycle [%]

Ch05Msr Active Time [µs],
Inactive Time [µs]

Ch03Msr, Ch06Msr, 
Ch07Msr, Ch08Msr

デフォルト設定
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• アクティブステートを以下のシグナルレベルに設
定します。

選択した値が“Active State”フィールドに表示さ
れます。

5. エッジを選択します（PWM Input モードと Event Counterモードのシ
グナルグループのみ）。

• 各行の“Significant Edge”列（234 ページを参照
してください）をダブルクリックして、イベント
として使用するエッジを選択します。

• 必要な設定をすべて終えたら、HWC エディタの
Accept をクリックして設定を保存します。

シグナルグループの設定が終わると、“Groups”タブの内容は以下のようになり
ます。

Group Active State

Ch03Msr Low

Ch04Msr – Ch08Msr High

Group Significant Edge

Ch04Msr, Ch05Msr, 
Ch07Msr

Inactive-
Active

Ch08Msr Both
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“Signals”タブ : ここには“Groups”タブで定義されたシグナルが表示されま
す。

このタブではシグナルの名前と式を編集できますが、サンプルプロジェクトにお
いては、何も変更する必要はありません。

“Mappings”タブ : ここで、プロジェクトのシグナルと ASCET メッセージを互
いに関連付けます。“ASCET Message”列のセルをクリックすると選択ダイアログ
が開きます。そのダイアログには、bñéçêíÉÇ 属性でしかもシグナルグループの転
送方向と一致するメッセージ（ここでは êÉÅÉáîÉ メッセージ）だけが表示されま
す。
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シグナルに任意の ASCET メッセージを割り当てる：

• “Mappings”タブを選択します。

• 各行の“ASCET Message”列をダブルクリックし
ます。

“Message selection”ダイアログボックス が開き
ます。

ASCET プロジェクトに含まれるすべての Receive
メッセージが表示されます。

• 各シグナルについて、以下の ASCET メッセージを
選択します。

• OK をクリックします。

• HWCエディタの Accept ボタンをクリックして設
定内容を保存します。

Signal ASCET Message

Ch03MsrState Ch03DigIn

Ch04MsrDutyCycle Ch04PWMdutycycleIn

Ch05MsrActiveTime Ch05PWMActiveTimeIn

Ch05MsrInactiveTime Ch05PWMInactiveTimeIn

Ch06MsrAdditiveActiveTime Ch06AddActiveTimeIn

Ch07MsrCounterValue Ch07Counter

Ch08MsrCounterValue Ch08Counter
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すべてのシグナルにメッセージが割り当てられると、このタブの表示は以下のよ
うになります。

iba=－=ES1325-LEDデバイス

“Groups”タブ : “Groups”タブではシグナルグループごとの設定を行います。

ES1325-LEDデバイスには、1 つのシグナルグループ（GroupLED）が割り当て
られています。ここでは、このグループにタスクを割り当てます。

“Groups”タブの設定を行う：

• “Groups”タブを選択します。

• 各行の“Task”列をダブルクリックして“Task 
selection”ダイアログボックスを開きます。

• タスク選択リストから、T_1ms (Alarm)タスク
を選択します。

• OK をクリックします。

選択したタスクが“Task”列に表示されます。
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• HWC エディタの Accept をクリックして設定を保
存します。

“Groups”タブの表示は以下のようになります。

“Signals”タブ : ここにはシグナルグループ GroupLEDに属するシグナルが表
示されます。ボード上の各 LED につき 1 つのシグナルが定義されています。

このタブではシグナルの名前と式を編集できますが、サンプルプロジェクトにお
いては、何も変更する必要はありません。
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“Mappings”タブ : ここではプロジェクトのシグナルと ASCET メッセージを互
いに関連付けます。“ASCET Message”列のセルをクリックすると選択ダイアログ
が開きます。そのダイアログには、bñéçêíÉÇ 属性でしかもシグナルグループの転
送方向と一致するメッセージ（ここでは ëÉåÇ メッセージ）だけが表示されます。

シグナルに任意の ASCET メッセージを割り当てる：

• “Mappings”タブを選択します。

• 各行の“ASCET Message”列をダブルクリックし
ます。

“Message selection”ダイアログボックス が開き
ます。

ASCET プロジェクトに含まれるすべての Send
メッセージが表示されます。
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• 各シグナルについて、以下の ASCET メッセージを
選択します。

• OK をクリックします。

• HWCエディタの Accept ボタンをクリックして設
定内容を保存します。

“Mappings”タブの内容は以下のようになります。

11.4.5 ハードウェアコンフィギュレーションの保存

作成したハードウェアコンフィギュレーションは、プロジェクトのファイルコン
テナ内に保存したり、または DOS ファイル（*.HWX）として保存することができ
ます。285 ページの 11.2.5 項を参照してください。

11.4.6 HWC モジュール用のコードの生成

続いて、HWC モジュールのコード生成を行います。コード生成の方法は、286
ページの 11.2.6 項を参照してください。

Signal ASCET Message

LED1 LED1_bool

LED2 LED2_disc

LED3 LED3_cont

LED4 Ch03DigOut

注記

サンプルプロジェクトの参考用コンフィギュレーションは、ES1325.hwkとい
う名前で保存されています。このファイルを上書きしないように注意してくだ
さい。
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11.4.7 サンプルプロジェクトの実験

前項までで RTIO に関する設定がすべて完了したので、HWC エディタを閉じ、次
にプロジェクトエディタで実験ターゲット用の標準的なコードを生成します。

実験ターゲット用のコードを生成する：

• プロジェクトエディタから Component → Build 
を選択して、プロジェクト全体のコードを生成し
ます。

• Component → View Generated Code を選択し
て生成されたコードを表示し、内容を確認しま
す。

オンライン実験を行う：

• ES1325 の入力ポートと出力ポートがまだ接続さ
れていない場合は 309 ページの「接続」の項の記
述に従って接続し、ES1000.x の電源をオンにし
ます。

• プロジェクトエディタの“Experiment Target”コ
ンボボックスから Online (RP)を選択します。

Offline (RP) は、ターゲット上でオフライン
実験を行うための設定です。

注記

HWC モジュールをプロジェクトエディタのグラフィック表示に含めることはお
勧めできません。HWC モジュールは RTIO のコード生成が行われるたびに変わ
るため、予期しない形で表示されてしまうためです。
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• Component → Open Experiment を選択しま
す。

“Physical Experiment“ウィンドウが開き、あらか
じめ定義されている実験環境（5 つのオシロス
コープ、1 つの数値ディスプレイ、4 つの適合エ
ディタ で構成されます）が開きます。

• “Physical Experiment”ウィンドウ のメニューか
ら Experiment → Start ERCOS を選択します。

または

• Start ERCOS ボタンをクリックします。

オペレーティングシステムが起動し、モデルが実
行されます。

• “Physical Experiment”ウィンドウ のメニューか
ら Experiment → Start Measurement を選択し
ます。

または
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• Start Measurement ボタンをクリックします。

ASCET メッセージの値が、オシロスコープと数値
ディスプレイに表示されます。

各モデルブロックについて、以下のような測定や適合を行えます。

デジタル I/O: “Channel 3: Digital I/O”というタイトルのオシロスコープには、
Ch03DigInと Ch03DigOutというメッセージの内容が表示されます。

PWM: : “Channel 4: PWM mode static”というタイトルのオシロスコープには、
DutycycleStaticCh04という変数の内容が表示されます。この変数は PWM シ
グナルのデューティサイクルを記録するものです。アクティブ時間と非アクティ
ブ時間にはどちらも固定的な値が定義されているので、この変数の値は一定です。

“Channel 5: PWM mode”というタイトルのオシロスコープには、
Ch05PWMActiveTimeIn（赤いライン）と Ch05PWMInactiveTimeIn（紫の
ライン）という入力メッセージの内容が表示されます。これらのメッセージには、
PWM シグナルのアクティブ時間と非アクティブ時間が格納されています。また、
Ch05PWMdutycycleOut（緑のライン）と Ch05PWMfrequencyOut（黄色い
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ライン）という出力メッセージも表示されます。これらのメッセージには、PWM
シグナルの周波数（Hz）とデューティーサイクル（%）が格納されています。実
験が開始されると、Ch05PWMActiveTimeInの Y 軸が表示されます。

“Channel 5: PWM mode Control”というタイトルの適合エディタ に表示されてい
るパラメータ P_Ch05Frequencyの値を変更すると、周波数が変わり、アク
ティブ時間と非アクティブ時間も変わります。デューティサイクルは変わりませ
ん。

また、同じ適合エディタに表示されているもう 1 つのパラメータ
P_Ch05DutyCountの値を変更すると、デューティーサイクルの動向が変わり、
アクティブ時間と非アクティブ時間も変わります。周波数は変わりません。
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下図の例では、ポイント 1 において周波数が 1000Hz から 2000Hz に変更された
ため、Ch05PWMActiveTimeIn、Ch05PWMInactiveTimeIn、および
Ch05PWMfrequencyOutのラインが不連続性を示しています。
P_Ch05DutyCount は変更されなかったので、Ch05PWMdutycycleOutの傾
斜はそのままです。

またポイント 2 では、P_Ch05DutyCountパラメータの値が 0.1から 0.5に変
更されたため、Ch05PWMdutycycleOut、Ch05PWMActiveTimeIn、および
Ch05PWMInactiveTimeInのラインの動向が変化しています。このポイントで
は周波数は変わっていません。

1 2
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アクティブタイムの合計 : “Channel 6: Additive Time mode”というタイトルの
オシロスコープには、シグナルのアクティブ時間の合計を受け取る
AdditiveActiveTimeChn06という変数が表示されます。

適合エディタ“Channel 5: PWM mode Control” に表示されている
P_Ch05DutyCountパラメータの値を変更すると、この鋸波の傾斜を変えるこ
とができます。上図のラインの最初の部分では 0.1という値が設定されています
が、次の部分では 0.01という設定に変更されています。

アクティブフェーズの合計時間は周波数には依存しないので、周波数を変更して
も AdditiveActiveTimeChn06シグナルの値は影響を受けません。
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イベントカウンタ : “Channel 7/8: Event Counter mode”というタイトルのオシ
ロスコープには、シグナルカウントを受け取る 2つの変数、CounterCh07（下
側のライン）および CounterCh08（上側のライン）が表示されます。

“Channel 7/8: Event Counter mode Control”というタイトルの適合エディタ の
P_Ch0708DigOutパラメータに trueと falseを交互に設定することにより、
両方の変数をインクリメントすることができます。

チャンネル 8 は両方向のステート変化をカウントするのに対し、チャンネル 7 は
falseから trueへの変化だけをカウントするので、CounterCh07の値は
CounterCh08の半分の速さで増加します。

LED: “LED1”、および“LED2/3”という適合エディタ に表示されるパラメータ
P_LED1、P_LED2、P_LED3を使用して、ES1325 のフロントパネルにある LED
をコントロールします。

LED1 は P_LED1が trueになると点灯し、LED2 は P_LED2が 0でない時に点
灯し、LED3 は P_LED3の値の小数部を切り捨てた結果が 0 でない時に点灯しま
す。
チュートリアル 339



340
11.5 チュートリアル - ES1325（トリガ使用）

トリガを使用する ES1325 のサンプルプロジェクトには、動的な PWM シグナル
を用いるモデル（PWMブロック、図 11-12 を参照してください）が含まれていま
す。このシグナルのデューティーサイクルは、鋸歯シグナルによって決まります。

図 11-11 ES1325（トリガあり） － モデル概観

図 11-12 ES1325( トリガあり） － PWM
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出力シグナル（Chn04PWMfrequencyOutと Chn04PWMdutycycleOutメッ
セージ）は連続的に送信されますが、入力シグナル（Chn04PWMActiveTimeIn と
Chn04PWMInactiveTimeInメッセージ）の読み取りは、ハードウェアトリガ
に
よりコントロールされます。ドリガの発行は、任意に行う（P_TriggerManual
パラメータを使用）ことも、自動的にも行うこともできます。

自動的にトリガをかける場合は、Triggerブロック（図 11-13）内で第 1 のトリ
ガシグナル ES1325_Triggerが計算されます。また任意にトリガをかける場合
は、トリガシグナルは P_Triggerパラメータによりコントロールされます。

第 2 のトリガシグナル ES1325_TriggerGateは、常に P_TriggerGateパラ
メータにより決まります。

図 11-13 ES1325 － トリガ

11.5.1 ES1325 ボード

このボードの機能についての概要、および配線については、308 ページの
「11.4.1　ES1325 ボード」を参照してください。
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11.5.2 サンプルプロジェクト

サンプルプロジェクトを開く：

• コンポーネントマネージャで、ASCET_RP/
RTIOTutorial/ES1325_triggeredという
フォルダを選択します。

• ES1325_triggered_projectというプロジェ
クトを開きます。
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• Specify Code Generation Options ボタンをク
リックします。

“Settings for: ES1325_triggered_project”ダイア
ログボックス が開きます。

• “Build”タブで以下のオプションを設定します。

Target: >ES1130< または >ES1135<
Compiler: GNU-C (PowerPC)

注記

RTIO との通信に使用できるのは、“Exported”として宣言されたメッセージのみ
です。
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11.5.3 ハードウェアコンフィギュレーションの作成

HWC エディタを開く：

• プロジェクトエディタの RTIO → Open Editor を
選択します。

HWC エディタが開きます。

ハードウェアコンフィギュレーション（HWC）を作成する：

各ハードウェアは、アイテムリスト内にツリー構造の形で定義します。このツ
リーのルートには、必ず HWCというアイテムが存在します。

• HWC エディタで Edit → Add Item を選択します。

または

注記

通常、ハードウェアコンフィギュレーションを作成するには、まず HWC とい
う C コードモジュールを作成し、それをプロジェクトに組み込んでからその内
容を編集しますが、このチュートリアルでは、すでにこの HWC モジュールが
プロジェクトに組み込まれています。
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• Add  Item... ボタンをクリックします。

“Add Item”ダイアログボックス が開きます。

Add Item には、次の階層レベルから使用可能な
ア現在選択されているアイテムの次の階層レベル
に追加できるアイテムの一覧が表示されます。

• ES113x を選択します。

このアイテムは、ES1000.x システムで使用され
る PowerPC プロセッサボード ES1130 または
ES1135 に相当します。

• OK をクリックします。

“Items”リストに ES113xというアイテムが追加
されます。

• “Items”リストから ES113x を選択します。
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“Globals”タブには、“Init Task” オプションの欄に Initというデフォルトのタス
ク名が表示されます。サンプルプロジェクトの OS エディタで同じ名前の Init タス
クが定義されているので、ここで他のタスクを選択する必要はありません。

ES1325 の組み込みと設定を行う：

• Edit → Add  Item... を選択して、次の階層レベル
で選択可能なアイテムの一覧を開きます。

• ES1325-DIOを選択します。

これは ES1325 インターフェースを定義するため
に使用されます。
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• OK をクリックします。

“Items”リストに ES1325-DIOというアイテム
が追加されます。

• “Items”リストから ES1325-DIOを選択します。

Init Taskと Exit Taskというオプションには、314 ページの「ES1325 の組
み込みと設定を行う：」の場合と同様に、それぞれ Initと Exitというタスク
名を使用できます。

“ID”オプションの番号は、自動的に設定されます。この ES1325-DIOアイテム
の他には同じタイプのボードは組み込まれていないため、値は ID1となります。

この例題ではハードウェアトリガを使用するので、以下のようにトリガを設定し
ます。

• “HW Trigger Mode”オプションの“Value”列の
セルをダブルクリックします（223 ページを参照
してください）。

ドロップダウンリストが開きます。

• Rising edgeを選択します。

• “HW Trigger Gate”オプションの“Value”列のセ
ルをダブルクリックします（225 ページを参照し
てください）。

ドロップダウンリストが開きます。
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• Onを選択します。

これらの設定により、使用するハードウェアトリ
ガのタイプが決まります。

• Accept を使用してこの設定を有効にします。

このタブの表示は下図のようになります。

デバイスを作成する：

• “Items”リストから ES1325-DIOを選択します。

• Edit → Add  Item... を選択して、次の階層レベル
に組み込むことができるアイテムの一覧を表示し
ます。

• ES1325-Outputを選択して OK をクリックしま
す。

これは、ES1325 の出力チャンネルを定義するた
めのアイテムです。

• さらに、ES1325-Inputというデバイスも追加
します。

これは ES1325 の入力チャンネルを定義するため
のアイテムです。
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これで、サンプルシステムのハードウェア構成に対応するアイテムツリーが完全
しました。

11.5.4 ES1325 の HWC 設定

次に、各入力と出力チャンネルについて設定します。ここでは、出力チャンネル
から供給される信号を入力チャンネルで測定できるようにします。

出力=－=ES1325-Outputデバイス

“Globals”タブ : “Globals”タブについては、ユーザーが設定する必要のあるオ
プションはありません。

“Groups”タブ : “Groups”ではシグナルグループごとの設定を行います。

ES1325-Outputデバイスには、各出力シグナル（Ch<n>Gen、<n>＝ 01～
16）ごとにシグナルグループが割り当てられています。ここでは、使用される各
グループについて、モード、タスク割り当て、生成されるシグナル、トリガタイ
プ（レベルまたはエッジ）を設定します。

“Groups”タブの設定を行う：

• “Groups”タブを選択します。

シグナルグループ 1、2、4 について、以下の手順を実行します。
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1. チャンネルモードを選択します。

• 各グループについて、“Channel Mode”列で以下
のモードを選択します。

“Active State”列には、設定されたモードに対応
するデフォルト値がセットされます。

“Task”列には、シグナル転送を行うタスクを割
り当てることができます。

2. タスクを割り当てます。 
• 各行の“Task”列をダブルクリックして“Task 

selection”ダイアログボックスを開きます。

• タスク選択リストから、データ転送用に以下のタ
スクを選択します。

• OK をクリックします。

選択したタスクが“Task”列に表示されます。

Group Channel Mode

Ch01Gen, Ch02Gen Digital Output

Ch04Gen PWM Periodic 
Output

Group Task

Ch01Gen, Ch01Gen T_1ms

Ch04Gen T_10ms
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3. シグナルを選択します。

• 各行の“Signals”列をダブルクリックして
“Signal Selection”ダイアログボックス を開きま
す。 

シグナルについての説明は、240 ページの
「Signals」という項を参照してください。

• 以下のシグナルを選択します。

• OK をクリックして選択を確定します。

4. レベルを選択します。

すべてのグループがデフォルト設定の Highを使用するので、“Active 
State”列については何も変更する必要はありません。

• すべての設定が終了したら、Accept ボタンで設定
内容を保存します。

Group Signals

Ch01Gen, Ch02Gen デフォルト設定

Ch04Gen Frequency [Hz],
Duty Cycle [%]
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シグナルグループの設定が終わると、“Groups”タブの表示は以下のようになり
ます。

“Signals”タブ : ここには“Groups”タブで生成されたシグナルが表示されま
す。

このタブではシグナルの名前と式を編集できますが、サンプルプロジェクトにお
いては、何も変更する必要はありません。
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“Mappings”タブ : ここではプロジェクトのシグナルと ASCET メッセージを互
いに関連付けます。“ASCET Message”列のセルをクリックすると選択ダイアログ
が開きます。そのダイアログには、bñéçêíÉÇ 属性でしかもシグナルグループの転
送方向と一致するメッセージ（ここでは ëÉåÇ メッセージ）だけが表示されます。

シグナルに任意の ASCET メッセージを割り当てる：

• “Mappings”タブを選択します。

• 当該行の“ASCET Message”列をダブルクリック
します。

“Message selection”ダイアログボックス が開き
ます。

ASCET プロジェクトに含まれるすべての Send
メッセージが表示されます。
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• 各シグナルについて、以下の ASCET メッセージを
選択します。

• OK をクリックします。

• HWCエディタの Accept ボタンをクリックして設
定内容を保存します。

すべてのシグナルにメッセージか値を割り当てると、このタブの表示は以下のよ
うになります。

入力=－=ES1325-Inputデバイス

“Globals”タブ : “Globals”タブでは、デバイス全体に共通するオプション設定
を行います。

Signal ASCET Message

Ch01GenState ES1325_Trigger

Ch02GenState ES1325_TriggerGate

Ch04GenFrequency Chn04PWMfrequencyOut

Ch04GenDutyCycle Chn04PWMdutycycleOut
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“Globals”タブの設定を行う：

• “Globals”タブを選択します。

• IRQ Handler Taskオプションの隣にある空の
ボックスをダブルクリックします。

“Task selection”ダイアログボックス が開きます。

• SW1という Software タスクを選択します。

他のオプションについては、デフォルト設定をそ
のまま使用します。

• Accept ボタンで設定内容を保存します。
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このタブの表示は以下のようになります。

“Groups”タブ : “Groups”タブではシグナルグループごとの設定を行います。

ES1325-Inputデバイスには、各入力シグナル（Ch<n>Msr、<n>＝ 01～
16）ごとにシグナルグループが割り当てられています。ここでは、使用される各
グループについて、モード、タスク割り当て、生成されるシグナル、トリガタイ
プ（レベルまたはエッジ）を設定します。

“Groups”タブの設定を行う：

• “Groups”タブを選択します。

シグナルグループ 4 について、以下の設定を行います。

1. チャンネルモードを選択します。

• 4 番目のシグナルグループの行の“Channel 
Mode”列をダブルクリックします。

ドロップダウンリストが開きます。

• PWM Inputモードを選択します。

同じ行の他の列に、このモードのデフォルト値が
セットされます。
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2. ハードウェアトリガの使用法について設定します。

• 同じ行の“Use HW Trigger”列をダブルクリック
します。

ドロップダウンリストが開きます。

• Yesを選択します。

• 同じ行の“IRQ”列をダブルクリックします。

ドロップダウンリストが開きます。

• Yesを選択します。

“Task”列の内容がリセットされ、ロックされま
す。

3. シグナルを選択します。

• 同じ行の“Signals”列をダブルクリックして
“Signal Selection”ダイアログボックス を開きま
す。

このダイアログボックス で、当該グループ用に生
成されるシグナルを指定します。シグナルについ
ての説明は、233 ページの「Signals」という項を
参照してください。

• Active Time [µs]と Inactive Time [µs]
というシグナルを選択します。

“Active State”列と“Significant Edge”列につい
てはデフォルト値を使用するので、これ以上設定
する必要はありません。

• 必要な設定をすべて終えたら、HWC エディタの
Accept をクリックして設定を保存します。
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シグナルグループの設定が終わると、“Groups”タブの内容は以下のようになり
ます。

“Signals”タブ : ここには“Groups”タブで生成されたシグナルが表示されま
す。

このタブではシグナルの名前と式を編集できますが、サンプルプロジェクトにお
いては、何も変更する必要はありません。
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“Mappings”タブ : ここではプロジェクトのシグナルと ASCET メッセージを互
いに関連付けます。“ASCET Message”列のセルをクリックすると選択ダイアログ
が開きます。そのダイアログには、bñéçêíÉÇ 属性でしかもシグナルグループの転
送方向と一致するメッセージ（ここでは êÉÅÉáîÉ メッセージ）だけが表示されま
す。

シグナルに任意の ASCET メッセージを割り当てる：

• “Mappings”タブを選択します。

• 各行の“ASCET Message”列をダブルクリックし
ます。

“Message selection”ダイアログボックス が開き
ます。

ASCET プロジェクトに含まれるすべての Receive
メッセージが表示されます。
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• 各シグナルについて、以下の ASCET メッセージを
選択します。

• OK をクリックします。

• HWCエディタの Accept ボタンをクリックして設
定内容を保存します。

すべてのシグナルにメッセージが割り当てられると、このタブの表示は以下のよ
うになります。

11.5.5 ハードウェアコンフィギュレーションの保存

作成したハードウェアコンフィギュレーションは、プロジェクトのファイルコン
テナ内に保存したり、または DOS ファイル（*.HWX）として保存することができ
ます。285 ページの 11.2.5 項を参照してください。

11.5.6 HWC モジュール用のコードの生成

続いて、HWC モジュールのコード生成を行います。コード生成の方法は、286
ページの 11.2.6 項を参照してください。

Signal ASCET Message

Ch04MsrActiveTime Chn04PWMActiveTimeIn

Ch04MsrInactiveTime Chn04PWMInactiveTime
In

注記

サンプルプロジェクトの参考用コンフィギュレーションは、ES1325.hwkとい
う名前で保存されています。このファイルを上書きしないように注意してくだ
さい。
チュートリアル



11.5.7 サンプルプロジェクトの実験

前項までで RTIO に関する設定がすべて完了したので、HWC エディタを閉じ、次
にプロジェクトエディタで実験ターゲット用の標準的なコードを生成します。

実験ターゲット用のコードを生成する：

• プロジェクトエディタから Component → Build 
を選択して、プロジェクト全体のコードを生成し
ます。

• Component → View Generated Code を選択し
て生成されたコードを表示し、内容を確認しま
す。

オンライン実験を行う：

• ES1325 の入力ポートと出力ポートがまだ接続さ
れていない場合は 309 ページの「接続」の項の記
述に従って接続し、ES1000.x の電源をオンにし
ます。

• プロジェクトエディタの“Experiment Target”コ
ンボボックスから Online (RP)を選択します。

Offline (RP) は、ターゲット上でオフライン
実験を行うための設定です。

注記

HWC モジュールをプロジェクトエディタのグラフィック表示に含めることはお
勧めできません。HWC モジュールは RTIO のコード生成が行われるたびに変わ
るため、予期しない形で表示されてしまうためです。
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• Component → Open Experiment を選択しま
す。

“Physical Experiment”ウィンドウガ開き、 あらか
じめ定義されている実験環境（1 つのオシロス
コープ、1 つの数値ディスプレイ、3 つの適合エ
ディタで構成されます）が開きます。

デフォルト設定では、第 1 のトリガシグナルと第 2 の固定されたトリガシグナル
の値は、自動的に計算されるようになっています。つまりパラメータ
P_TriggerManualは false、P_TriggerGateは trueに設定されていま
す。
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“PWM mode (triggered)”というタイトルのオシロスコープには、
Chn04PWMdutycycleOut（黄色いライン）という出力メッセージと
Chn04PWMActiveTimeIn（緑のライン）という入力メッセージが表示され、さ
らに、ES1325_Triggerメッセージ（第 1 のトリガシグナルが格納されていま
す）が下部のビットフィールドに表示されます。

デフォルト値を用いて測定を開始すると、2 本のラインが、1 ステップ分タイミン
グがずれた状態で表示されます。

“Trigger Control 2”というタイトルの適合エディタに表示されている
P_TriggerPeriod というパラメータの値を大きくすると、立ち上がりエッジ
間の時間が長くなり、それに伴い Chn04PWMActiveTimeInが読み込まれる頻
度が少なくなります。
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下図の例では、矢印のポイントにおいて P_TriggerPeriodパラメータが 0ms
から 250ms に変更されたため、オシロスコープの下部に表示されるトリガシグナ
ルの立ち上がりエッジの間隔が 250ms になり、それに伴って
Chn04PWMdutycycleOutInメッセージの読み取りの間隔も長くなり、ライン
のステップが大きくなっています。

また、“PWM Control”適合エディタでパラメータ P_Frequencyを変更すると、
周波数が変わり、それに応じてアクティブ時間と非アクティブ時間も変わります。
デューティーサイクルは変わりません。
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下図の例では、矢印のポイントにおいて周波数が 1000Hz から 1500Hz に変更さ
れています。これによって Chn04PWMdutycycleOutのラインは影響を受けま
せんが、Chn04PWMActiveTimeInのラインの最大値が小さくなりました。

上図の場合、オシロスコープ上でショートカットメニューを開いて Extras → 
Setup を選択すると、“Display setup”ダイアログボックスが開き、その中の

“Extent”フィールドには、x 軸の範囲が 5 秒に設定されています。

“Trigger Control 1”適合エディタでは、トリガをコントロールできます。 
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たとえば、P_TriggerGateパラメータの値を falseにすると、第 2 のトリガ
シグナルが falseになるので、Chn04PWMActiveTimeInは読み取られなくな
り、このラインの値は、最後に読み取られたときの値のまま保持されます。この
場合も Chn04PWMdutycycleOutのラインは変わりません。

上図の場合、オシロスコープの x 軸の範囲は 10 秒に設定されていて、さらに変数
P_TriggerGateが追加されています。

P_TriggerGateの値を trueに戻し、Chn04PWMActiveTimeInの測定を続
けてください。

また、同じ適合エディタ“Trigger Control 1”の P_TriggerManualパラメータ
の値を trueにすると、第 1 トリガシグナルのマニュアルコントロールが有効に
なります。すると P_Triggerパラメータの値を falseから trueに変えるた
びにトリガが発生し、同時に Chn04PWMActiveTimeInメッセージが読み取ら
れます。
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下図の例では、ポイント 1 においてマニュアルトリガが有効になっています。
ES1325_Triggerシグナルのラインは、P_Triggerがどのように変更された
かを示しています。Chn04PWMActiveTimeInは、このトリガシグナルの立ち
上がりエッジのたびに読み取られています。 

上図の場合、オシロスコープの x 軸の範囲は 10 秒に設定されています。

1
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NO bq^pネットワークマネージャ

本章では、ETAS ネットワークマネージャを使用して ETAS ネットワークのコン
フィギュレーション設定を行う方法を説明し、いつくかのネットワーク構成例も
ご紹介します。

12.1 概要

ASCET-RP からイーサネット経由でハードウェアシステムにアクセスするには、以
下のいずれかの方法で行えます。

• 複数のネットワークアダプタ（イーサネットカード）を使用

－ 社内 LAN 用アダプタ

－ ETAS ハードウェア用アダプタ

• 1 つのネットワークアダプタを共有

－ 社内 LAN と ETAS ハードウェアとを自動的に切り替え可能

ETAS ネットワークマネージャで、ネットワークアダプタを ETAS ハードウェアに
割り当てます。

ETAS ネットワークマネージャには、PC にインストールされているネットワーク
アダプタの一覧と、各アダプタの IP アドレス割り当て状況が表示されます。シス
テム内に 2 つ以上のネットワークアダプタがインストールされている場合は、こ
こでどちらのアダプタを ETAS ハードウェア用に使用するかを選択できます。ま
た、ETAS ハードウェア用に使用される IP アドレスの範囲を指定することもでき
ます。

ネットワークアダプタを選択したり ETAS ハードウェア用のネットワーク環境を
設定する際、管理者の権限は必要ありません。また ETAS ネットワークと社内
LAN との切り替えは、PC を再起動することなく行なえます。

注記

ASCET-RP V5.4 以降、ETAS ハードウェアを PC に接続するための個別のネット
ワークアダプタは必要なくなりました。社内 LAN と ETAS ネットワークとで 1
つのネットワークアダプタを共有できます。

注記

ネットワークマネージャでは、ネットワークアダプタのコンフィギュレーショ
ン自体を新しく作成したり変更することはできません。これらのことを行うに
は、管理者の権限が必要です（オペレーティングシステムのマニュアルを参考
にしてください）。
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12.2 ETAS ハードウェアのアドレッシング

ETAS ネットワークを使用すると、複数のデバイスを PC に接続することができ、
同種のデバイスを複数接続することも可能です。ETAS ローカルネットワークに接
続された各デバイスは、それぞれ異なる IP アドレスで認識されます。

ASCET-RP に組み込まれた IP マネージャがアドレスプールから 1 つのアドレスを
引き出し、接続されたデバイスに割り当てます。

アドレスプールのアドレス範囲は、ETAS ネットワークマネージャを使用して設定
します。

12.3 ネットワークアダプタのアドレス設定

12.3.1 ネットワークアダプタのアドレッシングタイプ

社内 LAN で使用されるネットワークアダプタのアドレッシングには、オペレー
ティングシステムの種類やネットワークアダプタのコンフィギュレーションに
よって、以下のようなタイプが使用されます。

また ETAS ネットワークがサポートするネットワークアダプタのアドレッシング
タイプは、以下のとおりです。

オペレーティング

システム

ネットワークアダプタのアドレッシングタイプ

マニュアル

設定

DHCP DHCP+APIPA DHCP +
代替 IP アドレス

Windows NT ○ ○ － －

Windows 98 SE ○ ○ ○ －

Windows 2000 ○ ○ ○ －

Windows XP ○ ○ ○ ○

○： 使用可、 －： 使用不可

オペレーティング

システム

ネットワークアダプタのアドレッシングタイプ

マニュアル
設定

DHCP DHCP+APIPA DHCP +
代替 IP アドレス

Windows NT ○ ○ － －

Windows 98 SE ○ － ○ －

Windows 2000 ○ － ○ －

Windows XP ○ － ○ ○

○： 使用可、 －： 使用不可
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1 つのネットワークアダプタを社内 LAN と ETAS ネットワークの両方で共有する
場合、DHCP アドレッシングのみをサポートするネットワークアダプタは使用で
きません（ただし Windows NT の場合を除きます）。DHCP が使用できるのは、
APIPA または代替 IP アドレスが併用されている場合のみです。

12.3.2 ネットワークアダプタアドレスのマニュアル設定

ネットワークアダプタのアドレスをマニュアル設定する方法は、オペレーティン
グシステムによって異なるため、ご使用のオペレーティングシステムのマニュア
ルを参考にしてください。

ネットワークアダプタのアドレスをマニュアル設定するには、管理者の権限が必
要ですので、詳しくはシステム管理者の方にご相談ください。

ネットワークアダプタのアドレスをマニュアル設定して固定 IP アドレスを割り当
てていた場合、社内ネットワーク に接続したまま ETAS ハードウェアの検索や初
期化の操作を行ってしまうとことを防ぐため、IP アドレスが ETAS ハードウェア
に割り当てられる前に警告が表示されるように、ネットワークマネージャで設定
しておくことができます。

12.3.3 DHCP によるネットワークアダプタのアドレス設定

DHCP でのアドレッシングを行うには、DHCP サーバーが利用可能である必要が
あります。DHCP サーバーがなかったり利用不可能であった場合（ETAS ネット
ワークへの接続時など）、ネットワークアダプタの設定は行えません。

このため、各オペレーティングシステム（Windows NT を除く）には、ネット
ワークアダプタに代替 IP アドレスを自動的に割り当てるための以下のようなメカ
ニズムが用意されています。

táåÇçïë=VU=pb

Windows 98 SE では、社内 LAN には自動的に DHCP アドレスが使用され、ETAS
ネットワークには APIPA アドレスが使用されます。PC 起動時に社内 LAN（DHCP
ネットワーク）に接続されていた場合、ETAS ソフトウェア（ASCET-RP など）が
起動されると、オペレーティングシステムによって、ネットワークアダプタは
DHCP アドレスから APIPA アドレスに自動的に再設定されます。この切り替え処
理が完了するまでには 60 秒ほどかかります。ETAS ネットワークを使用した後に
PC を DHCP ネットワークに再接続すると、ネットワークアダプタは DHCP アド
レスに再設定されます。この処理には 5 分ほどかかる場合がありますが、この時
間は、同じ処理をマニュアル実行することによって短くすることができます。そ
のためには、MS-DOS コマンドウィンドウから ipconfig /renewコマンドを
実行してください。

APIPA アドレスを併用しない DHCP でのネットワークアダプタのアドレス設定は
サポートされていません。
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táåÇçïë=OMMM

Windows 2000 では、DHCP サーバーへの接続が確立されているかどうか自動的
に判定され、接続されていない場合は APIPA によって IP アドレスが自動的に割り
当てられます。ETAS ネットワーク内では、常に APIPA アドレスが使用されます。
社内 LAN（DHCP ネットワーク）から ETAS ネットワークへの切り替えを行う際
は、オペレーティングシステムがネットワーク接続の切断を検知してネットワー
クアダプタの再設定を開始できるよう、10 秒間ほど接続を切断したままにしてく
ださい。オペレーティングシステムによる DHCP アドレスから APIPA アドレスへ
の再設定処理には、60 秒ほどを要します。その後、PC を再び DHCP ネットワー
クに接続する際には、DHCP サーバーへの接続が検出された時点で、すぐにネッ
トワークアダプタに対して DHCP アドレスが再設定されます。

APIPA アドレスを併用しない DHCP でのネットワークアダプタのアドレス設定は
サポートされていません。

táåÇçïë=um

Windows XP では、DHCP サーバーへの接続が確立されているかどうか自動的に
判定され、接続されていない場合は、APIPA によって IP アドレスが自動的に割り
当てられるか、またはユーザー定義の代替 IP アドレスが使用されます。ETAS
ネットワーク内では、APIPA アドレスと代替 IP アドレスのいずれか使用されます。
社内 LAN（DHCP ネットワーク）から ETAS ネットワークへの切り替えを行う際
は、オペレーティングシステムがネットワーク接続の切断を検知してネットワー
クアダプタコンフィギュレーションの再設定を開始できるよう、10 秒間ほど接続
を切断したままにしてください。オペレーティングシステムによる DHCP アドレ
スから APIPA アドレスまたは代替 IP アドレスへの再設定処理には、60 秒ほどを
要します。その後、PC を再び DHCP ネットワークに接続する際には、DHCP サー
バーへの接続が検出された時点で、すぐにネットワークアダプタに DHCP アドレ
スが再設定されます。

代替 IP アドレスや APIPA を併用しない DHCP でのネットワークアダプタのアドレ
ス設定はサポートされていません。

táåÇçïë=kq

Windows NT では、DHCP アドレスはある一定の時間（「リース期間」と呼ばれま
す）の間のみ割り当てられ、この期限を過ぎるとネットワークアダプタは未設定
状態となります。そこで、ネットワークマネージャでこのリース期間を延長する
ことにより、社内 LAN から切り離されても、延長された期間はネットワークアダ
プタの IP アドレスを使用できるようなります。リース期間は ETAS ソフトウェア
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（ASCET-RP など）が最初にハードウェアをアクセスした時からカウントされます。
リース期間を延長する処理には約 20 秒かかり、ETAS ソフトウェアが終了すると、
リース期間はもとの設定時間に戻ります。

12.4 ユーザーインターフェース

12.4.1 “ETAS ハードウェア用のネットワーク設定（ページ 1）”ダイアログボックス

現在使用可能なネットワークアダプタについての以下の情報が表示されます。

• 名前

ネットワークアダプタの名前です。このダイアログでは変更できません。

• IP アドレス

ネットワークアダプタの IP アドレスです。このダイアログでは変更できま
せん。

• サブネットマスク

サブネットマスクの設定です。このダイアログでは変更できません。

• DHCP

ネットワークアダプタが DHCP 用に設定されているかどうかを表わしま
す。

－ Enabled

ネットワークアダプタが DHCP 用に設定されています。

注記

リース期間の変更は、DHCP ネットワークから切り離される時間が、現在設定
されているリース期間よりも長い場合にのみ意味を持ちます。IP アドレスの衝
突を防ぐため、ETAS ソフトウェアを終了して DHCP ネットワークに戻す際は、
ETAS ソフトウェアの終了後 20 秒間は、DCHP ネットワークに接続しないでく
ださい。
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－ Disabled

ネットワークアダプタが固定 IP アドレス用に設定されています。

• 代替の IP コンフィギュレーション

DHCP 設定のネットワークアダプタの代替 IP アドレスが表示されます。こ
この表示内容は、オペレーティングシステムによって異なります。

－ APIPA

Automatic Private IP Addressing： ネットワーク接続用の IP コンフィ
ギュレーションの自動化を行います。

－ ---

代替 IP アドレスがありません。

Windows NT の場合は、代替 IP アドレスはサポートされていません。

－ ユーザー定義

代替 IP アドレスをユーザー定義することができます（Windows XP の
場合）。

12.4.2 “ETAS ハードウェア用のネットワーク設定（ページ 2）”ダイアログボックス

各アドレスの値の変更は、キー入力によって直接編集するか、またはリストボッ
クスからデフォルト設定を選択します。

以下のネットワークパラメータを設定できます。

• 先頭アドレス

ETAS ハードウェア用の IP アドレス範囲の 1 番目のアドレスです。

• 最終アドレス

ETAS ハードウェア用の IP アドレス範囲の最後のアドレスです。
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• サブネットマスク

使用するサブネットマスクです。

予約された fm アドレス

ETAS ハードウェアが現在使用している IP アドレス範囲（192.168.40.1 ～ 
192.168.40.254、サブネットマスク 255.255.255.0）のうち、以下の IP アドレス
は、ETAS の特定のハードウェア用に予約されています。

これらのアドレスは特定のデバイスにのみ使用でき、他の ETAS ハードウェアに
は使用できません。アドレスプールを定義する際は、この点を考慮する必要があ
ります。

12.4.3 “ETAS ハードウェア用のネットワーク設定（ページ 4）”ダイアログボックス

このダイアログボックスは、選択されたネットワークアダプタのアドレスがマ
ニュアル設定されている場合にのみ開きます。

ここでは以下のオプションを設定します。

IP アドレス ETAS ハードウェア

192.168.40.10 ES1120

192.168.40.11 ES1130

192.168.40.12 ES780

192.168.40.13 （予約済み）

192.168.40.14 LABCAR-RTPC

192.168.40.15 ES1135
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• IP 割り当てが行われる時に警告を表示する

このオプションがオンになっていると、ETAS ハードウェアデバイスに IP
アドレスが割り当てられる際に、前もって警告メッセージが表示されま
す。

12.4.4 “ETAS ハードウェア用のネットワーク設定（ページ 5）”ダイアログボックス

このダイアログボックスは、オペレーティングシステムが Windows NT で、かつ
選択されたネットワークアダプタが DHCP 用に設定されている場合にのみ開きま
す。

ここでは以下のオプションを設定します。

• オリジナルの DHCP リース期限

DHCP のリース期間が終了する時間を示します。このフィールドは変更で
きません。

• 期限の延長

リース期間を延長する日数を指定します。ここには 365 までの整数を入力
できます。

注記

この警告は、そのネットワークアダプタで、社内 LAN と、ETAS ネットワー
ク内の ETAS 測定モジュールの両方に接続する場合にのみ意味を持ちます。
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12.5 ETAS ハードウェア用のネットワークアドレスの設定

12.5.1 ネットワークアドレスの設定： 固定 IP アドレスのアダプタの場合

ネットワークマネージャを起動する：

• Windows のスタートメニューから、プログラム 
→ ETAS → ASCET5.1 → ETAS Network 
Settings を選択します。

“ETAS ハードウェア用のネットワーク設定（ペー
ジ 1）”ダイアログボックスが開きます。

ネットワークアダプタを選択する：

• 使用可能なネットワークアダプタフィールドで、
社内 LAN と ETAS ネットワーク用に使用したい
ネットワークアダプタを選択します。

ここでは、ETAS ネットワークがサポートするア
ドレッシングが指定されているネットワークアダ
プタしか選択できません。

ここでネットワークマネージャを終了するには、
キャンセル をクリックします。
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• 次へ をクリックして先に進みます。

“ETAS ハードウェア用のネットワーク設定（ペー
ジ 2）”ダイアログボックスが開きます。

ネットワークアドレスの設定：=固定 fm アドレスを使用している場合

アドレスプールを設定する：

• “ETAS ハードウェア用のネットワーク設定（ペー
ジ 2）”ダイアログボックスで、“先頭アドレス”、

“最終アドレス”、“サブネットマスク”のうち、
変更したいフィールドを選択します。

• アドレスの値を直接キー入力します。

または

• デフォルト ボタンをクリックします。

アドレス範囲とサブネットマスクの値は、ネット
ワークマネージャによって自動的に設定されま
す。その値を使用するか、またそれをさらに編集
することもできます。

設定内容を破棄してネットワークマネージャを終
了するには キャンセル をクリックし、前のペー
ジに戻るには戻る をクリックします。

注記

DHCP 環境内でネットワークアダプタの設定を行っている場合は、上記のボタ
ンの他に 終了 ボタンが表示されます。
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• 次へ をクリックします。

“ETAS ハードウェア用のネットワーク設定（ペー
ジ 4）”ダイアログボックスが開きます。

ユーザー定義の IP アドレスを設定する：

• ETASハードウェアへに IPアドレスが割り当てられ
る際に前もって警告メッセージが表示されるよう
にするには、IP 割り当てが行われる時に警告を表
示する オプションをオンにします。

設定内容を破棄してネットワークマネージャを終
了するには キャンセル をクリックし、前のペー
ジに戻るには戻る をクリックします。

• 終了 をクリックします。

ネットワークアダプタの設定が終了し、ダイアロ
グボックスが閉じます。変更された内容はすべて
保存されます。

• 変更内容が有効になるように、ASCET-RP（また
はその他の ETAS ソフトウェアアプリケーション）
を再起動します。

ASCET-RP でのハードウェア検索時または初期化
時に自動的にネットワークマネージャが呼び出さ
れた場合は、再起動は必要ありません。

注記

この警告は、そのネットワークアダプタで、社内
LAN と、ETAS ネットワーク内の ETAS 測定モ
ジュールの両方に接続する場合にのみ意味を持ち
ます。
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ネットワークアドレスの設定：=ae`m を使用している場合

アドレスプールを設定する：

• “ETAS ハードウェア用のネットワーク設定（ペー
ジ 2）”ダイアログボックスで、“先頭アドレス”、

“最終アドレス”、“サブネットマスク”のうち、
変更したいフィールドを選択します。

• アドレスの値を直接キー入力します。

または

• デフォルト ボタンをクリックします。

アドレス範囲とサブネットマスクの値は、ネット
ワークマネージャによって自動的に設定されま
す。その値を使用するか、またそれをさらに編集
することもできます。

1. DHCP 環境内において APIPA または代替 IP アドレスを使用しているネット
ワークアダプタの場合、以下のように操作して設定を終了します。

• 終了 をクリックします。

ネットワークアダプタの設定が終了し、ダイアロ
グボックスが閉じます。変更された内容はすべて
保存されます。

• 変更内容が有効になるように、HSP およびその他
の ETAS ソフトウェアアプリケーションを再起動
します。

HSP のハードウェア検索時または初期化時に自動
的にネットワークマネージャが呼び出された場合
は、再起動の必要はありません。

2. DHCP 環境内で使用されているネットワークアダプタを、Windows NT で
使用している場合、以下のように操作して設定を続けます。

• 次へ をクリックします。

“ETAS ハードウェア用のネットワーク設定（ペー
ジ 5）”ダイアログボックスが開きます。
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Windows NT で DHCP を設定する：

• 期限の延長 フィールドにリース期間を延長する日
数を入力します。

設定内容を破棄してネットワークマネージャを終
了するには キャンセル をクリックし、前のペー
ジに戻るには戻る をクリックします。

• 終了 をクリックします。

ネットワークアダプタの設定が終了し、ダイアロ
グボックスが閉じます。変更された内容はすべて
保存されます。

• 変更内容が有効になるように、ASCET-RP（また
はその他の ETAS ソフトウェアアプリケーション）
を再起動します。

ASCET-RP でのハードウェア検索時または初期化
時に自動的にネットワークマネージャが呼び出さ
れた場合は、再起動は必要ありません。

12.6 イーサネット経由のハードウェアアクセスについてのトラブルシュー
ティング

ここでは、イーサネットインターフェースで ETAS ハードウェアをアクセスする
際に発生する可能性のある障害について説明します。

12.6.1 Windows 98 SE、2000、XP において APIPA が無効になる

IP アドレッシングの代替メカニズムである APIPA は、通常、Windows 98 SE、
2000、および XP 環境においては有効になっていますが、時にはネットワークセ
キュリティポリシーによって無効となっている場合もあります。そのような場合、
DHCP 設定のネットワークアダプタを ETAS ハードウェアのアクセスに使用するこ
とはできず、そのアダプタを選択すると ETAS ネットワークマネージャは警告
メッセージを表示します。

無効になっている APIPA メカニズムを有効にするには、Windows のレジストリを
編集する必要がありますが、これを行うには管理者の権限が必要です。ネット
ワーク管理者の方にご相談のうえ行ってください。

APIPA メカニズムを有効にする：

• Windows の スタート メニューから ファイル名を
指定して実行 を選択します。

• regedit と入力して OK をクリックします。

レジストリエディタが開きます。
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• 以下のフォルダを開きます。

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControl
Set\Services\

• 編集 → 検索 を選択して以下のキーを検索します。

IPAutoconfigurationEnabled

• 見つかったキーの値をすべて 1 に変更し、APIPA
メカニズムを有効にします。

Windows のレジストリ内には、この名前のキー
がいくつか含まれている場合があります。これ
は、TCIP/IP サービス全般、および個々のネット
ワークアダプタごとに APIPA メカニズムを無効に
できるためです。

• レジストリエディタを閉じます。

APIPA メカニズムが無効になっていない場合、レジストリ内にこのキーは存在し
ません。

12.6.2 パーソナルファイアウォール

Windows XP には、パーソナルファイアウォールが組み込まれていますが、その
他のシステムの場合でも、Symantec、McAfee、BlackIce、といったサードパー
ティのパーソナルファイアウォールが使われていることがよくあります。

このパーソナルファイアウォールは、ASCET-RP からのイーサネットハードウェア
へのアクセスを妨害する場合があります。ハードウェアの自動検索を行った際、
ハードウェアのコンフィギュレーションは正しく設定されているにもかかわらず、
イーサネットハードウェアがまったく検出されない、というような場合、これは
PC 上にファイアウォールソフトウェアがインストールされているためである可能
性があります。

このような場合は、ASCET-RP での作業中にはファイアウォールソフトウェアを無
効にするか、または IP アドレス 192.168.40.240 （ポート 18000 - 18005）に対
してファイアウォールを開いておいてください。詳しくは、お使いのパーソナル
ファイアウォールの説明書を参照してください。
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NP 付録：=^mf関数

本章では、ASCET-RP において実験ターゲット ES113x 用に使用できる API
（Application Programming Interface）関数を紹介します。これらの関数は、
ASCET-RP と以下のコンポーネントとのインターフェースとして用いられます。

• ERCOSEK

• NVRAM

• ウォッチドッグ

• LED

• その他

以下の項では、上記のアプリケーションごとに API 関数の仕様を詳しく説明しま
す。各 API 関数の仕様は、以下の形式で記述されています。

13.1 API 関数（ERCOSEK）

次の表は、ASCET-RP において ES113ｘ 実験ターゲット用のコマンドとして使用
できる ERCOSEK 用 API 関数の一覧です。各コマンドの詳細は、機能別に以降の項
で説明します。

_exampleRoutine

機能 サービスの機能についての簡単な説明です。

構文 C 関数のプロトタイプ形式で構文が明記されています。

説明 ここには、サービスルーチンやその引数などについての詳細な説明、お
よびサービスルーチンを使用する際の注意事項が記載されています。

引数 引数として使用できる値の一覧です。（引数は、「説明」の行にまとめて
記述されている場合もあります。）

戻り値 戻り値がある場合にはその型と値の範囲、および意味が明記されます。

使用例 関数の典型的な使用法を示しています。

参照 関連する関数のリストです。

ヒント 一部の関数については、さらに有用な情報を提供するヒントが付記され
ています。

コマンド 機能 ページ

アプリケーションモード

DeclareAppMode アプリケーションモードの外部宣言を行います。 136

SetNextAppMode アクティブなすべてのタスクの処理を終了して

から、指定されたアプリケーションモードに切

り替えます。

140
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13.1.1 アプリケーションモード

アプリケーションモードのコンセプトを利用すれば、アプリケーションソフト
ウェアのさまざまな処理状態を効率的に管理することができます。各アプリケー
ションモードは、そのモードにおいてアクティブになる一連のタスクと、1 つま
たは複数のタイムテーブル（オプション）により定義されます。たとえば、エン
ジン ECU 用アプリケーションの場合、アプリケーションモードには、通常運転

（物理プロセス制御）、自動診断、フラッシュ EPROM プログラミングといったも
のが考えられます。アプリケーションモードは一度に 1 つだけアクティブにする
ことができます。

1 つのアプリケーションモードは 2 つのフェーズで構成されます。1 つめは初期
化フェーズで、そこでアプリケーションの初期化ルーチンの処理が行われます。
このフェーズでは割込みはディセーブルになっています。初期化が終わると割込
みがイネーブルになり、実行フェーズが始動します。そこでは、アクティブ化さ
れたタスクが、それぞれの優先度に応じて実行されます（＝スケジューリングさ
れます）。

タスク

DeclareTask タスクの外部宣言を行います。 143

ActivateTask SW タスクをアクティブ化します。 144

システムタイム

GetSystemTime 現在のシステムタイムを取得します。 151

GetSystemTimeLow 現在のシステムタイムの下位部分を取得します。 151

GetSystemTimeHigh 現在のシステムタイムの上位部分を取得します。 152

割込み処理

EnableAllInterrupts すべての割込みをイネーブルにします。 179

DisableAllInterrupts すべての割込みをディセーブルにします。 179

dT の問い合わせ

GetDeltaT dT の値を返します。 182

コマンド 機能 ページ
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DeclareAppMode

機能 アプリケーションモードの外部宣言を行います。

構文 #define DeclareAppMode(Mode) 
extern AppModeType Mode

説明 1 つのモジュール内でアプリケーションモードの切り替えが行われ、そ
のアプリケーションモードのディスクリプタが別のモジュール内で定義
されている場合、そのディスクリプタの使用法が DeclareAppMode()
で公開されている必要があります。
このサービスの機能と使用法は、変数の外部宣言と似ています。

使用例 extern uint excCtr;
extern uint randx;
DeclareAppMode(idleMode);

参照 DeclareTask

SetNextAppMode

機能 アクティブなすべてのタスクの処理を終えてから、指定されたアプリ
ケーションモードに切り替えます。

構文 StatusType SetNextAppMode(AppModeType appMode)

説明 SetNextAppMode()は、ポインタ appModeで参照されるアプリケー

ションモードへの切り替えをリクエストします。実行中のタスクがなく

なると、つまりオペレーティングシステムがアイドル状態になると、オ

ペレーティングシステムは直ちにこの切り替えを実行します。 
ChainTask()や RestartTask()（これらの API 関数は ASCET-RP で

はサポートされていません）によるタスクアクティブ化は無視されます。

ハードウェアタスクがスタートアップ時（初期化フェーズ）に初期化さ

れるようになっている場合、それらのタスクは次のアプリケーション

モード用に初期化されます。

戻り値 E_OK リクエストは正常に処理されました。

使用例 SetNextAppMode(driveMode);

参照 －

SetNextAppMode (driveMode);

ここで
アプリケーションモード

が切り替わります。

Task A

Task B

Task C

優先度

時間
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13.1.2 タスク

ERCOSEK には、2 種類のタスクがあります。1 つは ActivateTask()によりア
クティブ化されるソフトウェアタスク（SW タスク）で、その実行は ERCOSEK ス
ケジューラにより管理されます。もう 1 つは割込みによりアクティブ化される
ハードウェアタスク（HW タスク）で、その実行はプロセッサの割込み制御ロ
ジック、つまりハードウェアにより行われます。

DeclareTask

機能 タスクの外部宣言を行います。

構文 #define DeclareTask(TaskID) 
extern TaskType TaskID

説明 あるモジュールで使用するタスクが別のモジュールで定義されている場
合、その使用法が DeclareTask()で宣言されている必要があります。
このサービスの機能と使用法は、変数の外部宣言と似ています。

使用例 extern uint excCtr;
extern uint randx;
DeclareTask(synchroSeq);

参照 DeclareAppMode

ActivateTask

機能 SW タスクをアクティブ化します。

構文 StatusType ActivateTask(TaskType TaskID)

説明 ActivateTask()は、TaskIDで指定された SW タスクの処理をオペ
レーティングシステムに要求します。タスクのアクティブ化に成功する

（戻り値を参照してください）と、そのタスクはその優先度に応じて
ERCOSEK スケジューラによりスケジューリングされます。
BCC2 の仕様により 1 つのタスクを同時に複数個アクティブ化すること
が許されているため、タスクの現在のアクティブ化数が 1 より大きい場
合、このタスクは一時的に FIFO バッファに格納されます。
ActivateTask()が正常に実行されなかった場合、ユーザー定義のエ
ラーフック処理が実行されます。

戻り値 E_OK アクティブ化に成功しました。

E_OS_LIMIT アクティブ化は行われませんでした。（タスクのアク

ティブ化数が指定のリミット数に達していたか、ある

いは指定された優先度レベルの FIFO バッファ内のタス

ク数が最大数に達していたため）

使用例 ActivateTask(synchroSeq);

参照 －
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13.1.3 システムタイム

離散的なシステムタイムは、ERCOSEK の時間管理の基礎となるものです。ハード
ウェアベースのシステムタイムを持たないターゲットの場合、システムタイムは
オペレーティングシステムの起動と同時に 0 にセットされます。システムタイム
は通常 2 ワード長でカウントされ、アラームサービスや ERCOSEK タイムテーブル
の基準時間として使用されます。システムタイムのオーバフローが発生するまで
の時間は、CPU および使用されるハードウェアタイマの周波数によって異なりま
す。アプリケーションモードが変化しても、システムタイムに割込みがかかった
り、システムタイムがリセットされたりすることはありません。

システムタイムは、基礎となるタイマレジスタのカウント（tick）を単位としてカ
ウントされます。SYSTEM_TICK_DURATION というマクロは、この 1 カウント

（1 tick）の長さをナノ秒単位で返します。

GetSystemTime

機能 現在のシステムタイムを取得します。

構文 TimeType GetSystemTime(void)

説明 GetSystemTime()は、システムタイムを刻み単位で返します。シス
テムタイムのワード長はシステムによって異なります（16 ビットシステ
ムの場合は 32 ビット長、32 ビットシステムの場合は 64 ビット長で
す）。

戻り値 現在のシステムタイム

使用例 TimeType now;
now = GetSystemTime();

参照 GetSystemTimeLow, GetSystemTimeHigh

GetSystemTimeLow

機能 現在のシステムタイムの下位部分を取得します。

構文 TickType GetSystemTimeLow(void)

説明 GetSystemTimeLow()は、現在のシステムタイム（刻みを単位とする
値）の下位部分（32 ビット長のシステムタイムを使用するシステムの場
合は下位 16 ビット、64 ビット長のシステムタイムを使用するシステム
の場合は下位 32 ビット）を返します。

戻り値 現在のシステムタイムの下位部分

使用例 TickType lowPartOfNow;
lowPartOfNow = GetSystemTimeLow();

参照 GetSystemTime, GetSystemTimeHigh
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13.1.4 割込み処理

ERCOSEK の割込み関連の API 関数のうち、ASCET-RP では割込みイネーブル／
ディセーブルを制御するための関数がサポートされています。

GetSystemTimeHigh

機能 現在のシステムタイムの上位部分を取得します。

構文 TickType GetSystemTimeHigh(void)

説明 GetSystemTimeHigh()は、現在のシステムタイム（刻みを単位とす
る値）の上位部分（32 ビット長のシステムタイムを使用するシステムの
場合は上位 16 ビット、64 ビット長のシステムタイムを使用するシステ
ムの場合は上位 32 ビット）を返します。

戻り値 現在のシステムタイムの上位部分

使用例 TickType highPartOfNow;
highPartOfNow = GetSystemTimeHigh();

参照 GetSystemTime, GetSystemTimeLow

EnableAllInterrupts

機能 すべての割込みをイネーブルにします。

構文 void EnableAllInterrupts(void)

説明 EnableAllInterrupts()は、コントローラの割込みを、割込みマス
クの操作なしにすべてイネーブルにします。
DisableAllInterrupts()が複数回呼ばれていた場合、それと同じ
回数だけ EnableAllInterrupts()が呼び出されない限り割込みは
イネーブルにならない、という安全な多重割込みディセーブル処理がサ
ポートされています。

戻り値 なし

参照 DisableAllInterrupts

DisableAllInterrupts

機能 すべての割込みをディセーブルにします。

構文 void DisableAllInterrupts(void)

説明 DisableAllInterrupts()は、すべての割り込みをディセーブルに

します。

戻り値 なし

参照 EnableAllInterrupts
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13.1.5 dT の問い合わせ

ERCOSEK は、現在実行中のタスクの前回の処理開始から今回の処理開始までの時
間を問い合わせるためのサービスルーチンを提供します（下図を参照してくださ
い）。返される時間は、このサービスを呼び出したタスクの dT の値です。

GetDeltaT() が返す dT は、以下のような積分計算を行う際に非常に有用です。

GetDeltaT

機能 dT の値を返します。

構文 TickType GetDeltaT(void)

説明 GetDeltaT()は、タスクが 2 回連続して実行された間に経過した
時間を返します。
注記：この時間がハードウェアタイマの幅の半分を超える値となっ
た場合、返される値は信頼できません。
この関数は ERCOSEK のデバッグモードでのみサポートされます。
ERCOSEK アプリケーションのデバッグについての詳細は、

『ERCOSEK ユーザーズガイド』の「タスクモニタ内のデバッグ情報』
という項を参照してください。

戻り値 dT の値（システムタイマのカウント数）

使用例 TickType deltaT;
deltaT = GetDeltaT();

参照 －

優先度
dTB1

dTA1 dTA2 dTA3

GetDeltaT()==dTB1

*: GetDeltaT()==dTA1

GetDeltaT()==dTA2

GetDeltaT()==dTA3*Task B

時間

Task A

バックグラウンド
タスク

( ) ∫ ⋅=
x

dTTfxF
0

)(
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13.2 API 関数（NVRAM）

NVRAM（不揮発性 RAM）に配置される NV 変数を扱う「NVRAM マネージャ」の
デフォルトの機能は 6.2.1 項で説明されていますが、ASCET モデル（C コードコ
ンポーネント）内から以下の API 関数を使用して、この挙動を変更することがで
きます。

nvramInitModelVars

機能 NV 変数を初期化します。

構文 uint32 nvramInitModelVars(void)

説明 NVRAM の内容が有効であり、モデルとの整合性がある場合、NV 変数に

NVRAM の内容を初期値として設定します。この初期設定は、NVRAM の

定期的な更新を開始する前に、C コード、L1、または自動フラグを用い

て、一度だけトリガできます。

戻り値 EC_NVRAM_SUCCESS 成功

EC_NVRAM_NO_NV_VARIABLES モデル内に NV 変数がありませ

ん。

EC_NVRAM_INADMISSIBLE_USE 関数が既にコールされています。

EC_NVRAM_INTERNAL_ERROR 内部エラーが発生しました。

EC_NVRAM_NO_MATCH NVRAM の内容がカレントモデル

とマッチしません。

使用例 –

参照 nvramCheckForInitializedVars

nvramSetUpdateInterval

機能 NVRAM の自動更新の間隔を設定します。

構文 uint32 nvramSetUpdateInterval(uint32 interval_sec)

説明 NVRAM を自動更新する間隔を設定します。システム負荷（現在設定され

ている整合性レベルに大きく依存します）が高くなると、実際の時間間

隔はこの設定よりも長くなる可能性があり、10 回以上、要求された間隔

よりも長い間隔で更新が行われると、実験環境内でワーニングが発行さ

れます。

引数： interval_sec 更新間隔（単位は秒）。0 ～ 30 の値で

なければなりません（0 を設定すると

定期更新は行われません）。

戻り値 EC_NVRAM_SUCCESS 成功

EC_NVRAM_INVALID_ARG Interval_sec > 30

使用例 –

参照 nvramGetUpdateInterval
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nvramGetUpdateInterval

機能 NVRAM の自動更新の間隔を取得します。

構文 uint32 nvramGetUpdateInterval(void)

説明 NVRAM の自動更新の間隔を取得します。

戻り値 interval_sec 更新間隔（単位は秒）。

使用例 –

参照 nvramSetUpdateInterval

nvramSetConsistencyLevel

機能 NV 変数のデータ整合性レベルを設定します。

構文 uint32 nvramSetConsistencyLevel
(T_consistencyLevel level)

説明 NV 変数のデータ整合性レベルを設定します。

整合性なし：NVRAM の更新は、各変数の整合性を無視して行われます。

低レベルの整合性：NV 変数のうち、スカラ、ベクタ、マトリックス内の

データ整合性は保証されますが、特性カーブ／マップのデータの整合性

は保証されません。

高レベルの整合性：NVRAM 内の NV 変数の更新は、アイドルタスクにお

いて、すべての NV 変数の内容が中断なくローカルバッファに保存された

場合のみ行われるので、すべての NV 変数の整合性が保証されます。

戻り値 EC_NVRAM_SUCCESS 成功

EC_NVRAM_INVALID_ARG 引数 levelは無効です。

引数 level NVRAM_NO_CONSISTENCY
NVRAM_LOW_CONSISTENCY
NVRAM_HIGH_CONSISTENCY

使用例 –

参照 nvramGetConsistencyLevel

nvramGetConsistencyLevel

機能 NV 変数のデータ整合性レベルを取得します。

構文 T_consistencyLevel 
nvramGetConsistencyLevel(void)

説明 NV 変数のデータ整合性レベルを取得します。

戻り値 NVRAM_NO_CONSISTENCY 整合性なし

NVRAM_LOW_CONSISTENCY 低レベルの整合性

NVRAM_HIGH_CONSISTENCY 高レベルの整合性

使用例 –

参照 nvramSetConsistencyLevel
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nvramEnableAutoUpdate

機能 NVRAM の内容の自動更新をオンにします。

構文 uint32 nvramEnableAutoUpdate(void)

説明 NVRAM の内容の自動更新をオンにします。これにより、Exit タスクによ

り行われる更新処理に加え、定期的な自動更新が行われます。

戻り値 EC_NVRAM_SUCCESS 成功

使用例 –

参照 nvramDisableAutoUpdate, nvramCheckForAutoUpdate

nvramDisableAutoUpdate

機能 NVRAM の内容の自動更新をオフにします。

構文 uint32 nvramDisableAutoUpdate(void)

説明 NVRAM の内容の自動更新をオフにします。これにより、定期的な更新

と、Exit タスクにより実行される更新処理が行われなくなります。

戻り値 EC_NVRAM_SUCCESS 成功

使用例 –

参照 nvramEnableAutoUpdate, nvramCheckForAutoUpdate

nvramCheckForAutoUpdate

機能 自動更新がオンになっているかどうかを調べます。

構文 uint8 nvramCheckForAutoUpdate(void)

戻り値 true 自動更新はオンになっています。

false 自動更新はオンになっていません。

使用例 –

参照 nvramEnableAutoUpdate, nvramDisableAutoUpdate

nvramManualUpdateExit

機能 NVRAM の内容を、アプリケーションの最後に確実に更新します。

構文 void nvramManualUpdateExit (void)
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説明 この関数を必ず Exit タスク内の最後のユーザープロセスの後に配置し、

ユーザーアプリケーションモード終了時（Stop ERCOS ボタン押下時）に

NVRAM の内容が最終的に確実に更新されるようにしてください。処理中

にエラーが発生した場合には、実験環境内にエラーメッセージが表示され

ます。

使用例 –

参照 nvramManualUpdateBackground, 
nvramManualUpdateBlocked

nvramManualUpdateBackground

機能 NVRAM の内容の任意更新を開始します。

構文 uint32 nvramManualUpdateBackground(void)

説明 この関数は NVRAM の内容の任意更新を開始します。任意更新は定期的

に行われる自動更新よりも優先されるので、この定期更新がすでに開始

していた時に任意更新が要求されると、実行中の定期更新は中断されま

す。ただし、定期更新が途中で保留されている場合（つまり Idle タスク

がプリエンプティブタスクからのこの関数呼び出しにより中断されてい

た場合）には、任意更新は開始できません。

実際の更新処理はバックグラウンドで（Idle タスク内で）行われるので、

この関数は直ちに呼び出し元に戻ります。更新処理が完了したかどうか

は、nvramCheckRunningUpdate()関数により判断できます。

注記：自動更新がオンになっている間は、この関数は使用しないことを

お勧めします。

戻り値 EC_NVRAM_SUCCESS 成功

EC_NVRAM_NO_NV_VARIABLES モデル内に NV 変数がありません。

EC_NVRAM_FATAL_ERROR 以前に重大なエラーが発生していま

す。

EC_NVRAM_OVERFLOW NVRAM のオーバーフロー。NV 変

数の数／サイズを少なくしてくださ

い。

EC_NVRAM_UPDATE_RUNNING 他の更新プロセス（任意更新または自

動更新）が現在実行中です。任意更新

の開始に失敗しました。

使用例 –

参照 nvramManualUpdateBlocked, nvramManualUpdateExit

nvramManualUpdateExit
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nvramManualUpdateBlocked

機能 NVRAM の内容の任意更新を開始します（現在の優先度をブロックしま

す）。

構文 uint32 nvramManualUpdateBlocked
(uint32 timeoutUs)

説明 この関数は NVRAM の内容の任意更新を開始します。任意更新は定期的

に行われる自動更新よりも優先されるので、この定期更新がすでに開始し

ていた時に任意更新が要求されると、実行中の定期更新は中断されます。

ただし、定期更新が途中で保留されている場合（つまり Idle タスクがプ

リエンプティブタスクからのこの関数呼び出しにより割り込まれていた場

合）には、任意更新は開始できません。この関数は、すべての NV 変数の

内容がローカルバッファに書き込まれるまで、またはタイムアウトが発生

するまで、現在の優先度をブロックします。

実際の更新処理（ローカルバッファから NVRAM への書き込み）は、こ

の関数から呼び出し元にリターンした後、Idle タスク内で続行されます

（タイムアウトが発生しても行われます）。更新処理が完了したかどうかは

nvramCheckRunningUpdate()関数により判断できます。

更新処理中も割込みは保留されないので、更新処理より優先度の高いプリ

エンプティブタスクが更新処理に割込みをかける場合があり、このタスク

が NV 変数の内容を変更すると、データの不整合が生じる可能性がありま

す。

注記：自動更新がオンになっている際は、この関数は使用しないことを

お勧めします。

戻り値 EC_NVRAM_SUCCESS 成功

EC_NVRAM_NO_NV_VARIABLES モデル内に NV 変数がありません。

EC_NVRAM_FATAL_ERROR 以前に重大なエラーが発生していま

す。

EC_NVRAM_OVERFLOW NVRAM のオーバーフロー。NV 変数

の数／サイズを少なくしてください。

EC_NVRAM_UPDATE_RUNNING 他の更新プロセス（任意更新または自動

更新）が現在実行中です。任意更新の開

始に失敗しました。

引数 timeoutUs タイムアウト周期（µs）

使用例 –

参照 nvramManualUpdateBlocked, nvramManualUpdateExit, 
nvramCheckRunningUpdate
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nvramCheckRunningUpdate

機能 NVRAM の任意更新が実行されているかどうかを調べます。

構文 uint8 nvramCheckRunningUpdate(void)

説明 この関数は、nvramStartManualUpdateBackgroundまたは

nvramStartManualUpdateBlockedにより開始された NVRAM 任意

更新が、まだバックグラウンドで実行中であるかどうかを調べます。

戻り値 false 更新は実行されていません。（すでに終了したか、または

開始に失敗しました。）

true 更新は今も実行中です。

使用例 –

参照 nvramManualUpdateBackground, 
nvramManualUpdateBlocked

nvramCheckForInitializedVars

機能 NV 変数が NVRAM の値で初期化されているかどうかを調べます。

構文 uint8 nvramCheckForInitializedVars(void)

説明 NVRAM に保存されていた値がモデル内の NV 変数の初期値として使用さ

れたかどうかを調べます。初期化は、実験環境における自動更新により、

あるいは C コードから呼び出された API 関数により、実行される可能性

があります。

戻り値 true NV 変数に NVRAM の値が初期設定されています。

false NV 変数に、NVRAM の値ではなくモデルのデフォルト値

が初期設定されています。

使用例 –

参照 nvramInitModelVars

nvramGetUpdateAgeMs

機能 前回の更新終了以降の経過時間を返します。

構文 uint32 nvramGetUpdateAgeMs(void)

戻り値 updateAge 時間（ミリ秒）

説明 この関数は、前回の更新（任意更新または自動更新）が終了してから経過

した時間を返します。

使用例 –

参照 –
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13.3 API 関数（ウォッチドッグ）

ES1135 シミュレーションボードには、ハードウェアウォッチドッグ機能が搭載さ
れています。この機能を使用するためのインターフェースは、ボードのファーム
ウェアに含まれています。

ウォッチドッグ機能についての詳細は、6.2.2 項を参照してください。

13.3.1 ウォッチドッグの設定

nvramClear

機能 NVRAM の内容を消去します。

構文 uint32 nvramClear(void)

戻り値 EC_NVRAM_SUCCESS 成功

説明 この関数は NVRAM の内容を消去します。メモリにはゼロが初期設定され

ます。

使用例 –

参照 –

wdSetSafetyMode

機能 ウォッチドッグをセーフティモードに切り替えます。

構文 uint32 wdSetSafetyMode
(uint32 event, uint32 period)

説明 運用前モードまたは RSEF モードから、セーフティモードへの切り替えを

行います。切り替え後は、電源をオフにしない限り、このモードを解除

することはできません。

引数 eventにより、ウォッチドッグ満了時に実行するアクションが決ま

ります。

WD_EVENT_DISABLEはウォッチドッグをオフにします。

WD_EVENT_PPC750_RESETは IBM 750GX シミュレーションプロセッ

サをリセットします。

WD_EVENT_PPC750_INTはシミュレーションプロセッサへの割込みを

トリガします。

引数 period（ウォッチドッグが満了するまでの時間）には、0.25ms ～

4096ms の値を設定できます。

戻り値 EC_CFW_SUCCESS 成功

EC_CFW_WD_SAFETY_MODE ウォッチドッグは既にセーフティモード

になっています。

EC_CFW_INVALID_ARG eventまたは periodの値が無効です。
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引数 event WD_EVENT_DISABLE
WD_EVENT_PPC750_RESET
WD_EVENT_PPC750_INT

period WD_PERIOD_4096MS
WD_PERIOD_1024MS
WD_PERIOD_256MS
WD_PERIOD_64MS
WD_PERIOD_16MS
WD_PERIOD_4MS
WD_PERIOD_1MS
WD_PERIOD_0_25MS

使用例 uint32 period;
uint32 event;
uint32 retVal;
event = WD_EVENT_DISABLE;
period = WD_PERIOD_4096MS;
retVal = wdSetSafetyMode(event, period);

参照 wdSetPeriod, wdSetEvent

wdSetReducedSafetyMode

機能 ウォッチドッグを RSEF モードに設定します。

構文 uint32 wdSetReducedSafetyMode(void)

説明 運用前モードから RSEF（Reduced Safety Enhanced Function）モードへ

の切り替えを行います。

注記：この関数はブートローダ内でコールされます。従って、モデル実

行開始時にはウォッチドッグはすでに RSEF モードになっているため、ア

プリケーションからこの関数を呼び出しても何も状態は変化しません。

また、ブートローダはウォッチドッグイベントもディセーブルにします。

ウォッチドッグの時間とイベントは、それぞれ wdSetPeriodと

wdSetEventにより、任意に変更することができます。

戻り値 EC_CFW_SUCCESS 成功

EC_CFW_WD_SAFETY_MODE ウォッチドッグはセーフティモードに

なっています。これを解除することはで

きません。

EC_CFW_WD_RSEF_MODE ウォッチドッグはすでに RSEF モードに

なっています。

使用例 -

参照 wdSetPeriod, wdSetEvent

wdSetSafetyMode
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wdSetPeriod

機能 ウォッチドッグの監視時間を設定します。

構文 uint32 wdSetPeriod(uint32 period)

説明 ウォッチドッグの監視時間を設定します。この時間を過ぎてもウォッチ

ドッグサービスがおこなわれないと、ウォッチドッグイベントが発生しま

す。0.25ms ～ 4096ms の値を設定できます。

戻り値 EC_CFW_SUCCESS 成功

EC_CFW_WD_SAFETY_MODE ウォッチドッグはセーフティモードに

なっています。periodの修正はできま

せん。

EC_CFW_INVALID_ARG periodの値が無効です。

EC_CFW_WD_PRE_OP_MODE ウォッチドッグは運用前モードになって

います。まず RSEF モードに切り替えて

ください。

引数 period WD_PERIOD_4096MS
WD_PERIOD_1024MS
WD_PERIOD_256MS
WD_PERIOD_64MS
WD_PERIOD_16MS
WD_PERIOD_4MS
WD_PERIOD_1MS
WD_PERIOD_0_25MS

使用例 uint32 period;
uint32 retVal;
period = WD_PERIOD_4096MS;
retVal = wdSetPeriod(period);

参照 wdSetSafetyMode, wdSetEvent

wdSetEvent

機能 ウォッチドッグタイマが満了したときに処理するイベントを設定します。

構文 uint32 wdSetEvent(uint32 event)

説明 ウォッチドッグが満了したときに実行されるアクションを選択します。

WD_EVENT_DISABLEは、ウォッチドッグをディセーブルにします。

WD_EVENT_PPC750_RESETは IBM 750GX シミュレーションプロセッ

サをリセットします。

WD_EVENT_PPC750_INTはシミュレーションプロセッサへの割込みを

トリガします

戻り値 EC_CFW_SUCCESS 成功

EC_CFW_WD_SAFETY_MODE ウォッチドッグはセーフティモードに

なっています。eventの修正はできませ

ん。
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13.3.2 ウォッチドッグサービス

EC_CFW_INVALID_ARG eventの値が無効です。

EC_CFW_WD_PRE_OP_MODE ウォッチドッグは運用前モードになって

います。まず RSEF モードに切り替えてく

ださい。

引数 event WD_EVENT_DISABLE
WD_EVENT_PPC750_RESET
WD_EVENT_PPC750_INT

使用例 uint32 event;
uint32 retVal;
event = WD_EVENT_DISABLE;
retVal = wdSetEvent(event);

参照 wdSetSafetyMode, wdSetPeriod

wdService

機能 ウォッチドッグサービスを行います。

構文 Void wdService(void)

説明 ウォッチドッグサービスを行い、wdSetPeriod()によって設定された

値をウォッチドッグタイマにセットします。

使用例 wdService();

参照 wdEnableAutoService, wdDisableAutoService

wdEnableAutoService

機能 自動サービスをオンにします。

構文 void wdEnableAutoService (void)

説明 自動ウォッチドッグサービス機能をオンにします。割込みがイネーブル

になっている場合には、30ms 間隔でウォッチドッグサービスを行いま

す。RTIO デバイスドライバにより、さらにサービスを行うこともできま

す。サービス実行はデフォルトではイネーブルになっています。

使用例 wdEnableAutoService();

参照 wdService, wdDisableAutoService

wdSetEvent
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13.3.3 割込み制御

wdDisableAutoService

機能 自動サービスをオフにします。

構文 void wdDisableAutoService(void)

説明 自動ウォッチドッグサービス機能をオフにします。

注記：ウォッチドッグサービスをモデルで行う際には、適切な処理を行

う必要があります。自動機能をディセーブルにすると RTIO 内部サービス

コールもディセーブルになるので、注意が必要です。RTIO ドライバコー

ル（特に Init と Exit）によって長時間のブロックが生じる可能性があるの

で、自動サービスをオンにする処理は、Init タスクと Exit タスクの中で

行ってください。

使用例 wdDisableAutoService();

参照 wdService, wdEnableAutoService

wdIntEnable

機能 ウォッチドッグ割込み処理をイネーブルにします。

構文 void wdIntEnable(void)

説明 この関数はウォッチドッグ割込み処理をイネーブルにします。前もって

wdSetEvent()を使用して、ウォッチドッグイベントを適切にマッピン

グしておいてください。wdIntEnable()は割込みの伝達だけに影響し

ます。wdIntPend()は、ウォッチドッグ割込みがディセーブルになっ

ていても使用できます。

使用例 wdIntEnable();

参照 wdSetEvent, wdIntPend, wdIntDisable, wdIntAck

wdIntDisable

機能 ウォッチドッグ割込み処理をディセーブルにします。

構文 void wdIntDisable(void)

説明 この関数はウォッチドッグ割込み処理をディセーブルにします。

使用例 wdIntDisable();

参照 wdIntEnable
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wdIntPend

機能 割込みが処理待ち状態になっているかどうかを調べます。

構文 uint8 wdIntPend(void)

戻り値 false 処理待ち状態のウォッチドッグ割込みはありません。

true ウォッチドッグ割込みが処理待ち状態になっています。

説明 ウォッチドッグ割込みが処理待ち状態になっているかどうかを調べます。

前もって wdSetEvent()を使用して、ウォッチドッグイベントを適切

にマッピングしておいてください。

使用例 if(wdIntPend() == true)

{

intPollCount++;

/* Reset Interrupt */

wdIntAck();

}

参照 wdSetEvent, wdIntDisable, wdIntAck

wdIntAck

機能 ウォッチドッグ割込みに応答します。

構文 void wdIntAck(void)

説明 ウォッチドッグ割込みに応答するための関数です。ウォッチドッグタイマ

（イベントをトリガした後は自動的に再起動されます）はこのコールの影

響を受けません。ウォッチドッグタイマを初期化する必要がある場合に

は、先に wdService()を使用してください。

使用例 if(wdIntPend() == true)

{

intPollCount++;

/* Reset Interrupt */

wdIntAck();

}

参照 wdSetEvent, wdIntDisable, wdIntPend
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13.3.4 ウォッチドッグステータス

wdCheckReducedSafetyMode

機能 ウォッチドッグが RSEF モードになっているかどうかを調べます。

構文 uint8 wdCheckReducedSafetyMode(void)

説明 ウォッチドッグが Reduced Safety Enhanced Function（RSEF）モードで稼

働しているかどうかを調べます。RSEF モードになっていれば、ウォッチ

ドッグの設定をモデルから任意に修正できます。

戻り値 false ウォッチドッグはセーフティモードで稼働しています。

true ウォッチドッグは RSEF モードで稼働しています。

使用例 asdWriteUserDebug("Active = %u   
ReducedSafety = %u \n",
wdCheckActive(), 
wdCheckReducedSafetyMode());

* asdWriteUserDebugについては 13.5 項を参照してください。

参照 wdSetSafetyMode, wdCheckActive

wdCheckActive

機能 ウォッチドッグがオンになっているかどうかを調べます。

構文 uint8 wdCheckActive(void)

説明 ウォッチドッグが現在オンになっているかどうかを調べます。現在デバッ

ガが ES1135 ボードに接続されている場合、ウォッチドッグはオフとなり

ます。

戻り値 false ウォッチドッグは現在オンではありません。

true ウォッチドッグは現在オンになっています。

使用例 asdWriteUserDebug("Active = %u   
ReducedSafety = %u \n",
wdCheckActive(), 
wdCheckReducedSafetyMode());

* asdWriteUserDebugについては 13.5 項を参照してください。

参照 wdSetSafetyMode, wdSetEvent, 
wdCheckReducedSafetyMode
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13.4 API 関数（ES1135 LED）

ES1135 シミュレーションコントローラには設定可能な LED が 3 つあります。こ
れらについては、6.2.3 項に簡単に説明されています。この LED は、以下のイン
ターフェースを使用して制御します。

userLed[n]On

機能 LED[n]をオンにします。

構文 void userLed1On(void)
void userLed2On(void)
void userLed3On(void)

説明 指定の LED をオンにします。

使用例 userLed1On();

参照 userLed[n]Off, userLed[n]Toggle

userLed[n]Off

機能 LED[n]をオフにします。

構文 void userLed1Off(void)
void userLed2Off(void)
void userLed3Off(void)

説明 指定の LED をオフにします。

使用例 userLed1Off();

参照 userLed[n]On
userLed[n]Toggle

userLed[n]Toggle

機能 LED[n]のオン／オフを切り替えます。

構文 void userLed1Toggle(void)
void userLed2Toggle(void)
void userLed3Toggle(void)

説明 指定の LED のオン／オフを切り替えます。

使用例 userLed1Toggle();

参照 userLed[n]Off, userLed[n]On
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13.5 API 関数（その他）

さらにいくつかの API 関数を使用できます。

asdWriteUserError

機能 ASCET モニタウィンドウにコメントを出力します。

構文 ANSI-C 関数の printfと同じです。

説明 ASCET モニタウィンドウにユーザーメッセージを表示します。

使用例 uint8 number = 1;
asdWriteUserError("Example %u \n", number);

参照 asdWriteUserDebug

asdWriteUserDebug

機能 ASCET “Target Debugger”ウィンドウにコメントを出力します。

構文 ANSI-C 関数の printfと同じです。

説明 ASCET “Target Debugger”ウィンドウにユーザーメッセージを表示しま

す。

使用例 uint8 number = 1;
asdWriteUserDebug("Example %u \n", number);

参照 asdWriteUserError
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